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68000 Emulation and Analysis

The HP 64742, HP 64743, and HP 64744 family of 68000 emulators replace the
microprocessor in your embedded microprocessor system, also called the target
system, so that you can control execution and view or modify processor and target
system resources.

The emulator requires an emulation analyzer that captures 48 channels of emulation
processor bus cycle information synchronously with the processor’s clock signal.
The HP 64706 Emulation Bus Analyzer meets this requirement.

You can also use the HP 64703 Emulation Bus Analyzer which has 64 channels
and an external analyzer that captures up to 16 channels of data external to the
emulator.

And, you can use the HP 64704 or HP 64794 Emulation Bus Analyzers which have
80 channels; however, these analyzers do not have external analysis channels.

With the Emulator, You Can ...

• Plug into 68000 target systems.
• Download programs into emulation memory or target system RAM.
• Display or modify the contents of processor registers and memory resources.
• Run programs, set up software breakpoints, step through programs, and reset

the emulation processor.

With the Analyzer, You Can ...

• Trigger the analyzer when a particular bus cycle state is captured.  States are
stored relative to the trigger state.

• Qualify which states get stored in the trace.
• Prestore certain states that occur before each normal store state.
• Trigger the analyzer after a sequence of up to 8 events have occurred.
• Capture data on signals of interest in the target system with the external

analyzer.
• Cause emulator execution to break when the analyzer finds its trigger condition.
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With the HP 64700 Card Cage, You Can ...

• Use the RS-422 capability of the serial port and an RS-422 interface card on
the host computer (HP 98659 for the HP 9000 Series 300) to provide
upload/download rates of up to 230.4K baud.

• Easily upgrade HP 64700 firmware by downloading to flash memory.

With Multiple HP 64700s, You Can ...

• Start and stop up to 16 emulators at the same time (up to 32 if modifications
are made).

• Use the analyzer in one HP 64700 to arm (that is, activate) the analyzers in
other HP 64700 card cages or to cause emulator execution in other HP 64700
card cages to break.

• Use the HP 64700’s BNC connector to trigger an external instrument (for
example, a logic analyzer or oscilloscope) when the analyzer finds its trigger
condition, or you can allow an external instrument to arm the analyzer or break
emulator execution.

With the Graphical User Interface, You Can ...

• Use the emulator and analyzer under an X Window System that supports
OSF/Motif interfaces.

• Enter commands using pull-down or pop-up menus.
• Enter, recall, and edit commands using the command line pushbuttons.
• Enter file names, recalled commands, recalled values, etc., using dialog boxes.
• Set breakpoints by pointing the mouse cursor on a line in the mnemonic

memory display and clicking.
• Create action keys for commonly used commands or command files.

With the Softkey Interface, You Can ...

• Use the emulator and analyzer with a terminal or terminal emulator.
• Quickly enter commands using softkeys, command recall, and command

editing.
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In This Book

This book documents the Grapical User Interface and the Softkey Interface when
used with the HP 64742, HP 64743, and HP 64744 68000 family of emulators and
the HP 64703/704/706/794 analyzer.  It is organized into five parts whose chapters
are described below.

Part 1. Quick Start Guide

Chapter 1 presents an overview of emulation and analysis and quickly shows
you how to use the emulator and analyzer.

Part 2. User’s Guide

Chapter 2 shows you how to start and exit the HP 64700 interfaces.
Chapter 3 shows you how to enter commands.
Chapter 4 shows how to configure the emulator.
Chapter 5 shows how to use the emulator.
Chapter 6 shows how to use the analyzer.
Chapter 7 shows how to use the Software Performance Measurement Tool
(SPMT) with the analyzer.
Chapter 8 shows how to use the external state analyzer.
Chapter 9 shows how to make coordinated measurements.
Chapter 10 shows how to change X resource settings for the Graphical User
Interface.

Part 3. Reference

Chapter 11 describes emulator/analyzer interface commands.
Chapter 12 lists the error messages that can occur while using the
emulator/analyzer interface.

Part 4. Concept Guide

Chapter 13 contains conceptual information on various topics.

Part 5. Installation Guide

Chapter 14 outlines the installation of the Graphical User Interface, and shows
you how to start and exit the interface.

6



Contents

Part 1 Quick Start Guide

1 Getting Started

The Emulator/Analyzer Interface — At a Glance   24
The Softkey Interface   24
Softkey Interface Conventions   25
The Graphical User Interface   26
Graphical User Interface Conventions   28

The Getting Started Tutorial   31
Step 1. Start the demo   32
Step 2: Display the program in memory   33
Step 3: Run from the transfer address   34
Step 4: Step high-level source lines   35
Step 5: Display the previous mnemonic display   36
Step 6: Run until an address   37
Step 7: Display data values   38
Step 8: Display registers   39
Step 9: Step assembly-level instructions   40
Step 10: Trace the program   41
Step 11: Display memory at an address in a register   43
Step 12: Patch assembly language code   44
Step 13: Exit the emulator/analyzer interface   47

7



Part 2 User’s Guide

2 Starting and Exiting HP 64700 Interfaces

Starting the Emulator/Analyzer Interface   53
To start the emulator/analyzer interface   53
To start the interface using the default configuration   54
To run a command file on interface startup   55
To display the status of emulators   55
To unlock an interface that was left locked by another user   56

Opening Other HP 64700 Interface Windows   57
To open additional emulator/analyzer windows   57
To open the high-level debugger interface window   58
To open the software performance analyzer (SPA) interface window   58

Exiting HP 64700 Interfaces   59
To close an interface window   59
To exit a debug/emulation session   60

3 Entering Commands

Using Menus, the Entry Buffer, and Action Keys   63
To choose a pulldown menu item using the mouse (method 1)   64
To choose a pulldown menu item using the mouse (method 2)   65
To choose a pulldown menu item using the keyboard   65
To choose popup menu items   67
To place values into the entry buffer using the keyboard   68
To copy-and-paste to the entry buffer   68
To recall entry buffer values   71
To use the entry buffer   71
To copy-and-paste from the entry buffer to the command line entry area   72
To use the action keys   73
To use dialog boxes   73
To access help information   77

Contents

8



Using the Command Line with the Mouse   78
To turn the command line on or off   78
To enter a command   79
To edit the command line using the command line pushbuttons   80
To edit the command line using the command line popup menu   81
To recall commands   82
To get help about the command line   82

Using the Command Line with the Keyboard   83
To enter multiple commands on one command line   83
To recall commands   84
To edit commands   84
To access on-line help information   85

Using Command Files   86
To start logging commands to a command file   89
To stop logging commands to a command file   89
To playback (execute) a command file   90

Using Pod Commands   91
To display the pod commands screen   92
To use pod commands   92

Forwarding Commands to Other HP 64700 Interfaces   93
To forward commands to the high-level debugger   93
To forward commands to the software performance analyzer   94

4 Configuring the Emulator

Using the Configuration Interface   99
To start the configuration interface   100
To modify a configuration section   102
To store a configuration   104
To change the configuration directory context   105
To display the configuration context   106
To access help information   106
To exit the configuration interface   107
To load a configuration   107

Contents

9



Modifying the General Configuration Items   108
To select the emulator clock source (HP 64742/3)   108
To enable/disable entry into the monitor after configuration   109
To restrict the emulator to real-time runs   109
To turn OFF the restriction to real-time runs   110
To select the inverse assembly syntax   110

Selecting the Emulation Monitor Program   112
To use the background monitor program   115
To use a foreground monitor program   116
To synchronize monitor cycles to the target system (HP 64744)   119
To disable the synchronization of monitor cycles (HP 64744)   119

Mapping Memory   120
To map memory ranges   122
To characterize unmapped ranges   124
To delete memory map ranges   125
To map memory ranges that use function codes   126

Configuring the Emulator Pod   128
To synchronize emulation memory cycles to the target (HP 64742/3)   128
To disable synchronization of emulation memory cycles (HP 64742/3)   129
To enable/disable bus arbitration   129
To include bus arbitration tags in the trace   130
To exclude bus arbitration tags from the trace   130
To enable/disable /BERR response on emulation memory accesses   131
To enable/disable response to target system interrupts   132
To set the reset value for the Supervisor Stack Pointer   132
To set the processor data bus width (HP 64744)   133
To specify the target memory access size   133
To drive background cycles to the target system   134
To stop driving background cycles to the target system   135

Setting the Debug/Trace Options   136
To enable/disable breaks on writes to ROM   136
To specify which TRAP instruction is used for software breakpoints   137
To include/exclude background states in the trace   137

Contents

10



5 Using the Emulator

Loading and Storing Absolute Files   141
To load absolute files   141
To load absolute files without symbols   142
To store memory contents into absolute files   142

Using Symbols   143
To load symbols   143
To display global symbols   144
To display local symbols   145
To display a symbol’s parent symbol   149
To copy-and-paste a full symbol name to the entry buffer   150

Using Context Commands   151
To display the current directory and symbol context   152
To change the directory context   152
To change the current working symbol context   153

Executing User Programs   154
To run programs from the current PC   154
To run programs from an address   155
To run programs from the transfer address   155
To run programs from reset   155
To run programs until an address   156
To stop (break from) user program execution   157
To step high-level source lines   157
To step assembly-level instructions   158
To reset the emulation processor   159

Using Software Breakpoints   160
To display the breakpoints list   162
To enable/disable breakpoints   163
To set a permanent breakpoint   165
To set a temporary breakpoint   166
To set all breakpoints   167
To deactivate a breakpoint   167
To re-activate a breakpoint   168
To clear a breakpoint   170
To clear all breakpoints   172

Contents

11



Displaying and Modifying Registers   173
To display register contents   173
To modify register contents   174

Displaying and Modifying Memory   175
To display memory   175
To display memory in mnemonic format   176
To return to the previous mnemonic display   176
To display memory in hexadecimal format   177
To display memory in real number format   178
To display memory at an address   179
To display memory repetitively   180
To modify memory   180

Displaying Data Values   181
To display data values   181
To clear the data values display and add a new item   182
To add items to the data values display   182

Changing the Interface Settings   183
To set the source/symbol modes   183
To set the display modes   184

Using System Commands   186
To set UNIX environment variables   186
To display the name of the emulation module   187
To display the event log   187
To display the error log   188
To edit files   189
To copy information to a file or printer   192
To open a terminal emulation window   193

Using Simulated I/O   194
To display the simulated I/O screen   194
To use simulated I/O keyboard input   195

Using Basis Branch Analysis   196
To store BBA data to a file   196

Contents

12



6 Using the Emulation Analyzer

The Basics of Starting, Stopping, and Displaying Traces   199
To start a trace measurement   200
To display the trace status   200
To stop a trace measurement   203
To display the trace   204
To position the trace display on screen   205
To change the trace depth   206
To modify the last 
trace command entered   206

Qualifying Trigger and Store Conditions   207
To qualify the trigger state and position   212
To trigger on a number of occurrences of some state   214
To qualify states stored in the trace   215
To prestore states before qualified store states   216
To change the count qualifier   217
To trace until the analyzer is halted   219
To break emulator execution on the analyzer trigger   220

Using the Sequencer   221
To trigger after a sequence of states   221
To specify a global restart state   223
To trace "windows" of program execution   224

Modifying the Trace Display   226
To display the trace about a line number   227
To display the trace, disassembling from a line number   228
To display the trace in absolute format   229
To display the trace in mnemonic format   230
To display the trace with high-level source lines   231
To display the trace with symbol information   233
To change column widths in the trace display   234
To display time counts in absolute or relative format   235
To display the trace with addresses offset   236
To return to the default trace display   237
To display external analyzer information   238

Contents

13



Saving and Restoring Traces   239
To save trace commands   239
To restore trace commands   240
To save traces   241
To restore traces   242

7 Making Software Performance Measurements

Activity Performance Measurements   245
To set up the trace command for activity measurements   247
To initialize activity performance measurements   248
To interpret activity measurement reports   252

Duration Performance Measurements   260
To set up the trace command for duration measurements   261
To initialize duration performance measurements   263
To interpret duration measurement reports   265

Running Measurements and Creating Reports   269
To run performance measurements   269
To end performance measurements   270
To create a performance measurement report   271

8 Using the External State Analyzer

Setting Up the External Analyzer   275
To connect the external analyzer probe to the target system   276

Configuring the External Analyzer   279
To control the external analyzer with the emulator/analyzer interface   280
To specify the threshold voltage   281
To specify the external analyzer mode   282
To specify the slave clock mode   283
To define labels for the external analyzer signals   286

Contents

14



9 Making Coordinated Measurements

Setting Up for Coordinated Measurements   293
To connect the Coordinated Measurement Bus (CMB)   293
To connect to the rear panel BNC   295

Starting/Stopping Multiple Emulators   297
To enable synchronous measurements   297
To start synchronous measurements   298
To disable synchronous measurements   298

Using Trigger Signals   299
To drive the emulation analyzer trigger signal to the CMB   301
To drive the emulation analyzer trigger signal to the BNC connector   302
To drive the external analyzer trigger signal to the CMB   302
To drive the external analyzer trigger signal to the BNC connector   303
To break emulator execution on signal from CMB   303
To break emulator execution on signal from BNC   304
To break emulator execution on external analyzer trigger   304
To arm the emulation analyzer on signal from CMB   305
To arm the emulation analyzer on signal from BNC   305
To arm the emulation analyzer on external analyzer trigger   306
To arm the external analyzer on signal from CMB   306
To arm the external analyzer on signal from BNC   307
To arm the external analyzer on emulation analyzer trigger   307

10 Setting X Resources
To modify the Graphical User Interface resources   312
To use customized scheme files   316
To set up custom action keys   318
To set initial recall buffer values   319
To set up demos or tutorials   321

Contents

15



Part 3 Reference

11 Emulator/Analyzer Interface Commands

How Pulldown Menus Map to the Command Line   328
How Popup Menus Map to the Command Line   332
Syntax Conventions   334

Commands   335
break   336
bbaunld   337
cmb_execute   338
copy   339
copy local_symbols_in   342
copy memory   343
copy registers   345
copy trace   346
display   347
display data   349
display global_symbols   352
display local_symbols_in   353
display memory   354
display registers   358
display simulated_io   359
display software_breakpoints   360
display trace   361
end   365
--EXPR--   366
FCODE   369
forward   371
help   372
load   374
log_commands   376
modify   377
modify configuration   378
modify keyboard_to_simio   379
modify memory   380
modify register   383
modify software_breakpoints   384
performance_measurement_end   386
performance_measurement_initialize   387

Contents

16



performance_measurement_run   389
pod_command   391
QUALIFIER   393
RANGE   395
reset   397
run   398
SEQUENCING   400
set   402
specify   407
STATE   409
step   411
stop_trace   413
store   414
--SYMB--   416
trace   423
TRIGGER   426
wait   428
WINDOW   430

12 Error Messages

Graphical/Softkey Interface Messages - Unnumbered   435

Graphical/Softkey Interface Messages - Numbered   452

Terminal Interface Messages   455
Emulator Messages   455
68000 Emulator Messages   458
General Emulator and System Messages   460
Analyzer Messages   473

Contents

17



Part 4 Concept Guide

13 Concepts

X Resources and the Graphical User Interface   481
X Resource Specifications   481
How X Resource Specifications are Loaded   483
Scheme Files   485

Part 5 Installation Guide

14 Installation

Installation at a Glance   492
Installation Overview for HP 9000 Hosted Systems   492
Installation Overview for Sun SPARCsystems   494

Installation for HP 9000 Hosted Systems    495
Step 1. Install the hardware in the HP 64700 Series Cardcage   495
Step 2. Configure the emulator for the communication channel   495
Step 3. Connect the emulator to your system   496
Step 4. Install the software   496
Step 5. Verify the software installation   498
Step 6a. Start the X server and the Motif Window Manager (mwm)   499
Step 6b. Start HP VUE   499
Step 7. Set the necessary environment variables   500
Step 8. Determine the logical name of your emulator   502
Step 9. Start the interface with the emul700 command   503
Step 10. Exit the Graphical User Interface   505

Contents

18



Installation for Sun SPARCsystems   506
Step 1. Install the hardware in the HP 64700 Series Cardcage   506
Step 2. Configure the emulator for the communication channel   506
Step 3. Connect the emulator to your system   507
Step 4. Install the software   507
Step 5. Start the X server and OpenWindows   508
Step 6. Set the necessary environment variables   508
Step 7. Verify the software installation   510
Step 8. Map your function keys   511
Step 9. Determine the logical name of your emulator   512
Step 10. Start the interface with the emul700 command   513
Step 11. Exit the Graphical User Interface   515

Glossary

Index

Contents

19



20



Part 1

Quick Start Guide

21



Part 1

22



1

Getting Started

23



The Emulator/Analyzer Interface — At a Glance

When an X Window System that supports OSF/Motif interfaces is running on the
host computer, the emulator/analyzer interface is the Graphical User Interface
which provides pull-down and pop-up menus, point and click setting of
breakpoints, cut and paste, on-line help, customizable action keys and pop-up recall
buffers, etc.

The emulator/analyzer interface can also be the Softkey Interface which is provided
for several types of terminals, terminal emulators, and bitmapped displays.  When
using the Softkey Interface, commands are entered from the keyboard.

The Softkey Interface

Display area.

Status line.

Command line.

Display area. Can show memory, data values, analyzer traces, registers,
breakpoints, status, simulated I/O, global symbols, local symbols, pod commands
(the emulator’s underlying Terminal Interface), error log, or display log.  You can
use the UP ARROW, DOWN ARROW, PAGE UP, and PAGE DOWN cursor keys
to scroll or page up or down the information in the active window.

Chapter 1: Getting Started
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Status line. Displays the emulator and analyzer status. Also, when error and
status messages occur, they are displayed on the status line in addition to being
saved in the error log.

Command line. Commands are entered on the command line by pressing
softkeys (or by typing them in) and executed by pressing the Return key.  The Tab
and Shift-Tab keys allow you to move the cursor on the command line forward or
backward.  The Clear line key (or CTRL-e) clears from the cursor position to the
end of the line.  The CTRL-u key clears the whole command line.

Softkey Interface Conventions

Example Softkey Interface commands throughout the manual use the following
conventions:

bold Commands, options, and parts of command syntax.

bold italic Commands, options, and parts of command syntax which
may be entered by pressing softkeys.

normal User specified parts of a command.

$ Represents the UNIX prompt.  Commands which follow
the "$" are entered at the UNIX prompt.

<RETURN> The carriage return key.

Chapter 1: Getting Started
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The Graphical User Interface

Menu bar

Action keys

Entry buffer

Entry buffer recall
button.

Display area.

Scroll bar.

Status line.

Command line.

Command line entry
area.

Softkey pushbuttons

Command buttons.  Includes command
recall button.

Cursor buttons for command line area
control.

Menu Bar. Provides pulldown menus from which you select commands.  When
menu items are not applicable, they appear half-bright and do not respond to mouse
clicks.

Action Keys. User-defined pushbuttons.  You can label these pushbuttons and
define the action to be performed.

Chapter 1: Getting Started
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Entry Buffer. Wherever you see "()" in a pulldown menu, the contents of the
entry buffer are used in that command.  You can type values into the entry buffer,
or you can cut and paste values into the entry buffer from the display area or from
the command line entry area.  You can also set up action keys to use the contents of
the entry buffer.

Entry Buffer Recall Button. Allows you to recall entry buffer values that have
been predefined or used in previous commands.  When you click on the entry
buffer Recall button, a dialog box appears that allows you to select values.

Display Area. Can show memory, data values, analyzer traces, registers,
breakpoints, status, simulated I/O, global symbols, local symbols, pod commands
(the emulator’s underlying Terminal Interface), error log, or display log.

Whenever the mouse pointer changes from an arrow to a hand, you can press and
hold the select mouse button to access popup menus.

Scroll Bar. A "sticky slider" that allows navigation in the display area.  Click on
the upper and lower arrows to scroll to the top (home) and bottom (end) of the
window.  Click on the inner arrows to scroll one line.  Drag the slider handle up or
down to cause continuous scrolling.  Click between the inner arrows and the slider
handle to page up or page down.

Status Line. Displays the emulator and analyzer status. Also, when error and
status messages occur, they are displayed on the status line in addition to being
saved in the error log.  You can press and hold the select mouse button to access the
Status Line popup menu.

Command Line. The command line area is similar to the command line in the
Softkey Interface; however, the graphical interface lets you use the mouse to enter
and edit commands.

• Command line entry area.  Allows you to enter commands from the
command line.

• Softkey pushbuttons.  Clicking on these pushbuttons, or pressing softkeys,
places the command in the command line entry area.  You can press and hold
the select mouse button to access the Command Line popup menu.

• Command buttons (includes command recall button).  The command Return
button is the same as pressing the carriage return key — it sends the command
in the command line entry area to the emulator/analyzer.

Chapter 1: Getting Started
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The command Recall button allows you to recall previous or predefined
commands.  When you click on the command Recall button, a dialog box
appears that allows you to select a command.

• Cursor buttons for command line area control.  Allow you to move the
cursor in the command line entry area forward or backward, clear to the end of
the command line, or clear the whole command line entry area.

You can choose not to display the command line area by turning it off.  For the
most common emulator/analyzer operations, the pulldown menus, popup menus,
and action keys provide all the control you need.  Choosing menu items that require
use of the command line will automatically turn the command line back on.

Graphical User Interface Conventions

Choosing Menu Commands

This chapter uses a shorthand notation for indicating that you should choose a
particular menu item.  For example, the following instruction

Choose File→Load→Configuration

means to first display the File pulldown menu, then display the Load cascade
menu, then select the Configuration  item from the Load cascade menu.

Based on this explanation, the general rule for interpreting this notation can be
stated as follows:

• The leftmost item in bold is the pulldown menu label.

• If there are more than two items, then cascade menus are involved and all
items between the first and last item have cascade menus attached.

• The last item on the right is the actual menu choice to be made.

Chapter 1: Getting Started
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Mouse Button and Keyboard Bindings

Because the Graphical User Interface runs on different kinds of computers, which
may have different conventions for mouse buttons and key names, the Graphical
User Interface supports different bindings and the customization of bindings.

This manual refers to the mouse buttons using general (or "generic") terms.  The
following table describes the generic mouse button names and shows the default
mouse button bindings.

Mouse Button Bindings and Description

Generic
Button
Name

Bindings:

DescriptionHP 9000
Sun
SPARCsystem

paste left left Paste from the display
area to the entry buffer.

command pastemiddle1 middle1 Paste from the entry
buffer to the command
line text entry area. 

select right right Click selects first item in
popup menus. Press and
hold displays menus.

command selectleft right Displays pulldown menus.

pushbutton
select

left left Actuates pushbuttons
outside of the display area.

1 Middle button on three-button mouse. Both buttons on two-button mouse.

Chapter 1: Getting Started
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The following tables show the default keyboard bindings.

Keyboard Key Bindings

Generic Key Name HP 9000 Sun SPARCsystem

menu select extend char extend char

insert insert char insert char

delete delete char delete char

left-arrow left arrow left arrow

right-arrow right arrow right arrow

up-arrow up arrow up arrow

down-arrow down arrow down arrow

escape escape escape

TAB TAB TAB

Chapter 1: Getting Started
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The Getting Started Tutorial

This tutorial gives you step-by-step instructions on how to perform a few basic
tasks using the emulator/analyzer interface.  The tutorial examples presented in this
chapter make the following assumptions:

• The HP 64742/3/4 emulator and HP 64703/4/6 analyzer are installed into the
HP 64700 Card Cage, the HP 64700 is connected to the host computer, and the
Softkey Interface software has been installed as outlined in the "Installation"
chapter.

• The emulator is operating out-of-circuit (that is, not plugged into a target
system) and contains at least 60 Kbytes of emulation memory.  (If you’re using
the HP 64744 68000/HC001/EC000 Emulator, it must be plugged into the
64744-66509 demo board).

The Demonstration Program

The demonstration program used in this chapter is a simple environmental control
system.  The program controls the temperature and humidity of a room requiring
accurate environmental control.

Chapter 1: Getting Started
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Step 1. Start the demo

A demo program and its associated files are provided with the Graphical User
Interface.

1 Change to the demo directory.

$ cd  /usr/hp64000/demo/debug_env/hp64742 <RETURN>

Refer to the README file for more information on the demo program.

2 Check that "/usr/hp64000/bin" and "." are in your PATH environment variable.  To
see the value of PATH:

$ echo  $PATH <RETURN>

3 If the Graphical User Interface software is installed on a different type of computer
than the computer you are using, edit the "platformScheme" resource setting in the
"Xdefaults.emul" file.

For example, if the Graphical User Interface will be run on a HP 9000 computer
and displayed on a Sun SPARCsystem computer, change the platform scheme to
"SunOS".

4 Start the emulator/analyzer demo.

$ Startemul  <logical_emul_name> <RETURN>

This script starts the emulator/analyzer interface (with a customized set of action
keys), loads a configuration file for the demo program, and then loads the demo
program.

The <logical_emul_name> in the command above is the logical emulator name
given in the HP 64700 emulator device table file (/usr/hp64000/etc/64700tab.net).

Chapter 1: Getting Started
Step 1. Start the demo
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Step 2: Display the program in memory

1 If the symbol "main" is not already in the entry buffer, move the mouse pointer to
the entry buffer (notice the flashing I-beam cursor) and type in "main".

2 Choose Display→Memory→Mnemonic ().

Or, using the command line, enter:

display memory  main mnemonic  <RETURN>

The default display mode settings cause source lines and symbols to appear in
displays where appropriate.  Notice you can use symbols when specifying
expressions.  The global symbol "main" is used in the command above to specify
the starting address of the memory to be displayed.
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Step 3: Run from the transfer address

The transfer address is the entry address defined by the software development tools
and included with the program’s symbol information.

• Click on the Run Xfer til ()  action key.

Or, using the command line, enter:

run from transfer_address until  main <RETURN>

Notice the message "Software break: <address>" is displayed on the status line and
that the emulator is "Running in monitor".  When you run until an address, a
breakpoint is set at the address before the program is run.

Notice the highlighted bar on the screen; it shows the current program counter.
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Step 4: Step high-level source lines

You can step through the program by high-level source lines.  The emulator
executes as many instructions as are associated with the high-level program source
lines.

1 To step a source line from the current program counter, click on the Step Source
action key.

Or, using the command line, enter:

step source  <RETURN>

Notice that the highlighted bar (the current program counter) moves to the next
high-level source line.

2 Step into the "init_system" function by continuing to step source lines, either by
clicking on the Step Source action key, by clicking on the Again action key which
repeats the previous command, or by entering the step source command on the
command line.
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Step 5: Display the previous mnemonic display

• Click on the Disp Src Prev action key.

Or, using the command line, enter:

display memory mnemonic previous_display  <RETURN>

This command is useful, for example, when you have stepped into a funtion that
you do not wish to look at—you can display the previous mnemonic display and
run until the source line that follows the function call.
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Step 6: Run until an address

When displaying memory in mnemonic format, a selection in the popup menu lets
you run from the current program counter address until a specific source line.

• Position the mouse pointer over the line "proc_spec_init();", press and hold the
select mouse button, and choose Run Until  from the popup menu.

Or, using the command line, enter:

run until  main."main.c": line 97 <RETURN>

After the command has executed, notice the highlighted bar indicates the program
counter has moved to the specified source line.
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Step 7: Display data values

1 Position the mouse pointer over "num_checks" in the source line that reads
"num_checks++;" and click the paste mouse button (notice "num_checks" is cut
and pasted into the entry buffer).

2 Click on the Disp Var () action key.

Or, using the command line, enter:

display data ,  num_checks int32  <RETURN>

The "num_checks" variable is added to the data values display and its value is
displayed as a 32-bit integer.

Chapter 1: Getting Started
Step 7: Display data values

38



Step 8: Display registers

You can display the contents of the processor registers.

• Choose Display→Registers.

Or, using the command line, enter:

display registers  <RETURN>
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Step 9: Step assembly-level instructions

You can step through the program one instruction at a time.

• To step one instruction from the current program counter, click on the Step Asm
action key.

Or, using the command line, enter:

step  <RETURN>

Notice, when registers are displayed, stepping causes the assembly language
instruction just executed to be displayed.
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Step 10: Trace the program

When the analyzer traces program execution, it looks at the data on the emulation
processor’s bus and control signals at each clock cycle. The information seen at a
particular clock cycle is called a state.

When one of these states matches the "trigger state" you specify, the analyzer stores
states in trace memory.  When trace memory is filled, the trace is said to be
"complete."

1 Click on the Recall button to the right of the entry buffer.

A selection dialog box appears.  You can select from entry buffer values that have
been entered previously or that have been predefined.

2 Click on "main" in the selection dialog box, and click the "OK" pushbutton.

Notice that the value "main" has been returned to the entry buffer.

3 To trigger on the address "main" and store states that occur after the trigger, choose
Trace→After () .

Or, using the command line, enter:

trace after  main <RETURN>

Notice the message "Emulation trace started" appears on the status line.  This
shows that the analyzer has begun to look for the trigger state which is the address
"main" on the processor’s address bus.

4 Run the emulator demo program from its transfer address by choosing
Execution→Run→from Transfer Address.

Or, using the command line, enter:

run from transfer_address  <RETURN>
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Notice that now the message on the status line is "Emulation trace complete".  This
shows the trigger state has been found and the analyzer trace memory has been
filled.

5 To view the captured states, choose Display→Trace.

Or, using the command line, enter:

display trace  <RETURN>

The default display mode settings cause source lines and symbols to appear in the
trace list.

Captured states are numbered in the left-hand column of the trace list.  Line 0
always contains the state that caused the analyzer to trigger.

Other columns contain address information, data values, opcode or status
information, and time count information.
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Step 11: Display memory at an address in a
register

1 Click on the Disp @REG action key.

Or, using the command line, enter the name of the command file:

mematreg <RETURN>

A command file dialog box appears (or a prompt appears in the command line).

2 Move the mouse pointer to the dialog box text entry area, type "A7", and click on
the "OK" button.

Or, if the prompt is in the command line:

A7 <RETURN>
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Step 12: Patch assembly language code

The Patch () action key lets you patch code in your program.

1 With "main" still in the entry buffer, click on the Run Xfer til ()  action key.

2 To display memory with assembly-level instructions intermixed with the high-level
source lines, click on the Disp Src & Asm action key.

3 Click on the Patch () action key.

A window appears and the vi editor is started.  Add the line:

LINK A6,#1234h

Exit out of the editor, saving your changes.

The file you just edited is assembled, and the patch main menu appears.  Type "a
<RETURN>" to apply the patch.
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Notice in the emulator/analyzer interface that the instruction at address "main" has
changed.

4 Click on the Patch () action key again.

A window running the vi editor again appears, allowing you to modify the patch
code that was just created.  Modify the line you added previously to:

LINK A6,#0

Exit out of the editor, saving your changes.

The file you just edited is assembled, and the patch main menu appears.  Type "a
<RETURN>" to apply the patch.

Notice in the emulator/analyzer interface that the instruction at address "main" has
been changed back to what it was originally.

When patching a single address, make sure the new instruction takes up the same
number of bytes as the old instruction; otherwise, you may inadvertently modify
code that follows.
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5 Type "main+4 thru main+15" in the entry buffer.

By entering an address range in the entry buffer (that is, <address> thru <address>)
before clicking on the Patch () action key, you can modify a patch template file
which allows you to insert as much or as little code as you wish.

6 Click on the Patch () action key again.

A window running the vi editor again appears.  Suppose you want to patch the
demo program so that the proc_spec_init() funtion is called before the init_system()
function.  Suppose also that there is memory available at address 8800H.  Edit the
patch template file as shown below.

; PCHS700 Assembly Patch File: PCHmain+4.s
;
; Date : Tue Jun 30 14:06:06 MDT 1992
; Dir  : /users/guest/demo/debug_env/hp64742
; Owner: guest
; 
        INCLUDE PCHSINC.s
        ORG main+4
        BRA patch1     ;You may want to change this name!
        ORG 8800h      ;You MUST set this address!
patch1  NOP
; !!!!!!!!! You may need to modify labels and operands of the     !!!!!!!!!
; !!!!!!!!! following code to match your assembler syntax         !!!!!!!!!
; !!!!!!!!! Patching Range: main+4 thru main+15
; !!!!!!!!! Insert new code here !!!!!!!!!
        JSR _proc_spec_init
        JSR _init_system
        BRA main+16    ;You MUST set this address also!

Notice that symbols can be used in the patch file.  Exit out of the editor, saving
your changes.

The file you just edited is assembled, and the patch main menu appears.  Type "a
<RETURN>" to apply the patch.

You can step through the program to view execution of the patch.
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Step 13: Exit the emulator/analyzer interface

• To exit the emulator/analyzer interface and release the emulator, choose
File→Exit→Released.

Or, using the command line, enter:

end release_system  <RETURN>
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Starting and Exiting HP 64700 Interfaces

You can use several types of interfaces to the same emulator at the same time to
give yourself different views into the target system.

The strength of the emulator/analyzer interface is that it lets you perform the
real-time analysis measurements that are helpful when integrating hardware and
software.

The C debugger interface (which is a separate product) lets you view the stack
backtrace and high-level data structures, and it lets you use C language expressions
and macros.  These features are most useful when debugging software.

The Software Performance Analyzer interface (which is also a separate product)
lets you make measurements that can help you improve the performance of your
software.

These interfaces can operate at the same time with the same emulator.  When you
perform an action in one of the interfaces, it is reflected in the other interfaces.

Up to 10 interface windows may be started for the same emulator. Only one C
debugger interface window and one SPA window are allowed, but you can start
multiple emulator/analyzer interface windows.

The tasks associated with starting and exiting HP 64700 interfaces are grouped into
the following sections:

• Starting the emulator/analyzer interface.

• Opening other HP 64700 interface windows.

• Exiting HP 64700 interfaces.
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Starting the Emulator/Analyzer Interface

Before starting the emulator/analyzer interface, the emulator and interface software
must have already been installed as described in the "Installation" chapter.

This section describes how to:

• Start the interface.

• Start the interface using the default configuration.

• Run a command file on interface startup.

• Display the status of emulators defined in the 64700tab.net file.

• Unlock an interface that was left locked by another user.

To start the emulator/analyzer interface

• Use the emul700 <emul_name> command.

If /usr/hp64000/bin is specified in your PATH environment variable (as shown in
the "Installation" chapter), you can start the interface with the emul700
<emul_name> command.  The "emul_name" is the logical emulator name given in
the HP 64700 emulator device table (/usr/hp64000/etc/64700tab.net).

If you are running a window system on your host computer (for example, the X
Window System), you can run the interface in up to 10 windows.  This capability
provides you with several views into the emulation system.  For example, you can
display memory in one window, registers in another, an analyzer trace in a third,
and data in the fourth.
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Examples To start the emulator/analyzer interface for the 68000 emulator:

$ emul700  em68000 <RETURN>

The "em68000" in the command above is the logical emulator name given in the
HP 64700 emulator device table file (/usr/hp64000/etc/64700tab.net).

# Blank  lines  and  the  rest of each line after a ’#’ character are ignored.
# The information in each line must be in the specified order, with  one  line
# for  each  HP series 64700 emulator.  Use blanks or tabs to separate fields.
#
#--------+------------+-----------+-------------------------------------------
# Channel|  Logical   | Processor | Remainder of Information for the Channel
#  Type  |   Name     |   Type    | (IP address for LAN connections)
#--------+------------+-----------+-------------------------------------------
#  lan:      em68000    m68000     21.17.9.143
serial:      em68000    m68000     myhost /dev/emcom23 OFF 9600 NONE XON 2 8

If you’re currently running the X Window System, the Graphical User Interface
starts; otherwise, the Softkey Interface starts.

The status message shows that the default configuration file has been loaded.  If the
command is not successful, you will be given an error message and returned to the
UNIX prompt.  Error messages are described in the "Error Messages" chapter.

To start the interface using the default
configuration

• Use the emul700 -d <emul_name> command.

In the emul700 -d <emul_name> command, the -d option says to use the default
configuration.  The -d option is ignored if the interface is already running in
another window or on another terminal.
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To run a command file on interface startup

• Use the emul700 -c <cmd_file> <emul_name> command.

You can cause command files to be run upon starting the interface by using the -c
<cmd_file> option to the emul700 command.

Refer to the "Using Command Files" section in the "Entering Commands" chapter
for information on creating command files.

Examples To start the emulator/analyzer interface and run the "startup" command file:

$ emul700 -c  startup em68000 <RETURN>

To display the status of emulators

• Use the emul700 -l or emul700 -lv command.

The -l option of the emul700 command lists the status of all emulators defined in
the 64700tab and 64700tab.net files.  If a logical emulator name is included in the
command, just the status of that emulator is listed.

You can also use the -v option with the -l option for a verbose listing of the status
information.

Examples To list, verbosely, the status of the emulator whose logical name is "em68000":

$ emul700 -lv  em68000 <RETURN>

The information may be similar to:
em68000 - m68000 running; user = guest
    description:      M68000 emulation, w/64740EA, 60Kb emul mem
    user interfaces:  xdebug, xemul, xperf, skemul, sktiming
    device channel:   /dev/emcom23
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Or, the information may be similar to:
em68000 - m68000 running; user = guest@myhost
    description:      M68000 emulation, w/64740EA, 60Kb emul mem
    user interfaces:  xdebug, xemul, xperf, skemul, sktiming
    internet address: 21.17.9.143

To unlock an interface that was left locked by
another user

• Use the emul700 -U <emul_name> command.

The -U option to the emul700 command may be used to unlock the emulators
whose logical names are specified.  This command will fail if there currently is a
session in progress.

Examples To unlock the emulator whose logical name is "em68000":

$ emul700 -U  em68000 <RETURN>
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Opening Other HP 64700 Interface Windows

The File→Emul700 menu lets you open additional emulator/analyzer interface
windows or other HP 64700 interface windows if those products have been
installed (for example, the software performance analyzer (SPA) interface and the
high-level debugger interface).

This section shows you how to:

• Open additional emulator/analyzer interface windows.

• Open the high-level debugger interface window.

• Open the software performance analyzer (SPA) interface window.

To open additional emulator/analyzer windows

• To open additional Graphical User Interface windows, choose
File→Emul700→Emulator/Analyzer under Graphic Windows, or enter the
emul700 <emul_name> command in another terminal emulation window.

• To open additional conventional Softkey Interface windows, choose
File→Emul700→Emulator/Analyzer under Terminal Windows, or enter the
emul700 -u skemul <emul_name> command in another terminal emulation
window.

You can open additional Graphical User Interface windows, or terminal emulation
windows containing the Softkey Interface.

When you open an additional window, the status line will show that this session is
joining a session already in progress, and the event log is displayed.

You can enter commands in any window in which the interface is running.  When
you enter commands in different windows, the command entered in the first
window must complete before the command entered in the second window can
start.  The status lines and the event log displays are updated in all windows.
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To open the high-level debugger interface window

• Choose File→Emul700→High-Level Debugger ... under "Graphic Windows", or
enter the emul700 -u xdebug <emul_name> command in another terminal
emulation window.

For information on how to use the high-level debugger interface, refer to the
debugger/emulator User’s Guide.

To open the software performance analyzer
(SPA) interface window

• Choose File→Emul700→Performance Analyzer ... under "Graphic Windows", or
enter the emul700 -u xperf <emul_name> command in another terminal
emulation window.

For information on how to use the software performance analyzer, refer to the
Software Performance Analyzer User’s Guide.
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Exiting HP 64700 Interfaces

There are several options available when exiting the HP 764700 interfaces.  You
can simply close one of the open interface windows, or you can exit the debug
session by closing all the open windows.  When exiting the debug session, you can
lock the emulator so that you can continue later, or you can release the emulation
system so that others may use it.  This section describes how to:

• Close an interface window.

• Exit a debug/emulation session.

To close an interface window

• In the interface window you wish to close, choose File→Exit→Window.  In the
emulator/analyzer interface command line, enter the end command with no options.

All other interface windows remain open, and the emulation session continues,
unless the window closed is the only one open for the emulation session.  In that
case, closing the window ends the emulation session, but locks the emulator so that
other users cannot access it.
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To exit a debug/emulation session

• To exit the interface, save your configuration to a temporary file, and lock the
emulator so that it cannot be accessed by other users, choose File→Exit→Locked.
In the emulator/analyzer interface command line, enter the end locked command.

• To exit the interface and release the emulator for access by other users, choose
File→Exit→Released.  In the emulator/analyzer interface command line, enter the
end release_system command.

If you exit the interface locked, the interface saves the current configuration to a
temporary file and locks the emulator to prevent other users from accessing it.
When you again start the interface with the emul700 command, the temporary file
is reloaded, and therefore, you return to the configuration you were using when you
quit the interface locked.

Also saved when you exit the interface locked are the contents of the entry buffer
and command recall buffer.  These recall buffer values will be present when you
restart the interface.

In contrast, if you end released, you must have saved the current configuration to a
configuration file (if the configuration has changed), or the changes will be lost.
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Entering Commands

When an X Window System that supports OSF/Motif interfaces is running on the
host computer, the emulator/analyzer interface is the Graphical User Interface
which provides pull-down and pop-up menus, point and click setting of
breakpoints, cut and paste, on-line help, customizable action keys and pop-up recall
buffers, etc.

The emulator/analyzer interface also provides the Softkey Interface for several
types of terminals, terminal emulators, and bitmapped displays.  When using the
Softkey Interface, commands are entered from the keyboard.

When using the Graphical User Interface, the command line portion of the interface
gives you the option of entering commands in the same manner as they are entered
in the Softkey Interface.  If you are using the Softkey Interface, you can only enter
commands from the keyboard using the command line.

The menu commands in the Graphical User Interface are a subset of the commands
available when using the command line.  While you have a great deal of capability
in the menu commands, you have even more in the command line.

This chapter shows you how to enter commands in each type of emulator/analyzer
interface.  The tasks associated with entering commands are grouped into the
following sections:

• Using menus, the entry buffer, and action keys.

• Using the command line with the mouse.

• Using the command line with the keyboard.

• Using command files.

• Using pod commands.

• Forwarding commands to other HP 64700 interfaces.
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Using Menus, the Entry Buffer, and Action Keys

This section describes the tasks you perform when using the Graphical User
Interface to enter commands.  This section describes how to:

• Choose a pulldown menu item using the mouse.

• Choose a pulldown menu item using the keyboard.

• Use the popup menus.

• Use the entry buffer.

• Copy and paste to the entry buffer.

• Use action keys.

• Use dialog boxes.

• Access help information.
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To choose a pulldown menu item using the
mouse (method 1)

1 Position the mouse pointer over the name of the menu on the menu bar.

2 Press and hold the command select mouse button to display the menu.

3 While continuing to hold down the mouse button, move the mouse pointer to the
desired menu item.  If the menu item has a cascade menu (identified by an arrow on
the right edge of the menu button), then continue to hold the mouse button down
and move the mouse pointer toward the arrow on the right edge of the menu.  The
cascade menu will display.  Repeat this step for the cascade menu until you find the
desired menu item.

4 Release the mouse button to select the menu choice.

If you decide not to select a menu item, simply continue to hold the mouse button
down, move the mouse pointer off of the menu, and release the mouse button.

Some menu items have an ellipsis ("...") as part of the menu label.  An ellipsis
indicates that the menu item will display a dialog or message box when the menu
item is chosen.

Chapter 3: Entering Commands
Using Menus, the Entry Buffer, and Action Keys

64



To choose a pulldown menu item using the
mouse (method 2)

1 Position the mouse pointer over the menu name on the menu bar.

2 Click the command select mouse button to display the menu.

3 Move the mouse pointer to the desired menu item.  If the menu item has a cascade
menu (identified by an arrow on the right edge of the menu button), then repeat the
previous step and then this step until you find the desired item.

4 Click the mouse button to select the item.

If you decide not to select a menu item, simply move the mouse pointer off of the
menu and click the mouse button.

Some menu items have an ellipsis ("...") as part of the menu label.  An ellipsis
indicates that the menu item will display a dialog or other box when the menu item
is chosen.

To choose a pulldown menu item using the
keyboard

• To initially display a pulldown menu, press and hold the menu select key (for
example, the "Extend char" key on a HP 9000 keyboard) and then type the
underlined character in the menu label on the menu bar.  (For example, "f" for
"File".  Type the character in lower case only.)

• To move right to another pulldown menu after having initially displayed a menu,
press the right-arrow  key.
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• To move left to another pulldown menu after having initially displayed a menu,
press the left-arrow  key.

• To move down one menu item within a menu, press the down-arrow key.

• To move up one menu item within a menu, press the up-arrow  key.

• To choose a menu item, type the character in the menu item label that is underlined.
Or, move to the menu item using the arrow keys and then press the <RETURN>
key on the keyboard.

• To cancel a displayed menu, press the Escape key.

The interface supports keyboard mnemonics and the use of the arrow keys to move
within or between menus.  For each menu or menu item, the underlined character in
the menu or menu item label is the keyboard mnemonic character.  Notice the
keyboard mnemonic is not always the first character of the label.  If a menu item
has a cascade menu attached to it, then typing the keyboard mnemonic displays the
cascade menu.

Some menu items have an ellipsis ("...") as part of the menu label.  An ellipsis
indicates that the menu item will display a dialog or other box when the menu item
is chosen.

Dialog boxes support the use of the keyboard as well.  To direct keyboard input to a
dialog box, you must position the mouse pointer somewhere inside the boundaries
of the dialog box.  That is because the interface keyboard focus policy is set to
pointer.  That just means that the window containing the mouse pointer receives the
keyboard input.

In addition to keyboard mnemonics, you can also specify keyboard accelerators
which are keyboard shortcuts for selected menu items.  Refer to the "Setting X
Resources" chapter and the "Softkey.Input" scheme file for more information about
setting the X resources that control defining keyboard accelerators.
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To choose popup menu items

1 Move the mouse pointer to the area whose popup menu you wish to access.  (If a
popup menu is available, the mouse pointer changes from an arrow to a hand.)

2 Press and hold the select mouse button.

3 After the popup menu appears (while continuing to hold down the mouse button),
move the mouse pointer to the desired menu item.

4 Release the mouse button to select the menu choice.

If you decide not to select a menu item, simply continue to hold the mouse button
down, move the mouse pointer off of the menu, and release the mouse button.

The following popup menus are available in the Graphical User Interface:

• Mnemonic Memory Display.

• Breakpoints Display.

• Global Symbols Display.

• Local Symbols Display.

• Status Line.

• Command Line.
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To place values into the entry buffer using the
keyboard

1 Position the mouse pointer within the text entry area.  (An "I-beam" cursor will
appear.)

2 Enter the text using the keyboard.

To clear the entry buffer text area from beginning until end, press the <Ctrl>u  key
combination.

To copy-and-paste to the entry buffer

• To copy and paste a discrete text string as determined by the interface, position the
mouse pointer over the text to copy and click the paste mouse button.

• To specify the exact text to copy to the entry buffer: press and hold the paste mouse
button; drag the mouse pointer to highlight the text to copy-and-paste; release the
paste mouse button.

You can copy-and-paste from the display area, the status line, and from the
command line entry area.

When you position the pointer and click the mouse button, the interface expands
the highlight to include the most complete text string it considers to be discrete.
Discrete here means that the interface will stop expanding the highlight in a given
direction when it discovers a delimiting character not determined to be part of the
string.  A common delimiter would, of course, be a space.

When you press and hold the mouse button and drag the pointer to highlight text,
the interface copies all highlighted text to the entry buffer when you release the
mouse button.

Because the interface displays absolute addresses as hex values, any copied and
pasted string that can be interpreted as a hexadecimal value (that is, the string
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contains only numbers 0 through 9 and characters "a" through "f") automatically
has an "h" appended.

Note If you have multiple Graphical User Interface windows open, a copy-and-paste
action in any window causes the text to appear in all entry buffers in all windows.
That is because although there are a number of entry buffers being displayed, there
is actually only one entry buffer and it is common to all windows.  That means you
can copy a symbol or an address from one window and then use it in another
window.

On a memory display or trace display, a symbol may not be completely displayed
because there are too many characters to fit into the width limit for a particular
column of the display.  To make a symbol usable for copy-and-paste, you can scroll
the screen left or right to display all, or at least more, of the characters from the
symbol. The interface displays absolute addresses as hex values.

Text pasted into the entry buffer replaces that which is currently there.  You cannot
use paste to append text to existing text already in the entry buffer.

See "To copy-and-paste from the entry buffer to the command line entry area" for
information about pasting the contents of the entry buffer into the command line
entry area.
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Example To paste the symbol "num_checks" into the entry buffer from the interface display
area, position the mouse pointer over the symbol and then click the paste mouse
button.

A mouse click
causes the interface
to expand the
highlight to include
the symbol
"num_checks" and
paste the symbol
into the entry buffer.
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To recall entry buffer values

• Position the mouse pointer over the Recall button just to the right of the entry
buffer text area, click the mouse button to bring up the Entry Buffer Recall dialog
box, and then choose a string from that dialog box.

The Entry Buffer Recall dialog box contains a list of entries gained during the
emulation session as well as any predefined entries present at interface startup.

If you exit the emulation/analysis session with the interface "locked", recall buffer
values are saved and will be present when you restart the interface.

You can predefine entries for the Entry Buffer Recall dialog box and define the
maximum number of entries by setting X resources (refer to the "Setting X
Resources" chapter).

See the following "To use dialog boxes" section for information about using dialog
boxes.

To use the entry buffer

1 Place information into the entry buffer (see the previous "To place values into the
entry buffer using the keyboard", "To copy-and-paste to the entry buffer", or "To
recall entry buffer values" task descriptions).

2 Choose the menu item, or click the action key, that uses the contents of the entry
buffer (that is, the menu item or action key that contains "()").
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To copy-and-paste from the entry buffer to the
command line entry area

1 Place text to be pasted into the command line in the entry buffer text area.

You may do that by:

• Copying the text from the display area using the copy-and-paste feature.

• Enter the text directly by typing it into the entry buffer text area.

• Choose the text from the entry buffer recall dialog box.

2 Position the mouse pointer within the command line text entry area.

3 If necessary, reposition the cursor to the location where you want to paste the text.

4 If necessary, choose the insert or replace mode for the command entry area.

5 Click the command paste mouse button to paste the text in the command line entry
area at the current cursor position.

The entire contents of the entry buffer are pasted into the command line at the
current cursor position.

Although a paste from the display area to the entry buffer affects all displayed entry
buffers in all open windows, a paste from the entry buffer to the command line only
affects the command line of the window in which you are currently working.

See "To copy-and-paste to the entry buffer" for information about pasting
information from the display into the entry buffer.
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To use the action keys

1 If the action key uses the contents of the entry buffer, place the desired information
in the entry buffer.

2 Position the mouse pointer over the action key and click the action key.

Action keys are user-definable pushbuttons that perform interface or system
functions.  Action keys can use information from the entry buffer — this makes it
possible to create action keys that are more general and flexible.

Several action keys are predefined when you first start the Graphical User Interface.
You can use the predefined action keys, but you’ll really appreciate them when you
define and use your own.

Action keys are defined by setting an X resource.  Refer to the chapter "Setting X
Resources" for more information about creating action keys.

To use dialog boxes

1 Click on an item in the dialog box list to copy the item to the text entry area.

2 Edit the item in the text entry area (if desired).

3 Click on the "OK" pushbutton to make the selection and close the dialog box, click
on the "Apply" pushbutton to make the selection and leave the dialog box open, or
click on the "Cancel" pushbutton to cancel the selection and close the dialog box.

The graphical interface uses a number of dialog boxes for selection and recall:

Directory Selection Selects the working directory.  You can change to a
previously accessed directory, a predefined directory, or
specify a new directory.
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File Selection From the working directory, you can select an existing file
name or specify a new file name.

Entry Buffer Recall You can recall a previously used entry buffer text string, a
predefined entry buffer text string, or a newly entered entry
buffer string, to the entry buffer text area.

Command Recall You can recall a previously executed command, a
predefined command, or a newly entered command, to the
command line.

The dialog boxes share some common properties:

• Most dialog boxes can be left on the screen between uses.
• Dialog boxes can be moved around the screen and do not have to be positioned

over the graphical interface window.
• If you iconify the interface window, all dialog boxes are iconified along with

the main window.

Except for the File Selection dialog box, predefined entries for each dialog box
(and the maximum number of entries) are set via X resources (refer to the "Setting
X Resources" chapter).
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Examples To use the File Selection dialog box:

The file filter selects
specific files.

A list of
filter-matching files
from the current
directory.

A list of files
previously accessed
during the emulation
session.

A single click on a
file name from either
list highlights the file
name and copies it to
the text area. A
double click chooses
the file and closes the
dialog box.

Label informs you
what kind of file
selection you are
performing.

Text entry area.
Text is either
copied here from
the recall list, or
entered directly.

Clicking this button
chooses the file name
displayed in the text entry
area and closes the dialog
box.

Entering a new file filter
and clicking this button
causes a list of files
matching the new filter to
be read from the directory.

Clicking this button
cancels the file selection
operation and closes the
dialog box.
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To use the Directory Selection dialog box:

Label informs you
of the type of list
displayed.

A list of predefined
or previously
accessed directories.

A single click on a
directory name from
the list highlights
the name and copies
it to the text area. A
double click chooses
the directory and
closes the dialog
box.

Text entry area.
Directory name is
either copied here
from the recall list,
or entered directly.

Clicking this button
chooses the directory
displayed in the text entry
area and closes the dialog
box.

Clicking this button
chooses the directory
displayed in the text entry
area, but keeps the dialog
box on the screen instead
of closing it.

Clicking this button
cancels the directory
selection operation and
closes the dialog box.
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To access help information

1 Display the Help Index by choosing Help→General Topic... or Help→Command
Line....

2 Choose a topic of interest from the Help Index.

The Help Index lists topics covering operation of the interface as well other
information about the interface.  When you choose a topic from the Help Index, the
interface displays a window containing the help information.  You may leave the
window on the screen while you continue using the interface.

Chapter 3: Entering Commands
Using Menus, the Entry Buffer, and Action Keys

77



Using the Command Line with the Mouse

When using the Graphical User Interface, the command line portion of the interface
gives you the option of entering commands in the same manner as they are entered
in the Softkey Interface.  Additionally, the graphical interface makes the softkey
labels pushbuttons so commands may be entered using the mouse.

If you are using the Softkey Interface, using the command line with the keyboard is
the only way to enter commands.

This section describes how to:

• Turn the command line off/on.

• Enter commands.

• Edit commands.

• Recall commands.

• Display the help window.

To turn the command line on or off

• To turn the command line on or off using the pulldown menu, choose
Settings→Command Line.

• To turn the command line on or off using the status line popup menu: position the
mouse pointer within the status line area, press and hold the select mouse button,
and choose Command Line Off from the menu.

• To turn the command line off using the command line entry area popup menu:
position the mouse pointer within the entry area, press and hold the select mouse
button, and choose Command Line Off from the menu.

Turns display of the command line area "on" or "off."  On means that the command
line is displayed and you can use the softkey label pushbuttons, the command
return and recall pushbuttons, and the cursor pushbuttons for command line editing.
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Off means the command line is not displayed and you use only the pulldown menus
and the action keys to control the interface.

The command line area begins just below the status line and continues to the
bottom of the emulator/analyzer window.  The status line is not part of the
command line and continues to be displayed whether the command line is on or off.

Choosing certain pulldown menu items while the command line is off causes the
command line to be turned on.  That is because the menu item chosen requires
some input at the command line that cannot be supplied another way.

To enter a command

1 Build a command using the softkey label pushbuttons by successively positioning
the mouse pointer on a pushbutton and clicking the pushbutton select mouse button
until a complete command is formed.

2 Execute the completed command by clicking the Return pushbutton (found near
the bottom of the command line in the "Command" group).

Or:

Execute the completed command using the Command Line entry area popup menu:
Position the mouse pointer in the command line entry area; press and hold the
select mouse button until the Command Line popup menu appears; then, choose the
Execute Command menu item.

You may need to combine pushbutton and keyboard entry to form a complete
command.

A complete command is a string of softkey labels and text entered with the
keyboard.  You know a command is complete when Return pushbutton is not
halfbright.  The interface does not check or act on a command, however, until the
command is executed.  (In contrast, commands resulting from pulldown menu
choices and action keys are supplied with the needed carriage return as part of the
command.)

Chapter 3: Entering Commands
Using the Command Line with the Mouse

79



To edit the command line using the command
line pushbuttons

• To clear the command line, click the Clear pushbutton.

• To clear the command line from the cursor position to the end of the line, click the
Clear to end pushbutton.

• To move to the right one command word or token, click the Forward  pushbutton.

• To move to the left one command word or token, click the Backup pushbutton.

• To insert characters at the cursor position, press the insert key to change to
insertion mode, and then type the characters to be inserted.

• To delete characters to the left of the cursor position, press the <BACKSPACE>
key.

When the cursor arrives at the beginning of a command word or token, the softkey
labels change to display the possible choices at that level of the command.

When moving by words left or right, the Forward  pushbutton becomes halfbright
and unresponsive when the cursor reaches the end of the command string.
Similarly, the Backup pushbutton becomes halfbright and unresponsive when the
cursor reaches the beginning of the command.

See "To edit the command line using the mouse and the command line popup
menu" and "To edit the command line using the keyboard" for information about
additional editing operations you can perform.
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To edit the command line using the command
line popup menu

• To clear the command line: position the mouse pointer within the Command Line
entry area; press and hold the select mouse button until the Command Line popup
menu appears; choose Clear Entire Line from the menu.

• To clear the command line from the cursor position to the end of the line: position
the mouse pointer at the place where you want the clear-to-end to start; press and
hold the select mouse button until the Command Line popup menu appears; choose
Clear to End of Line from the menu.

• To position the cursor and insert characters at the cursor location: position the
mouse pointer in a non-text area of the command line entry area; press and hold the
select mouse button to display the Command Line popup menu; choose Position
Cursor, Insert Mode from the menu; type the characters to be inserted.

• To replace characters at the current cursor location: position the mouse pointer in a
non-text area of the command line entry area; press and hold the select mouse
button to display the Command Line popup menu; choose Position Cursor,
Replace Mode from the menu; type the characters to be inserted.

• To position the cursor and replace characters at the cursor location: position the
mouse pointer in a non-text area of the command line entry area; press and hold the
select mouse button to display the Command Line popup menu; choose Position
Cursor, Replace Mode from the menu; type the characters to be inserted.

When the cursor arrives at the beginning of a command word or token, the softkey
labels change to display the possible choices at that level of the command.

See "To edit the command line using the mouse and the command line
pushbuttons" and "To edit the command line using the keyboard" for information
about additional editing operations you can perform.
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To recall commands

1 Click the pushbutton labeled Recall in the Command Line to display the dialog box.

2 Choose a command from the buffer list.  (You can also enter a command directly
into the text entry area of the dialog box.)

Because all command entry methods in the interface — pulldown menus, action
keys, and command line entries — are echoed to the command line entry area, the
contents of the Command Recall dialog box is not restricted to just commands
entered directly into the command line entry area.

The Command Recall dialog box contains a list of interface commands executed
during the session as well as any predefined commands present at interface startup.

If you exit the emulation/analysis session with the interface "locked", commands in
the recall buffer are saved and will be present when you restart the interface.

You can predefine entries for the Command Recall dialog box and define the
maximum number of entries by setting X resources (refer to the "Setting X
Resources" chapter).

See "To use dialog boxes" for information about using dialog boxes.

To get help about the command line

• To display the help topic explaining the operation of the command line, press the
Help pushbutton located near the bottom-right corner of the Command Line area.
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Using the Command Line with the Keyboard

When using the command line with the keyboard, you enter commands by pressing
softkeys whose labels appear at the bottom of the screen.  Softkeys provide for
quick command entry, and minimize the possibility of errors.

The command line also provides command completion.  You can type the first few
characters of a command (enough to uniquely identify the command) and then
press <Tab>.  The interface completes the command word for you.

Entering commands with the keyboard is easy.  However, the interface provides
other features that make entering commands even easier.  For example, you can:

• Enter multiple commands on one line.

• Recall commands.

• Edit commands.

• Access on-line help information.

To enter multiple commands on one command
line

• Separate the commands with semicolons (;).

More than one command may be entered in a single command line if the commands
are separated by semicolons (;).

Examples To reset the emulator and break into the monitor:

reset  ; break  <RETURN>
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To recall commands

• Press <CTRL>r or <CTRL>b.

The most recent 20 commands you enter are stored in a buffer and may be recalled
by pressing <CTRL>r. Pressing <CTRL>b  cycles forward through the recall buffer.

Examples For example, to recall and execute the command prior to the last command:

<CTRL>r <CTRL>r <RETURN>

To edit commands

• Use the <Left arrow>, <Right arrow>, <Tab>, <Shift><Tab>, <Insert char>, <Back
space>, <Delete char>, <Clear line>, and <CTRL>u keys.

The <Left arrow> and <Right arrow> keys move the cursor single spaces to the left
or right.

The <Tab> and <Shift><Tab> keys move the cursor to the next or previous word
on the command line.

The <Insert char> key enters the insert editing mode and allows characters or
command options to be inserted at the cursor location.

The <Back space> key deletes the character to the left of the cursor.

The <Delete char> key deletes the character to the right of the cursor.

The <Clear line> key deletes the characters from the cursor to the end of the line.

The <CTRL>u key erases the command line.
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To access on-line help information

• Use the help or ? commands.

To access the command line’s on-line help information, type either help or ? on the
command line.  You will notice a new set of softkeys.  By pressing one of these
softkeys and <RETURN>, you can display information on that topic.

Examples To display information on the system commands:

help system_commands  <RETURN>

Or:

? system_commands  <RETURN>

The help information is scrolled on to the screen.  If there is more than a screen full
of information, you will have to press the space bar to see the next screen full, or
the <RETURN> key to see the next line, just as you do with the UNIX more
command.  After all the information on the particular topic has been displayed (or
after you press "q" to quit scrolling through information), you are prompted to press
<RETURN> to return to the command line.
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Using Command Files

You can execute a series of commands that have been stored in a command file.
You can create command files by logging commands while using the interface or
by using an editor on your host computer.

Once you create a command file, you can execute the file in the emulation
environment by typing the name of the file on the command line and pressing
<RETURN>.

Command files execute until an end-of-file is found or until a syntax error occurs.
You can stop a command file by pressing <CTRL>c or the <Break> key.

This section shows you how to:

• Start logging commands to a command file.

• Stop logging commands to a command file.

• Playback (execute) a command file.

Nesting Command Files

You can nest a maximum of eight levels of command files.  Nesting command files
means one command file calls another.

Comments in Command Files

Text that follows a pound sign (#), up to the end of the line, is interpreted as a
comment.

Using the wait Command

When editing command files, you can insert wait commands to pause execution of
the command file at certain points.

If you press <CTRL>c to stop execution of a command file while the "wait"
command is being executed from the command file, the <CTRL>c will terminate
the "wait" command, but will not terminate command file execution.  To do this,
press <CTRL>c again.
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Use the wait measurement_complete command after changing the trace depth.
By doing this, when you copy or display the trace after changing the trace depth,
the new trace states will be available. Otherwise the new states won’t be available.

Passing Parameters

Command files provide a convenient method for passing parameters by using a
parameter declaration line preceding the commands in the command file.  When the
command file is called, the system will prompt you for current values of the formal
parameters listed.

Parameters are defined as:

Passed Parameters - These are ASCII strings passed to a command file.  Any
continuous set of ASCII characters can be passed.  Spaces separate the
parameters.

Formal Parameters - These are symbols preceded by an ampersand (& ),
which are the variables of the command file.

The ASCII string passed (passed parameter) will be substituted for the formal
parameter when the command file is executed.

The only way to pass a parameter containing a space is to enclose the parameter in
double quotes (") or single quotes (’).  Thus, to pass the parameter HP 9000 to a
command file, you can use either "HP 9000" or ’HP 9000’.

The special parameter &ArG_lEfT  gets set to all the remaining parameters
specified when the command file was invoked. This lets you use variable size
parameter lists.  If no parameters are left, &ArG_lEfT  gets set to NULL.

Consider the command file example (named CMDFILE) shown below:

PARMS &ADDR &VALUE1
#
# modify a location or list of locations in memory
# and display the result
#
modify memory &ADDR words to &VALUE1 &ArG_lEfT
display memory &ADDR blocked words
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When you execute CMDFILE, you will be prompted with:

Define command file parameter [&ADDR]

To pass the parameter, enter the address of the first memory location to be
modified.  You will then be prompted for &VALUE1 .  If you enter, for example,
"0,-1,20, 0ffffh, 4+5*4", the first parameter "0,-1,20," is passed to &VALUE1  and
the remaining parameters "0ffffh," and "4+5*4" are passed to &ArG_lEfT .

You can also pass the parameters when you invoke the command file (for example,
CMDFILE 1000h 0,-1,20, 0ffffh, 4+5*4).

Other Things to Know About Command Files

You should know the following about using command files:

1 Command files may contain shell variables.  Only those shell variables
beginning with "$" followed by an identifier will be supported.  An identifier is
a sequence of letters, digits or underscores beginning with a letter or
underscore.  The identifier may be enclosed by braces "{ }" or entered directly
following the "$" symbol.  Braces are required when the identifier is followed
by a letter, a digit or an underscore that is not interpreted as part of its name.

For example, assume a directory named /users/softkeys and the shell variable
"S".  The value of "S" is "soft".  By specifying the directory as /users/${S}keys
the correct result is obtained.  However, if you attempt to specify the directory
as /users/$Skeys, the Softkey Interface looks for the value of the variable
"Skeys".  This is not the operators intended result.  You may not get the
intended result unless Skeys is already defined to be "softkeys".

You can examine the current values of all shell variables defined in your
environment with the command "env".

2 Positional shell variables, such as $1, $2, and so on, are not supported.  Neither
are special shell variables, such as $@, $*, and so on, supported.

3 You can continue command file lines.  This is done by avoiding the line feed
with a backslash (\).  A line terminated by "\" is concatenated with any
following lines until a line that does not contain a backslash is found.  A line
constructed in this manner is recognized and executed as one single command
line.  If the last line in a command file is terminated by "\", it appears on the
command line but is not executed.  Normally, the line feed is recognized as the
command terminator.  The UNIX environment recognizes three quoting
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characters for shell commands which are double quotes ("), single quotes (’),
and the backslash symbol (\).

For example, the following three lines are treated as a single shell command.
The two hidden line feeds are ignored because they are inside the two single
quotes (’):

!awk ’/$/ { blanks++ }

END { print blanks }

’ an_unix_file

To start logging commands to a command file

• Choose File→Log→Record and use the dialog box to select a command file name.

• Using the command line, enter the log_commands to <file> command.

To stop logging commands to a command file

• Choose File→Log→Stop.

• Using the command line, enter the log_commands off command.
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To playback (execute) a command file

• Choose File→Log→Playback and use the dialog box to select the name of the
command file you wish to execute.

• Using the command line, enter the name of the command file and press
<RETURN>.

If you enter the name of the command file in the command line and the interface
cannot find the command file in the current directory, it searches the directories
specified in the HP64KPATH environment variable.

To interrupt playback of a command file, press the <CTRL>c key combination.
(The mouse pointer must be within the interface window.)

If you press <CTRL>c to stop execution of a command file while the "wait"
command is being executed from the command file, the <CTRL>c will terminate
the "wait" command, but will not terminate command file execution.  To do this,
press <CTRL>c again.
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Using Pod Commands

Pod commands are Terminal Interface commands.  The Terminal Interface is the
low-level interface that resides in the firmware of the emulator.

A pod command used in the Graphical User Interface bypasses the interface and
goes directly to the emulator.  Because some pod commands can cause the interface
to become out-of-sync with the emulator, or even cause the interface to terminate
abnormally, they must be used with care.

For example, if you change configuration items, the actual state of the emulator will
no longer match the internal record the interface keeps about the state of the
emulator.

Issuing certain communications-related commands can prevent the interface from
communicating with the emulator and cause abnormal termination of the interface.

However, it is sometimes necessary to use pod commands.  For example, you must
use a pod command to execute the emulator’s performance verification (pv)
routine.  Performance verification is an internal self-test procedure for the emulator.

Remember that pod commands can cause trouble for the high-level interface if they
are used indiscriminately.

This section shows you how to:

• Display the pod commands screen.

• Use pod commands.
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To display the pod commands screen

• Choose Display→Pod Commands.

The pod commands screen displays the results of pod (Terminal Interface)
commands.  To set the interface to use pod commands, choose Settings→Pod
Command Keyboard.

To use pod commands

• To begin using pod commands, choose Settings→Pod Command Keyboard.

• To end using pod commands, click the suspend pushbutton softkey.

The Settings→Pod Command Keyboard command displays the pod commands
screen and activates the keyboard for entering pod command on the command line.
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Forwarding Commands to Other HP 64700
Interfaces

To allow the emulator/analyzer interface to run concurrently with other HP 64700
interfaces like the high-level debugger and software performance analyzer, a
background "daemon" process is necessary to coordinate actions in the interfaces.

This background process also allows commands to be forwarded from one interface
to another.  Commands are forwarded using the forward  command available in the
command line.  The general syntax is:

forward  <interface_name> "<command_string>" <RETURN>

This section shows you how to:

• Forward commands to the high-level debugger.

• Forward commands to the software performance analyzer.

To forward commands to the high-level debugger

• Enter the forward debug "<command string>"  command using the command
line.

Examples To send the "Program Run" command to the debugger:

forward debug  "Program Run" <RETURN>

Or, since only the capitalized key is required:

forward debug  "P R" <RETURN>
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To forward commands to the software
performance analyzer

• Enter the forward perf "<command string>"  command using the command line.

Examples To send the "profile" command to the software performance analyzer:

forward perf  "profile" <RETURN>
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Configuring the Emulator

This chapter describes how to configure the emulator.  You must map memory
whenever you use the emulator.  When you plug the emulator into a target system,
you must configure the emulator so that it operates correctly in the target system.
The configuration tasks are grouped into the following sections:

• Using the configuration interface.

• Modifying the general configuration items.

• Selecting the emulation monitor program.

• Mapping emulation and target system memory.

• Configuring the emulator pod.

• Setting the debug/trace options.

The simulated I/O feature and configuration questions are described in the
Simulated I/O User’s Guide.

The external analyzer configuration questions are described in the "Using the
External State Analyzer" chapter.

The interactive measurement configuration questions are described in the "Making
Coordinated Measurements" chapter.

Configuring for Operation in the Target System

After you plug the emulator into a target system and turn on power to the
HP 64700, you need to configure the emulator so that it operates properly with your
target system.

Map memory. Because the emulator can use target system memory or emulation
memory (or both), it is necessary to map ranges of memory so that the emulator
knows where to direct its accesses.

You can synchronize emulation memory accesses to the target system in order to
more closely imitate target system memory. For example, if emulation memory
replaces slower target system memory that requires wait states, synchronizing
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emulation memory to the target system causes wait states to be inserted on
emulation memory accesses as they would be on target system memory accesses.

You specify the synchronization of emulation memory differently depending on
which emulator you’re using:  If you’re using the HP 64744 emulator, you use the
dti  attribute when mapping emulation memory ranges, and you answer a
configuration question to make the specification for monitor program cycles.  If
you’re using the HP 64742/3 emulators, you answer a configuration question to
make the specification for all emulation memory and background monitor cycles.

Select the target system clock as the emulator’s clock source. When
plugging the emulator into a target system, the emulator should use the target
system clock.  When using the HP 64744 emulator, this is not applicable because
the emulator must either be plugged into a target system or the demo board which
provides a clock.

Set the reset value of the supervisor stack pointer register. Because the
stack is used when the emulator transitions into the run state, steps, etc., after
emulation reset, the supervisor stack pointer must point to RAM.

If you’re emulating a 68HC001 or 68EC000 microprocessor, should the
emulator operate in 16-bit mode or 8-bit mode? In other words, what is
the target system data bus width?  This is only applicable when using the HP 64744
emulator which supports 68HC001 and 68EC000 emulation.

Is there circuitry in the target system that requires programs to run in
real-time? Some emulator commands cause temporary breaks to the monitor
program, typically to access microprocessor register values or target system
memory.  If the target system requires that programs run in real-time, you must
restrict the emulator to real-time runs.

Should the emulator respond to target system interrupts when
running programs? If so, you must enable the emulator’s response to target
system interrupts; otherwise, you must disable the emulator’s response to target
system interrupts.

Should the emulator respond to target system interrupts when
running in the monitor program? If so, you must use a foreground monitor
program since target system interrupts are always ignored during background
operation (refer to the "Selecting the Emulation Monitor Program" section later in
this chapter).  You must also enable the emulator’s response to target system
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interrupts.  If it’s not important that the emulator respond to target system interrupts
when running in the monitor, you can use the background monitor.

Is there circuitry in the target system that constantly monitors bus
cycle execution (for example, memory refresh circuitry or a watchdog
timer)? If so, you should drive background cycles to the target system.
(Foreground monitor cycles appear at the target interface exactly as if they were
bus cycles caused by a user program.)

Should bus arbitration be allowed? Generally, the answer to this question
will be "yes".  However, you may disable bus arbitration in order to isolate target
system problems.  For example, if you have a situation where the processor never
seems to execute any code, you can disable bus arbitration to check and see if
arbitration circuitry in your target system might be contributing to the problem.
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Using the Configuration Interface

This section shows you how to modify, store, and load configurations using the
emulator configuration interface.

This section shows you how to:

• Start the configuration interface.

• Modify a configuration section.

• Store a configuration.

• Change the configuration directory context.

• Display the configuration context.

• Access help information.

• Exit the configuration interface.

• Load a configuration.

This chapter describes emulator configuration in general terms. For information
about your emulator’s specific configuration questions, refer to your emulator
User’s Guide.
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To start the configuration interface

• Choose Modify →Emulator Config... from the emulator/analyzer interface
pulldown menu.

• Using the command line, enter the modify configuration command.

The configuration interface main menu (see example below) is displayed.

The configuration sections that are presented depend on the hardware and features
of your particular emulator.

The configuration interface may be left running while you are using the
emulator/analyzer interface.

If you’re using the Softkey Interface, you don’t get a main menu from which to
choose configuration sections; however, the same display area and command line
are used to answer the configuration questions.
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Examples The 68000 emulator configuration interface main menu is shown below.

Clicking on one of these
lines selects a particular
configuration section.

Clicking this button
presents the questions
for the selected
configuration section.

Clicking this button
stores the current
configuration.

Clicking this button
exits the configuration
interface.

Clicking this button
presents the on-line help.
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To modify a configuration section

1 Start the emulator configuration interface.

2 Click on a section name in the configuration interface main menu, and click the
"Modify Section" pushbutton.

3 Use the command line to answer the configuration questions.

If you’re using the Softkey Interface:

The configuration questions in the "General Items" section are the first to be
asked.

To access the questions in the "Monitor Type" section, answer "yes" to the
"Modify memory configuration?" question.

To access the questions in the "Memory Map" section, answer "yes" to the
"Modify memory configuration?" question.

To access the questions in the "Emulator Pod Settings" section, answer "yes" to
the "Modify emulator pod configuration?" question.

To access the questions in the "Debug/Trace Options" section, answer "yes" to
the "Modify debug/trace options?" question.
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Each configuration section presents a window similar to the following.

The menu bar.

Configuration help
text display area.

Emulator status and
error message line.

Command line text
entry area.

Pushbutton softkeys.

Command control
and cursor control
pushbuttons.

To answer a configuration question, click the softkey pushbutton that has your
answer.  Or, click on the "Return" command pushbutton to accept the answer that is
shown.

When you answer a configuration question, you are normally presented with the
next question in the section; however, there are some cases when a carriage return
is required, and you can supply it by clicking the "Return" command pushbutton or
by pressing the <RETURN> key.
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At the last question of a configuration section, you are asked if you wish to return
to the main menu.  You can click the "next_sec" softkey pushbutton to access the
questions in the next configuration section.

To recall a configuration question, click the "RECALL" softkey pushbutton.  If you
do this at the starting question of a configuration section, you are asked if you want
to return to the main menu.

In order for the emulator to recognize any configuration changes, the configuration
must be applied to the emulator.

To store a configuration

• When answering the configuration questions, choose File→Store... from the
pulldown menu, and use the File Selection dialog box to name the configuration
file.

• From the configuration interface main menu, click on the "Apply to Emulator"
button, and use the File Selection dialog box to name the configuration file.

• If you’re using the Softkey Interface, the last configuration question,
"Configuration file name?", lets you name the file to which configuration
information is stored.  If you don’t enter a name, configuration information is saved
to a temporary file (which is deleted when you exit the interface and release the
emulation system).

The file to which the configuration is stored becomes the current configuration file.
The emulator only recognizes configuration changes when they are stored or loaded.

When modifying a configuration using the graphical interface, you can store your
answers at any time.  This is useful for quickly verifying the effect a configuration
change has on the emulator.

Configuration information is saved in two files with extensions of ".EA" and ".EB".
The file with the ".EA" extension is the "source" copy of the file, and the file with
the ".EB" extension is the "binary" or loadable copy of the file.
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For more information on how to use dialog boxes, refer to the "To use dialog
boxes" description in the "Using Menus, the Entry Buffer, and Action Keys"
section of the "Entering Commands" chapter.

To change the configuration directory context

• When answering the configuration questions, choose File→Directory... from the
pulldown menu, and use the Directory Selection dialog box to specify the new
directory.

The directory context specifies the directory to which configuration files are stored
and from which they are loaded.

For more information on how to use dialog boxes, refer to the "To use dialog
boxes" description in the "Using Menus, the Entry Buffer, and Action Keys"
section of the "Entering Commands" chapter.
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To display the configuration context

• When answering the configuration questions, choose Display→Context... from the
pulldown menu.

The current directory context and the current configuration files are displayed in a
window.  Click the "Done" pushbutton when you wish to close the window.

To access help information

• When answering the configuration questions, choose Help→General Topic... from
the pulldown menu.

• From the configuration interface main menu, click on the "Help Topic" button.
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To exit the configuration interface

• When answering the configuration questions, choose File→Exit... from the
pulldown menu (or type <CTRL>x), and click "Yes" in the confirmation dialog box.

• From the configuration interface main menu, click the "Exit Window" button, and
click "Yes" in the confirmation dialog box.

The confirmation dialog box only appears if changes have been made to the current
configuration.

When you choose "Yes" from the confirmation dialog box, any modifications made
to the configuration which haven’t been stored are lost.  Choosing "No" from the
confirmation dialog box cancels the exit and keeps the emulator configuration
interface running.

To load a configuration

• In the emulator/analyzer interface, choose File→Load→Emulator Config... from
the pulldown menu, and use the File Selection dialog box to specify the
configuration file to be loaded.

• Using the command line, enter the load configuration <FILE>  command.

This command loads previously created and stored configuration files.
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Modifying the General Configuration Items

In order to modify the general configuration items, you must first start the
configuration interface and access the "General Items" configuration section (refer
to the previous "Using the Configuration Interface" section).

This section shows you how to:

• Select the emulator clock source (HP 64742/3).

• Enable/disable entry into the monitor after configuration.

• Restrict to real-time runs.

• Turn OFF the restriction to real-time runs.

• Select the inverse assembly syntax for mnemonic displays.

To select the emulator clock source (HP 64742/3)

• Answer "external" or "internal" to the "Micro-processor clock source?" question.

You should always select the external clock option when using the emulator
in-circuit to synchronize the emulator with your target system.

Your target system clock must conform to the specifications for the 68000
microprocessor.  The maximum clock speed with the HP 64743 emulator is
16 MHz. The HP 64742 emulator has a maximum clock speed of 12.5 MHz.

Note that changing the clock source drives the emulator into the reset state.  The
emulator may later break into the monitor depending on how the "Enter monitor
after configuration?" question is answered.

Answering "internal" to the "Micro-processor clock source?" question selects the
emulator’s internal clock oscillator.
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To enable/disable entry into the monitor after
configuration

• Answer "yes" or "no" to the "Enter monitor after configuration?".

This question allows you to select whether the emulator will be running in the
monitor or held in the reset state on completion of the emulator configuration.

The answer to this configuration question is important in some situations. For
example, when you select the external clock (HP 64742/3 only) and the target
system is turned off, do not select reset to monitor.  Otherwise, configuration will
fail. When you select an external clock source, this question becomes "Enter
monitor after configuration (using external clock)?" and the default answer
becomes "no".

To restrict the emulator to real-time runs

• Answer "yes" to the "Restrict to real-time runs?" question.

CAUTION If your target system circuitry is dependent on constant execution of program code,
you should restrict the emulator to real-time runs.  This will help insure that target
system damage does not occur.  However, remember you can still execute the reset,
break, and step commands; you should use caution in executing these commands.

The default configuration does not restrict the emulator to real-time runs.
Therefore, the emulator might make temporary breaks into the monitor to complete
certain commands.  However, you may wish to restrict runs to real-time to prevent
temporary breaks that might cause target system problems.

When runs are restricted to real-time and the emulator is running the user program,
all commands that cause a break (except reset, break, run , and step are refused.
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The following commands are not allowed when runs are restricted to real-time and
the emulator is running the user program:

• Display/modify registers.

• Display/modify target system memory.

• Load/store target system memory.

If you want to enter one of these commands, you must first make an explicit break
into the monitor using the break command.

Because the emulator contains dual-port emulation memory, commands that access
emulation memory are allowed while runs are restricted to real-time.

To turn OFF the restriction to real-time runs

• Answer "no" to the "Restrict to real-time runs?" question.

All commands, regardless of whether or not they require a break to the emulation
monitor, are accepted by the emulator.

To select the inverse assembly syntax

• Answer "64870" or "64845" to the "Inverse assembly syntax to use?" question.

The HP 64742/3 emulators accept absolute files generated by either of
Hewlett-Packard’s software development tool sets.

• HP 64819 68000/10 C Cross Compiler 
HP 64845 68000/10 Cross Assembler and Linker

• HP 64902 68000 C Cross Compiler 
HP 64870 68000/10/20 Assembler/Linker/Librarian
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The assembly language syntax used by the HP 64845 assembler does not use
Motorola assembly language syntax.  For example, you use brackets instead of
parentheses around address registers and the PC in address register and program
counter indirect address modes.  The HP 64870 assembler uses Motorola syntax.

This configuration question lets you select which syntax the inverse assembler
should use in mnemonic memory, trace, and register displays.
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Selecting the Emulation Monitor Program

In order to select the type of monitor program used by the emulator, you must first
start the configuration interface and access the "Monitor Type" configuration
section (refer to the previous "Using the Configuration Interface" section).

This section shows you how to:

• Use the background monitor program.

• Use a foreground monitor program.

• Synchronize monitor cycles to the target system (HP 64744).

• Disable the synchronization of monitor cycles (HP 64744).

When you power up the emulator, or when you initialize it, the background monitor
is used by default.  You can also configure the emulator to use a foreground
monitor.  Before the background and foreground monitors are described, you
should understand the foreground and background emulator modes as well as the
function of the emulation monitor program.

The Background Emulator Mode

Background is the mode in which emulation processor execution does not appear
normally on the emulator probe.  Background cycles may be driven to the target
system or hidden from the target system.  When background cycles are driven, they
appear as reads.  When background cycles are hidden, the emulator appears to the
target system to be in a suspended state.  In background mode, the emulation
microprocessor executes out of background memory.

The Foreground Emulator Mode

Foreground is the mode in which all emulation processor cycles appear on the
emulation probe, and the emulator executes as if it were a real microprocessor.  The
emulator is in foreground when it executes user programs.  In foreground mode, the
emulation microprocessor typically executes out of target system or emulation
memory.
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The Function of the Monitor Program

The monitor program is the interface between the emulation system controller and
the target system.  The emulation system controller uses its own microprocessor to
accept and execute emulation, system, and analysis commands.  The monitor
program is executed by the emulation microprocessor.

The monitor program makes possible emulation commands which access target
system resources.  (The only way to access target system resources is through the
emulation processor.)  For example, when you enter a command to modify target
system memory, it is the execution of monitor program instructions that cause the
new values to be written to target system memory.

When the emulation system controller recognizes that an emulation command
needs to access target system resources, it writes a command code to a
communications area and breaks the emulation processor execution into the
monitor program.  The monitor program reads this command (and any associated
parameters) from the communications area and executes the appropriate
instructions to access these target system resources.

The Background Monitor

On emulator power-up, or after initialization, the emulator uses the background
monitor program.  The background monitor program executes entirely in the
background emulator mode.  The background monitor does not occupy processor
address space.

The Foreground Monitor

You can configure the emulator to use a foreground monitor program.  When a
foreground monitor is selected, it executes in the foreground emulator mode.  The
foreground monitor occupies processor memory space and executes as if it were
part of the user program.

When you use a foreground monitor, breaks into the monitor still cause the
emulator to execute a number of cycles in background.  The difference between the
foreground monitor and the background monitor is that when the background
monitor is used, all monitor functions are executed in background; when the
foreground monitor is used, the monitor functions are executed in foreground.
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The foreground monitors are supplied with the interface software and can be found
in the following path:

/usr/hp64000/monitor/*

The monitor program named fmon68000.S should be assembled and linked with
the HP 64845 68000/10 Cross Assembler/Linker, and the monitor named
Mfmon68000.s should be assembled and linked with the HP 64870 assembler.

You may customize the foreground monitor if necessary; however, you must
maintain the basic communications protocol between the monitor and the emulation
system controller.  Comments in the monitor program source file detail sections
that cannot be changed.

Comparison of Background and Foreground Monitor Programs

Monitor Program Characteristic Background Foreground

Takes up processor memory space No Yes

Allows the emulator to respond to target system
interrupts during monitor execution

No Yes

Can be customized No Yes

Can be used when performing coordinated measurements
with other emulators

Yes No

Resident in emulator firmware Yes No, must be
assembled, linked,

and loaded
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To use the background monitor program

1 Answer "background" to the "Monitor type?" question.

2 Answer "yes" to the "Reset map (change of monitor type requires map reset)?"
question.

3 If you’re using the HP 64744 emulator, answer the "Enable /MONDTACK
interlocking?" question (see the following descriptions on synchronizing monitor
cycles).

4 Re-map memory (see the following section on "Mapping Memory").

When you select the background monitor program, a memory overlay is created
and the background monitor is loaded into that area.

Changing the monitor configuration resets the memory map, so you must re-map
memory.

You can use the emulator pod configuration questions listed below to specify how
the emulator will drive the target system during background monitor execution.

• "Drive background cycles to target system?"
• "Value for address bits A23-A8 during background cycles?"
• "Function code for background cycles?"
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To use a foreground monitor program

1 Edit the monitor program source file to define its base address.

2 Assemble and link the monitor program.

3 Start the configuration interface and access the "Monitor Type" section.

4 Answer "foreground" to the "Monitor type?" question.

5 Answer "yes" to the "Reset map (change of monitor type requires map reset)?"
question.

6 Enter the base address of the monitor in response to the "Monitor address?"
question.

7 Answer "none" or "supervisor" to the "Monitor function code?" question.

8 Enter the name of the monitor program absolute file in response to the "Monitor
filename?" question.

9 If you’re using the HP 64744 emulator, answer the "Enable /MONDTACK
interlocking?" question (see the following descriptions on synchronizing monitor
cycles).

10 Re-map memory (see the following section on "Mapping Memory").

11 Modify the TRACE exception vector to point to the TRACE_ENTRY symbol in
the monitor program so that you can step through the user program.

The foreground monitor program’s base address should be on any 4 Kbyte
boundary (address ending in 000H) except 0H (since that’s the location of the
vector table).  An ORG statement in the foreground monitor source file defines the
base address. Also, the base address is specified when configuring the emulator to
use a foreground monitor program.
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When using the HP 64742/3 emulators, the monitor program’s base address should
be on a 2 Kbyte boundary unless you are using the HP 64170 memory board with
1 Mbyte memory modules, which requires the base address to be on an 8 Kbyte
boundary.

When you select a foreground monitor, a block of emulation memory is
automatically mapped with the function code specified.

The monitor program absolute file will be loaded after you have answered all the
configuration questions.  Only the memory reserved for the monitor is loaded after
configuration. Therefore, you should not link the foreground monitor to the user
program.  If the symbol database must contain both monitor and user program
symbols, create a different absolute file linking the monitor and user program.  You
load this file after configuration.

In order to step through programs when using a foreground monitor, you must
modify the TRACE vector (24H) in the processor’s exception vector table.  The
TRACE exception vector must point to the TRACE_ENTRY label in the
foreground monitor program.

Examples The following examples of how to set up and use a foreground monitor program
assume the HP 64870 or HP B1464 68000/08/10/20/302
Assembler/Linker/Librarian is installed on the host computer.

To copy the foreground monitor program source file:

$ cp  /usr/hp64000/monitor/Mfmon68000.s .  <RETURN>

To edit the monitor program source:

$ chmod 644 Mfmon68000.s <RETURN>
$ vi  Mfmon68000.s <RETURN>

The monitor will be loaded at 10000H, so the modify ORG statement near the top
of the file to look like this:
ORG 010000H  * START MONITOR ON 4K BOUNDARY OTHER THAN ZERO

Notice that the ORG statement is indented from the left margin; if it is not indented,
the assembler will interpret the ORG as a label and will generate an error when
processing the address portion of the statement.
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To assemble and link the monitor program, enter the following commands
(which assume that /usr/hp64000/bin is defined in the PATH environment
variable):

$ as68k -L  Mfmon68000.s > Mfmon68000.lis <RETURN>

$ ld68k -c  Mfmon68000.k -L >  Mfmon68000.map <RETURN>

Where the "Mfmon68000.k" linker command file is:
name Mfmon68000
load Mfmon68000.o
end

To configure the emulator to use a foreground monitor program, access the
configuration questions, and answer the questions as shown below.

Inverse assembly syntax to use? 64870
Modify memory configuration? yes
Monitor type? foreground
Reset map (change of monitor type requires map reset)? yes
Monitor address? 10000h
Monitor file name? Mfmon68000

Re-map memory for the emulator demo program by entering the following mapper
commands:

0 thru  5fffh emulation rom  <RETURN>
7000h thru  0efffh emulation ram  <RETURN>
end  <RETURN>

Configuration file name? fmoncfg

To load the demo program absolute file, enter the following command using the
command line:

load  ecs <RETURN>

To modify the TRACE exception vector to point to the TRACE_ENTRY label
in the monitor program (so that the emulator can single-step), enter the following
commands using the command line:

load symbols  Mfmon68000 <RETURN>
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modify memory  24h long to  Mfmon68000.s:TRACE_ENTRY
<RETURN>

Now, you are ready to use the emulator.

To synchronize monitor cycles to the target
system (HP 64744)

• Answer "yes" to the "Enable /MONDTACK interlocking?" question.

The termination of monitor cycles, that is, accesses to the locations that the monitor
program occupies, will not occur until the target system provides a /DTACK or
/VPA (if the microprocessor being emulated supports /VPA).

When using the background monitor, background cycles must be driven to the
target system in order for the "Enable /MONDTACK interlocking?" configuration
setting to have an effect.  A /BERR signal from the target system will also
terminate a monitor cycle and cause the emulator to begin execution of the bus
error handler.

To disable the synchronization of monitor cycles
(HP 64744)

• Answer "no" to the "Enable /MONDTACK interlocking?" question.

Monitor cycles, that is, accesses to the locations that the monitor program occupies,
are terminated by an emulator-generated /DTACK signal.
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Mapping Memory

Because the emulator can use target system memory or emulation memory (or
both), it is necessary to map ranges of memory so that the emulator knows where to
direct its accesses.

When mapping memory, there a couple terms that you should be familiar with:

Mapper ranges — the maximum number of address ranges that can be
mapped.

Resolution — the minimum size address range that can be mapped.

Block size — the smallest amount of emulation memory that can be allocated
by the mapper.
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The following table summarizes these parameters for the various emulators and
emulation memory configurations.

Emulation Memory Configurations

Emulator, Amount of memory Mapper
ranges

Block size Resolution Foreground
monitor

block size1

HP 64742, 128 Kbytes 7 512 bytes 512 bytes 2 Kbytes

HP 64743, 128 Kbytes 7 1 Kbyte 1 Kbyte 2 Kbytes

HP 64742/3, 512 Kbytes 7 1 Kbyte 1 Kbyte 2 Kbytes

HP 64743 w/HP 64170 and 1 or 2
HP 64171A memory modules
(256 Kbytes each)

7 2 Kbytes 256 bytes 2 Kbytes

HP 64743 w/HP 64170 and 1 or 2
HP 64171B memory modules (1 Mbyte
each)

7 8 Kbytes 1 Kbyte 8 Kbytes

HP 64744, 60 Kbytes base memory and
up to 2 additional memory modules —
either HP 64171A (256 Kbytes) or HP
64171B (1 Mbyte)

16 4 Kbytes 4 Kbytes 4 Kbytes

1This also the boundary on which the monitor’s base address must be located.

Notice the resolution can be smaller than the block size.  In this case, it’s possible
for emulation memory to be wasted.  For example, suppose the resolution is 256
bytes and the block size is 2 Kbytes; if you map an emulation memory range that is
2304 bytes long (2 Kbytes + 256 bytes), the mapper will allocate 4 Kbytes of
emulation memory, 1792 bytes (2 Kbytes - 256 bytes) of which are unused.

Direct memory access (DMA) to emulation memory is not permitted.

You should map all memory ranges used by your programs before loading
programs into memory.
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In order to map memory, you must first start the configuration interface and access
the "Memory Map" configuration section (refer to the previous "Using the
Configuration Interface" section).

To map memory ranges

• Enter the address range, memory type, and if you’re using the HP 64744 emulator
you can also enter the dti  attribute for emulation memory ranges.

You can characterize memory ranges as emulation RAM, emulation ROM, target
system RAM, target system ROM, or as guarded memory.

Guarded memory accesses will cause emulator execution to break into the monitor
program.

Writes to locations characterized as ROM will cause emulator execution to break
into the monitor program if the "Break processor on write to ROM?" trace/debug
configuration option is enabled.

Writes to emulation ROM will be inhibited.  Writes by user code to target system
memory locations mapped as ROM or guarded memory will result in a break to the
monitor but are not inhibited (that is, the write still occurs).

When using the HP 64744 emulator:

Emulation memory ranges can have the dti  attribute which specifies that accesses
in that range be synchronized with the target system.  This means the termination of
accesses in the range will not occur until the target system provides a /DTACK or
/VPA.  A /BERR signal from the target system will also terminate an emulation
memory cycle and cause the emulator to begin execution of the bus error handler.

For emulation memory accesses that are not synchronized to the target system (that
is, accesses to ranges that are mapped without the dti  attribute), you can either
allow the emulator to respond to target system /BERR signals by answering "yes"
to the "Enable Bus Error on emulation memory accesses?" emulator pod
configuration question, or cause the emulator to ignore target system /BERR
signals by answering "no".

Chapter 4: Configuring the Emulator
Mapping Memory

122



Examples Consider the following section summary from the linker load map output listing.

SECTION SUMMARY
---------------

SECTION    ATTRIBUTE                     START      END        LENGTH     ALIGN

           ABSOLUTE DATA                 00000000   0000002F   00000030   0 (BYTE)  
0          NORMAL                        00000030   00000030   00000000   2 (WORD)  
env        NORMAL CODE                   00000400   0000098A   0000058B   2 (WORD)  
prog       NORMAL CODE                   0000098C   00000A73   000000E8   2 (WORD)  
const      NORMAL ROM                    00000A74   00000AD6   00000063   2 (WORD)  
lib        NORMAL CODE                   00000AD8   00000E39   00000362   2 (WORD)  
libc       NORMAL CODE                   00000E3A   00000E99   00000060   2 (WORD)  
libm                                     00000E9A   00000E9A   00000000   0 (BYTE)  
mon        NORMAL CODE                   00000E9A   00000FE3   0000014A   2 (WORD)  
envdata    NORMAL DATA                   00007000   00007055   00000056   4 (LONG)  
data       NORMAL DATA                   00007056   00007076   00000021   2 (WORD)  
idata                                    00007077   00007077   00000000   0 (BYTE)  
udata                                    00007077   00007077   00000000   0 (BYTE)  
libdata    NORMAL DATA                   00007078   0000707B   00000004   4 (LONG)  
libcdata   NORMAL DATA                   0000707C   00007106   0000008B   2 (WORD)  
mondata    NORMAL DATA                   00007108   0000712B   00000024   2 (WORD)  
heap       NORMAL DATA                   0000712C   0000A129   00002FFE   4 (LONG)  
stack      NORMAL DATA                   0000B000   0000EFFF   00004000   4 (LONG)  

Notice the ABSOLUTE DATA, CODE, and ROM sections occupy locations 0
through 0FE3H.  Because the contents of these sections will eventually reside in
target system ROM, this area should be characterized as ROM when mapped.  This
will prevent these locations from being written over accidentally.  If breaks on
writes to ROM are enabled, instructions that attempt to write to these locations will
cause emulator execution to break into the monitor.

Also, notice the DATA sections occupy locations 7000H through 0EFFFH.  Since
these sections are written to, they should be characterized as RAM when mapped.

Enter the following commands to map memory for the above program.

delete all  <RETURN>
0 thru  0fffh emulation rom  <RETURN>
7000h thru  0efffh emulation ram  <RETURN>

The resulting memory mapper screen is shown below.
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To synchronize emulation memory accesses in the range 0 through 0FFFH, you
would enter the following command in place of the command above:

0 thru  0fffh emulation rom dti  <RETURN>

To exit out of the memory mapper, enter:

end  <RETURN>

To characterize unmapped ranges

• Use the default softkey to characterize unmapped ranges.

The default softkey in the memory mapper allows you to characterize unmapped
memory ranges.  Unmapped memory ranges are treated as target system RAM by
default.  Unmapped memory ranges cannot be characterized as emulation memory.

Examples To characterize unmapped ranges as target RAM:

default target ram  <RETURN>

To characterize unmapped ranges as guarded memory:

default guarded  <RETURN>

To exit out of the memory mapper, enter:

end  <RETURN>
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To delete memory map ranges

• Use the delete softkey to delete mapped ranges.

Note that programs should be reloaded after deleting mapper terms.  The memory
mapper may re-assign blocks of emulation memory after the insertion or deletion of
mapper terms.

Examples To delete term 1 in the memory map:

delete  1 <RETURN>

To delete all map terms:

delete all  <RETURN>

To exit out of the memory mapper, enter:

end  <RETURN>
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To map memory ranges that use function codes

• Specify function codes with address ranges when mapping memory.

Function code information lets you further characterize memory blocks as
supervisor, user, supervisor program, supervisor data, user program, or user data
space.  When you specify function codes with mapper ranges, the 68000 function
code outputs (FC0, FC1, FC2) are decoded to select particular blocks of memory.
Function codes let you overlay address ranges.  When you specify function codes
as part of the address, the emulator memory mapper knows that overlaid blocks are
different memory regions and will define them separately.

If you specify a function code when mapping a range of memory, you must include
the function code when referring to locations in that range.  If you don’t include the
function code, an "ambiguous address" error message is displayed.

If you use different function codes, it’s possible to map address ranges that overlap.
When address ranges with different function codes overlap, you must load a
separately linked module for the space associated with each function code.  The
modules are linked separately because linker errors occur when address ranges
overlap.

When address ranges are mapped with different function codes, and there are no
overlapping ranges, your program modules may exist in one absolute file.
However, you have to use multiple load commands—one for each function code
specifier.  This is necessary to load the various sections of the absolute file into the
appropriate function code qualified memory ranges.  When you do this, be sure that
all address ranges not mapped (that is, the "other" memory mapper term) are
mapped as target RAM.  When "other" is mapped as guarded, guarded memory
access errors (from the attempt to load the absolute file sections that are outside the
specified function code range) can prevent the absolute file sections that are inside
the specified function range from being loaded.
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Examples Suppose you’re developing a system with the following characteristics:

• Input port at 100 hex.

• Output port at 400 hex.

• Supervisor program from 1000 through 1fff hex.

• Supervisor data from 2000 through 2fff hex.

• User program from 3000 through 3fff hex.

• User data from 3000 through 3fff hex.

Notice that the last two terms have address ranges that overlap. You can use
function codes to cause these terms to be mapped to different blocks of memory.

Suppose also that the only things that exist in your target system at this time are the
input and output ports and some control logic; no memory is available.  You can
reflect this by mapping the I/O ports to target system memory space and the rest of
memory to emulation memory space with the following mapper commands:

0h thru  0fffh target ram  <RETURN>
1000h thru  1fffh supervisor program emulation rom
<RETURN>
2000h thru  2fffh supervisor data emulation ram  <RETURN>
3000h thru  3fffh user program emulation ram  <RETURN>
3000h thru  3fffh user data emulation ram  <RETURN>

After the configuration is saved, display memory at 1000H by entering the
following command (using the command line):

display memory  1000h blocked bytes  <RETURN>

Notice that an "ambiguous address" error occurs because the "sp" function code
was not included with the address.  The following command should have been
entered instead:

display memory fcode sp  1000h blocked bytes  <RETURN>
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Configuring the Emulator Pod

In order to configure the emulator pod, you must first start the configuration
interface and access the "Emulator Pod Settings" configuration section (refer to the
previous "Using the Configuration Interface" section).

This section shows you how to:

• Synchronize emulation memory cycles to the target system (HP 64742/3).

• Disable the synchronization of emulation memory cycles (HP 64742/3).

• Enable/disable bus arbitration.

• Include bus arbitration tags in the trace.

• Exclude bus arbitration tags from the trace.

• Enable/disable /BERR response on certain types of emulation memory cycle.

• Enable/disable response to target system interrupts.

• Set the reset value of the Supervisor Stack Pointer.

• Set the processor data bus width.

• Set the target system memory access size.

• Drive background cycles to the target system.

• Stop driving background cycles to the target system.

To synchronize emulation memory cycles to the
target (HP 64742/3)

• Answer "yes" to the "Interlock emulator /DTACK with user /DTACK?" question.

An emulation memory cycle will not end until the target system asserts the
/DTACK or /VPA (valid peripheral address) signals. Note the following
relationships to other configuration items:
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If a /BERR signal occurs during an emulation memory cycle when bus error
response is enabled (see the following "Enable Bus Error on emulation
memory accesses?" question), then the cycle will be terminated, and the
emulation processor will begin executing the bus error handler.

If you have enabled background monitor cycles to be driven to the target
system (see the following "Drive background cycles to the target system?"
question), the target system must still provide a /DTACK or /VPA signal as if
it were a normal user program access to emulation memory.

If you are not operating the emulator in-circuit, all emulation and background
monitor accesses are completed by the emulator generated /DTACK signal,
regardless of the answer to this configuration question.

To disable synchronization of emulation memory
cycles (HP 64742/3)

• Answer "no" to the "Interlock emulator /DTACK with user /DTACK?" question.

Emulation and background monitor accesses are terminated with a /DTACK signal
generated by the emulator.

To enable/disable bus arbitration

• Answer "yes" to the "Enable bus arbitration?" question to enable target system bus
arbitration; answer "no" to disable the target bus arbitration.

When bus arbitration is enabled:

The emulator responds to the /BR (bus request) and /BGACK (bus grant
acknowledge) signals from the target system just like the microprocessor.

The emulator does not support DMA (direct memory access) to emulation
memory.
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When bus arbitration is disabled:

The emulator ignores the /BR and /BGACK signals from the target system.

To include bus arbitration tags in the trace

1 Answer "yes" to the "Enable bus arbitration?" question to enable target system bus
arbitration.

2 Answer "yes" to the "Tag bus arbitration for analyzer?" question.

When bus arbitration tagging is enabled (and a trace has been started), the
emulation analyzer will store a single trace state (and label it as a bus arbitration
state) every time your target system goes through a bus arbitration sequence.

You can qualify analyzer status as a bus arbitration sequence by using the qualifier
status 0xx011xxxb or status dma.  For example, to trigger on the arbitration, you
could enter the following command:

trace after status dma  <RETURN>

To exclude bus arbitration tags from the trace

1 Answer "yes" to the "Enable bus arbitration?" question to enable target system bus
arbitration.

2 Answer "no" to the "Tag bus arbitration for analyzer?" question.

If any bus arbitration sequence occurs, it will be ignored by the analyzer.
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To enable/disable /BERR response on emulation
memory accesses

• Answer "yes" or "no" to the "Enable Bus Error on emulation memory accesses?"
question.

The emulator will always respond to the /BERR signal during target system
memory cycles.

When /BERR response is enabled:

If your target system asserts the /BERR signal during certain types of
emulation memory cycles (as explained below), the emulation processor
terminates the cycle and begins executing your bus error handler.

When /BERR response is disabled:

The emulator ignores assertion of the /BERR signal from the target system
during certain types of emulation memory accesses (as explained below).

The types of emulation memory cycles that this configuration question applies to
are different depending on the emulator you’re using.

When using the HP 64744 emulator:

This question applies to emulation memory accesses that are not interlocked with
the target system /DTACK.

When emulation memory accesses are interlocked with the target /DTACK (by
using the dti  attribute when mapping emulation memory), a /BERR signal from the
target system will always terminate an emulation memory cycle and cause the
emulator to begin execution of the bus error handler.

When using HP 64742/3 emulators:

This question applies to emulation memory accesses when the target system
/DTACK is interlocked with the emulation system /DTACK.

If the target and emulation /DTACKs are not interlocked, the emulator will not
respond correctly to the /BERR signal from the target system.

Chapter 4: Configuring the Emulator
Configuring the Emulator Pod

131



To enable/disable response to target system
interrupts

• Answer "yes" to the "Respond to target system interrupts?" question to enable the
emulator’s response; answer "no" to disable the emulator’s response.

When enabled, the emulator responds to target system interrupts during foreground
operation.  Target system interrupts are always ignored during background
operation.

All 68000 systems require a vector table to process system conditions such as
divide by zero or trace traps.  You need to provide such a vector table to manage
these conditions.  Exception processing attempted without a vector table will cause
unpredictable behavior.

To set the reset value for the Supervisor Stack
Pointer

• Enter an even address in response to the "Reset value of Supervisor Stack Pointer?"
question.

In order for the emulator to transition into the run state, to step, or to perform other
functions after emulation reset, the supervisor stack pointer must be set to an
appropriate value.

The value specified must be a 32-bit hexadecimal even address.  This address
should reside in an otherwise unused emulation or target system RAM area.

Upon the first transition from emulation reset into the emulation monitor, the
supervisor stack pointer register is set to the value specified.

Note that a target system reset that occurs during background monitor operation
will not affect the supervisor stack pointer value.

Note that when you use a foreground monitor, the reset value of the supervisor
stack pointer must be at least six bytes away from a guarded memory area.  If the
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reset value of SSP is not six bytes away from a guarded area, a "Stack is in guarded
memory" error will occur when you attempt to run the program.

To set the processor data bus width (HP 64744)

• Answer "16-bit" to the "Processor data bus width?" question to set 16-bit mode;
answer "8-bit" to set 8-bit mode.

This configuration option is only valid for 68HC001/68EC000 emulation.  When
emulating the 68000, the 16-bit mode is the only valid selection.

When an 8-bit data bus width is specified, target memory is always accessed as
bytes, and the "Target memory access size?" configuration question is not asked.

To specify the target memory access size

• Answer the "Target memory access size?" question.

When accessing target system memory locations, the access mode specifies the type
of microprocessor cycles that are used to read or write the value(s).  For example,
when the access mode is byte and a target system location is modified to contain
the value 12345678H, byte instructions are used to write the byte values 12H, 34H,
56H, and 78H to target system memory.

Answer "bytes" if the emulator should make 8-bit accesses to target system
memory.

Answer "words" if the emulator should make 16-bit accesses to target system
memory.
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To drive background cycles to the target system

1 Answer "yes" to the "Drive background cycles to the target system?" question.

2 Select the A23-A8 values for driven background cycles by entering a hexadecimal
word value in response to the "Value for address bits A23-A8 during background
cycles?" question.  (When using the HP 64742/3 emulators, you must enter a
hexadecimal byte value for address bits A23-A16.)

3 Select the function code for driven background cycles by responding to the
"Function code for background cycles?" question.

These questions are only asked when you are using a background monitor.

When background cycles are driven to the target system, all of the emulation
processor’s address, data and control strobes are driven.  Writes to background
memory will appear as reads to the target system.

When specifying a value for the upper address bits, you should choose an address
block which will not interfere with your target system circuitry such as memory
management units or cache memory.

The function code specified can be:

supr prog (FC2-FC0=110)

supr data (FC2-FC0=101)

user prog (FC2-FC0=010)

user data (FC2-FC0=001)

Choose a function code that will not cause target system hardware such as memory
management units to behave in an unpredictable manner.
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To stop driving background cycles to the target
system

• Answer "no" to the "Drive background cycles to the target system?" question.

The emulator will appear to the target system as if it is between bus cycles while it
is operating in the background monitor.
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Setting the Debug/Trace Options

In order to set the debug/trace options, you must first start the configuration
interface and access the "Debug/Trace Options" configuration section (refer to the
previous "Using the Configuration Interface" section).

This section shows you how to:

• Enable/disable breaks on writes to ROM.

• Specify which TRAP instruction is used for software breakpoints
(HP 64742/3/4).

• Include/exclude background states in the trace.

To enable/disable breaks on writes to ROM

• Answer "yes" to the "Break processor on write to ROM?" question to enable
breaks; answer "no" to disable breaks.

When breaks on writes to ROM are enabled:

The emulator will break into the emulation monitor whenever the user program
attempts to write to a memory region mapped as ROM.

The emulator will prevent the processor from actually writing to memory
mapped as emulation ROM; however, it cannot prevent writes to target system
RAM locations which are mapped as ROM, even though the write to ROM
break is enabled.

When breaks on writes to ROM are disabled:

The emulator will not break to the monitor upon a write to ROM.

The emulator will not modify the memory location if it is in emulation ROM.
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To specify which TRAP instruction is used for
software breakpoints

• Enter a value in response to the "Trap number for software breakpoint (0..0FH)?"
question.

You can answer with values from 0 through 0FH to specify the particular TRAP
instruction used for software breakpoints.  The value indicates the exception vector
to use in processing the trap.

Use this configuration option if you have inserted other TRAP instructions in your
code with varying exception vector values. The configuration option allows you to
specify a different exception vector than the ones previously inserted. The
emulation monitor then responds normally to execution of a breakpoint.

When you change the answer to this configuration question, any software
breakpoints currently defined are disabled. (The software breakpoint trap
instructions currently in memory would be different than the new value you have
specified.)

To include/exclude background states in the trace

• Answer "background" or "both" to the "Trace background or foreground
operation?" question to include background states in the trace; answer "foreground"
to exclude background states from the trace.

Answering "background" specifies that the analyzer trace only background cycles.
This is rarely a useful setting for user program debugging.

Answering "both" specifies that the analyzer trace both foreground and background
cycles.  You may wish to specify this option so that all emulation processor cycles
may be viewed in the trace display.

Answering "foreground" specifies that the analyzer trace only foreground cycles.
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Using the Emulator

This chapter describes general tasks you may wish to perform while using the
emulator.  These tasks are grouped into the following sections:

• Loading absolute files.

• Using symbols.

• Executing user programs (starting, stopping, stepping, and resetting the
emulator).

• Using software breakpoints.

• Displaying and modifying registers.

• Displaying and modifying memory.

• Changing the interface settings.

• Using system commands.
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Loading and Storing Absolute Files

This section describes the tasks related to loading absolute files into the emulator
and storing memory contents into absolute files.  This section shows you how to:

• Load absolute files into memory.

• Load absolute files without symbols.

• Store memory contents into absolute files.

To load absolute files

• Choose File→Load→Executable and use the dialog box to select the absolute file.

• Using the command line, enter the load <absolute_file> command.

You can load absolute files into emulation or target system memory.  You can load
IEEE-695 format absolute files.  You can also load HP format absolute files.  The
store memory command creates HP format absolute files.

If you wish to load only that portion of the absolute file that resides in memory
mapped as emulation RAM or ROM, use the command line’s load emul_mem
syntax.

If you wish to load only the portion of the absolute file that resides in memory
mapped as target RAM, use the command line’s load user_mem syntax.

If you want both emulation and target memory to be loaded, do not specify
emul_mem or user_mem.

Examples To load the demo program absolute file, enter the following command:

load  ecs.x <RETURN>
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To load only portions of the absolute file that reside in target system RAM:

load user_mem  absfile <RETURN>

To load only portions of the absolute file that reside in emulation memory:

load emul_mem  absfile <RETURN>

To load absolute files without symbols

• Choose File→Load→Program Only and use the dialog box to select the absolute
file.

• Using the command line, enter the load <absolute_file> nosymbols command.

To store memory contents into absolute files

• Using the command line, enter the store memory command.

You can store emulation or target system memory contents into HP format absolute
files on the host computer.  Absolute files are stored in the current directory.  If no
extension is given for the absolute file name, it is given a ".X" extension.

Examples To store the contents of memory locations 900H through 9FFH to an absolute file
on the host computer named "absfile":

store memory  900h thru  9ffh to  absfile <RETURN>

After the command above, a file named "absfile.X" exists in the current directory
on the host computer.
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Using Symbols

If symbol information is present in the absolute file, it is loaded along with the
absolute file (unless you use the nosymbols option).  Both global symbols and
symbols that are local to a program module can be displayed.

Long symbol names can be truncated in the symbols display; however, you can
increase the width of the symbols display by starting the interface with more
columns (refer to the "Setting X Resources" chapter).

This section describes how to:

• Load symbols.

• Display global symbols.

• Display local symbols.

• Display a symbol’s parent symbol.

• Copy-and-paste a full symbol name to the entry buffer.

To load symbols

• Choose File→Load→Symbols Only and use the dialog box to select the absolute
file.

• Using the command line, enter the load symbols <absolute_file> command.

Unless you use the nosymbols option when loading absolute files, symbols are
loaded automatically.  However, if you did use the nosymbols option when loading
the absolute file, you can load the symbols without loading the absolute file again.

This option is particularly useful for loading symbols for files located in target
ROM so that you can use symbols with that code.
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Examples To load symbols from the demo program:

load symbols  ecs.x <RETURN>

To display global symbols

• Choose Display→Global Symbols.

• Using the command line, enter the display global_symbols command.

Listed are: address ranges associated with a symbol, the segment the symbol is
associated with, and the offset of that symbol within the segment.

If there is more than a screen full of information, you can use the up arrow, down
arrow, <NEXT>, or <PREV> keys to scroll the information up or down on the
display.

Examples To display global symbols in the demo program:

display global_symbols  <RETURN>
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To display local symbols

• When displaying symbols, position the mouse pointer over a symbol on the symbol
display screen and click the select mouse button.

• When displaying symbols, position the mouse pointer over the symbol, press and
hold the select mouse button, and choose Display Local Symbols from the popup
menu.

• Position the mouse cursor in the entry buffer and enter the module whose local
symbols are to be displayed; then, choose Display→Local Symbols ().

• Using the command line, enter the display local_symbols_in <module> command.

To display the address ranges associated with the high-level program’s source file
line numbers, you must display the local symbols in the file.
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Examples To use the Symbols Display popup menu:

View the local
symbols associated
with the highlighted
symbol by choosing
this menu item.
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Using the command line:

To display local symbols in a module:

display local_symbols_in  update_sys <RETURN>

To display local symbols in a procedure:

display local_symbols_in  update_sys.save_points <RETURN>
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To display address ranges associated with the high-level source line numbers:

display local_symbols_in  update_sys."update_sys.c":
<RETURN>
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To display a symbol’s parent symbol

• When displaying symbols, position the mouse pointer over the symbol, press and
hold the select mouse button, and choose Display Parent Symbols from the popup
menu.

Examples

View the parent
symbol associated
with the highlighted
symbol by choosing
this menu item.
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To copy-and-paste a full symbol name to the
entry buffer

• When displaying symbols, position the mouse pointer over the symbol, press and
hold the select mouse button, and choose Cut Full Symbol Name from the popup
menu.

Once the full symbol name is in the entry buffer, you can use it with pulldown
menu items or paste it to the command line area. 

By cutting the full symbol name, you get the complete names of symbols that have
been truncated.  Also, you are guaranteed of specifying the proper scope of the
symbol.

Examples

Copy the full name
of the highlighted
symbol to the entry
buffer by choosing
this menu item.
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Using Context Commands

The commands in this section display and control the directory and symbol
contexts for the interface.

Directory context. The current directory context is the directory accessed by all
system references for files—primarily load, store, and copy commands—if no
explicit directory is mentioned. Unless you have changed directories since
beginning the emulation session, the current directory context is that of the
directory from which you started the interface.

Symbol context. The emulator/analyzer interface and the Symbol Retrieval
Utilities (SRU) together support a current working symbol context.  The current
working symbol represents an enclosing scope for local symbols. If symbols have
not been loaded into the interface, you cannot display or change the symbol context.

This section shows you how to:

• Display the current directory and symbol context.

• Change the directory context.

• Change the symbol context.
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To display the current directory and symbol
context

• Choose Display→Context.

• Using the command line, enter the pwd and pws commands.

The current directory and working symbol contexts are displayed, and also the
name of the last executable file from which symbols were loaded.

Example

Directory context.

Executable from
which symbols were
last loaded.

Symbol context.

To change the directory context

• Choose File→Context→Directory  and use the dialog box to select a new directory.

• Using the command line, enter the cd <directory> command.

The Directory Selection dialog box contains a list of directories accessed during the
emulation session as well as any predefined directories present at interface startup.
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You can predefine directories and set the maximum number of entries for the
Directory Selection dialog box by setting X resources (see the "Setting X
Resources" chapter).

To change the current working symbol context

• Choose File→Context→Symbols and use the dialog box to select the new
working symbol context.

• Using the command line, enter the cws <symbol_context> command.  (Because
cws is a hidden command and doesn’t appear on a softkey label, you have to type it
in.)

You can predefine symbol contexts and set the maximum number of entries for the
Symbol Scope Selection dialog box by setting X resources (see the "Setting X
Resources" chapter).

Displaying local symbols or displaying memory in mnemonic format causes the
working symbol context to change as well.  The new context will be that of the
local symbols or memory locations displayed.
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Executing User Programs

You can use the emulator to run programs, break program execution into the
monitor, step through the program by high-level source lines or by assembly
language instructions, and reset the emulation processor.

When displaying memory in mnemonic format, a highlighted bar shows the current
program counter address.  When you step, the mnemonic memory display is
updated to highlight the new program counter address.

When displaying resisters, the register display is updated to show you the contents
of the registers after each step.

You can open multiple interface windows to display memory in mnemonic format
and registers at the same time.  Both windows are updated after stepping.

This section describes how to:

• Start the emulator running the user program.

• Stop (break from) user program execution.

• Step through user programs.

• Reset the emulation processor.

To run programs from the current PC

• Choose Execution→Run→from PC.

• Using the command line, enter the run  command.

When the emulator is executing the user program, the message "Running user
program" is displayed on the status line.
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To run programs from an address

• Position the mouse pointer in the entry buffer and enter the address you want to run
from; then, choose Execution→Run→from ().

• Using the command line, enter the run from <address> command.

Examples To run from address 920H:

run from  920h <RETURN>

To run programs from the transfer address

• Choose Execution→Run→from Transfer Address.

• Using the command line, enter the run from transfer_address command.

Most software development tools allow you to specify a starting or entry address
for program execution.  That address is included with the absolute file’s symbolic
information and is known by the interface as the transfer address.

To run programs from reset

• Choose Execution→Run→from Reset.

• Using the command line, enter the run from reset command.

When you run from reset, the emulator drives the target reset line and begins
executing from the contents of exception vector 0 (this will occur within a few
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cycles of the /RESET signal).  When the target system /RESET line becomes active
and then inactive, the 68000 registers are initialized to their reset values.

To run programs until an address

• When displaying memory in mnemonic format, position the mouse pointer over the
line that you want to run until; then press and hold the select mouse button and
choose Run Until  from the popup menu.

• Position the mouse pointer in the entry buffer and enter the address you want to run
from; then, choose Execution→Run→until () .

• Using the command line, enter the run until <address> command.

When you run until an address, a software breakpoint is set at the address and the
program is run from the current program counter.

When using the command line, you can combine the various types of run
commands; for example, you can run from the transfer address until another
address.

Examples To run from the transfer address until the address of the global symbol main:

run from transfer_address until address  main <RETURN>
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To stop (break from) user program execution

• Choose Execution→Break.

• Using the command line, enter the break command.

This command generates a break to the background monitor.

Software breakpoints and the run until  command allow you to stop execution at
particular points in the user program.

Examples To break emulator execution from the user program to the monitor:

break  <RETURN>

To step high-level source lines

• Choose Execution→Step Source and select one of the items from the cascade
menu.

• Using the command line, enter the step source command.

When stepping through instructions associated with source lines, execution can
remain in a loop and the message "Stepping source line 1; Next PC: <address>" is
displayed on the status line.  In this situation you can abort the step command by
pressing <CTRL>c.
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Examples To step through instructions associated with the high-level source lines at the
current program counter:

step source  <RETURN>

To step through instructions associated with high-level source lines at address
"main":

step source from  main <RETURN>

To step assembly-level instructions

• Choose Execution→Step Instruction and select one of the items from the cascade
menu.

• Using the command line, enter the step command.

The step command allows you to step through program execution an instruction or
a number of instructions at a time.  Also, you can step from the current program
counter or from a specific address.

Examples To step one instruction from the current program counter:

step  <RETURN>

To step a number of instructions from the current program counter:

step  8 <RETURN>

To step a number of instructions from a specified address:

step  16 from  920h <RETURN>

Chapter 5: Using the Emulator
Executing User Programs

158



To reset the emulation processor

• Choose Execution→Reset.

• Using the command line, enter the reset command.

The reset command causes the processor to be held in a reset state until a break,
run , or step command is entered.  A CMB execute signal will also cause the
emulator to run if reset.
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Using Software Breakpoints

Software breakpoints provide a way to accurately stop the execution of your
program at selected locations.

Note Version A.04.00 or greater of the HP 64700 system firmware provides support for
permanent as well as temporary breakpoints.  If your version of HP 64700 system
firmware is less than A.04.00, only temporary breakpoints are supported.

Software breakpoints are implemented in the 68000 emulators by replacing
opcodes with TRAP instructions.  You can configure the emulator to use one of 16
different TRAP instructions for software breakpoints.  The default emulator
configuration specifies that the TRAP #0FH is used for software breakpoints.

In the 68010 emulator, software breakpoints are implemented by replacing opcodes
with the BKPT (breakpoint illegal) instruction.

In order to successfully set a software breakpoint, the emulator must be able to
write to the memory location specified.  Therefore, software breakpoints cannot be
set in target memory while the emulator is reset, and they can never be set in target
ROM.  (You can, however, copy target ROM to emulation memory by storing the
contents of target ROM to an absolute file, re-mapping the range as emulation
RAM, and loading the absolute file.)

When you set a software breakpoint, the emulator replaces the opcode at the
address specified with the TRAP (68000) or BKPT (68010) instruction. When the
emulator detects a read from the appropriate vector table location (TRAP or BKPT
instruction has executed in the user program), execution breaks to the monitor.

If the TRAP (68000) or BKPT (68010) was generated by a software breakpoint, a
message containing the address of the breakpoint is displayed on the status line,
and, if the breakpoint is temporary, the original opcode is restored in the user
program.  If the breakpoint is permanent, it remains active.  A subsequent run  or
step command will execute from the breakpoint address.

If the TRAP (68000) or BKPT (68010) was not inserted as the result of a modify
software_breakpoints set command (in other words, it is part of the user
program), the "Undefined software breakpoint" message is displayed on the status
line. To continue with program execution, you must run or step from the user
program’s TRAP instruction vector address.
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Another way to break user program execution at a certain point is to break on the
analyzer trigger.

CAUTION Software breakpoints should not be set, cleared, enabled, or disabled while the
emulator is running user code.  If any of these commands are entered while the
emulator is running user code, and the emulator is executing code in the area where
the breakpoint is being modified, program execution may be unreliable.

When using the HP 64742/3 emulators:

In the HP 64742/3 emulators, all read accesses to the software breakpoint
TRAP vector location will cause the emulator to break into background.  Only
the read associated with the TRAP instruction will cause a proper transfer to
monitor.  All other accesses will result in undefined execution.  Therefore, if
software breakpoints are enabled, the TRAP vector should not be accessed by any
instruction other than a TRAP. Note that this includes boot-up code that attempts to
perform a checksum over the vector table area.  The status of the emulator may
become undefined, and the monitor program may become unusable.

This section shows you how to:

• Display the breakpoints list.

• Enable/disable breakpoints.

• Set a permanent breakpoint.

• Set a temporary breakpoint.

• Set all breakpoints.

• Deactivate a breakpoint.

• Re-activate a breakpoint.

• Clear a breakpoint.

• Clear all breakpoints.
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To display the breakpoints list

• Choose Display→Breakpoints or Breakpoints→Display.

• Using the command line, enter the display software_breakpoints command.

The breakpoints display shows the address and status of each breakpoint currently
defined.  If symbolic addresses are turned on (when setting the display modes), the
symbolic label associated with a breakpoint is also displayed.  Also, the breakpoints
display shows whether the breakpoint feature is enabled or disabled.

The status of a breakpoint can be:

temporary Which means the temporary breakpoint has been set but not
encountered during program execution.  These breakpoints are
removed when the breakpoint is encountered.

pending Which means the temporary breakpoint has been set but not
encountered during program execution.  These breakpoints are
inactivated when the breakpoint is encountered.

permanent Which means the permanent breakpoint is active.

inactivated Which means the breakpoint has been inactivated somehow.
Temporary breakpoints are inactivated when they are
encountered during program execution.  Both temporary and
permanent breakpoints may be inactivated using the breakpoints
display popup menu.

In the breakpoints display, a popup menu is available.  You can set, inactivate, or
clear breakpoints as well as enable or disable the breakpoints feature from the
popup menu.
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To enable/disable breakpoints

• Choose the Breakpoints→Enable toggle.

• When displaying the breakpoint list, press and hold the select mouse button and
then choose Enable/Disable Software Breakpoints from the popup menu.

• Using the command line, enter the modify software_breakpoints enable or
modify software_breakpoints disable command.

The breakpoints feature must be enabled before you can set, inactivate, or clear
breakpoints.

If breakpoints were set when the feature was disabled, they are "inactivated" when
the feature is re-enabled, and you must set them again.

The emulator/analyzer interface will enable software breakpoints whenever the
XEnv_68k_except symbol is present in the symbol data base.

The run-time library provided with the 68000 C Cross Compiler uses software
breakpoints to interrupt program execution when exceptions (for example, divide
by zero) are encountered.  If software breakpoints are disabled, exception
processing may result in "access to guarded memory" errors and/or other
unpredictable behavior.  To prevent this, a special global symbol,
XEnv_68k_except, is included in the library.

When the XEnv_68k_except symbol is present, the 68000 emulator writes a value
to this location.  The value tells the run-time library which TRAP instruction to use
to perform a software break.
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Examples To enable software breakpoints using the breakpoints display popup menu:

Bring up menu and
choose this item to
change states.
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To set a permanent breakpoint

• When displaying memory in mnemonic format, position the mouse pointer over the
program line at which you wish to set the breakpoint and click the select mouse
button.  Or, press and hold the select mouse button and choose Set/Clear Software
Breakpoint from the popup menu.

• Place an absolute or symbolic address in the entry buffer; then, choose
Breakpoints→Permanent ()

• Using the command line, enter the modify software_breakpoints set <address>
permanent command.

Permanent breakpoints are available if your version of HP 64700 system firmware
is A.04.00 or greater.

The breakpoints feature must be enabled before individual breakpoints can be set.

Note that you must only set software breakpoints at memory locations which
contain instruction opcodes (not operands or data).

When displaying memory in mnemonic format, asterisks (*) appear next to
breakpoint addresses.  An asterisk shows the breakpoint is active.  Also, if
assembly level code is being displayed, the disassembled instruction mnemonic at
the breakpoint address will show the breakpoint instruction.
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Examples To set permanent breakpoints using the mnemonic memory display popup menu:

Click this line to set a
breakpoint.

Click this line to
clear a breakpoint.
(Asterisks mark set
breakpoints.)

Bring up menu and
choose this item to
set (or clear) a
breakpoint on the
highlighted line.

To set a temporary breakpoint

• Place an absolute or symbolic address in the entry buffer; then, choose
Breakpoints→Temporary () (or Breakpoints→Set () if your version of
HP 64700 system firmware is less than A.04.00).

• Using the command line, enter the modify software_breakpoints set <address>
temporary or modify software_breakpoints set <address> command.

The breakpoints feature must be enabled before individual breakpoints can be set.
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Note that you must only set software breakpoints at memory locations which
contain instruction opcodes (not operands or data).

When displaying memory in mnemonic format, asterisks (*) appear next to
breakpoint addresses.  An asterisk shows the breakpoint is active.  Also, if
assembly level code is being displayed, the disassembled instruction mnemonic at
the breakpoint address will show the breakpoint instruction.

To set all breakpoints

• When displaying the breakpoint list, position the mouse pointer within the
breakpoints display screen, press and hold the select mouse button, and choose Set
All Breakpoints from the popup menu.

• Choose Breakpoints→Set All.

• Using the command line, enter the modify software_breakpoints set command.

Breakpoints must be enabled before being set.

To deactivate a breakpoint

• When displaying breakpoints, position the mouse pointer over the line displaying
the active breakpoint and click the select mouse button.  Or, press and hold the
select mouse button and choose Set/Inactivate Breakpoint from the popup menu.

A deactivated breakpoint remains in the breakpoint list and can be re-activated
later.  Deactivating a breakpoint is different than clearing a breakpoint because a
cleared breakpoint is removed from the breakpoints list.
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To re-activate a breakpoint

• When displaying breakpoints, position the mouse pointer over the line displaying
the inactivated breakpoint and click the select mouse button.  Or, press and hold the
select mouse button and choose Set/Inactivate Breakpoint from the popup menu.

The "inactivated" breakpoint either becomes "temporary" (or "pending") if it was
set as a temporary breakpoint or "permanent" if it was set as a permanent
breakpoint.
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Examples To re-activate breakpoints using the breakpoints display popup menu:

Change status with a
mouse click on this
line (menu and
highlight do not
appear).

Choose this menu
item to change the
state of the
highlighted
breakpoint.
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To clear a breakpoint

• When displaying memory in mnemonic format, position the mouse pointer over the
program line at which you wish to clear a currently set breakpoint (notice the
asterisk at the left of the line) and click the select mouse button. Or, press and hold
the select mouse button and choose Set/Clear Software Breakpoint from the
popup menu.

• When displaying breakpoints, position the mouse pointer over the line displaying
the breakpoint you wish to clear, press and hold the select mouse button, and
choose Clear (delete) Breakpoint from the popup menu.

• Place an absolute or symbolic address in the entry buffer; then choose
Breakpoints→Clear ().

• Using the command line, enter the modify software_breakpoints clear <address>
command.

When you clear a breakpoint, it is removed from the breakpoints list.
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Examples To clear a software breakpoint using the breakpoints display popup menu:

Bring up the menu
and choose this item
to clear the
highlighted
breakpoint.
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To clear all breakpoints

• When displaying breakpoints, position the mouse pointer within the Breakpoints
Display screen, press and hold the select mouse button, and choose Clear (delete)
All Breakpoints from the popup menu.

• Choose Breakpoints→Clear All .

• Using the command line, enter the modify software_breakpoints clear command.
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Displaying and Modifying Registers

You can display and modify the contents of emulation processor registers.  Most
emulators have at least a BASIC class of registers.  Some emulators have additional
register classes whose register contents can be displayed and modified.  Consult
your emulator-specific Softkey Interface documentation for a definition of the
register classes.

This section shows you how to:

• Display register contents.

• Modify register contents.

To display register contents

• Choose Display→Registers.

• Using the command line, enter the display registers command.

When displaying registers, you can display classes of registers and individual
registers.
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To modify register contents

• Choose Modify →Registers... and use the dialog box to name the register and
specify its value.

Clicking the "Recall" pushbutton lets
you select register names and values
from predefined or previously
specified entries.

Placing the mouse pointer in the text
entry area lets you type in the register
name and value.

To define the type of value, press and
hold the command select mouse
button and drag the mouse to select
the value type.

Clicking this checkbox causes the
current value of the named register to
be placed in the "Value" text entry
area.

Clicking this button modifies the
register to the value specified and
closes the dialog box.

Clicking this button modifies
the register to the value
specified and leaves the dialog
box open.

Clicking this button cancels
modification and closes the
dialog box.

• Using the command line, enter the modify register <register> to <value>
command.
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Displaying and Modifying Memory

You can display and modify the contents of memory in hexadecimal formats and in
real number formats.  You can also display the contents of memory in assembly
language mnemonic format.

This section shows you how to:

• Display memory.

• Display memory in mnemonic format.

• Display memory in mnemonic format at the current PC.

• Return to the previous mnemonic display.

• Display memory in hexadecimal format.

• Display memory in real number format.

• Display memory at an address.

• Display memory repetitively.

• Modify memory.

• Modify memory at an address.

To display memory

• Choose Display→Memory.

This command either re-displays memory in the format specified by the last
memory display command, or, if no previous command has been executed, displays
memory as hexadecimal bytes beginning at address zero.
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To display memory in mnemonic format

• To display memory at a particular address, place an absolute or symbolic address in
the entry buffer; then, choose Display→Memory→Mnemonic (), or, using the
command line, enter the display memory <address> mnemonic command.

• To display memory at the current program counter address, choose
Display→Memory→Mnemonic at PC, or, using the command line, enter the
display memory mnemonic at_pc command.

A highlighted bar shows the location of the current program counter address.  This
allows you to view the program counter while stepping through user program
execution.

Whether source lines, assembly language instructions, or symbols are included in
the display depends on the modes you choose with the
Settings→Source/Symbols Modes or Settings→Display Modes pulldown menu
items.  See the "Changing the Interface Settings" section.

If symbols are loaded into the interface, the default is to display source only.

To return to the previous mnemonic display

• Choose Display→Memory→Mnemonic Previous.

• Using the command line, enter the display memory mnemonic previous_display
command.

This command is useful for quickly returning to the previous mnemonic memory
display.

For example, suppose you are stepping source lines and you step into a function
that you would like to step over.  You can return to the previous mnemonic
memory display, set a breakpoint at the line following the function call, and run the
program from the current program counter.
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To display memory in hexadecimal format

• Place an absolute or symbolic address in the entry buffer; then, choose
Display→Memory→Hex () and select the size from the cascade menu.

• Using the command line, enter the display memory <address> blocked <size>
command.

This command displays memory as hexadecimal values beginning at the address in
the entry buffer.

Examples To display memory in absolute word format:

display memory  ascii_old_data absolute words  <RETURN>
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To display memory in blocked byte format:

display memory  ascii_old_data blocked bytes  <RETURN>

To display memory in real number format

• Place an absolute or symbolic address in the entry buffer; then, choose
Display→Memory→Real () and select the size from the cascade menu.

• Using the command line, enter the display memory <address> real <size>
command.

Displays memory as a list of real number values beginning at the address in the
entry buffer.  Short means four byte real numbers and long means eight byte real
numbers.
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Examples To display memory in 64-bit real number format:

display memory real long  <RETURN>

To display memory at an address

• Place an absolute or symbolic address in the entry buffer; then, choose
Display→Memory→At ().

This command displays memory in the same format as that of the last memory
display command.  If no previous command has been issued, memory is displayed
as hexadecimal bytes.
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To display memory repetitively

• Choose Display→Memory→Repetitively.

• Using the command line, enter the display memory repetitvely command.

The memory display is constantly updated.  The format is specified by the last
memory display command.

This command is ignored if the last memory display command was a mnemonic
display.

To modify memory

• Choose Modify →Memory and complete the command using the command line.

• To modify memory at a particular address, place an absolute or symbolic address in
the entry buffer; then, choose Modify →Memory at () and complete the command
using the command line.

• Using the command line, enter the modify memory command.

You can modify the contents of one memory location or a range of memory
locations.  Options allow you to modify memory in byte, short, word, and real
number formats.
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Displaying Data Values

The data values display lets you view the contents of memory as data types.  You
can display data values in the following formats:

bytes
8-bit integers
unsigned 8-bit integers
chars
words
16-bit integers
unsigned 16-bit integers
long words
32-bit integers
unsigned 32-bit integers

This section shows you how to:

• Display data values.

• Clear the data values display and add a new item.

• Add item to the data values display.

To display data values

• Choose Display→Data Values.

• Using the command line, enter the display data command.

Items must be added to the data values display before you can use this command.

The data display shows the values of simple data types in the user program.  When
the display mode setting turns ON symbols, a label column that shows symbol
values is added to the data display.

Step commands and commands that cause the emulator to enter the monitor (for
example, encountering a breakpoint) cause the data values screen to be updated.
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To clear the data values display and add a new
item

• Place an absolute or symbolic address in the entry buffer; then, choose
Display→Data Values→New () and select the data type from the cascade menu.

• Using the command line, enter the display data <address> command.

To add items to the data values display

• Place an absolute or symbolic address in the entry buffer; then, choose
Display→Data Values→Add () and select the data type from the cascade menu.

• Using the command line, enter the display data , <address> command.
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Changing the Interface Settings

This section shows you how to:

• Set the source/symbol modes.

• Set the display modes.

To set the source/symbol modes

• To display assembly language mnemonics with absolute addresses, choose
Settings→Source/Symbol Modes→Absolute, or, using the command line, enter
the set source off symbols off command.

• To display assembly language mnemonics with absolute addresses replaced by
global and local symbols where possible, choose Settings→Source/Symbol
Modes→Symbols, or, using the command line, enter the set source off symbols
on command.

• To display assembly language mnemonics intermixed with high-level source lines,
choose Settings→Source/Symbol Modes→Source Mixed, or, using the command
line, enter the set source on symbols on command.

• To display only high-level source lines, choose Settings→Source/Symbol
Modes→Source Only, or, using the command line, enter the set source only
symbols on command.

The source/symbol modes affect mnemonic memory displays and trace displays.

Each display mode cascade menu choice is a toggle.  Choosing one of these items
causes it to be the only one active and toggles all others off.  Provided that symbols
were loaded, the interface defaults to:

• Source only for mnemonic memory displays.

• Source mixed for trace listing displays.
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To set the display modes

• Choose Settings→Display Modes... to open the display modes dialog box.

Press and hold the select mouse
button and drag the mouse to
select "Source Only", "Source
Mixed", or "Off".

Clicking toggles whether
symbolic information is
displayed.

Move the mouse pointer to the
text entry area and type in the
value.  Descriptions of the
modes follow.

Clicking toggles auto update
settings.

Clicking this checkbox changes
all display mode settings to
their defaults.

Clicking this button saves your
changes and closes the dialog
box.

Clicking this button saves
your changes and leaves the
dialog box open.

Clicking this button cancels your
changes and closes the dialog box.
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Source/Symbols View

Source in Memory specifies whether source lines are included, mixed with
assembly code, or excluded from mnemonic memory displays.

Source in Trace specifies whether source lines are included, mixed with stored
states, or excluded from trace displays.

Symbolic Addresses specifies whether symbols are included in displays.

Tab Expansion sets the number of spaces displayed for tabs in source lines.

Source/Symbols View

Label Field sets the width (in characters) of the address field in the trace list or
label (symbols) field in any of the other displays.

Mnemonic Field sets the width (in characters) of the mnemonic field in memory
mnemonic, trace list, and register step mnemonic displays.  It also changes the
width of the status field in the trace list.

Symbols in Mnemonic Field sets the maximum width of symbols in the mnemonic
field of the trace list, memory mnemonic, and register step mnemonic displays.

Source Lines sets the width (in characters) of the source lines in the memory
mnemonic display.

Auto Update

Memory Displays toggles whether memory displays are automatically updated
after commands that change memory contents or whether you must enter memory
display commands to update the display.  You may wish to turn off memory
display updates, for example, when displaying memory mapped I/O.

Trace Displays toggles whether trace displays are automatically updated when
trace measurements complete or whether you must enter trace display commands to
update the display.  You may wish to turn off trace display updates in one
emulator/analyzer window in order to compare the display with a new trace display
in another emulator/analyzer window.
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Using System Commands

With the Softkey Interface system commands, you can:

• Set UNIX environment variables while in the Softkey Interface.

• Display the name of the emulation module.

• Display the event log.

• Display the error log.

To set UNIX environment variables

• Using the command line, enter the set <VAR> command.

You can set UNIX shell environment variables from within the Softkey Interface
with the set <environment_variable> = <value> command.

Examples To set the PRINTER environment variable to "lp -s":

set  PRINTER = "lp -s" <RETURN>

After you set an environment variable from within the Softkey Interface, you can
verify the value of it by entering !set <RETURN>.
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To display the name of the emulation module

• Using the command line, enter the name_of_module command.

While operating your emulator, you can verify the name of the emulation module.
This is also the logical name of the emulator in the emulator device file.

Examples To display the name of your emulation module:

name_of_module <RETURN>

The name of the emulation module is displayed on the status line.

To display the event log

• Choose Display→Event Log.

• Position the mouse pointer on the status line, press and hold the select mouse
button, and then choose Display Event Log from the popup menu.

• Using the command line, enter the display event_log command.

The last 100 events that have occurred during the emulation session are displayed.

The status of the emulator and analyzer are recorded in the event log, as well as the
conditions that cause the status to change (for example, software breakpoints and
trace commands).
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To display the error log

• Choose Display→Error Log .

• Position the mouse pointer on the status line, press and hold the select mouse
button, and then choose Display Error Log  from the popup menu.

• Using the command line, enter the display error_log command.

The last 100 error messages that have occurred during the emulation session are
displayed.
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To edit files

• Choose File→Edit→File and use the dialog box to specify the file name.

• To edit a file based on an address in the entry buffer, place an address reference
(either absolute or symbolic) in the entry buffer; then, choose File→Edit→At ()
Location.

• To edit a file based on the current program counter, choose File→Edit→At PC
Location.

• To edit a file associated with a symbol when you are displaying symbols, position
the mouse pointer over the symbol, press and hold the select mouse button, and
choose Edit File At Symbol from the popup menu.

• To edit a file when displaying memory in mnemonic format, position the mouse
pointer over the line of source where you want to begin the edit, press and hold the
select mouse button, and choose Edit Source from the popup menu.

When editing files at addresses, the interface determines which source file contains
the code generated for the address and opens an edit session on the file.  The
interface will issue an error if it cannot find a source file for the address.

The interface will choose the "vi" editor as its default editor, unless you specify
another editor by setting an X resource.  Refer to the "Setting X Resources" chapter
for more information about setting this resource.

You must load symbols before most commands will work because symbol
information is needed to be able to locate the files.
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Examples To edit a file that defines a symbol:

Choosing this menu
item brings up a
terminal window
with an edit session
open on the file
where the
highlighted symbol is
defined.
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To edit a file at a source line:

Choosing this menu
item brings up a
terminal window
with an edit session
open on the file
where the
highlighted source
line exists.
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To copy information to a file or printer

• Choose File→Copy, select the type of information from the cascade menu, and use
the dialog box to select the file or printer.

• Using the command line, enter the copy command.

ASCII characters are copied to the file or printer.

If you copy information to an existing file, it will be appended to the file.

Refer to the following paragraphs for details about the different copy options.

Display ... Copies information currently in the display area. This option is useful
for restricting the number of lines that are copied.  Also, this option is useful for
copying the contents of register classes other than BASIC.

Memory ... Copies the contents of a range of memory.  The format is the same as
specified in the last display memory command.  For example, if you copy memory
after displaying a range of memory in mnemonic format, the file would contain the
mnemonic memory information.  If there is no previous display memory command,
the format used is a blocked hex byte format beginning at address zero.

Data Values ... Copies the contents of the defined data values last displayed.  An
error occurs if you try to copy data values to a file if you have not yet displayed
data values.

Trace ... The most recently captured trace is copied to the file.  The copied trace
listing is formatted according to the current display mode.

You can set the display mode with the Settings→Source/Symbols Modes or
Settings→Display Modes pulldown menu items.  See the "Changing the Interface
Settings" section.

Registers ... Copies the current values of the BASIC register class to a file.  To
copy the contents of the other register classes, first display the registers in that
class, and then use the File→Copy→Display ... command.

Breakpoints ... Copies the breakpoints list.  If no breakpoints are present in the
list, only the enable/disable status is copied.
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Status ... Copies the emulator/analyzer status display.

Global Symbols ... Copies the global symbols.  If symbols have not been
loaded, this menu item is grayed-out and unresponsive.

Local Symbols () ... Copies the local symbols from the symbol scope named
(by an enclosing symbol) in the entry buffer.  If symbols have not been loaded, this
menu item is grayed-out and unresponsive.

Pod Commands ... Copies the last 100 lines from the pod commands display.

Error Log ... Copies the last 100 lines from the error log display.

Event Log ... Copies the last 100 lines from event log display.

To open a terminal emulation window

• Choose File→Term...

This command opens a terminal window into the current working directory context.
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Using Simulated I/O

Simulated I/O is a feature of the emulator/analyzer interface that lets you use the
same keyboard and display that you use with the interface to provide input to
programs and display program output.

To use simulated I/O, your programs must communicate with the simulated I/O
control address and the buffer locations that follow it.  (The Hewlett-Packard AxLS
compilers, if your program uses I/O, automatically link with environment
dependent routines that communicate with the simulated I/O control address and
buffer.)

Also, before simulated I/O can work, the emulator must be configured to enable
polling of the simulated I/O control address and to define the control address
location.

This section shows you how to:

• Display the simulated I/O screen.

• Use simulated I/O keyboard input.

Refer to the Simulated I/O User’s Guide for complete details on how simulated I/O
works.

To display the simulated I/O screen

• Choose Display→Simulated IO.

Before you can display simulated I/O, polling for simulated I/O must be enabled in
the emulator configuration.
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Examples

A message tells you whether the display is open or closed.  You can modify the
configuration to enable status messages.

To use simulated I/O keyboard input

• To begin using simulated I/O input, choose Settings→Simulated IO Keyboard.

• To end simulated I/O and return to using the interface, use the suspend softkey.

The command line entry area is used for simulated input with the keyboard.
Therefore, if the command line is turned off, choosing this menu item with turn
command line display back on.

If you are planning to use even a modest amount of simulated I/O input during an
emulation session, it might be a good idea to open another Emulator/Analyzer
window to be used exclusively for simulated I/O input and output.
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Using Basis Branch Analysis

Basis branch analysis (BBA) is provided by the HP Branch Validator product.  This
product is used to analyze the testing of your programs, create more complete test
suites, and quantify your level of testing.

The HP Branch Validator records branches executed in a program and generates
reports that provide information about program execution during testing.  It uses a
special C preprocessor to add statements that write to a data array when program
branches are taken.  After running the program in the emulator (using test input),
you can store the BBA information to a file.  Then, you can generate reports based
on the stored information.

This section shows you how to:

• Store BBA data to a file.

Refer to the HP Branch Validator (BBA) User’s Guide for complete details on the
BBA product and how it works.

To store BBA data to a file

• Choose File→Store→BBA Data and use the selection dialog box to specify the
file name.

The default file name "bbadump.data" can be selected from the dialog box.
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Using the Emulation Analyzer

This chapter describes tasks you may wish to perform while using the emulation
analyzer.  These tasks are grouped into the following sections:

• The basics of starting, stopping, and displaying traces.

• Qualifying trigger and store conditions.

• Using the sequencer.

• Modifying trace displays.

• Saving and restoring traces.
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The Basics of Starting, Stopping, and Displaying
Traces

This section describes the basic tasks that relate to starting and stopping trace
measurements.

When you start a trace measurement, the analyzer begins looking at the data on the
emulation processor’s bus and control signals on each analyzer clock signal.  The
information seen on a particular clock is called a state.

When one of these states matches the "trigger state" you specify, the analyzer stores
states in trace memory.  When trace memory is filled, the trace is said to be
"complete."  The default trigger state specification is "any state," so when you start
a trace measurement after initializing the analyzer, the analyzer will "trigger" on the
first state it sees and store the following states in trace memory.

Once you start a trace measurement, you can view the progress of the measurement
by displaying the trace status.

In some situations, for example, when the trigger state is never found or when the
analyzer hasn’t filled trace memory, the trace measurement does not complete.  In
these situations, you can halt the trace measurement.

Once a trace is displayed, you can use the cursor keys and other keys to position the
trace list on the display.  To speed up the display of traces, you can reduce the
depth of the trace list.  Also, when entering trace commands, there is a special
command that allows you to recall and modify the last trace command entered.

This section describes how to:

• Start trace measurements.

• Display the trace status.

• Stop trace measurements.

• Display the trace.

• Position the trace display on the screen.

• Change the trace depth.

• Modify the last trace command entered.
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To start a trace measurement

• Choose Trace→Everything.

• Using the command line, enter the trace command.

The trace command tells the analyzer to begin monitoring the states which appear
on the trace signals.  You will see a message that confirms that a trace is started.

The default trace command (simply trace with no options) will trigger on any state,
store all captured states.

Examples While the emulator is running the user program, you can start the default trace
measurement with the command:

trace  <RETURN>

A message is displayed on the status line to show you that the "Emulation trace
[has] started", and another message will show you when the "Emulation trace [is]
complete".

To display the trace status

• Choose Display→Status.

• Using the command line, enter the display status command.

In addition to the analyzer information shown on the status line (Emulation trace
started, Emulation trace complete, etc.), you can display complete analyzer status
with the command below.
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Examples To display the trace status:

display status  <RETURN>

The first line of the emulation trace status display shows the user trace has been
"completed"; other possibilities are that the trace is still "running" or that the trace
has been "halted".

The "Arm ignored" line shows that the arm condition, which can be used to qualify
trace measurements, is ignored.  Consequently, the "Arm to trigger" time is not
meaningful and a question mark is displayed.  (The "Making Coordinated
Measurements" chapter explains arm conditions.)

The second line of the trace status display contains information on the arm
condition.  If the analyzer is always armed, the message "Arm ignored" is
displayed.  If the analyzer is to be armed by one of the internal signals, either the
message "Arm not received" or "Arm received" is displayed. The display indicates
if the arm condition happened any time since the most recent trace started, even if it
happened after the trace was halted or became complete.

The "Arm to trigger" line displays the amount of time between the arm condition
and the trigger.  The time displayed will be from -0.04 microseconds to 41.943
milliseconds, less than -0.04 microseconds, or greater than 41.943 milliseconds.  If
the arm signal is ignored or the trigger is not in memory, a question mark (?) is
displayed.
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The "States" line shows the number of states that have been stored (out of the
number that is possible to store) and the line numbers that the stored states occupy.
(The trigger state is always stored on line 0.)

The "Sequence term" line of the trace status display shows the number of the term
the sequencer was in when the trace completed.  Because a branch out of the last
sequence term constitutes the trigger, the number displayed is what would be the
next term (2 in the preceding example) even though that term is not defined.  If the
trace is halted, the sequence term number just before the halt is displayed;
otherwise, the current sequence term number is displayed.  If the current sequence
term is changing too quickly to be read, a question mark (?) is displayed.

The "Occurrence left" line of the trace status display shows the number of
occurrences remaining before the primary branch can be taken out of the current
sequence term.  If the occurrence left is changing too quickly to be read, a question
mark (?) is displayed.
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To stop a trace measurement

• Choose Trace→Stop.

• Using the command line, enter the stop_trace command.

You can, and most likely will, specify traces whose trigger or storage states are
never found.  When this happens, the "Emulation trace complete" message is never
shown, and the trace continues to run ("Emulation trace running").  When these
situations occur, you can halt the trace measurement with the stop_trace command.

The stop_trace command is also useful to deactivate signals which are driven
when the trigger is found (refer to the "Making Coordinated Measurements"
chapter).

Examples To halt a trace measurement:

stop_trace  <RETURN>

When the stop_trace command is entered, the message "Emulation trace halted" is
displayed.
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To display the trace

• Choose Trace→Display or Display→Trace.

• Using the command line, enter the display trace command.

You can display captured trace data with the display trace command.  The
available options to the display trace command are described in the "Modifying
the Trace Display" section later in this chapter.

Examples To display the trace:

display trace  <RETURN>

The first column in the trace list contains the line number.  The trigger is always on
line 0.

The second column contains the address information associated with the trace
states.  Addresses in this column may be locations of instruction opcodes on fetch
cycles, or they may be sources or destinations of operand cycles.

The third column shows mnemonic information about the emulation bus cycle.
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The next column shows the count information (time is counted by default).
"Relative" indicates that each count is relative to the previous state.

If your analyzer card contains external analysis (for example, HP 64703), the next
column shows the data captured on the external trace signals.

You can use the <NEXT> and <PREV> keys to scroll through the trace list a page
at a time.  The <Up arrow> and <Down arrow> keys will scroll through the trace
list a line at a time.  You can also display the trace list centered around a specific
line number (for example, display trace 100 <RETURN>).  Refer to the
"Modifying the Trace Display" section for more information on the trace list
display.

Note that when a trigger condition is found but not enough states are captured to fill
trace memory, the status line will show the trace is still running.  You can display
all but the last captured state in this situation; you must halt the trace to display the
last captured state.

To position the trace display on screen

• Use the scroll bar or the <Up arrow>, <Down arrow>, <PREV>, <NEXT>,
<CTRL>f, and <CTRL>g keys.

You can reposition the display on the screen with the keys described below.

The <Up arrow> and <Down arrow> (or roll up and roll down) keys move the
display up or down on the screen one line at a time.

The <PREV> and <NEXT> (or page up and page down) keys allow you to move
the display up or down a page at a time.

The <CTRL>f and <CTRL>g keys allow you to move the display left or right,
respectively.  These keys are used when the width of the address or
mnemonic/absolute columns is increased so that not all the trace display data can be
displayed across the screen.
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To change the trace depth

• Using the command line, enter the display trace depth command.

The display trace depth command allows you to specify the number of states that
are displayed.  By reducing the trace depth, you can shorten the time it takes for the
Softkey Interface to upload the trace information.  You can increase the trace depth
to view more states of the current trace.

The minimum trace depth is 9.

If you wish to reduce the number of states that are displayed, the display trace
depth command must be entered before the trace command.  You cannot use this
command to reduce the number of states displayed in the current trace.

To modify the last trace command entered

• Choose Trace→Trace Spec and use the dialog box to select and edit a trace
command.

• Using the command line, enter the trace modify_command command.

The Trace Specification Selection dialog box contains a list of trace specifications
executed during the emulation session as well as any predefined trace specifications
present at interface startup.

You can predefine trace specifications and set the maximum number of entries for
the dialog box by setting X resources (see the "Setting X Resources" chapter).

The trace modify_command command recalls the last trace command.  The
advantage of this command over command recall is that you do not have to move
forward and backward over other commands to find the last trace command; also,
the last trace command is always available, no matter how many commands have
since been entered.
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Qualifying Trigger and Store Conditions

This section describes tasks relating to the qualification of trigger and storage states.

You can trigger on, or store, specific states or specific values on a set of trace
signals (which are identified by trace labels).

Also, you can prestore states.  The prestore qualifier is a second storage qualifier
used for storing states that occur before the normally stored states.  Prestore is
useful for capturing entry points to procedures or for identifying where global
variables are accessed from.

This section describes how to:

• Qualify the trigger state and the trigger position in the trace.

• Trigger on a number of occurrences of some state.

• Qualify states stored in the trace.

• Prestore states before qualified store states.

• Change the count qualifier.

• Trace until the analyzer is halted.

• Cause the emulator to break into the monitor when the analyzer triggers.

Expressions in Trace Commands

When modifying the analysis specification, you can enter expressions which consist
of values, symbols, and operators.

Values Values are numbers in hexadecimal, decimal, octal, or binary.  These
number bases are specified by the following characters:

B b Binary (example: 10010110b).

Q q O o Octal (example: 377o or 377q).

D d (default) Decimal (example: 2048d or 2048).
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H h Hexadecimal (example: 0a7fh).
You must precede any hexadecimal number that begins
with an A, B, C, D, E, or F with a zero.

Don’t care digits may be included in binary, octal, or hexadecimal numbers and
they are represented by the letters X or x. A zero must precede any numerical value
that begins with an "X".

Symbols A symbol database is built when the absolute file is loaded into the
emulator.  Both global and local symbols can be used when entering expressions.
Global symbols are entered as they appear in the global symbols display.  When
specifying a local symbol, you must include the name of the module ("anly.c") as
shown below.

anly.c:cmp_function

Operators Analysis specification expressions may contain operators.  All
operations are carried out on 32-bit, two’s complement integers.  (Values which are
not 32 bits will be sign extended when expression evaluation occurs.)

The available operators are listed below in the order of evaluation precedence.
Parentheses are also allowed in expressions to change the order of evaluation.

-, ~ Unary two’s complement, unary one’s complement.  The
unary two’s complement operator is not allowed on
constants containing don’t care bits.

* , /, % Integer multiply, divide, and modulo.  These operators are
not allowed on constants containing don’t care bits.

+, - Addition, subtraction.  These operators are not allowed on
constants containing don’t care bits.

& Bitwise AND.

| Bitwise inclusive OR.

Values, symbols, and operators may be used together in analysis specification
expressions.  For example, if the local symbol exists, the following is a valid
expression:

module.c:symb+0b67dh&0fff00h
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However, you cannot add two symbols unless one of them is an EQU type symbol.

Emulation Analyzer Trace Signals

When you qualify states, you specify values that should be found on the analyzer
trace signals.  The emulation analyzer trace signals are described in the table that
follows.
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Emulation Analyzer Trace Signals

Trace
Signals

Signal
Name

Signal
Description

0 UDS Upper Data Strobe (A0)

1-23 A1-A23 Address Lines 1-23

31 GRDAC_L Guarded Memory Access Cycle

30 ROMAC_L ROM Memory Access Cycle

29
28
27

TFC2
TFC1
TFC0

Function Codes 0-2.  These lines to the analyzer are derived from the
68000 processor’s function code lines.  During normal foreground
operation (user program or a foreground monitor), the processor function
code lines are passed directly to the analyzer.  When a DMA tag cycle is
generated, an illegal function code pattern is driven to the analyzer to
indicate the tag.  Two other illegal function code patterns are used during
emulation monitor operations to generate additional status information.
The modified function code meanings are:

   000 - Monitor Program Space
   001 - User Data Space
   010 - User Program Space
   011 - DMA tag cycle status
   100 - Monitor Data Space
   101 - Supervisor Data Space
   110 - Supervisor Program Space
   111 - Interrupt Acknowledge

26 VMA 6800 peripheral cycle

25 RD/WR High Read/Low Write

24 B/W High Byte Access/Low Word Access

32-47 D0-D15 Processor  Data 0-15
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State Qualifiers

Whenever a state can be specified in the trace command (trigger state, storage state,
prestore state, etc.), you will see the following softkeys that allow you to qualify the
state:

address The value following this softkey is searched for on the lines that
monitor the emulation processor’s address bus.

data The value following this softkey is searched for on the lines that
monitor the emulation processor’s data bus.

status The value following this softkey is searched for on the lines that
monitor other emulation processor signals.

When a value is specified without one of these softkeys it is assumed to be an
address value.

Predefined Values for Qualifiers When you specify status qualifiers for
analyzer states (by pressing the status softkey), you will be given the following
softkeys which are predefined values for the qualifiers.
Qualifier     Status Bits (31..24)     Description
byte          0xxxx xxx1b              byte cycle
cyc6800       0xxxx x0xxb              6800 cycle
data          0xxx0 1xxxb              data cycle
dma           0xx01 1xxxb              bus released to DMA device
grd           00xxx xxxxb              guarded memory
intack        0xx11 1xxxb              interrupt acknowledge
prog          0xxx1 0xxxb              program cycle
read          0xxxx xx1xb              memory read
super         0xx1x xxxxb              supervisor cycle
supdata       0xx10 1xxxb              supervisor data
supprog       0xx11 0xxxb              supervisor program
user          0xx0x xxxxb              user cycle
userdata      0xx00 1xxxb              user data
userprog      0xx01 0xxxb              user program
word          0xxxx xxx0b              word cycle
write         0xxxx xx0xb              memory write
wrrom         0x0xx xx0xb              write to rom

These predefined values may be used as other values would be used.  For example:

trace after status write

is the same as:

trace after status  0xxxxxx0xb
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To qualify the trigger state and position

• Enter a trigger state specification in the entry buffer; then, choose Trace→After () ,
Trace→About (), or Trace→Before ().

• When displaying memory in mnemonic format, position the mouse pointer over the
source line where you want to set the trace trigger, press and hold the select mouse
button and choose Trace After , Trace Before, or Trace About from the popup
menu.

• Using the command line, enter the trace after, trace about, or trace before
commands.

Tracing after the trigger state says states that occur after the trigger state should be
saved; in other words, the trigger is positioned at the top of the trace.

Tracing before the trigger state says states that occur before the trigger state should
be saved; in other words, the trigger is positioned at the bottom of the trace.

Tracing about the trigger state says states that occur before and after the trigger
state should be saved; in other words, the trigger is positioned at the center of the
trace.

When the analyzer counts time or states, the actual trigger position is within +/- 1
state of the number specified.  When counts are turned OFF, the actual trigger
position is within +/- 3 states of the number specified.

Usually, when you enter a trace about command, the trigger state (line 0) is
labeled "about".  However, if there are three or fewer states before the trigger, the
trigger state is labeled "after".  Likewise, if there are 3 or fewer states after the
trigger, the trigger state is labeled "before".

The state you define after trace after, trace about, or trace before is the state that
will trigger the analyzer and cause states to be stored.
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Examples Suppose you want to look at the execution of the demo program after the call of the
"update_system()" function (main.c: line 101) occurs.  To trigger on this address,
enter:

trace after address  main."main.c": line 101 <RETURN>

set source on inverse_video on symbols on  <RETURN>

display trace  <RETURN>

In the preceding trace list, line 0 (labeled "after") shows the beginning of the
program loop.
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To trigger on a number of occurrences of some
state

• Use the occurs <#TIMES> after specifying the trigger state.

When specifying a trigger state, you can include an occurrence count.  The
occurrence count specifies that the analyzer trigger on the Nth occurrence of some
state.

The default base for an occurrence count is decimal.  You may specify occurrence
counts from 1 to 65535.

Examples To trigger on the 20th occurrence of the call of the "update_system()" function
(main.c: line 101):

trace after address  main."main.c": line 101 occurs  20
<RETURN>
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To qualify states stored in the trace

• Enter a storage state specification in the entry buffer; then, choose Trace→Only ().

• Using the command line, use the only option in the trace command.

By default, all captured states are stored; however, you can qualify which states get
stored with the trace command’s only option.

Examples When the emulator is running the demo program, to store only accesses of the
"target_temp" variable:

trace after  main."main.c": line 101 
only  target_temp <RETURN>

Notice the trigger state (line 0, labeled "after") is included in the trace list; trigger
states are always stored.
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To prestore states before qualified store states

• Enter a storage state specification in the entry buffer; then, choose Trace→Only ()
Prestore.

• Use the prestore option in the trace command.

Prestore allows you to save up to two states which precede a normal store state.
Prestore is turned off by default.  However, you can use the trace command’s
prestore option to specify a prestore qualifier.

Prestore is useful when you want to find the cause of a particular state.  For
example, if a variable is accessed from many different places in the program, you
can qualify the trace so that only accesses of that variable are stored.  Then, you can
turn on prestore to find out where accesses of that variable originate from.

States which satisfy the prestore qualifier and the storage qualifier at the same time
are stored as normal states.

Examples To storing only write accesses to the variable "target_temp" and prestore the two
previous states:

trace after  main."main.c": line 101 
only  target_temp status write  
prestore anything  <RETURN>
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To change the count qualifier

• Use the counting option in the trace command.

After initializing the analyzer, the default count qualifier is "time", which means
that the time between states is saved.

When you count states, the counter is incremented each time the state is captured
(not necessarily stored) by the analyzer.

When using an analyzer that can only store 1024 states, counting time or states
reduces the trace buffer depth to 512 states.
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Examples Suppose you want to know how many loops of the program occur between calls of
the "do_sort" function.  To change the count qualifier to count a state that occurs
once for each loop of the program, enter:

trace only  do_sort 
counting state  main."main.c": line 101 <RETURN>

set source off  <RETURN>

The trace listing above shows that the program loops 4 times for each call of the
"do_sort" function.
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To trace until the analyzer is halted

• Choose Trace→Until Stop.

• Using the command line, enter the trace on_halt command.

The trace on_halt command allows you to prevent triggering.  In other words, the
trace runs until you enter the stop_trace command.  The trace on_halt command
is the same as tracing before a state that never occurs.

The trace on_halt command is useful, for example, when you wish to trace the
states leading up to a break into the monitor.  Suppose your program breaks on an
access to guarded memory.  To trace the states that lead up to the break, enter the
trace on_halt command, and run the program.  When the break occurs, the
emulator is running in the background monitor, and the analyzer is no longer
capturing states.  To display the states leading up to the break, enter the stop_trace
command (and the display trace command if traces are not currently being
displayed).

When the on_halt option is used in a trace command, the trigger condition (and
position) options, as well as the repetitively and break_on_trigger options, cannot
be included in the command.

Also, note that this does not work the same when using a foreground monitor
because the analyzer continues to capture states when the break to monitor occurs
(unless the code that causes the break also causes processor to halt).  In this case,
you can use the command line to enter a trace command that stores only states
outside the range of the foreground monitor program (for example, trace only not
range <mon_start_addr> thru <mon_end_addr> on_halt).
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To break emulator execution on the analyzer
trigger

• Enter a trigger state specification in the entry buffer; then, choose Trace→Until () .

• When displaying memory in mnemonic format, position the mouse pointer over the
program line which you wish to trace before, press and hold the select mouse
button and choose Trace Until from the popup menu.

• Using the command line, use the break_on_trigger option to the trace command.

The break_on_trigger option to the trace command allows you to cause the
emulator to break when the analyzer finds the trigger state.

Note that the actual break may be several cycles after the analyzer trigger.

Examples To trace before source line 101 and cause the emulator to break into the monitor
when the analyzer triggers:

trace before address  main."main.c": line 101
break_on_trigger  <RETURN>
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Using the Sequencer

When you use the analyzer’s sequencer, you can specify traces that trigger on a
series, or sequence, of states.  You can specify a state which, when found, causes
the analyzer to restart the search for the sequence of states.  Also, the analyzer’s
sequencer allows you to trace "windows" of code execution.

This section describes how to:

• Trigger on a sequence of states.

• Specify a global restart state.

• Trace "windows" of program execution.

The sequencing and windowing capabilities from within the Softkey Interface are
not as powerful or flexible as they are from within the Terminal Interface.  For
example, in the Terminal Interface, you can specify different restart states for each
sequence term and you can set up a windowing trace specification where the trigger
does not have to be in the window.  If you do not find the sequencing flexibility
you need from within Softkey Interface, refer to the 68000 Emulator User’s Guide
for the Terminal Interface.

To trigger after a sequence of states

• Use the trace find_sequence command.

The analyzer’s sequencer has several levels (also called sequence terms).  Each
state in the series of states to be found before triggering, as well as the trigger state,
is associated with a sequence term.

The sequencer works like this:  The analyzer searches for the state associated with
the first sequence term.  When that state is captured, the analyzer starts searching
for the state associated with the second term, and so on.  The last sequence term
used is associated with the trigger state.  When the trigger state is captured the
analyzer is triggered.  Up to seven sequence terms and an optional occurrence count
for each term are available.
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Examples In the demo program, suppose you wish to trigger on the following sequence of
events: the "save_points" function, the "interrupt_sim" function, and finally the
"do_sort" function. Also, suppose you wish to store only opcode fetches of the
assembly language LINK A6,#0 instruction (data values that equal 4E56H) to show
function entry addresses.

To set up the sequencing trace specification, enter the following trace command.

trace find_sequence  save_points then  interrupt_sim
trigger about  do_sort only data  4e56h <RETURN>

set source off  <RETURN>

Notice the states that contain "sq adv" in the first column (you may have to press
<PREV> in order to see the states captured prior to the trigger).  These are the
states associated with (or captured for) each sequence term.  Just as the trigger state
is always stored in trace memory, the states captured in the sequence are always
stored if the trace buffer is deep enough.

Chapter 6: Using the Emulation Analyzer
Using the Sequencer

222



To specify a global restart state

• Use the restart option to the trace command.

When using the analyzer’s sequencer, an additional sequence restart term is also
allowed.  This restart is a "global restart"; that is, it applies to all the sequence terms.

The restart term is a state which, when captured before the analyzer has found the
trigger state, causes the search for the sequence of states to start over.  You can use
the restart term to make certain some state does not occur in the sequence that
triggers the analyzer.

Examples In the demo program, suppose you wish to trigger on the following sequence of
events: the "save_points" function, the "interrupt_sim" function, and the "do_sort"
function.  However, you only want to trigger when the "interrupt_sim" calls the
"do_sort" function.  In other words, if the "proc_specific" function is entered before
the "do_sort" function is entered, you know "interrupt_sim" did not call "do_sort"
this time, and the analyzer should start searching again from the beginning.

Again, suppose you wish to store only opcode fetches of the assembly language
LINK A6,#0 instruction (data values that equal 4E56H).

To set up this sequencing trace specification, enter the following trace command.

trace find_sequence  save_points then  interrupt_sim
restart  proc_specific trigger about  do_sort only data
4e56h <RETURN>

set source off  <RETURN>

Chapter 6: Using the Emulation Analyzer
Using the Sequencer

223



Notice in the preceding trace (you may have to press <PREV> in order to see the
states captured prior to the trigger) that, in addition to states captured in the
sequence, "sq adv" is also shown next to states which cause a sequencer restart.

To trace "windows" of program execution

• Use the enable and disable options to the trace command.

Windowing refers to the analyzer feature that allows you to turn on, or enable, the
capturing of states after some state occurs then to turn off, or disable, the capturing
of states when another state occurs.  In effect, windowing allows you capture
"windows" of code execution.

Windowing is different than storing states in a range (the only range option in the
trace command syntax) because it allows you to capture execution of all states in a
window of code whereas storing states in a range won’t capture the execution of
subroutines that are called in that range or reads and writes to locations outside that
range.

When you use the windowing feature of the analyzer, the trigger state must be in
the window or else the trigger will never be found.
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If you wish to combine the windowing and sequencing functions of the analyzer,
there are some restrictions:

• Up to four sequence terms are available when windowing is in effect.

• Global restart is not available when windowing is in effect.

• Occurrence counts are not available.

Examples In the demo program, suppose you are only interested in the execution that occurs
within the switch statement of the "combsort" function.  You could specify source
line number 228 as the window enable state and the source line number of the next
statement (line number 240) as the window disable state.  Set up the windowing
trace specification with the following command.

trace enable  main."main.c": line 228 disable
main."main.c": line 240 <RETURN>

set source on  <RETURN>

Notice in the resulting trace (you have to press the <NEXT> key) that the enable
and disable states have the "sq adv" string in the line number column.  This is
because the windowing feature uses the analyzer’s sequencer.
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Modifying the Trace Display

This section describes the options available when displaying trace lists.

This section describes how to:

• Display the trace about a line number.

• Display the trace, disassembling from a line number.

• Display the trace in absolute format.

• Display the trace in mnemonic format.

• Display the trace with high-level source lines.

• Display the trace with symbol information.

• Change the column widths in the trace display.

• Display time counts in absolute or relative format.

• Display the trace with address information offset by a value.

• Return to the default trace display.

• Display the external analyzer information.
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To display the trace about a line number

• Use the <LINE #> option to the display trace command.

The <LINE #>  trace display option allows you to specify the line number to be
centered in the display.

Examples To display the trace about line number 72:

set default  <RETURN>
display trace  72 <RETURN>
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To display the trace, disassembling from a line
number

• Use the disassemble_from_line_number option to the display trace command.

The "disassemble_from_line_number" trace display option causes the inverse
assembler to attempt to begin disassembling the trace information from the
specified line number.  This option is required for inverse assemblers that cannot
uniquely identify opcode fetch states on the processor bus.

If the line number specified is not an opcode fetch state, the disassembled
information will be incorrect.

Examples To display the trace, disassembling from line number 72:

display trace disassemble_from_line_number  72 <RETURN>
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To display the trace in absolute format

• Use the absolute option to the display trace command.

The absolute trace display option allows you to display status information in
absolute format (binary, hex, or mnemonic).  The absolute status mnemonic
display is the same as default mnemonic display, except that opcodes are not
disassembled.

Examples To display the trace in absolute format with the status information as binary values:

display trace absolute status binary  <RETURN>
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To display the trace in mnemonic format

• Use the mnemonic option to the display trace command.

The mnemonic trace display option allows you to display the trace information in
mnemonic format (that is, opcodes and status).  The default trace display is in
mnemonic format.

Examples To display the trace in mnemonic format:

display trace mnemonic  <RETURN>
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To display the trace with high-level source lines

• Use the set source command.

To include high-level source lines in the trace display, you must use the set
command.  The set command allows you to include symbolic information in trace,
memory, register, and software breakpoint displays.  The set command affects all
displays for the current window.

The set source on/off/only command allows you to include source file information
in the trace list or memory mnemonic display.  The source only option specifies
that only the source file information will be displayed.

When source lines are included, comments that contain file and line information
appear before the source lines.

Also, when source lines are turned on, three additional options are available in the
set command: inverse video, tabs are, and number of source lines.

The inverse_video option allows you to display source lines in inverse video.

The tabs_are option allows you to specify the number of spaces between tab stops
so that the appropriate number of spaces can be inserted for source lines.  The
default value is eight.  Values from two to 15 can be entered.

Typically, there are lines in the source file that are not associated with actual
instructions (declarations, comments, etc.).  The number_of_source_lines option
allows you to specify the number of these source lines to be displayed for every
source line that is associated with an actual instruction.  Only source lines up to the
the previous source line that corresponds to actual code will be displayed. The
default value is five.  Values from one to 50 can be entered.

Examples To display the trace with high-level source lines:

set source on  <RETURN>
display trace  <RETURN>
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To set the number of source lines to be displayed at 12:

set source on number_of_source_lines  12 <RETURN>
display trace  <RETURN>
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To display the trace with symbol information

The set symbols on/off command allows you to specify that address information be
displayed in terms of program symbols.

Examples To display the trace with symbol information:

set source off symbols on  <RETURN>
display trace  <RETURN>
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To change column widths in the trace display

• Use the set width command.

The set width command allows you to change the width of the address and
mnemonic (or absolute) columns in the trace list.  Values from one to 80 can be
entered.

When address information is being displayed in terms of symbols (in other words,
symbols on), you may wish to increase the width of the address column to display
more of the symbol information.

When trace information is displayed in mnemonic format, you can additionally
specify the width of symbols in the "Opcode or Status" column.

Examples To display the trace with the address column width set to 30 characters:

set width label  30 <RETURN>
display trace  <RETURN>
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To display time counts in absolute or relative
format

• Use the count option to the display trace command.

Count information may be displayed two ways: relative (which is the default), or
absolute.  When relative is selected, count information is displayed relative to the
previous state.  When absolute is selected, count information is displayed relative to
the trigger condition.

The count absolute/relative trace display option is not available when counting is
turned off in the trace command.

Examples To display the trace with absolute time counts:

set default  <RETURN>

display trace count absolute  <RETURN>
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To display the trace with addresses offset

• Use the offset_by option to the display trace command.

The offset_by trace display option allows you to cause the address information in
the trace display to be offset by the amount specified.  The offset value is subtracted
from the instruction’s physical address to yield the address that is displayed.

If code gets relocated and therefore makes symbolic information obsolete, you can
use the offset_by option to change the address information so that it again agrees
with the symbolic information.

You can also specify an offset to cause the listed addresses to match the addresses
in compiler or assembler listings.

Examples To display the trace with addresses offset by 1594H:

display trace offset_by  1594h <RETURN>
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To return to the default trace display

• Use the set default command.

The set default command allows you to return to the default display.

Examples To return to the default trace display:

set default  <RETURN>
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To display external analyzer information

• Use the external option to the display trace command.

The external trace display option allows you to include data from the external
analyzer in the trace list.  External bits are displayed by default.  If you do not wish
to have the external bits information in the display, you can turn them off.

The bits associated with the external analyzer labels may be displayed in binary or
hexadecimal format.  Labels must be defined in the external analyzer configuration
(and prior to trace command entry) before they appear as softkey selections when
displaying the trace.  Refer to the "To define labels for the external analyzer
signals" description in the "Using the External State Analyzer" chapter.

Examples To display the "xbits" column in binary format:

display trace external xbits binary  <RETURN>
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Saving and Restoring Traces

The emulator/analyzer interface allow you to save trace commands and trace lists.
You can restore trace commands in order to set up the same trace specification.
You can restore traces in order to view trace data captured in the stored trace.

This section describes how to:

• Save trace commands.

• Restore trace commands.

• Save traces.

• Restore traces.

To save trace commands

• Choose File→Store→Trace Spec.

• Using the command line, enter the store trace_spec command.

You can save a trace command to a "trace specification" file and reload it at a later
time.

The trace command is saved in a file named "tspecfile.TS" in the current directory.
The extension ".TS" is appended to trace specification files if no extension is
specified in the store trace_spec command.

Examples To store the current trace command:

store trace_spec  tspecfile <RETURN>
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To restore trace commands

• Choose File→Load→Trace Spec.

• Using the command line, enter the load trace_spec command.

Trace commands that are restored will always work, even if symbols have been
changed; however, once you modify the trace command, it may no longer work.

Loading a trace specification does not start the trace; to do this, you must enter the
trace command either by selecting it from the Trace Specification Selection dialog
box or by using the Trace→Again pulldown menu item.

Examples To bring back the trace command saved in "tspecfile.TS" and perform a trace
measurement using it:

load trace_spec  tspecfile <RETURN>

trace again  <RETURN>
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To save traces

• Choose File→Store→Trace Data.

• Using the command line, enter the store trace command.

You can save a trace to a trace file and reload it at a later time.

The trace is saved in a file named "trcfile.TR" in the current directory.  The
extension ".TR" is appended to trace files if it is not specified in the store trace
command.

Examples To store the current trace:

store trace  trcfile <RETURN>
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To restore traces

• Choose File→Load→Trace Data.

• Using the command line, enter the load trace command.

The restored trace depth is the depth specified when the trace was stored and cannot
be increased.  You may want to increase the trace depth before storing traces.

When a trace is loaded, the trace command is not restored.  A trace again or trace
modify command will use the last trace command entered, not the command which
resulted in the loaded trace.  Also, the trace status shown by the display status
command does not reflect the loaded trace.

Examples To restore the "trcfile.TR" trace file:

load trace  trcfile <RETURN>

The trace information stored in "trcfile.TR" is restored.  You can view the trace as
you would any other trace.
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Making Software Performance
Measurements

The Software Performance Measurement Tool (SPMT) is a feature of the Softkey
Interface that allows you to make software performance measurements on your
programs.

The SPMT allows you to make some of the measurements that are possible with the
HP 64708 Software Performance Analyzer and its Graphical User Interface
(HP B1487).

The SPMT post-processes information from the analyzer trace list.  When you end
a performance measurement, the SPMT dumps the post-processed information to a
binary file, which is then read using the perf32 report generator utility.

Two types of software performance measurements can be made with the SPMT:
activity measurements, and duration measurements.

This chapter describes tasks you  perform while using the Software Performance
Measurement Tool (SPMT).  These tasks are grouped into the following sections:

• Activity performance measurements.

• Duration performance measurements.

• Running performance measurements and creating reports.
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Activity Performance Measurements

Activity measurements are measurements of the number of accesses (reads or
writes) within an address range.  The SPMT shows you the percentage of analyzer
trace states that are in the specified address range, as well as the percentage of time
taken by those states.  Two types of activity are measured: memory activity, and
program activity.

Memory activity is all activity that occurs within the address range.

Program activity is the activity caused by instruction execution in the address
range.  Program activity includes opcode fetches and the cycles that result from the
execution of those instructions (reads and writes to memory, stack pushes, etc.).

For example, suppose an address range being measured for activity contains an
opcode that causes a stack push, which results in multiple write operations to the
stack area (outside the range). The memory activity measurement will count only
the stack push opcode cycle.  However, the program activity measurement will
count the stack push opcode cycle and the write operations to the stack.

By comparing the program activity and the memory activity in an address range,
you can get an idea of how much activity in other areas is caused by the code being
measured.  An activity measurement report of the code (prog), data, and stack
sections of a program is shown below.

 Label 
 
prog  
      Address Range       ADEH thru     1261H  
 
 
      Memory Activity  
           State Percent  Rel =  57.77  Abs =  57.77  
                         Mean = 295.80  Sdv =  26.77  
           Time  Percent  Rel =  60.97  Abs =  60.97  
 
      Program Activity  
           State Percent  Rel =  99.82  Abs =  99.82  
                         Mean = 511.10  Sdv =   0.88  
           Time  Percent  Rel =  99.84  Abs =  99.84  
 
data  
      Address Range     6007AH thru    603A5H  
 
 
      Memory Activity  
           State Percent  Rel =  30.51  Abs =  30.51  
                         Mean = 156.20  Sdv =  31.87  
           Time  Percent  Rel =  28.09  Abs =  28.09  
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      Program Activity  
           State Percent  Rel =   0.18  Abs =   0.18  
                         Mean =   0.90  Sdv =   0.88  
           Time  Percent  Rel =   0.16  Abs =   0.16  
 
stack  
      Address Range     40000H thru    43FFFH  
 
 
      Memory Activity  
           State Percent  Rel =  11.72  Abs =  11.72  
                         Mean =  60.00  Sdv =  29.24  
           Time  Percent  Rel =  10.94  Abs =  10.94  
 
      Program Activity  
           State Percent  Rel =   0.00  Abs =   0.00  
                         Mean =   0.00  Sdv =   0.00  
           Time  Percent  Rel =   0.00  Abs =   0.00  
 
 
  
         Graph of Memory Activity relative state percents >= 1 
prog                  57.77%  *****************************  
data                  30.51%  ****************  
stack                 11.72%  ******  
  
         Graph of Memory Activity relative time percents >= 1 
prog                  60.97%  ******************************* 
data                  28.09%  **************  
stack                 10.94%  ******  
 
 
  
         Graph of Program Activity relative state percents >= 1 
prog                  99.82% **************************************************  
 
  
         Graph of Program Activity relative time percents >= 1 
prog                  99.84% **************************************************  
 
      Summary Information for     10 traces 
 
 
           Memory Activity  
           State count 
                Relative count     5120  
                Mean sample      170.67  
                Mean Standard Dv 29.30  
                95% Confidence 12.28% Error tolerance  
           Time  count  
                Relative Time - Us 2221.20  
 
 
           Program Activity  
           State count 
                Relative count     5120  
                Mean sample      170.67  
                Mean Standard Dv 0.58  
                95% Confidence 0.24% Error tolerance  
           Time  count  
                Relative Time - Us 2221.20  
      Absolute Totals  

Chapter 7: Making Software Performance Measurements
Activity Performance Measurements

246



                Absolute count - state     5120  
                Absolute count - time - Us 2221.20  
 

This section describes how to:

• Set up the trace command for activity measurements.

• Initialize activity performance measurements.

• Interpret activity measurement reports.

To set up the trace command for activity
measurements

1 Specify a trace display depth of 512.

2 Trace after any state, store all states, and count time.

Before you initialize and run performance measurements, the current trace
command (in other words, the last trace command entered) must be properly set up.

In general, you want to give the SPMT as many trace states as possible to
post-process, so you should increase the trace depth to the maximum number, as
shown in the following command.

If you wish to measure activity as a percentage of all activity, the current trace
command should be the default (in other words, trace <RETURN>).  The default
trace command triggers on any state, and all captured states are stored.  It is
important that time be counted by the analyzer; otherwise, the SPMT measurements
will not be correct.  Also, since states are stored "after" the trigger state, the
maximum number of captured states appears in each trace list.

You can qualify trace commands any way you like to obtain specific information.
However, when you qualify the states that get stored in the trace memory, your
SPMT results will be biased by your qualifications; the percentages shown will be
of only those states stored in the trace list.
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Examples To specify a trace depth of 512:

display trace depth  512 <RETURN>

To trace after any state, store all states, and count time:

trace counting time  <RETURN>

To initialize activity performance measurements

• Use the performance_measurement_initialize command.

After you set up the trace command, you must tell the SPMT the address ranges on
which you wish to make activity measurements. This is done by initializing the
performance measurement.  You can initialize the performance measurement in the
following ways:

• Default initialization (using global symbols if the symbols database is loaded).

• Initialize with user-defined files.

• Initialize with global symbols.

• Initialize with local symbols.

• Restore a previous performance measurement (if the emulation system has
been exited and reentered).

Default Initialization

Entering the performance_measurement_initialize command with no options
specifies an activity measurement.  If a valid symbolic database has been loaded,
the addresses of all global procedures and static symbols will be used; otherwise, a
default set of ranges that cover the entire processor address range will be used.
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Initialization with User Defined Ranges

You can specifically give the SPMT address ranges to use by placing the
information in a file and entering the file name in the
performance_measurement_initialize command.

Address range files may contain program symbols (procedure name or static), user
defined address ranges, and comments.  An example address range file is shown
below.

# Any line which starts with a # is a comment. 
# All user’s labels must be preceded by a "|". 
 
|users_label  10H 1000H 
program_symbol 
 
# A program symbol can be a procedure name or a static.  In the case of a pro- 
# cedure name the range of that procedure will be used. 

|users_label2 program_symbol1 -> program_symbol2 
 
# "->" means thru.  The above will define a range which starts with symbol1 
# and goes thru symbol2.  If both symbols are procedures then the range will 
# be defined as the start of symbol1 thru the end of symbol2. 

dir1/dir2/source_file.s:local_symbol 
 
# The above defines a range based on the address of local_symbol. 

Initialization with Global Symbols

When the performance_measurement_initialize command is entered with no
options or with the global_symbols option, the global symbols in the symbols
database become the address ranges for which activity is measured.  If the symbols
database is not loaded, a default set of ranges that cover the entire processor address
range will be used.

The global symbols database contains procedure symbols, which are associated
with the address range from the beginning of the procedure to the end, and static
symbols, which are associated with the address of the static variable.

Initialization with Local Symbols

When the performance_measurement_initialize command is entered with the
local_symbols_in option and a source file name, the symbols associated with that
source file become the address ranges for which activity is measured.  If the
symbols database is not loaded, an error message will occur telling you that the
source filename symbol was not found.
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You can also use the local_symbols_in option with procedure symbols; this allows
you to measure activity related to the symbols defined in a single function or
procedure.

Restoring the Current Measurement

The performance_measurement_initialize restore command allows you to
restore old performance measurement data from the perf.out file in the current
directory.

If you have not exited and reentered emulation, you can add traces to a performance
measurement simply by entering another performance_measurement_run
command.  However, if you exit and reenter the emulation system, you must enter
the performance_measurement _initialize restore command before you can add
traces to a performance measurement.  When you restore a performance
measurement, make sure your current trace command is identical to the command
used with the restored measurement.

The restore option checks the emulator software version and will only work if the
perf.out files you are restoring were made with the same software version as is
presently running in the emulator.  If you ran tests using a former software version
and saved perf.out files, then updated your software to a new version number, you
will not be able to restore old perf.out measurement files.

Chapter 7: Making Software Performance Measurements
Activity Performance Measurements

250



Examples Suppose the "addr_ranges" file contains the names of all the functions in the "ecs"
demo program loop:
combsort
do_sort
gen_ascii_data
get_targets
graph_data
interrupt_sim
proc_specific
read_conditions
save_points
set_outputs
strcpy8
update_system
write_hdwr

Since these labels are program symbols, you do not have to specify the address
range associated with each label; the SPMT will search the symbol database for the
addresses of each label.

An easy way to create the "addr_ranges" file is to use the copy global_symbols
command to copy the global symbols to a file named "addr_ranges"; then, fork a
shell to UNIX (by entering "! <RETURN>" on the Softkey Interface command
line) and edit the file so that it contains the procedure names shown above.  Enter a
<CTRL>d  at the UNIX prompt to return to the Softkey Interface.

To initialize the activity measurement with a user-defined address range file:

performance_measurement_initialize  addr_ranges <RETURN>
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To interpret activity measurement reports

• View the performance measurement report.

Activity measurements are measurements of the number of accesses (reads or
writes) within an address range.  The reports generated for activity measurements
show you the percentage of analyzer trace states that are in the specified address
range, as well as the percentage of time taken by those states.  The performance
measurement must include four traces before statistics (mean and standard
deviation) appear in the activity report.  The information you will see in activity
measurement reports is described below.

Memory Activity All activity found within the address range.

Program Activity All activity caused by instruction execution in the address
range.  Program activity includes opcode fetches and the cycles that result from the
execution of those instructions (reads and writes to memory, stack pushes, etc.).

Relative With respect to activity in all ranges defined in the performance
measurement.

Absolute With respect to all activity, not just activity in those ranges defined in
the performance measurement.

Mean Average number of states in the range per trace.  The following equation is
used to calculate the mean:
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Standard Deviation Deviation from the mean of state count.  The following
equation is used to calculate standard deviation:

Where:

N Number of traces in the measurement.

mean Average number of states in the range per trace.

Ssumq Sum of squares of states in the range per trace.

Symbols Within Range Names of other symbols that identify addresses or
ranges of addresses within the range of this symbol.

Additional Symbols for Address Names of other symbols that also identify
this address.

Note that some compilers emit more than one symbol for certain addresses.  For
example, a compiler may emit "interrupt_sim" and "_interrupt_sim" for the first
address in a routine named interrupt_sim.  The analyzer will show the first symbol
it finds to represent a range of addresses, or a single address point, and it will show
the other symbols under either "Symbols within range" or "Additional symbols for
address", as applicable.  In the "interrupt_sim" example, it may show either
"interrupt_sim" or "_interrupt_sim" to represent the range, depending on which
symbol it finds first.  The other symbol will be shown below "Symbols within
range" in the report.  These conditions appear particularly in default measurements
that include all global and local symbols.

Relative and Absolute Counts Relative count is the total number of states
associated with the address ranges in the performance measurement.  Relative time
is the total amount of time associated with the address ranges in the performance
measurement.  The absolute counts are the number of states or amount of time
associated with all the states in all the traces.
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Error Tolerance and Confidence Level An approximate error may exist in
displayed information.  Error tolerance for a level of confidence is calculated using
the mean of the standard deviations and the mean of the means.  Error tolerance
gives an indication of the stability of the information.  For example, if the error is
5% for a confidence level of 95%, then you can be 95% confident that the
information has an error of 5% or less.

The Student’s "T" distribution is used in these calculations because it improves the
accuracy for small samples.  As the size of the sample increases, the Student’s "T"
distribution approaches the normal distribution.

The following equation is used to calculate error tolerance:

Where:

Om Mean of the standard deviations.

t Table entry in Student’s "T" table for a given confidence
level.

N Number of traces in the measurement.

Pm Mean of the means (i.e., mean sample).

Examples Consider the following activity measurement report (generated with the commands
shown):

display trace depth  512 <RETURN> 
trace counting time  <RETURN> 
performance_measurement_initialize  addr_ranges <RETURN> 
performance_measurement_run  20 <RETURN> 
performance_measurement_end  <RETURN> 
!perf32 | more
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 Label

strcpy8 
         Address Range      10DCH thru     113CH 

         Memory Activity 
                 State Percent  Rel =  20.98  Abs =  15.49 
                               Mean =  79.30  Sdv = 151.55 
                 Time  Percent  Rel =  20.32  Abs =  15.47 

         Program Activity 
                 State Percent  Rel =  24.57  Abs =  19.67 
                               Mean = 100.70  Sdv = 193.47 
                 Time  Percent  Rel =  23.14  Abs =  18.74 

set_outputs 
         Address Range      18B2H thru     1964H 

         Memory Activity 
                 State Percent  Rel =  20.32  Abs =  15.00 
                               Mean =  76.80  Sdv = 187.57 
                 Time  Percent  Rel =  20.55  Abs =  15.64 

         Program Activity 
                 State Percent  Rel =  18.74  Abs =  15.00 
                               Mean =  76.80  Sdv = 187.57 
                 Time  Percent  Rel =  19.32  Abs =  15.64 

write_hdwr 
         Address Range      196CH thru     19FAH 

         Memory Activity 
                 State Percent  Rel =  20.32  Abs =  15.00 
                               Mean =  76.80  Sdv = 187.57 
                 Time  Percent  Rel =  20.55  Abs =  15.64 

         Program Activity 
                 State Percent  Rel =  18.74  Abs =  15.00 
                               Mean =  76.80  Sdv = 187.57 
                 Time  Percent  Rel =  19.32  Abs =  15.64 

update_system 
         Address Range      1678H thru     1748H 

         Memory Activity 
                 State Percent  Rel =  13.55  Abs =  10.00 
                               Mean =  51.20  Sdv = 157.59 
                 Time  Percent  Rel =  13.71  Abs =  10.43 

         Program Activity 
                 State Percent  Rel =  12.53  Abs =  10.03 
                               Mean =  51.35  Sdv = 157.54 
                 Time  Percent  Rel =  12.91  Abs =  10.46 

do_sort 
         Address Range      14EEH thru     159CH 
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         Memory Activity 
                 State Percent  Rel =   6.77  Abs =   5.00 
                               Mean =  25.60  Sdv = 114.49 
                 Time  Percent  Rel =   6.85  Abs =   5.21 

         Program Activity 
                 State Percent  Rel =   6.25  Abs =   5.00 
                               Mean =  25.60  Sdv = 114.49 
                 Time  Percent  Rel =   6.44  Abs =   5.21 

proc_specific 
         Address Range      1C0AH thru     1C34H 

         Memory Activity 
                 State Percent  Rel =   6.77  Abs =   5.00 
                               Mean =  25.60  Sdv = 114.49 
                 Time  Percent  Rel =   6.85  Abs =   5.21 

         Program Activity 
                 State Percent  Rel =   6.25  Abs =   5.00 
                               Mean =  25.60  Sdv = 114.49 
                 Time  Percent  Rel =   6.44  Abs =   5.21 

read_conditions 
         Address Range      17F8H thru     18AAH 

         Memory Activity 
                 State Percent  Rel =   6.77  Abs =   5.00 
                               Mean =  25.60  Sdv = 114.49 
                 Time  Percent  Rel =   6.85  Abs =   5.21 

         Program Activity 
                 State Percent  Rel =   6.25  Abs =   5.00 
                               Mean =  25.60  Sdv = 114.49 
                 Time  Percent  Rel =   6.44  Abs =   5.21 

combsort 
         Address Range      12A8H thru     14E6H 

         Memory Activity 
                 State Percent  Rel =   4.15  Abs =   3.07 
                               Mean =  15.70  Sdv =  32.69 
                 Time  Percent  Rel =   3.98  Abs =   3.03 

         Program Activity 
                 State Percent  Rel =   6.25  Abs =   5.00 
                               Mean =  25.60  Sdv =  53.97 
                 Time  Percent  Rel =   5.61  Abs =   4.54 

gen_ascii_data 
         Address Range      1144H thru     12A0H 

         Memory Activity 
                 State Percent  Rel =   0.36  Abs =   0.26 
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                               Mean =   1.35  Sdv =   4.18 
                 Time  Percent  Rel =   0.33  Abs =   0.25 

         Program Activity 
                 State Percent  Rel =   0.44  Abs =   0.35 
                               Mean =   1.80  Sdv =   5.58 
                 Time  Percent  Rel =   0.39  Abs =   0.31 

get_targets 
         Address Range      1750H thru     17F0H 

         Memory Activity 
                 State Percent  Rel =   0.00  Abs =   0.00 
                               Mean =   0.00  Sdv =   0.00 
                 Time  Percent  Rel =   0.00  Abs =   0.00 

         Program Activity 
                 State Percent  Rel =   0.00  Abs =   0.00 
                               Mean =   0.00  Sdv =   0.00 
                 Time  Percent  Rel =   0.00  Abs =   0.00 

graph_data 
         Address Range      1B08H thru     1BD4H 

         Memory Activity 
                 State Percent  Rel =   0.00  Abs =   0.00 
                               Mean =   0.00  Sdv =   0.00 
                 Time  Percent  Rel =   0.00  Abs =   0.00 

         Program Activity 
                 State Percent  Rel =   0.00  Abs =   0.00 
                               Mean =   0.00  Sdv =   0.00 
                 Time  Percent  Rel =   0.00  Abs =   0.00 

interrupt_sim 
         Address Range      1028H thru     10D4H 

         Memory Activity 
                 State Percent  Rel =   0.00  Abs =   0.00 
                               Mean =   0.00  Sdv =   0.00 
                 Time  Percent  Rel =   0.00  Abs =   0.00 

         Program Activity 
                 State Percent  Rel =   0.00  Abs =   0.00 
                               Mean =   0.00  Sdv =   0.00 
                 Time  Percent  Rel =   0.00  Abs =   0.00 

save_points 
         Address Range      1A02H thru     1B00H 

         Memory Activity 
                 State Percent  Rel =   0.00  Abs =   0.00 
                               Mean =   0.00  Sdv =   0.00 
                 Time  Percent  Rel =   0.00  Abs =   0.00 

         Program Activity 
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                 State Percent  Rel =   0.00  Abs =   0.00 
                               Mean =   0.00  Sdv =   0.00 
                 Time  Percent  Rel =   0.00  Abs =   0.00 

 
         Graph of Memory Activity relative state percents >= 1
strcpy8               20.98%  *********** 
set_outputs           20.32%  ********** 
write_hdwr            20.32%  ********** 
update_system         13.55%  ******* 
do_sort                6.77%  **** 
proc_specific          6.77%  **** 
read_conditions        6.77%  **** 
combsort               4.15%  ** 

 
         Graph of Memory Activity relative time percents >= 1
strcpy8               20.32%  ********** 
set_outputs           20.55%  *********** 
write_hdwr            20.55%  *********** 
update_system         13.71%  ******* 
do_sort                6.85%  **** 
proc_specific          6.85%  **** 
read_conditions        6.85%  **** 
combsort               3.98%  ** 

 
         Graph of Program Activity relative state percents >= 1
strcpy8               24.57%  ************* 
set_outputs           18.74%  ********** 
write_hdwr            18.74%  ********** 
update_system         12.53%  ******* 
do_sort                6.25%  *** 
proc_specific          6.25%  *** 
read_conditions        6.25%  *** 
combsort               6.25%  *** 

 
         Graph of Program Activity relative time percents >= 1
strcpy8               23.14%  ************ 
set_outputs           19.32%  ********** 
write_hdwr            19.32%  ********** 
update_system         12.91%  ******* 
do_sort                6.44%  *** 
proc_specific          6.44%  *** 
read_conditions        6.44%  *** 
combsort               5.61%  *** 

         Summary Information for     20 traces

                 Memory Activity 
                 State count
                         Relative count     7559 
                         Mean sample       29.07 
                         Mean Standard Dv 81.89 
                         95% Confidence 131.89% Error tolerance 
                 Time  count 
                         Relative Time - Us 3976.40 
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                 Program Activity 
                 State count
                         Relative count     8197 
                         Mean sample       31.53 
                         Mean Standard Dv 86.86 
                         95% Confidence 129.00% Error tolerance 
                 Time  count 
                         Relative Time - Us 4230.80 
         Absolute Totals 
                         Absolute count - state    10240 
                         Absolute count - time - Us 5225.16 

The measurements for each label are printed in descending order according to the
amount of activity.  You can see that the strcpy8 function has the most activity.
Also, you can see that no activity is recorded for several of the functions.  The
histogram portion of the report compares the activity in the functions that account
for at least 1% of the activity for all labels defined in the measurement.
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Duration Performance Measurements

Duration measurements provide a best-case/worst-case characterization of code
execution time.  These measurements record execution times that fall within a set of
specified time ranges.  The analyzer trace command is set up to store only the entry
and exit states of the module to be measured (for example, a C function or Pascal
procedure).  The SPMT provides two types of duration measurements: module
duration, and module usage.

Module duration measurements record how much time it takes to execute a
particular code segment (for example, a function in the source file).

Module usage shows how much of the execution time is spent outside of the
module (from exit to entry).  This measurement gives an indication of how often
the module is being used.

When using the SPMT to perform duration measurements, there should be only two
addresses stored in the trace memory: the entry address, and the exit address.
Recursion can place several entry addresses before the first exit address, and/or
several exit addresses before the first entry address.  Duration measurements are
made between the last entry address in a series of entry addresses, and the last exit
address in a series of exit addresses (see the figure below).  All of the entry and exit
addresses which precede these last addresses are assumed to be unused prefetches,
and are ignored during time measurements.

When measuring a recursive function, module duration will be measured between
the last recursive call and the true end of the recursive execution.  This will affect
the accuracy of the measurement.

                    START  - assumed prefetch 
                    START  - assumed prefetch 
                    START  - assumed prefetch 
                    START  - last ENTRY address -
                    END    - assumed prefetch 
                    END    - assumed prefetch         Measure duration
                    END    - assumed prefetch 
                    END    - last EXIT address  -
                    START  - assumed prefetch 
                    START  - assumed prefetch         Measure duration
                    START  - assumed prefetch 
                    START  - last ENTRY address -
                    END    - assumed prefetch 
                    END    - assumed prefetch 
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If a module is entered at the normal point, and then exited by a point other than the
defined exit point, the entry point will be ignored.  It will be judged the same as any
other unused prefetch, and no time-duration measurement will be made.  Its time
will be included in the measure of time spent outside the procedure or function.

If a module is exited from the normal point, and then reentered from some other
point, the exit will also be assumed to be an unused prefetch of the exit state.

Note that if you are making duration measurements on a function that is recursive,
or one that has multiple entry and/or exit points, you may wind up with invalid
information.

This section describes how to:

• Set up the trace command for duration measurements.

• Initialize duration performance measurements.

• Interpret duration measurement reports.

To set up the trace command for duration
measurements

1 Specify a trace display depth of 512.

2 Trace after and store only funtion start and end addresses.

For duration measurements, the trace command must be set up to store only the
entry and exit points of the module of interest.  Since the trigger state is always
stored, you should trigger on the entry or exit points.  For example:

trace after  symbol_entry or  symbol_exit only
symbol_entry or  symbol_exit counting time  <RETURN>

CAUTION The previous command depends on the generation of correct exit address symbols
by the software development tools.
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Or:

trace after  module_name start or  module_name end only
module_name start or  module_name end counting time
<RETURN>

Where "symbol_entry" and "symbol_exit" are symbols from the user program.  Or,
where "module_name" is the name of a C function or Pascal procedure (and is
listed as a procedure symbol in the global symbol display).

Examples To specify a trace display depth of 512:

display trace depth  512 <RETURN>

To set up the trace command for duration measurements on the interrupt_sim
function:

trace after  interrupt_sim start or  interrupt_sim end
only  interrupt_sim start or  interrupt_sim end counting
time  <RETURN>

The trace specification sets up the analyzer to capture only the states that contain
the start address of the interrupt_sim function or the end address of the
interrupt_sim function.  Since the trigger state is also stored, the analyzer is set up
to trigger on the entry or exit address of the interrupt_sim function.  With these
states in memory, the analyzer will derive two measurements: time from start to
end of interrupt_sim, and time from end to start of interrupt_sim.
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To initialize duration performance measurements

• Use the performance_measurement_initialize command with the duration
option.

After you set up the trace command, you must tell the SPMT the time ranges to be
used in the duration measurement.  This is done by initializing the performance
measurement.  You can initialize the performance measurement in the following
ways:

• Initialize with user-defined files.

• Restore a previous performance measurement (if the emulation system has
been exited and reentered).

Initialization with User Defined Ranges

You can specifically give the SPMT time ranges to use by placing the information
in a file and entering the file name in the performance_measurement_initialize
command.

Time range files may contain comments and time ranges in units of microseconds
(us), milliseconds (ms), or seconds (s).  An example time range file is shown below.

# Any line which starts with a # is a comment. 

1 us 20 us 
10.1 ms 100.6 ms 
3.55 s  6.77 s 
 
# us microseconds 
# ms milliseconds 
#  s seconds 
# 
# The above are the only abbreviations allowed.  The space between the  number 
# and the units abbreviation is required. 
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When no user defined time range file is specified, the following set of default time
ranges are used.
1 us 10 us
10.1 us 100 us
100.1 us 500 us
500.1 us 1 ms
1.001 ms 5 ms
5.001 ms 10 ms
10.1 ms 20 ms
20.1 ms 40 ms
40.1 ms 80 ms
80.1 ms 160 ms
160.1 ms 320 ms
320.1 ms 640 ms
640.1 ms 1.2 s

Restoring the Current Measurement

The performance_measurement_initialize restore command allows you to
restore old performance measurement data from the perf.out file in the current
directory.

If you have not exited and reentered emulation, you can add traces to a performance
measurement simply by entering another performance_measurement_run
command.  However, if you exit and reenter the emulation system, you must enter
the performance_measurement _initialize restore command before you can add
traces to a performance measurement.  When you restore a performance
measurement, make sure your current trace command is identical to the command
used with the restored measurement.

The restore option checks the emulator software version and will only work if the
perf.out files you are restoring were made with the same software version as is
presently running in the emulator.  If you ran tests using a former software version
and saved perf.out files, then updated your software to a new version number, you
will not be able to restore old perf.out measurement files.

Examples To initialize the duration measurement:

performance_measurement_initialize duration  <RETURN>
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To interpret duration measurement reports

• View the performance measurement report.

Duration measurements provide a best-case/worst-case characterization of code
execution time.  These measurements record execution times that fall within a set of
specified time ranges.  The information you will see in duration measurement
reports is described below.

Number of Intervals Number of "from address" and "to address" pairs (after
prefetch correction).

Maximum Time The greatest amount of time between the "from address" to the
"to address".

Minimum Time The shortest amount of time between the "from address" to the
"to address".

Average Time Average time between the "from address" and the "to address".
The following equation is used to calculate the average time:
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 Standard Deviation Deviation from the mean of time.  The following equation
is used to calculate standard deviation:

Where:

N Number of intervals.

mean Average time.

Ssumq Sum of squares of time in the intervals.

Error Tolerance and Confidence Level An approximate error may exist in
displayed information.  Error tolerance for a level of confidence is calculated using
the mean of the standard deviations and the mean of the means.  Error tolerance
gives an indication of the stability of the information.  For example, if the error is
5% for a confidence level of 95%, then you can be 95% confident that the
information has an error of 5% or less.

The Student’s "T" distribution is used in these calculations because it improves the
accuracy for small samples.  As the size of the sample increases, the Student’s "T"
distribution approaches the normal distribution.

The following equation is used to calculate error tolerance:

Where:

Om Mean of the standard deviations in each time range.

t Table entry in Student’s "T" table for a given confidence
level.

N Number of intervals.
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Pm Mean of the means (i.e., mean of the average times in each
time range).

Examples Consider the following duration measurement report (generated with the commands
shown):

display trace depth  512 <RETURN> 
trace after  interrupt_sim start or  interrupt_sim end
only  interrupt_sim start or  interrupt_sim end counting
time  <RETURN> 
performance_measurement_initialize  time_ranges duration
<RETURN> 
performance_measurement_run  10 <RETURN> 
performance_measurement_end  <RETURN> 
!perf32 | more

                 Time Interval Profile 

From Address      10D4  
         File main(module)."/users/guest/demo/debug_env/hp64742/main.c" 
         Symbolic Reference at interrupt_sim+AC 
To Address        1028  
         File main(module)."/users/guest/demo/debug_env/hp64742/main.c" 
         Symbolic Reference at main.interrupt_sim 
Number of intervals   2550 
Maximum Time 93962.240 us 
Minimum Time 62013.440 us 
Avg Time     71536.150 us 

         Statistical summary - for     10 traces
                 Stdv 14601.99 
                 95% Confidence 0.79% Error tolerance 

 
         Graph of relative percents  
1 us 10 us             0.00%   
10.1 us 100 us         0.00%   
100.1 us 500 us        0.00%   
500.1 us 1 ms          0.00%   
1.001 ms 5 ms          0.00%   
5.001 ms 10 ms         0.00%   
10.1 ms  20 ms         0.00%   
20.1 ms  40 ms         0.00%   
40.1 ms  80 ms        70.24%  *********************************** 
80.1 ms  160 ms       29.76%  *************** 
160.1 ms 320 ms        0.00%   
320.1 ms 640 ms        0.00%   
640.1 ms 1.2 s         0.00%   
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From Address      1028  
         File main(module)."/users/guest/demo/debug_env/hp64742/main.c" 
         Symbolic Reference at main.interrupt_sim 
To Address        10D4  
         File main(module)."/users/guest/demo/debug_env/hp64742/main.c" 
         Symbolic Reference at interrupt_sim+AC 
Number of intervals   2550 
Maximum Time 413450.240 us 
Minimum Time 181.200 us 
Avg Time     45558.284 us 

         Statistical summary - for     10 traces
                 Stdv 94452.14 
                 95% Confidence 8.05% Error tolerance 

 
         Graph of relative percents  
1 us 10 us             0.00%   
10.1 us 100 us         0.00%   
100.1 us 500 us       15.02%  ******** 
500.1 us 1 ms          5.02%  *** 
1.001 ms 5 ms         25.06%  ************* 
5.001 ms 10 ms        14.98%  ******** 
10.1 ms  20 ms        15.06%  ******** 
20.1 ms  40 ms         0.00%   
40.1 ms  80 ms        10.00%  ***** 
80.1 ms  160 ms        4.94%  *** 
160.1 ms 320 ms        5.02%  *** 
320.1 ms 640 ms        4.90%  *** 
640.1 ms 1.2 s         0.00%   

Two sets of information are given in the duration measurement report: module
duration and module usage.

The first set is the "module usage" measurement.  Module usage measurements
show how much time is spent outside the module of interest; they indicate how
often the module is used.  The information shown in the first part of the duration
report above shows that the average amout of time spent outside the interrupt_sim
function is about 71.5 milliseconds.

The second set of information in the duration measurement report is the "module
duration" measurement.  The module duration report shows that the amount of time
it takes for the interrupt_sim function to execute varies from 181.2 microseconds to
413.5 milliseconds. The average amount of time it takes for the interrupt_sim
module to execute is roughly 45.6 milliseconds.
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Running Measurements and Creating Reports

Several performance measurement tasks are the same whether you are making
activity or duration measurements.

This section describes how to:

• Run performance measurements.

• End performance measurements.

• Create a performance measurement report.

To run performance measurements

• Use the performance_measurement_run command.

The performance_measurement_run command processes analyzer trace data.
When you end the performance measurement, this processed data is dumped to the
binary "perf.out" file in the current directory.  The perf32 report generator utility is
used to read the binary information in the "perf.out" file.

If the performance_measurement_run command is entered without a count, the
current trace data is processed.  If a count is specified, the current trace command is
executed consecutively the number of times specified.  The data that results from
each trace command is processed and combined with the existing processed data.
The STATUS line will say "Processing trace <NO.>" during the run so you will
know how your measurement is progressing.  The only way to stop this series of
traces is by using <CTRL>c (sig INT).

The more traces you include in your sample, the more accurate will be your results.
At least four consecutive traces are required to obtain statistical interpretation of
activity measurement results.
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Examples To run the performance measurement, enter the following command:

performance_measurement_run  20 <RETURN>

The command above causes 20 traces to occur.  The SPMT processes the trace
information after each trace, and the number of the trace being processed is shown
on the status line.

To end performance measurements

• Use the performance_measurement_end command.

The performance_measurement_end command takes the data generated by the
performance_measurement_run command and places it in a file named perf.out
in the current directory.  If a file named "perf.out" already exists in the current
directory, it will be overwritten.  Therefore, if you wish to save a performance
measurement, you must rename the perf.out file before performing another
measurement.

The performance_measurement_end command does not affect the current
performance measurement data which exists within the emulation system.  In other
words, you can add more traces later to the existing performance measurement by
entering another performance_measurement_run command.

Once you have entered the performance_measurement_end command, you can
use the perf32 report generator to look at the data saved in the perf.out file.

Note that the "perf.out" file is a binary file.  Do not try to read it with the UNIX
more or cat commands.  The perf32 report generator utility (described in the
following section) must be used to read the contents of the "perf.out" file.

Examples To cause the processed trace information to be dumped to the "perf.out" file:

performance_measurement_end  <RETURN>
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To create a performance measurement report

• Use the perf32 command at the UNIX prompt.

The perf32 report generator utility must be used to read the information in the
"perf.out" file and other files dumped by the SPMT (in other words, renamed
"perf.out" files).  The perf32 utility is run from the UNIX shell.  You can fork a
shell while in the Softkey Interface and run perf32, or you can exit the Softkey
Interface and run perf32.

Options to "perf32"

A default report, containing all performance measurement information, is generated
when the perf32 command is used without any options.  The options available with
perf32 allow you to limit the information in the generated report.  These options
are described below.

-h Produce outputs limited to histograms.

-s Produce a summary limited to the statistical data.

-p Produce a summary limited to the program activity.

-m Produce a summary limited to the memory activity.

-f<file> Produce a report based on the information contained in
<file> instead of the information contained in perf.out.

For example, the following commands save the current performance measurement
information in a file called "perf1.out", and produce a histogram showing only the
program activity occupied by the functions and variables.

mv perf.out perf1.out <RETURN> 
perf32 -hpf  perf1.out <RETURN>

Options -h, -s, -p, and -m affect the contents of reports generated for activity
measurements.  These options have no effect on the contents of reports generated
for duration (time interval) measurements.
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Examples Now, to generate a report from the "perf.out" file, type the following on the
command line to fork a shell and run the perf32 utility:

!perf32 | more
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Using the External State Analyzer
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Using the External State Analyzer

The HP 64703A analyzer provides an external analyzer with 16 external trace
channels.  These trace channels allow you to capture activity on signals external to
the emulator, typically other target system signals.  The external analyzer may be
configured as an extension to the emulation analyzer, as an independent state
analyzer, or as an independent timing analyzer.

When the external analyzer is configured as an independent state analyzer, the
emulator/analyzer interface does not control the external analyzer.  However, you
can use pod commands to control the independent state analyzer via the terminal
interface.  Refer to the 68000 Emulator User’s Guide for the Terminal Interface for
information on using the external analyzer when it is configured as an independent
state analyzer.

When the external analyzer is configured as an independent timing analyzer, you
must use a special Timing Analyzer Interface program.  Refer to the Timing
Analyzer Interface User’s Guide for information on using the external analyzer
when it is configured as an independent timing analyzer.

The tasks you perform with the external analyzer are grouped into the following
sections:

• Setting up the external analyzer.

• Configuring the external analyzer.
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Setting Up the External Analyzer

This section assumes you have already connected the external analyzer probe to the
HP 64700 Card Cage.

Before you can use the external analyzer, you must:

• Connect the external analyzer probe to the target system.

• Specify threshold voltages of external trace signals.

• Label the external trace signals.

• Select the external analyzer mode.
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To connect the external analyzer probe to the
target system

1  Assemble the Analyzer Probe.  The analyzer probe is a two-piece assembly, consisting of ribbon cable
and 18 probe wires (16 data channels and the J and K clock inputs) attached to a connector.  Either end of
the ribbon cable may be connected to the 18 wire connector, and the connectors are keyed so they may
only be attached one way.  Align the key of the ribbon cable connector with the slot in the 18 wire
connector, and firmly press the connectors together.
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2  Attach grabbers to probe wires.  Each of the 18 probe wires has a signal and a ground connection.
Each probe wire is labeled for easy identification.  Thirty-six grabbers are provided for the signal and
ground connections of each of the 18 probe wires.  The signal and ground connections are attached to the
pin in the grabber handle.
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CAUTION Turn OFF target system power before connecting analyzer probe wires to the target
system.  The probe grabbers are difficult to handle with precision, and it is
extremely easy to short the pins of a chip (or other connectors which are close
together) with the probe wire while trying to connect it.

3  You can connect the grabbers to pins, connectors, wires, etc., in the target system.  Pull the hilt of the
grabber towards the back of the grabber handle to uncover the wire hook.  When the wire hook is around
the desired pin or connector, release the hilt to allow the grabber spring tension to hold the connection.
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Configuring the External Analyzer

After you have assembled the external analyzer probe and connected it to the
emulator and target system, the next step is to configure the external analyzer.

The external analyzer is a versatile instrument, and you can configure it to suit your
needs.  For example, you can specify threshold voltage levels on the external
analyzer channels, and you can operate the external analyzer in several different
modes.

The default configuration specifies that the external analyzer is aligned with the
emulation analyzer.  TTL level threshold voltages are defined, as well as an
external label named "xbits" which contains all 16 channels.

This section describes how to:

• Specify whether the emulation emulator/analyzer interface should control the
external analyzer.

• Specify the threshold voltages for the external channels.

• Select the external analyzer mode.

• Specify the slave clock mode when configured as an independent state
analyzer.

• Define labels for the external analyzer channels.
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To control the external analyzer with the
emulator/analyzer interface

1 Enter the modify configuration command.

2 Answer "yes" to the "Modify external analyzer configuration?" question.

3 Answer the "Should emulation control the external bits?" question.

Answer "yes" if the emulation emulator/analyzer interface should control the
external analyzer.  You must answer "yes" to access the remaining external
analyzer configuration questions.  At the end of the configuration process the
external analyzer mode and threshold voltages will be set; existing labels will be
deleted, and only the labels specified in response to the questions below will be
defined.

Answer "no" if the emulation emulator/analyzer interface shouldn’t control the
external analyzer.  If emulation does not control the external bits, the external
analyzer configuration will not be modified in any way by the emulation interface.
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To specify the threshold voltage

1 Enter the modify configuration command.

2 Answer "yes" to the "Modify external analyzer configuration?" question.

3 Answer "yes" to the "Should emulation control the external bits?" question.

4 Answer the "Threshold voltage for bits 0-7 and J clock?" question.

5 Answer the "Threshold voltage for bits 8-15 and K clock?" question.

The external analyzer probe signals are divided into two groups: the lower byte
(channels 0 through 7 and the J clock), and the upper byte (channels 8 through 15
and the K clock).  You can specify a threshold voltage for each of these groups.

The default threshold voltages are specified as TTL  which translates to 1.40 volts.

Voltages may be in the range from -6.40 volts to 6.35 volts (with a 0.05V
resolution).  You may also specify CMOS (which translates to 2.5 volts), or ECL
(which translates to -1.3 volts).
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To specify the external analyzer mode

1 Enter the modify configuration command.

2 Answer "yes" to the "Modify external analyzer configuration?" question.

3 Answer "yes" to the "Should emulation control the external bits?" question.

4 Answer the "External analyzer mode?" question.

The default configuration selects the "emulation" external analyzer mode.  In this
mode, you have 16 external trace signals on which data is captured synchronously
with the emulation clock.

The external analyzer may also operate as an independent state analyzer, or it may
operate as an independent timing analyzer if a host computer interface program is
used.

Answer "emulation" to select the emulation mode.  In this mode, the external
analyzer becomes an extension of the emulation analyzer.  In other words, they
operate as one analyzer.  The external bits are clocked with the emulation clock.
External labels may be used in trace commands to qualify trigger, storage, prestore,
or count states.  External labels may be viewed in the trace display.

Answer "state" to select the independent state mode of the external analyzer.  The
external bits are not available for use from the emulation interface.  You can,
however, use pod commands to control the external state analyzer in its
independent mode.

Answer "timing" to select the timing mode of the external analyzer.  The external
bits are not available for use from the emulation interface.  Because the pod
commands for the timing analyzer dump information in binary format, you will
need to use Timing Analyzer Interface, or other interface program, to capture the
timing analyzer data.

Chapter 8: Using the External State Analyzer
Configuring the External Analyzer

282



To specify the slave clock mode

1 Enter the modify configuration command.

2 Answer "yes" to the "Modify external analyzer configuration?" question.

3 Answer "yes" to the "Should emulation control the external bits?" question.

4 Answer "state" to the "External analyzer mode?" question.

5 Answer the "Slave clock mode for external bits?" question.

There are two modes of demultiplexing that can be set for the 16 channels of the
external analyzer: mixed clocks and true demultiplexing.

Answer "off" to turn slave clocks OFF.  If the slave clock is "off", all 16 external
bits are clocked with the emulation clock.

Answer "mixed" to specify the mixed clock demultiplexing mode.  In this mode,
the lower eight external bits (0-7) are latched when the slave clock (as specified by
your answers to the next four questions) is received.  The upper eight bits and the
latched lower eight are then clocked into the analyzer when the emulation clock is
received (see the figure below).
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If no slave clock has appeared since the last master clock, the data on the lower 8
bits of the pod will be latched at the same time as the upper 8 bits.  If more than one
slave clock has appeared since the last master clock, only the first slave data will be
available to the analyzer (see the figure below).
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Answer "demux" to specify the true demultiplexing mode.  In this mode, only the
lower eight external channels (0-7) are used.  The slave clock (as specified by your
answers to the next four questions) latches these bits and the emulation clock
samples the same channels again.  The latched bits show up as bits 0-7 in the trace
data, and the second sample shows up as bits 8-15 (see the figure below).
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If no slave clock has appeared since the last master clock, the data on the lower 8
bits of the pod will be the same as the upper 8 bits.  If more than one slave clock
has appeared since the last master clock, only the first slave data will be available to
the analyzer.

6 If the "mixed" or "true demultiplexing" slave clock modes are selected, answer the
"Edges of J (K,L,M) clock used for slave clock?" questions.

These four questions are asked when you select either the "mixed" or "demux"
slave clock mode.  They allow you to define the slave clock.  You can specify
rising, falling, both, or neither (none) edges of the J, K, L, and M clocks.  When
several clock edges are specified, any one of the edges clocks the trace.

Clocks J and K are the external clock inputs of the external analyzer probe.  The L
and M clocks are generated by the emulator.  Typically, the L clock is the
emulation clock derived by the emulator and the M clock is not used.

To define labels for the external analyzer signals

1 Enter the modify configuration command.

2 Answer "yes" to the "Modify external analyzer configuration?" question.

3 Answer "yes" to the "Should emulation control the external bits?" question.

4 For each defined external label (there can be up to 8), answer the "name?", "start
bit?", "width?", and "polarity?" questions.

You can define up to eight labels for the 16 external data channels in the
configuration.  These external analyzer labels can be used in trace commands, and
the data associated with these labels can be displayed in the trace list.  One external
analyzer label, "xbits", is defined by the default configuration and is included in the
default trace list.

External labels can be defined with bits in the range of 0 through 15.  The start bit
may be in the range 0 through 15, but the width of the label must not cause the label
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to extend past bit 15.  Thus, the sum of the start bit number plus the width must not
exceed 16.

The "polarity?" question allows you to specify positive or negative logic for the
external bits.  In other words, positive means high=1, low=0.  Negative means
low=1, high=0.

Once external labels are defined, they may be used in trace commands to qualify
events (if the emulation controls the external analyzer).  Also, you can modify the
trace display to include data for the various trace labels.

Note that the Timing Analyzer Interface does not use the external labels defined in
the emulator/analyzer interface.  You maintain labels for the timing analyzer within
the Timing Analyzer Interface itself.
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Making Coordinated Measurements

When HP 64700 Card Cages are connected together via the Coordinated
Measurement Bus (CMB), you can start and stop up to 32 emulators at the same
time.

You can use the analyzer in one HP 64700 to arm (that is, activate) the analyzers in
other HP 64700 Card Cages or to cause emulator execution in other HP 64700 Card
Cages to break into the monitor.

You can use the HP 64700’s BNC connector (labeled TRIGGER IN/OUT on the
lower left corner of the HP 64700 rear panel) to trigger an external instrument (for
example, a logic analyzer or oscilloscope) when the analyzer finds its trigger
condition.  Also, you can allow an external instrument to arm the analyzer or break
emulator execution into the monitor.

The coordinated measurement tasks you can perform are grouped into the
following sections:

• Setting up for coordinated measurements.

• Starting and stopping multiple emulators.

• Driving trigger signals to the CMB or BNC.

• Stopping program execution on trigger signals.

• Arming analyzers on trigger signals.
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The location of the CMB and BNC connectors on the HP 64700 rear panel is
shown in the following figure.

CMB Connector

BNC Connector

Signal Lines on the CMB

There are three bi-directional signal lines on the CMB connector on the rear panel
of the emulator. These CMB signals are:

TRIGGER The CMB TRIGGER line is low true.  This signal can be driven or
received by any HP 64700 connected to the CMB.  This signal can be used to
trigger an analyzer. It can be used as a break source for the emulator.

READY The CMB READY line is high true.  It is an open collector and performs
an ANDing of the ready state of enabled emulators on the CMB.  Each emulator on
the CMB releases this line when it is ready to run.  This line goes true when all
enabled emulators are ready to run, providing for a synchronized start.
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When CMB is enabled, each emulator is required to break to background when
CMB READY goes false, and will wait for CMB READY to go true before
returning to the run state.  When an enabled emulator breaks, it will drive the CMB
READY false and will hold it false until it is ready to resume running.  When an
emulator is reset, it also drives CMB READY false.

EXECUTE The CMB EXECUTE line is low true.  Any HP 64700 on the CMB
can drive this line.  It serves as a global interrupt and is processed by both the
emulator and the analyzer.  This signal causes an emulator to run from a specified
address when CMB READY returns true.

BNC Trigger Signal

The BNC trigger signal is a positive rising edge TTL level signal.  The BNC trigger
line can be used to either drive or receive an analyzer trigger, or receive a break
request for the emulator.

Comparison Between CMB and BNC Triggers The CMB trigger and BNC
trigger lines have the same logical purpose: to provide a means for connecting the
internal trigger signals (trig1 and trig2) to external instruments.  The CMB and
BNC trigger lines are bi-directional.  Either signal may be used directly as a break
condition.

The CMB trigger is level-sensitive, while the BNC trigger is edge-sensitive.  The
CMB trigger line puts out a true pulse following receipt of EXECUTE, despite the
commands used to configure it.  This pulse is internally ignored.

Note that if you use the EXECUTE function, the CMB TRIGGER should not be
used to trigger external instruments, because a false trigger will be generated when
EXECUTE is activated.
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Setting Up for Coordinated Measurements

This section describes how to:

• Connect the Coordinated Measurement Bus.

• Connect the rear panel BNC.

To connect the Coordinated Measurement Bus
(CMB)

Caution Be careful not to confuse the 9-pin connector used for CMB with those used by
some computer systems for RS-232C communications.  Applying RS-232C signals
to the CMB connector is likely to result in damage to the HP 64700 Card Cage.

To use the CMB, you will need one CMB cable for the first two emulators and one additional cable for
every emulator after the first two.  The CMB cable is orderable from HP under product number
HP 64023A.  The cable is four meters long.

You can build your own compatible CMB cables using standard 9-pin D type subminiature connectors
and 26 AWG wire.

Note that Hewlett-Packard does not ensure proper CMB operation if you are using a self-built cable!
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1  Connect the cables to the HP 64700 CMB ports.
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Number of HP 64700 Series
Emulators

Maximum Total Length of
Cable

Restrictions on the CMB
Connection

2 to 8 100 meters None.

9 to 16 50 meters None.

9 to 16 100 meters Only 8 emulators may have rear
panel pullups connected. *

17 to 32 50 meters Only 16 emulators may have rear
panel pullups connected. *

* A modification must be performed by your HP Customer Engineer.

Emulators using the CMB must use background emulation monitors.

At least 3/4 of the HP 64700-Series emulators connected to the CMB must be powered up before proper
operation of the entire CMB configuration can be assured.

To connect to the rear panel BNC

Caution The BNC line on the HP 64700 accepts input and output of TTL levels only.  (TTL
levels should not be less than 0 volts or greater than 5 volts.)  Failure to observe
these specifications may result in damage to the HP 64700 Card Cage.
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1  Connect one end of a 50 ohm coaxial cable with male BNC connectors to the HP 64700 BNC
receptacle and the other end to the appropriate BNC receptacle on the other measuring instrument.

The BNC connector is capable of driving TTL level signals into a 50 ohm load.  (A positive rising edge is
the trigger signal.)  It requires a driver that can supply at least 4 mA at 2 volts when used as a receiver.
The BNC connector is configured as an open-emitter structure which allows for multiple drivers to be
connected.  It can be used for cross-triggering between multiple HP 64700Bs when no other
cross-measurements are needed.  The output of the BNC connector is short-circuit protected and is
protected from TTL level signals when the emulator is powered down.
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Starting/Stopping Multiple Emulators

When HP 64700 Card Cages are connected together via the Coordinated
Measurement Bus (CMB), you can start and stop up to 32 emulators at the same
time.  These are called synchronous measurements.

This section describes how to:

• Enable synchronous measurements.

• Start synchronous measurements.

• Disable synchronous measurements.

To enable synchronous measurements

• Enter the specify run command.

You can enable the emulator’s interaction with the CMB by using the specify run
command.  When the EXECUTE signal is received, the emulator will run at the
current program counter address or the address specified in the specify run
command.

Note that when the CMB is being actively controlled by another emulator, the step
command does not work correctly.  The emulator may end up running in user code
(NOT stepping).  Disable CMB interaction (see "To disable synchronous
measurements" below) while stepping the processor.

Note that enabling CMB interaction does not affect the operation of analyzer
cross-triggering.

You can use the specify trace command to specify that an analyzer measurement
begin upon reception of the CMB EXECUTE signal.

The trace measurement defined by the specify trace command will be started when
the EXECUTE signal becomes active.  When the trace measurement begins, you
will see the message "CMB execute; emulation trace started".
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When you enter a normal trace command, trace at execute is disabled, and the
analyzer ignores the CMB EXECUTE signal.

Examples To enable synchronous measurements:

specify run from  1e8h <RETURN>

To trace when synchronous execution begins:

specify trace after address  main <RETURN>

To start synchronous measurements

• Enter the cmb_execute command.

The cmb_execute command will cause the EXECUTE line to be pulsed, thereby
initiating a synchronous measurement.  CMB interaction does not have to be
enabled in order to use either of these commands.  (When you enable CMB
interaction, you only specify how the emulator will react to the CMB EXECUTE
signal.)

All emulators whose CMB interaction is enabled will break into the monitor when
any one of those emulators breaks into its monitor.

To disable synchronous measurements

• Enter the specify run disable command.

You can disable the emulator’s interaction with the CMB by using the specify run
disable command.  When interaction is disabled, the emulator ignores the CMB
EXECUTE and READY lines.
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Using Trigger Signals

The HP 64700 contains two internal lines, trig1 and trig2, over which trigger
signals can pass from the emulator or analyzer to other HP 64700s on the
Coordinated Measurement Bus (CMB) or other instruments connected to the BNC
connector.

You can configure the internal lines to make connections between the emulator,
analyzer, external analyzer (if its configured as an independent state or timing
analyzer), CMB connector, or BNC connector.  Measurements that depend on these
connections are called interactive measurements or coordinated measurements.

To configure the internal trig1 and trig2 lines, you must enter the modify
configuration command and then answer "yes" to the "Modify interactive
measurement specification?" question.  When you do this, the following display
appears.

This display illustrates the possible connections between the internal lines (trig1
and trig2) and the emulator, analyzer, and external devices.

Note that the "External Analyzer" option for "Trig2" only appears if you have
selected "state" or "timing" for the external analyzer mode.

Notice that the analyzer always drives trig1, and the emulator always receives trig1.
This provides for the break_on_trigger syntax of the trace command.
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You can use the trig1 or trig2 line to make a connection between the analyzer and
the CMB connector or BNC connector so that, when the analyzer finds its trigger
condition, a trigger signal is driven on the HP 64700’s Coordinated Measurement
Bus (CMB) or BNC connector.  This can also be done for the external analyzer
when it is configured as an independent state or timing analyzer.

You can use the trig1 or trig2 line to make a connection between the emulator break
input and the CMB connector, BNC connector, analyzer, (or external analyzer
when configured as an independent state or timing analyzer) so that program
execution can break when a trigger signal is received from the CMB, BNC, or
analyzer.

You can use the trig2 line to make a connection between the analyzer and the CMB
connector or BNC connector so that the analyzer can be armed (that is, enabled)
when a trigger signal is received from the CMB or BNC connector.  This can also
be done for the external analyzer when it is configured as an independent state or
timing analyzer.

You can use the trig1 and trig2 lines to make several type of connections at the
same time.  For example, when the analyzer finds its trigger condition, a signal is
driven on the trig1 line.  This signal may be used to stop user program execution,
but the trigger signal may also be driven on the CMB and BNC connectors.

Also, it’s possible for signals to be driven and received on the CMB or BNC
connectors.  So, for example, while the analyzer’s trigger signal can be driven on
the CMB and BNC connectors, signals can also be received from the CMB and
BNC connectors and used to stop user program execution.  In this case, the
emulator will break into the monitor on either the analyzer trigger or on the
reception of a trigger signal from the CMB or BNC.

You can disable connections made by the internal trig1 and trig2 lines by
answering "neither" or "no" to the appropriate interactive measurement
configuration question.
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This section shows you how to:

• Drive the emulation analyzer trigger signal to the CMB.

• Drive the emulation analyzer trigger signal to the BNC connector.

• Drive the external analyzer trigger signal to the CMB.

• Drive the external analyzer trigger signal to the BNC connector.

• Break emulator execution on signal from CMB.

• Break emulator execution on signal from BNC.

• Break emulator execution on external analyzer trigger.

• Arm the emulation analyzer on signal from CMB.

• Arm the emulation analyzer on signal from BNC.

• Arm the emulation analyzer on external analyzer trigger.

• Arm the external analyzer on signal from CMB.

• Arm the external analyzer on signal from BNC.

• Arm the external analyzer on emulation analyzer trigger.

To drive the emulation analyzer trigger signal to
the CMB

1 Enter the modify configuration command.

2 Answer "yes" to the "Modify interactive measurement specification?" question.

3 Answer "receive" to the "Should CMBT drive or receive Trig1?" question.

You could also drive the emulation analyzer trigger to the CMB over the trig2
internal line by specifying that the CMBT should receive trig2 and that the
emulation analyzer should drive trig2.
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To drive the emulation analyzer trigger signal to
the BNC connector

1 Enter the modify configuration command.

2 Answer "yes" to the "Modify interactive measurement specification?" question.

3 Answer "receive" to the "Should BNC drive or receive Trig1?" question.

You could also drive the emulation analyzer trigger to the BNC over the trig2
internal line by specifying that the BNC should receive trig2 and that the emulation
analyzer should drive trig2.

To drive the external analyzer trigger signal to
the CMB

1 Enter the modify configuration command.

2 Answer "yes" to the "Modify interactive measurement specification?" question.

3 Answer "receive" to the "Should CMBT drive or receive Trig2?" question.

4 Answer "drive" to the "Should External Analyzer drive or receive Trig2?" question.
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To drive the external analyzer trigger signal to
the BNC connector

1 Enter the modify configuration command.

2 Answer "yes" to the "Modify interactive measurement specification?" question.

3 Answer "receive" to the "Should BNC drive or receive Trig2?" question.

4 Answer "drive" to the "Should External Analyzer drive or receive Trig2?" question.

To break emulator execution on signal from CMB

1 Enter the modify configuration command.

2 Answer "yes" to the "Modify interactive measurement specification?" question.

3 Answer "drive" to the "Should CMBT drive or receive Trig1?" question.

You could also break emulator execution on a trigger signal from the CMB over the
trig2 internal line by specifying that the CMB should drive trig2 and that the
emulator break should receive trig2.
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To break emulator execution on signal from BNC

1 Enter the modify configuration command.

2 Answer "yes" to the "Modify interactive measurement specification?" question.

3 Answer "drive" to the "Should BNC drive or receive Trig1?" question.

You could also break emulator execution on a trigger signal from the BNC over the
trig2 internal line by specifying that the BNC should drive trig2 and that the
emulator break should receive trig2.

To break emulator execution on external analyzer
trigger

1 Enter the modify configuration command.

2 Answer "yes" to the "Modify interactive measurement specification?" question.

3 Answer "yes" to the "Should Emulator break receive Trig2?" question.

4 Answer "drive" to the "Should External Analyzer drive or receive Trig2?" question.

When an emulator break occurs due to the analyzer trigger, the analyzer will stop
driving the internal signal that caused the break.  Therefore, if trig2 is used both to
break and to drive the CMB TRIGGER (for example), TRIGGER will go true
when the trigger is found and then will go false after the emulator breaks.
However, if trig1 is used to cause the break and trig2 is used to drive the CMB
TRIGGER, TRIGGER will stay true until the trace is halted or until the next trace
starts.
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To arm the emulation analyzer on signal from
CMB

1 Enter the modify configuration command.

2 Answer "yes" to the "Modify interactive measurement specification?" question.

3 Answer "drive" to the "Should CMBT drive or receive Trig2?" question.

4 Answer "receive" to the "Should Analyzer drive or receive Trig2?" question.

5 Use the arm_trig2  option to the trace command.

To arm the emulation analyzer on signal from
BNC

1 Enter the modify configuration command.

2 Answer "yes" to the "Modify interactive measurement specification?" question.

3 Answer "drive" to the "Should BNC drive or receive Trig2?" question.

4 Answer "receive" to the "Should Analyzer drive or receive Trig2?" question.

5 Use the arm_trig2  option to the trace command.
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To arm the emulation analyzer on external
analyzer trigger

1 Enter the modify configuration command.

2 Answer "yes" to the "Modify interactive measurement specification?" question.

3 Answer "receive" to the "Should Analyzer drive or receive Trig2?" question.

4 Answer "drive" to the "Should External Analyzer drive or receive Trig2?" question.

5 Use the arm_trig2  option to the trace command.

To arm the external analyzer on signal from CMB

1 Enter the modify configuration command.

2 Answer "yes" to the "Modify interactive measurement specification?" question.

3 Answer "drive" to the "Should CMBT drive or receive Trig2?" question.

4 Answer "receive" to the "Should External Analyzer drive or receive Trig2?"
question.
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To arm the external analyzer on signal from BNC

1 Enter the modify configuration command.

2 Answer "yes" to the "Modify interactive measurement specification?" question.

3 Answer "drive" to the "Should BNC drive or receive Trig2?" question.

4 Answer "receive" to the "Should External Analyzer drive or receive Trig2?"
question.

To arm the external analyzer on emulation
analyzer trigger

1 Enter the modify configuration command.

2 Answer "yes" to the "Modify interactive measurement specification?" question.

3 Answer "drive" to the "Should Analyzer drive or receive Trig2?" question.

4 Answer "receive" to the "Should External Analyzer drive or receive Trig2?"
question.
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Setting X Resources

The Graphical User Interface is an X Window System application which means it is
a client in the X Window System client-server model.

The X server is a program that controls all access to input devices (typically a
mouse and a keyboard) and all output devices (typically a display screen).  It is an
interface between application programs you run on your system and the system
input and output devices.

An X resource controls an element of appearance or behavior in an X application.
For example, in the graphical interface, one resource controls the text in action key
pushbuttons as well as the action performed when the pushbutton is clicked.

By modifying resource settings, you can change the appearance or behavior of
certain elements in the graphical interface.

When the graphical interface starts up, it reads resource specifications from a set of
configuration files.  Resources specifications in later files override those in earlier
files. Files are read in the following order:

1 The application defaults file.  For example,
/usr/lib/X11/app-defaults/HP64_Softkey in HP-UX or
/usr/openwin/lib/X11/app-defaults/HP64_Softkey in SunOS.

2 The $XAPPLRESDIR/HP64_Softkey file.  (The XAPPLRESDIR environment
variable defines a directory containing system-wide custom application
defaults.)

3 The server’s RESOURCE_MANAGER property.  (The xrdb  command loads
user-defined resource specifications into the RESOURCE_MANAGER
property.)

If no RESOURCE_MANAGER property exists, user defined resource settings
are read from the $HOME/.Xdefaults file.

4 The file named by the XENVIRONMENT environment variable.

If the XENVIRONMENT variable is not set, the $HOME/.Xdefaults-host file
(typically containing resource specifications for a specific remote host) is read.
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5 Resource specifications included in the command line with the -xrm  option.

6 System scheme files in directory /usr/hp64000/lib/X11/HP64_schemes.

7 System-wide custom scheme files located in directory
$XAPPLRESDIR/HP64_schemes.

8 User-defined scheme files located in directory $HOME/.HP64_schemes (note
the dot in the directory name).

Scheme files group resource specifications for different displays, computing
environments, and languages.

This chapter shows you how to:

• Modify the Graphical User Interface resources.

• Use customized scheme files.

• Set up custom action keys.

• Set initial recall buffer values.

• Set up demos or tutorials.

Refer to the "X Resources and the Graphical Interface" section in the "Concepts"
chapter for more detailed information.
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To modify the Graphical User Interface resources

You can customize the appearance of an X Windows application by modifying its
X resources.  The following tables describe some of the commonly modified
application resources.

Application Resources for Schemes

Resource Values Description

HP64_Softkey.platformScheme HP-UX
SunOS
(custom)

Names the subdirectory for platform
specific schemes.  This resource should be
set to the platform on which the X server is
running (and displaying the Graphical User
Interface) if it is different than the platform
where the application is running.

HP64_Softkey.colorScheme BW
Color
(custom)

Names the color scheme file.

HP64_Softkey.sizeScheme Small
Large
(custom)

Names the size scheme file which defines
the fonts and the spacing used.

HP64_Softkey.labelScheme Label
$LANG
(custom)

Names to use for labels and button text.
The default uses the $LANG environment
variable if it is set and if a scheme file
named Softkey.$LANG exists in one of the
directories searched for scheme files;
otherwise, the default is Label.

HP64_Softkey.inputScheme Input
(custom)

Specifies mouse and keyboard operation.
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Commonly Modified Application Resources

Resource Values Description

HP64_Softkey.lines 24
(min. 18)

Specifies the number of lines in the main
display area.

HP64_Softkey.columns 100
(min. 80)

Specifies the number of columns, in
characters, in the main display area.

HP64_Softkey.enableCmdline True
False

Specifies whether the command line area is
displayed when you initially enter the
Graphical User Interface.

*editFile (example) vi
%s

Specifies the command used to edit files.

*editFileLine (example) vi
+%d %s

Specifies the command used to edit a file at
a certain line number.

*<proc>*actionKeysSub.keyDefs (paired list
of strings)

Specifies the text that should appear on the
action key push buttons and the commands
that should be executed in the command line
area when the action key is pushed.  Refer
to the "To set up custom action keys"
section for more information.

*<proc>*dirSelectSub.entries (list of
strings)

Specifies the initial values that are placed in
the File→Context→Directory  popup recall
buffer.  Refer to the "To set initial recall
buffer values" section for more information.

*<proc>*recallSub.entries (list of
strings)

Specifies the initial values that are placed in
the entry buffer (labeled "():").  Refer to the
"To set initial recall buffer values" section
for more information.
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The following steps show you how to modify the Graphical User Interface’s X
resources.

1 Copy part or all of the HP64_Softkey application defaults file to a temporary file.

The HP64_Softkey file contains the default definitions for the graphical interface
application’s X resources.

For example, on an HP 9000 computer you can use the following command to copy
the complete HP64_Softkey file to HP64_Softkey.tmp (note that the HP64_Softkey
file is several hundred lines long):

cp /usr/lib/X11/app-defaults/HP64_Softkey HP64_Softkey.tmp

NOTE: The HP64_Softkey application defaults file is re-created each time
Graphical User Interface software is installed or updated.  You can use the UNIX
diff  command to check for differences between the new HP64_Softkey application
defaults file and the old application defaults file that is saved as
/usr/hp64000/lib/X11/HP64_schemes/old/HP64_Softkey.

2 Modify the temporary file.

Modify the resource that defines the behavior or appearance that you wish to
change.

For example, to change the number of lines in the main display area to 36:

vi HP64_Softkey.tmp

Search for the string "HP64_Softkey.lines".  You should see lines similar to the
following.

!------------------------------------------------------------------------------
! The lines and columns set the vertical and horizontal dimensions of the
! main display area in characters, respectively.  Minimum values are 18 lines
! and 80 columns.  These minimums are silently enforced.
!
! Note: The application cannot be resized by using the window manager.

!HP64_Softkey.lines:    24
!HP64_Softkey.columns:  85
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Edit the line containing "HP64_Softkey.lines" so that it is uncommented and is set
to the new value:

!------------------------------------------------------------------------------
! The lines and columns set the vertical and horizontal dimensions of the
! main display area in characters, respectively.  Minimum values are 18 lines
! and 80 columns.  These minimums are silently enforced.
!
! Note: The application cannot be resized by using the window manager.

HP64_Softkey.lines:    36
!HP64_Softkey.columns:  85

Save your changes and exit the editor.

3 If the RESOURCE_MANAGER property exists (as is the case with HP VUE — if
you’re not sure, you can check by entering the xrdb -query command), use the
xrdb  command to add the resources to the RESOURCE_MANAGER property. For
example:

xrdb -merge -nocpp HP64_Softkey.tmp

Otherwise, if the RESOURCE_MANAGER property does not exist, append the
temporary file to your $HOME/.Xdefaults file.  For example:

cat HP64_Softkey.tmp >> $HOME/.Xdefaults

4 Remove the temporary file.

5 Start or restart the Graphical User Interface.

After you have completed the above steps, you must either start, or restart by
exiting and starting again, the Graphical User Interface.  Starting and exiting the
Graphical User Interface is described in the "Starting and Exiting HP 64700
Interfaces" chapter.
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To use customized scheme files

Scheme files are used to set platform specific resources that deal with color, fonts
and sizes, mouse and keyboard operation, and labels and titles.  You can create and
use customized scheme files by following these steps.

1 Create the $HOME/.HP64_schemes/<platform> directory.

For example:

mkdir $HOME/.HP64_schemes
mkdir $HOME/.HP64_schemes/HP-UX

2 Copy the scheme file to be modified to the $HOME/.HP64_schemes/<platform>
directory.

Label scheme files are not platform specific; therefore, they should be placed in the
$HOME/.HP64_schemes directory.  All other scheme files should be placed in the
$HOME/.HP64_schemes/<platform> directory.

For example:

cp /usr/hp64000/lib/X11/HP64_schemes/HP-UX/Softkey.Color
$HOME/.HP64_schemes/HP-UX/Softkey.MyColor

Note that if your custom scheme file has the same name as the default scheme file,
the load order requires resources in the custom file to explicitly override resources
in the default file.

3 Modify the $HOME/.HP64_schemes/<platform>/Softkey.<scheme> file.

For example, you could modify the
"$HOME/.HP64_schemes/HP-UX/Softkey.MyColor" file to change the defined
foreground and background colors.  Also, since the scheme file name is different
than the default, you could comment out various resource settings to cause general
foreground and background color definitions to apply to the Graphical User
Interface.  At least one resource must be defined in your color scheme file for it to
be recognized.
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4 If your custom scheme file has a different name than the default, you must modify
the scheme resource definitions.

The Graphical User Interface application defaults file contains resources that
specify which scheme files are used.  If your custom scheme files are named
differently than the default scheme files, you must modify these resource settings so
that your customized scheme files are used instead of the default scheme files.

For example, to use the "$HOME/.HP64_schemes/HP-UX/Softkey.MyColor" color
scheme file you would set the "HP64_Softkey.colorScheme" resource to
"MyColor":
HP64_Softkey.colorScheme: MyColor

Refer to the previous "To customize Graphical User Interface resources" section for
more detailed information on modifying resources.
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To set up custom action keys

• Modify the "actionKeysSub.keyDefs" resource.

The "actionKeysSub.keyDefs" resource defines a list of paired strings.  The first
string defines the text that should appear on the action key pushbutton.  The second
string defines the command that should be sent to the command line area and
executed when the action key is pushed.

A pair of parentheses (with no spaces, that is "()") can be used in the command
definition to indicate that text from the entry buffer should replace the parentheses
when the command is executed.

Action keys that use the entry buffer should always include the entry buffer
symbol, "( )", in the action key label as a visual cue to remind you to place
information in the entry buffer before clicking the action key.

Shell commands can be executed by using an exclamation point prefix.  A second
exclamation point ends the command string and allows additional options on the
command line.

Also, command files can be executed by placing the name of the file in the
command definition.

Finally, an empty action ("") means to repeat the previous operation, whether it
came from a pulldown, a dialog, a popup, or another action key.

Examples To set up custom action keys when the graphical interface is used with 68000
emulators, modify the "*m68000*actionKeysSub.keyDefs" resource:

*m68000*actionKeysSub.keyDefs: \
   "Make"               "cd /users/project2/68k; !make! in_browser" \
   "Load Pgm"           "load configuration config.EA; load program2" \
   "Run Pgm"            "run from reset" \ 
   "Trace after ( )"    "trace after (); display trace" \ 
   "Step Source"        "set source on; display memory mnemonic; step source" \ 
   "Again"              ""

Refer to the previous "To modify Graphical User Interface resources" section for
more detailed information on modifying resources.
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To set initial recall buffer values

• Modify the "entries" resource for the particular recall buffer.

There are six popup recall buffers present in the Graphical User Interface.  The
resources for these popup recall buffers are listed in the following table.

The window manager resource "*transientDecoration" controls the borders around
dialog box windows.  The most natural setting for this resource is "title."

Popup Recall Buffer Resources

Recall Popup Resources Description

File→Context→Directory ... *dirSelect.textColumns
*dirSelect.listVisibleItemCount
*dirSelectSub.entries

The default number of text
columns in the popup is 50.

The default number of visible
lines in the popup is 12.

The "entries" resource is
defined as a list of strings (see
the following example).

Up to 40 unique values are
saved in each of the recall
buffers (as specified by the
resource settings
"*XcRecall.maxDepth: 40" and
"*XcRecall.onlyUnique: True").

File→Context→Symbols ... *symSelect.textColumns
*symSelect.listVisibleItemCount
*symSelectSub.entries

Trace→Trace Spec ... *modtrace.textColumns
*modtrace.listVisibleItemCount
*modtraceSub.entries

Entry Buffer (): *recall.textColumns
*recall.listVisibleItemCount
*recallSub.entries

Command Line command
recall

*recallCmd.textColumns
*recallCmd.listVisibleItemCount
*recallCmdSub.entries

Command Line pod/simio
recall

*recallKbd.textColumns
*recallKbd.listVisibleItemCount
*recallKbdSub.entries
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Examples To set the initial values for the directory selection dialog box when the Graphical
User Interface is used with 68000 emulators, modify the
"*m68000*dirSelectSub.entries" resource:
*m68000*dirSelectSub.entries: \
   "$HOME" \
   ".." \
   "/users/project1" \
   "/users/project2/68k"

Refer to the previous "To modify the Graphical User Interface resources" section
for more detailed information on modifying resources.
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To set up demos or tutorials

You can add demos or tutorials to the Graphical User Interface by modifying the
resources described in the following tables.

Demo Related Component Resources

Resource Value Description

*enableDemo False
True

Specifies whether Help→Demo
appears in the pulldown menu.

*demoPopupSub.indexFile ./Xdemo/Index-topics Specifies the file containing the list
of topic and file pairs.

*demoPopup.textColumns 30 Specifies the width, in characters,
of the of the demo topic list popup.

*demoPopup.listVisibleItemCount 10 Specifies the length, in lines, of the
demo topic list popup.

*demoTopic About demos Specifies the default topic in the
demo popup selection buffer.
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Tutorial Related Component Resources

Resource Value Description

*enableTutorial False
True

Specifies whether
Help→Tutorial  appears in the
pulldown menu.

*tutorialPopupSub.indexFile ./Xtutorial/Index-topics Specifies the file containing the
list of topic and file pairs.

*tutorialPopup.textColumns 30 Specifies the width, in
characters, of the of the tutorial
topic list popup.

*tutorialPopup.listVisibleItemCount 10 Specifies the length, in lines, of
the tutorial topic list popup.

*tutorialTopic About tutorials Specifies the default topic in the
tutorial popup selection buffer.

The mechanism for providing demos and tutorials in the graphical interface is
identical.  The following steps show you how to set up demos or tutorials in the
Graphical User Interface.

1 Create the demo or tutorial topic files and the associated command files.

Topic files are simply ASCII text files.  You can use "\I" to produce inverse video
in the text, "\U" to produce underlining in the text, and "\N" to restore normal text.

Command files are executed when the "Press to perform demo (or tutorial)" button
(in the topic popup dialog) is pushed.  A command file must have the same name as
the topic file with ".cmd" appended.  Also, a command file must be in the same
directory as the associated topic file.
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2 Create the demo or tutorial index file.

Each line in the index file contains first a quoted string that is the name of the topic
which appears in the index popup and second the name of the file that is raised
when the topic is selected.  For example:
"About demos"       /users/guest/gui_demos/general
"Loading programs"  /users/guest/gui_demos/loadprog
"Running programs"  /users/guest/gui_demos/runprog

You can use absolute paths (for example, /users/guest/topic1), paths relative to the
directory in which the interface was started (for example, mydir/topic2), or paths
relative to the product directory (for example, ./Xdemo/general where the product
directory is something like /usr/hp64000/inst/emul/64742A).

3 Set the "*enableDemo" or "*enableTutorial" resource to "True".

4 Define the demo index file by setting the "*demoPopupSub.indexFile" or
"*tutorialPopupSub.indexFile" resource.

For example:
*demoPopupSub.indexFile:  /users/guest/gui_demos/index

You can use absolute paths (for example, /users/guest/Index), paths relative to the
directory in which the interface was started (for example, mydir/indexfile), or paths
relative to the product directory (for example, ./Xdemo/Index-topics where the
product directory is something like /usr/hp64000/inst/emul/64742A).

5 If you wish to define a default topic to be selected, set the "*demoTopic" or
"*tutorialTopic" resource to the topic string.

For example:
*demoTopic:  "About demos"

Refer to the previous "To customize Graphical User Interface resources" section for
more detailed information on modifying resources.
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Emulator/Analyzer Interface Commands

This chapter describes the emulator/analyzer interface commands in alphabetical
order.  First, the syntax conventions are described and the commands are
summarized.

How Pulldown Menus Map to the Command Line

The following table shows the items available in the pulldown menus and the
command line commands to which they map.
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Pulldown Command Line

File→Context→Directory
File→Context→Symbols
File→Load→Emulator Config
File→Load→Executable
File→Load→Program Only
File→Load→Symbols Only
File→Store→Trace Data
File→Store→Trace Spec
File→Store→BBA Data
File→Copy→Display
File→Copy→Memory
File→Copy→Data Values
File→Copy→Trace
File→Copy→Registers
File→Copy→Breakpoints
File→Copy→Status
File→Copy→Global Symbols
File→Copy→Local Symbols ()
File→Copy→Pod Commands
File→Copy→Error Log
File→Copy→Event Log
File→Log→Playback
File→Log→Record
File→Log→Stop
File→Emul700→High-Level Debugger
File→Emul700→Performance Analyzer
File→Emul700→Emulator/Analyzer
File→Emul700→Timing Analyzer
File→Edit→File
File→Edit→At () Location
File→Edit→At PC Location
File→Term
File→Exit→Window (save session)
File→Exit→Locked (all windows, save session)
File→Exit→Released (all windows, release
emulator)

cd
cws
load configuration
load <abs_file>
load <abs_file> nosymbols
load symbols
store trace
store trace_spec
bbaunload
copy display to
copy memory to
copy data to
copy trace to
copy registers to
copy software_breakpoints to
copy status to
copy global_symbols to
copy local_symbols_in --SYMB-- to
copy pod_command to
copy error_log to
copy event_log to
<command file>
log_commands to
log_commands off
N/A
N/A
N/A
N/A
! vi <file> ! no_prompt_before_exit
! vi +<line> <file> ! no_prompt_before_exit
! vi +<line> <file> ! no_prompt_before_exit
! 
end
end locked
end release_system
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Pulldown Command Line

Display→Context
Display→Memory
Display→Memory→Mnemonic ()
Display→Memory→Mnemonic at PC
Display→Memory→Mnemonic Previous
Display→Memory→Hex ()→bytes
Display→Memory→Hex ()→words
Display→Memory→Hex ()→long
Display→Memory→Real ()→short
Display→Memory→Real ()→long
Display→Memory→At ()
Display→Memory→Repetitively
Display→Data Values
Display→Data Values→New ()→<type>
Display→Data Values→Add ()→<type>
Display→Trace
Display→Registers
Display→Breakpoints
Display→Status
Display→Simulated IO
Display→Global Symbols
Display→Local Symbols ()
Display→Pod Commands
Display→Error Log
Display→Event Log

pwd, pws
display memory
display memory --EXPR-- mnemonic
display memory mnemonic at_pc
display memory mnemonic previous_display
display memory --EXPR-- blocked bytes
display memory --EXPR-- blocked words
display memory --EXPR-- blocked long
display memory --EXPR-- real short
display memory --EXPR-- real long
display memory --EXPR-- 
display memory repetitively
display data
display data --EXPR-- <type>
display data, --EXPR-- <type>
display trace
display registers
display software_breakpoints
display status
display simulated_io
display global_symbols
display local_symbols_in --SYMB--
display pod_command
display error_log
display event_log

Modify →Emulator Config
Modify →Memory
Modify →Memory at ()
Modify →Register

modify configuration
modify memory
modify memory --EXPR--
modify register
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Pulldown Command Line

Execution→Run→from PC
Execution→Run→from ()
Execution→Run→from Transfer Address
Execution→Run→from Reset
Execution→Run→until ()
Execution→Step Source→from PC
Execution→Step Source→from ()
Execution→Step Source→from Transfer
Address
Execution→Step Instruction→from PC
Execution→Step Instruction→from ()
Execution→Step Instruction→from Transfer
Address
Execution→Break
Execution→Reset

run
run from --EXPR--
run from transfer_address
run from reset
run until --EXPR--
step source
step source from --EXPR--
step source from transfer_address

step
step from --EXPR--
step from transfer_address

break
reset

Breakpoints→Display
Breakpoints→Enable
Breakpoints→Permanent ()

Breakpoints→Temporary ()

Breakpoints→Set All
Breakpoints→Clear ()
Breakpoints→Clear All

display software_breakpoints
modify software_breakpoints enable/disable
modify software_breakpoints set --EXPR-- 
permanent
modify software_breakpoints set --EXPR-- 
temporary
modify software_breakpoints set
modify software_breakpoints clear --EXPR--
modify software_breakpoints clear

Trace→Display
Trace→Trace Spec
Trace→After ()
Trace→Before ()
Trace→About ()
Trace→Only ()
Trace→Only () Prestore
Trace→Again
Trace→Repetitively
Trace→Everything
Trace→Until ()
Trace→Until Stop
Trace→Stop

display trace
N/A (browses recall buffer for trace commands)
trace after STATE
trace before STATE
trace about STATE
trace only STATE
trace only STATE prestore anything
trace again
<previous trace spec> repetitively
trace
trace before STATE break_on_trigger
trace on_halt
stop_trace
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Pulldown Command Line

Settings→Source/Symbol Modes→Absolute
Settings→Source/Symbol Modes→Symbols
Settings→Source/Symbol Modes→Source
Mixed
Settings→Source/Symbol Modes→Source
Only
Settings→Display Modes→Source Only
Settings→Pod Command Keyboard
Settings→Simulated IO Keyboard
Settings→Command Line

set source off symbols off
set source off symbols on
set source on inverse_video on symbols on

set source only inverse_video off symbols on

set
display pod_command; pod_command keyboard
display simulated_io; modify keyboard_to_simio
N/A (toggles the command line)

How Popup Menus Map to the Command Line

The following tables show the items available in the popup menus and the
command line commands to which they map.

Mnemonic Memory Display Popup Command Line

Set/Clear Breakpoint
Edit Source
Run Until
Trace After
Trace Before
Trace About
Trace Until

modify software_breakpoints set/clear --EXPR--
! vi +<line> <file> ! no_prompt_before_exit
run until --EXPR--
trace after STATE
trace before STATE
trace about STATE
trace before STATE break_on_trigger

Breakpoints Display Popup Command Line

Set/Inactivate Breakpoint
Clear (delete) Breakpoint
Enable/Disable Software Breakpoints
Set All Breakpoints
Clear (delete) All Breakpoints

modify software_breakpoints set/deactivate --EXPR--
modify software_breakpoints clear --EXPR--
modify software_breakpoints enable/disable
modify software_breakpoints set
modify software_breakpoints clear
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Symbols Display Popup Command Line

Display Local Symbols
Display Parent Symbols

Cut Full Symbol Name
Edit File Defining Symbol

display local_symbols_in --SYMB--
display local_symbols_in --SYMB--, display
global_symbols
N/A
! vi +<line> <file> ! no_prompt_before_exit

Status Line Popup Command Line

Remove Temporary Message
Display Error Log
Display Event Log
Command Line On/Off

N/A
display error_log
display event_log
(toggles command line)

Command Line Popup Command Line

Position Cursor, Replace Mode
Position Cursor, Insert Mode
Execute Command
Clear to End of Line
Clear Entire Line
Command Line Off

<INSERT CHAR> key (when in insert mode)
<INSERT CHAR> key
<RETURN> key
<CTRL>e
<CTRL>u
(toggles command line)
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Syntax Conventions

Conventions used in the command syntax diagrams are defined below.

Oval-shaped Symbols

Oval-shaped symbols show options available on the softkeys and other commands
that are available, but do not appear on softkeys (such as log_commands and wait).
These appear in the syntax diagrams as:

Rectangular-shaped Symbols

Rectangular-shaped symbols contain prompts or references to other syntax
diagrams.  Prompts are enclosed with angle brackets (< and >). References to other
diagrams are shown in all capital letters.  Also, references to expressions are shown
in all capital letters, for example --EXPR-- and --SYMB-- (see those syntax
diagrams).  These appear in the following syntax diagrams as:

Circles

Circles indicate operators and delimiters used in expressions and on the command
line as you enter commands.  These appear in the syntax diagrams as:

The -NORMAL- Key

The softkey labeled -NORMAL-  allows you exit the --SYMB-- definition, and
access softkeys that are not displayed when defining expressions.  You can press
this key after you have defined an expression to view other available options.
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Commands

Emulator/analyzer interface commands are summarized in the table below and
described in the following pages.

!UNIX_COMMAND
bbaunload
break
cd (change directory)3

cmb_execute
<command file>3

copy data4

copy display
copy error_log
copy event_log
copy global_symbols
copy help
copy local_symbols_in
copy memory4

copy pod_command
copy registers1

copy software_breakpoints
copy status
copy trace
cws(change working symbol)3

display data4

display error_log

display event_log
display global_symbols
display local_symbols_in
display memory4

display pod_command
display registers1

display simulated_io2

display software_breakpoints
display status
display trace
end
forward
help3

load <absolute_file>
load configuration
load emul_mem
load trace
load trace_spec
load user_memory
log_commands3

modify configuration
modify keyboard_to_simio2

modify memory4

modify register1

modify software_breakpoints1

name_of_module3

performance_measurement_end
performance_measurement_init
performance_measurement_run
pod_command
pwd (print working directory)3

pws (print working symbol)3

reset
run
set
specify
step
stop_trace
store memory
store trace
store trace_spec
trace
wait3

1  This option is not available in real-time mode.
2  This is only available when simulated I/O is defined.
3  These commands are not displayed on softkeys.
4  This option is not available in real-time mode if addresses are in user memory.
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break

This command causes the emulator to leave user program execution and begin
executing in the monitor.

The behavior of break depends on the state of the emulator:

running Break diverts the processor from execution of your
program to the emulation monitor.

reset Break releases the processor from reset, and diverts
execution to the monitor.

running in monitor The break command does not perform any operation while
the emulator is executing in the monitor.

See Also The reset, run , and step commands.
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bbaunld

This command is available when the HP Branch Validator product is installed.
This basis branch analyzer (BBA) product is used to analyze the testing of your
programs, create more complete test suites, and quantify your level of testing.

The HP Branch Validator records branches executed in a program and generates
reports that provide information about program execution during testing.  It uses a
special C preprocessor to add statements that write to a data array when program
branches are taken.  After running the program in the emulator (using test input),
you can use the bbaunload command to store the BBA information to a file.  Then,
you can generate reports based on the stored information.

See Also Refer to the HP Branch Validator (BBA) User’s Guide for complete details on the
bbaunload command syntax.
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cmb_execute

The cmb_execute command causes the emulator to emit an EXECUTE pulse on its
rear panel Coordinated Measurement Bus (CMB) connector. All emulators
connected to the CMB (including the one sending the CMB EXECUTE pulse) and
configured to respond to this signal will take part in the measurement.

See Also The specify run and specify trace commands.
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copy

Use this command with various parameters to save or print emulation and analysis
information.

The copy command copies selected information to your system printer or listing
file, or directs it to an UNIX process.
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Depending on the information you choose to copy, default values may be options
selected for the previous execution of the display command.  For example, if you
display memory locations 10h through 20h, then issue a copy memory to myfile
command, myfile will list only memory locations 10h through 20h.

The parameters are as follows:

data This allows you to copy a list of memory contents formatted in various data types
(see display data).

display This allows you to copy the display to a selected destination.

error_log This allows you to copy the most recent errors that occurred.

event_log This allows you to copy the most recent events that occurred.

<FILE> This prompts you for the name of a file where you want the specified information
to be copied.  If you want to specify a file name that begins with a number, you
must precede the file name with a backslash.  For example: copy display to \12.10
<RETURN>

global_symbols This lets you copy a list of global symbols to the selected destination.

help This allows you to copy the contents of the emulation help files to the selected
destination.

<HELP_FILE> This represents the name of the help file to be copied. Available help file names are
displayed on the softkey labels.

UNIX CMD This represents an UNIX filter or pipe where you want to route the output of the
copy command.  UNIX commands must be preceded by an exclamation point (!).
An exclamation point following the UNIX command continues command line
execution after the UNIX command executes.  Emulation is not affected when
using an UNIX command that is a shell intrinsic.

local_symbols_in This lets you copy all the children of a given symbol to the selected destination.
See the --SYMB-- syntax page and the Symbolic Retrieval Utilities User’s Guide
for information on symbol hierarchy.

memory This allows you to copy a list of the contents of memory to the selected destination.

noappend This causes any copied information to overwrite an existing file with the same
name specified by <FILE>.  If this option is not selected, the default operation is to
append the copied information to the end of an existing file with the same name
that you specify.
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noheader This copies the information into a file without headings.

pod_command This allows you to copy the most recent commands sent to the HP 64700 Series
emulator/analyzer.

printer This option specifies your system printer as the destination device for the copy
command.  Before you can specify the printer as the destination device, you must
define PRINTER as a shell variable. For example, you could enter the text shown
below after the "$" symbol:

$ PRINTER=lp 
$ export PRINTER

If you don’t want the print message to overwrite the command line, execute:

$ set PRINTER = "lp -s"

registers This allows you to copy a list of the contents of the emulation processor registers to
the selected destination.

software
_breakpoints

This option lets you copy a list of the current software breakpoints to a selected
destination.

status This allows you to copy emulation and analysis status information.

to This allows you to specify a destination for the copied information.

trace This lets you copy the current trace listing to the selected destination.

! An exclamation point specifies the delimiter for UNIX commands.  An exclamation
point must precede all UNIX commands.  A trailing exclamation point should be
used if you want to return to the command line and specify noheader.  Otherwise,
the trailing exclamation point is optional.  If an exclamation point is part of the
UNIX command, a backslash (\) must precede the exclamation point.

Examples See the following pages on various copy syntax diagrams.

See Also See the following pages on various copy syntax diagrams.
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copy local_symbols_in

This command lets you copy local symbols contained in a source file and relative
segments (program, data, or common) to the selected destination.

Local symbols are symbols that are children of the particular file or symbol defined
by --SYMB--, that is, they are defined in that file or scope.

For additional information on symbols, refer to the --SYMB-- syntax pages and the
Symbolic Retrieval Utilities User’s Guide.

--SYMB-- is the current working symbol.

The parameters are as follows:

--SYMB-- This option represents the symbol whose children are to be listed.  See the
--SYMB-- syntax diagram and the Symbolic Retrieval Utilities User’s Guide for
information on symbol hierarchy.

Examples
copy local_symbols_in  mod_name to printer  <RETURN>

copy local_symbols_in  mod_name: to  linenumfile <RETURN>

See Also The display local_symbols_in command.
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copy memory

This command copies the contents of a memory location or series of locations to
the specified output.

The memory contents are copied in the same format as specified in the last display
memory command.

Contents of memory can be displayed if program runs are not restricted to
real-time.  Memory contents are listed as an asterisk (*) under the following
conditions:

1 The address refers to guarded memory.

2 Runs are restricted to real-time, the emulator is running a user program, and
the address is located in user memory.

Values in emulation memory can always be displayed.

Initial values are the same as those specified by the command display memory 0
blocked bytes offset_by 0.

Defaults are to values specified in the previous display memory command.
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The parameters are as follows:

--EXPR-- An expression is a combination of numeric values, symbols, operators, and
parentheses, specifying a memory address or offset value.  See the EXPR syntax
diagram.

FCODE The function code used to define the address space being referenced. See the syntax
diagram for FCODE to see a list of the function codes available and for an
explanation of those codes.

, A comma used immediately after memory in the command line appends the
current copy memory command to the preceding display memory command.  The
data specified in both commands is copied to the destination specified in the current
command.  Data is formatted as specified in the current command.  The comma is
also used as a delimiter between values when specifying multiple memory
addresses.

Examples
copy memory  start to  printer  <RETURN>

copy memory  0 thru  100h , start thru  +5 , 500H ,
target2 to  memlist <RETURN>

copy memory  2000h thru  204fh to  memlist <RETURN>

See Also The display memory, modify memory, and store memory commands.
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copy registers

This command copies the contents of the processor registers to a file or printer.

The copy register process does not occur in real-time.  The emulation system must
be configured for nonreal-time operation to list the registers while the processor is
running.

With no options specified, the basic register class is copied. This includes the local
and global registers.

The parameters are as follows:

<CLASS> Specifies a particular class of the emulator registers.

<REGISTER>

Examples
copy registers  global to printer  <RETURN>

copy registers to  reglist <RETURN>

See Also The display registers and modify registers commands.
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copy trace

This command copies the contents of the trace buffer to a file or to the printer.

Trace information is copied in the same format as specified in the last display trace
command.

Initial values are the same as specified by the last display trace command.

The parameters are as follows:

from_line_number This specifies the trace list line number from which copying will begin.

<LINE#> Use this with from_line_number and thru_line_number to specify the starting
and ending trace list lines to be copied.

thru_line_number Specifies the last line number of the trace list to include in the copied range.

Examples
copy trace to  tlist <RETURN>

copy trace from_line_number  0 thru_line_number  5 
to  longtrac <RETURN>

See Also The display trace and store trace commands.
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display

This command displays selected information on your screen.

You can use the <Up arrow>, <Down arrow>, <PREV>, and <NEXT> keys to
view the displayed information.  For software_breakpoints, data, memory, and trace
displays you can use the <CTRL>g and <CTRL>f keys to scroll left and right if the
information goes past the edge of the screen.

Depending on the information you select, defaults may be the options selected for
the previous execution of the display command.

The parameters are as follows:

data This allows you to display a list of memory contents formatted in various data types
(see the display data pages for details).

error_log This option displays the recorded list of error messages that occurred during the
emulation session.
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event_log This option displays the recorded list of events.

global_symbols This option lets you display a list of all global symbols in memory.

local_symbols_in This option lets you display all the children of a given symbol.  See the --SYMB--
syntax page and the Symbolic Retrieval Utilities User’s Guide for details on symbol
hierarchy.

memory This option allows you to display the contents of memory.

pod_command This option lets you display the output of previously executed emulator pod
commands.

registers This allows you to display the contents of emulation processor registers.

simulated_io This lets you display data written to the simulated I/O display buffer after you have
enabled polling for simulated I/O in the emulation configuration.

software
_breakpoints

This option lets you display the current list of software breakpoints.

status This displays the emulator and trace status.

trace This displays the current trace list.

Examples
display event_log  <RETURN>

display local_symbols_in  mod_name <RETURN>

See Also The copy command description and the following pages which describe the various
display commands.
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display data

The display data command can display the values of simple data types in your
program.  Using this command can save you time; otherwise, you would need to
search through memory displays for the location and value of a particular variable.

The address, identifier, and data value of each symbol may be displayed. You must
issue the command set symbols on to see the symbol names displayed.

In the first display data command after you begin an emulation session, you must
supply at least one expression specifying the data item(s) to display.

Thereafter, the display data command defaults to the expressions specified in the
last display data command, unless new expressions are supplied or appended (with
a leading comma).
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Symbols are normally set off until you give the command set symbols on.
Otherwise, only the address, data type, and value of the data item will be displayed.

The parameters are as follows:

, A leading comma allows you to append additional expressions to the previous
display data command.

Commas between expression/data type specifications allow you to specify multiple
variables and types for display with the current command.

--EXPR-- Prompts you for an expression specifying the data item to display.  The expression
can include various math operators and program symbols.  See the --EXPR-- and
--SYMB-- syntax pages for more information.

thru --EXPR-- Allows you to specify a range of addresses for which you want data display.
Typically, you use this to display the contents of an array.  You can display both
single-dimensioned and multi-dimensioned arrays.  Arrays are displayed in the
order specified by the language definition, typically row major order for most
Algol-like languages.

<TYPE> Specifies the format in which to display the information. (Data type information is
not available from the symbol database, so you must specify.)

byte Hex display of one 8 bit location.

word Hex display of one 16 bit location.

long Hex display of one 32 bit location.

Note that byte ordering in word and long displays is determined by the conventions
of the processor in use.

int8 Display of one 8 bit location as a signed integer using two’s complement notation.

int16 Display of two bytes as a signed integer using two’s complement notation.

int32 Display of four bytes as a signed integer using two’s complement notation.

u_int8 Display of one byte as an unsigned positive integer.

u_int16 Display of two bytes as an unsigned positive integer.

u_int32 Display of four bytes as an unsigned positive integer.

char Displays one byte as an ASCII character in the range 0 through 127. Control
characters and values in the range 128 through 255 are displayed as a period (.).
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Examples
display data  Msg_A thru  +17 char , Stack long  <RETURN>

set symbols on  <RETURN>

set width label  30 <RETURN>

display data  , Msg_B thru  +17 char , Msg_Dest thru  +17
char  <RETURN>

See Also The copy data and set commands.
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display global_symbols

This command displays the global symbols defined for the current absolute file.

Global symbols are symbols declared as global in the source file.  They include
procedure names, variables, constants, and file names.  When the display
global_symbols command is used, the listing will include the symbol name and its
logical address.

See Also The copy global_symbols command.
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display local_symbols_in

Displays the local symbols in a specified source file and their relative segment
(program, data, or common).

Local symbols of --SYMB-- are the ones which are children of the file and/or scope
specified by --SYMB--.  That is, they are defined in that file or scope.

See the --SYMB-- syntax pages and the Symbolic Retrieval Utilities User’s Guide
for further explanation of symbols.

Displaying the local symbols sets the current working symbol to the one specified.

The parameters are as follows:

--SYMB-- This option represents the symbol whose children are to be listed.  See the
--SYMB-- syntax diagram and the Symbolic Retrieval Utilities User’s Guide for
more information on symbol hierarchy and representation.

Examples
display local_symbols_in  mod_name <RETURN>

display local_symbols_in  mod_name:main <RETURN>

See Also The copy local_symbols_in command.
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display memory

This command displays the contents of the specified memory location or series of
locations.
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The memory contents can be displayed in mnemonic, hexadecimal, or real number
format.  In addition, the memory addresses can be listed offset by a value, which
allows the information to be easily compared to the program listing.

When displaying memory mnemonic and stepping, the next instruction that will
step is highlighted.  The memory mnemonic display autopages to the new address if
the next PC goes outside the currently displayed address range.  This feature works
even if stepping is performed in a different emulation window than the one
displaying memory mnemonic.

Pending software breakpoints are shown in the memory mnemonic display by an
asterisk (*) in the leftmost column of the assembly instruction or source line that
has a pending breakpoint.

A label column (symbols) may be displayed for all memory displays except
blocked mode.  Memory mnemonic may be displayed with source and assembly
code intermixed, or with source code only.  Symbols also can be displayed in the
memory mnemonic string.  (See the set command.)

Initial values are the same as specified by the command:

display memory  0 blocked bytes offset_by  0

Defaults are values specified in a previous display memory command.

The symbols and source defaults are:

set source off symbols off

The parameters are as follows:

absolute Formats the memory listing in a single column.

at_pc Displays the memory at the address pointed to by the current program counter value.

blocked Formats the memory listing in multiple columns.

bytes Displays the absolute or blocked memory listing as byte values.

--EXPR-- An expression is a combination of numeric values, symbols, operators, and
parentheses, specifying a memory address or memory offset value.  See the EXPR
syntax diagram.

Chapter 11: Emulator/Analyzer Interface Commands
display memory

355



FCODE The function code used to define the address space being referenced. See the syntax
diagram for FCODE to see a list of the function codes available and for an
explanation of those codes.

long Displays memory in a 64-bit real number format or 32-bit long words when
preceded by blocked or absolute.

mnemonic This causes the memory listing to be formatted in assembly language instruction
mnemonics with associated operands.  When specifying mnemonic format, you
should include a starting address that corresponds to the first byte of an operand to
ensure that the listed mnemonics are correct.  If set source only is on, you will see
only the high level language statements and corresponding line numbers.

offset_by This option lets you specify an offset that is subtracted from each of the absolute
addresses before the addresses and corresponding memory contents are listed.  You
might select the offset value so that each module appears to start at address 0000H.
The memory contents listing will then appear similar to the assembler or compiler
listing.

This option is also useful for displaying symbols and source lines in dynamically
relocated programs.

previous_display Returns to display associated with the previous mnemonic memory display
command.

real Formats memory values in the listing as real numbers.  (NaN in the display list
means "Not a Number.")

repetitively Updates the memory listing display continuously.  You should only use this to
monitor memory while running user code, since it is very CPU intensive.  To allow
updates to the current memory display whenever memory is modified, a file is
loaded, software breakpoint is set, etc., use the set update command.

short Formats the memory list as 32-bit real numbers.

thru This option lets you specify a range of memory locations to be displayed.  Use the
<Up arrow>, <Down arrow>, <NEXT>, and <PREV> keys to view additional
memory locations.

words Displays the absolute or blocked memory listing as 16-bit word values.

, A comma after memory in the command line appends the current display memory
command to the preceding display memory command.  The data specified in both
commands is displayed. The data will be formatted as specified in the current
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command.  The comma is also a delimiter between values when specifying multiple
addresses.

Examples You can display memory in real number and mnemonic formats:

display memory  2000h thru  202fh , 2100h real long
<RETURN>

display memory  400h mnemonic  <RETURN>

set symbols on  <RETURN> 
set source on  <RETURN> 
display memory main mnemonic  <RETURN>

See Also The copy memory, modify memory, set, and store memory commands.
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display registers

This command displays the current contents of the emulation processor registers.

If a step command just executed, the mnemonic representation of the last
instruction is also displayed, if the current display is the register display.  This
process does not occur in real-time. The emulation system must be configured for
nonreal-time operation to display registers while the processor is running.  Symbols
also may be displayed in the register step mnemonic string (see set symbols).

With no options specified, the basic register class is displayed as the default.  This
includes the local and global registers.

The parameters are as follows:

<CLASS> This allows you to display a particular class of emulation processor registers.

<REGISTER> This displays an individual register or control register field.

Examples
display registers  <RETURN>

display registers  BASIC D2 <RETURN>

See Also The copy registers, modify registers, set, and step commands.
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display simulated_io

This command displays information written to the simulated I/O display buffer.

After you have enabled polling for simulated I/O during the emulation
configuration process, six simulated I/O addresses can be defined. You then define
files used for standard input, standard output, and standard error.

For details about setting up simulated I/O, refer to the Simulated I/O User’s Guide.

Examples
display simulated_io  <RETURN>

See Also The modify configuration and modify keyboard_to_simio commands.
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display software_breakpoints

This command displays the currently defined software breakpoints and their status.

If the emulation session is continued from a previous session, the listing will
include any previously defined breakpoints.  The column marked "status" shows
whether the breakpoint is pending, inactivated, or unknown.

A pending breakpoint causes the processor to enter the emulation monitor upon
execution of that breakpoint.  Executed breakpoints are listed as inactivated.
Entries that show an inactive status can be reactivated by executing the modify
software_breakpoints set command.

A label column also may be displayed for addresses that correspond to a symbol.
See the set command for details.

The parameters are as follows:

--EXPR-- An expression is a combination of numeric values, symbols, operators, and
parentheses, specifying an offset value for the breakpoint address.  See the
--EXPR-- syntax diagram.

offset_by This option allows you to offset the listed software breakpoint address value from
the actual address of the breakpoint.  By subtracting the offset value from the
breakpoint address, the system can cause the listed address to match that given in
the assembler or compiler listing.

Examples
display software_breakpoints  <RETURN>

display software_breakpoints offset_by  1000H <RETURN>

See Also The copy software_breakpoints, modify software_breakpoints, and set
commands.
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display trace

This command displays the contents of the trace buffer.

Captured information can be presented as absolute hexadecimal values or in
mnemonic form. The processor status values captured by the analyzer can be listed
mnemonically or in hexadecimal or binary form.
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Addresses captured by the analyzer are physical addresses.

The offset_by option subtracts the specified offset from the addresses of the
executed instructions before listing the trace. With an appropriate entry for offset,
each instruction in the listed trace will appear as it does in the assembled or
compiled program listing.

The count parameter lists the time associated with a trace event either relative to
the previous event in the trace list or as an absolute count measured from the trigger
event.

The source parameter allows display of source program lines in the trace listing,
enabling you to quickly correlate the trace list with your source program.

Initial values are the same as specified by the command:

display trace mnemonic count relative offset_by  0
<RETURN>

The parameters are as follows:

absolute Lists trace information in hexadecimal format, rather than mnemonic opcodes.

count

   absolute This lists the time count for each event of the trace as the total time measured from
the trigger event.

   relative This lists the time count for each event of the trace as the time measured relative to
the previous event.

depth

 <DEPTH#> This defines the number of states to be uploaded by the interface.

Note that after you have changed the trace depth, execute the command wait
measurement_complete before displaying the trace. Otherwise the new trace states
will not be available.

disassemble
_from_line
_number

Displays the trace at a certain line number and disassembles instruction opcodes.

--EXPR-- An expression is a combination of numeric values, symbols, operators, and
parentheses, specifying an offset value to be subtracted from the addresses traced
by the emulation analyzer. See the EXPR syntax diagram.
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external

   binary Displays the external analyzer trace list in binary format.

   <external
   _label>

This option displays a defined external analyzer label.

   hex Displays the external analyzer trace list in hexadecimal format.

   off Use this option to turn off the external trace list display.

   then This allows you to display multiple external analysis labels. This option appears
when more than one external analyzer label is in use.

<LINE#> This prompts you for the trace list line number to be centered in the display. Also,
you can use <LINE#> with disassemble_from_line_number. <LINE#> prompts
you for the line number from which the inverse assembler attempts to disassemble
data in the trace list.

mnemonic Lists trace information with opcodes in mnemonic format.

offset_by This option allows you to offset the listed address value from the address of the
instruction. By subtracting the offset value from the physical address of the
instruction, the system makes the listed address match that given in the assembler
or compiler listing.

This option is also useful for displaying symbols and source lines in dynamically
relocated programs.

Note that when using the set source only command, the analyzer may operate more
slowly than when using the set source on command. This is an operating
characteristic of the analyzer:

When you use the command set source on, and are executing only assembly
language code (not high-level language code), no source lines are displayed.
The trace list will then fill immediately with the captured assembly language
instructions.

When using set source only, no inverse assembled code is displayed.
Therefore, the emulation software will try to fill the display with high-level
source code. This requires the emulation software to search for any captured
analysis data generated by a high-level language statement.

In conclusion, you should not set the trace list to set source only  when tracing
assembly code. This will result in optimum analyzer performance.
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status

   binary Lists absolute status information in binary form.

   hex Lists absolute status information in hexadecimal form.

   mnemonic Lists absolute status information in mnemonic form.

Examples
display trace count absolute  <RETURN>

display trace absolute status binary  <RETURN>

display trace mnemonic  <RETURN>

See Also The copy trace, store trace, and set commands.
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end

This command terminates the current emulation session.

You can end the emulation session and keep the emulator in a locked state.  The
current emulation configuration is stored, so that you can continue the emulation
session on reentry to the emulator. You also can release the emulation system when
ending the session so that others may use the emulator.

Note that pressing <CTRL>d performs the same operation as pressing end
<RETURN>.  Pressing <CTRL>\ or <CTRL>| performs the same as end
release_system <RETURN>.

When the emulation session ends, control returns to the UNIX shell without
releasing the emulator.

The parameters are as follows:

locked This option allows you to stop all active instances of an emulator/analyzer interface
session in one or more windows and/or terminals.  This option is not available
when operating the emulator in the measurement system.

release_system This option stops all instances of the emulator/analyzer interface in one or more
windows or terminals.  The emulation system is released for other users.  If you do
not release the emulation system when ending, others cannot access it.

Examples
end  <RETURN>

end release_system  <RETURN>

See Also The "Exiting the Emulator/Analyzer Interface" section in the "Starting and Exiting
HP 64700 Interfaces" chapter.
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--EXPR--

An expression is a combination of numeric values, symbols, operators, and
parentheses used to specify address, data, status, executed address, or any other
value used in the emulation commands.

The function of an expression (--EXPR--) is to let you define the address, data,
status, or executed address expression that fits your needs.  You can combine
multiple values to define the expression.

Certain emulation commands will allow the option of <+EXPR> after pressing a
thru softkey.  This allows you to enter a range without retyping the original base
address or symbol.  For example, you could specify the address range

disp_buf  thru disp_buf + 25

as

disp_buf  thru +25

The parameters are as follows:

DON’T CARE 
NUMBER

You can include "don’t care numbers" in expressions. These are indicated by a
number containing an "x." These numbers may be defined as binary, octal, decimal,
or hexadecimal. For example: 1fxxh, 17x7o, and 011xxx10b are valid.

Note that "Don’t care numbers" are not valid for all commands.

--NORMAL-- This appears as a softkey label to enable you to return to the --EXPR-- key.  The
--NORMAL--  label can be accessed whenever defining an expression, but is only
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valid when "C" appears on the status line, which indicates a valid expression has
been defined.

<NUMBER> This can be an integer in any base (binary, octal, decimal, or hexadecimal), or can
be a string of characters enclosed with quotation marks.

<OP> This represents an algebraic or logical operand and may be any of the following (in
order of precedence):

mod modulo

* multiplication

/ division

& logical AND

+ addition

- subtraction

| logical OR

--SYMB-- This allows you to define symbolic information for an address, range of addresses,
or a file.  See the --SYMB-- syntax pages and the Symbolic Retrieval Utilities
User’s Guide for more information on symbols.

   end This displays the last location where the symbol information may be located.  For
example, if a particular symbol is associated with a range of addresses, end will
represent the last address in that range.

   start This displays first memory location where the symbol you specify may be located.
For example, if a particular symbol is associated with a range of addresses, start
will represent the first address in that range.

<UNARY> This defines either the algebraic negation (minus) sign (-) or the logical negation
(NOT) sign (~).

(  ) Parentheses may be used in expressions to enclose numbers. For every opening
parenthesis, a closing parenthesis must exist.

Note that when "C" appears on the right side of the status line, a valid expression
exists.  The --NORMAL--  key can be accessed at any time, but is only valid when
"C" is on the command line.

Note that when a thru  softkey has been entered, a <+ EXPR> prompt appears.
This saves you from tedious repeated entry of long symbols and expressions.  For
example:
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disp_buf thru  +25

is the same as

disp_buf thru  disp_buf + 25

Examples
05fxh

0ffffh

disp_buf + 5

symb_tbl + (offset / 2)

start

mod_name: line 15 end

See Also The SYMB syntax description.
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FCODE

The function code is used to define the address space being referenced.  Select the
appropriate function code from those listed below.

d Data space.

none Causes the emulator to ignore the function code bits.

p Program space.

s Supervisor space.

sd Supervisor data space.

sp Supervisor program space.

u User space.

ud User data space.

up User program space.
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Examples To copy a portion of user data memory to a file:

copy memory fcode ud 1000H thru  1fffH to mymem <RETURN>

To modify a location in program memory:

modify memory fcode p 5000h long to 12345678h <RETURN>
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forward

This command lets you forward commands to other HP 64700 interfaces that use
the "emul700dmn" daemon process to coordinate actions between the interfaces.

bms Sends messages to the Broadcast Message Server or BMS.

<COMMAND> An ASCII string, enclosed in quotes, that is the command to be forwarded to the
named interface.

debug Forwards command to the high-level debugger interface.

emul Forwards command to the emulator/analyzer interface.

perf Forwards commands to the software performance analyzer interface.

<UINAME> Forwards commands to a user interface name other than those available on the
softkeys.

Examples To send the "Program Run" command to the debugger:

forward debug  "Program Run" <RETURN>

To send the "profile" command to the software performance analyzer:

forward debug  "profile" <RETURN>

See Also The User’s Guide for the interface to which you are forwarding commands.
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help

Displays information about system and emulation features during an emulation
session.

Typing help or ? displays softkey labels that list the options on which you may
receive help.  When you select an option, the system will list the information to the
screen.

The help command is not displayed on the softkeys.  You must enter it into the
keyboard.  You may use a question mark in place of help to access the help
information.

The parameters are as follows:

<HELP_FILE> This represents one of the available options on the softkey labels.  You can either
press a softkey representing the help file, or type in the help file name.  If you are
typing in the help file name, make sure you use the complete syntax.  Not all of the
softkey labels reflect the complete file name.

Examples
help system_commands  <RETURN>

? run  <RETURN>

This is a summary of the commands that appear on the softkey labels when you
type help or press ?:

system_commands
run
trace
step
break
display
modify
load
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store
copy
reset
stop_trace
end
software_breakpoints
registers
expressions (--EXPR--)
symbols (--SYMB--)
specify
cmb
cmb_execute
map
set
wait
pod_command
bbaunload
coverage
performance_measurement_initialize
performance_measurement_run
performance_measurement_end
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load

This command transfers absolute files from the host computer into emulation or
target system RAM.  With other parameters, the load command can load emulator
configuration files, trace records, trace specifications, or symbol files.

The absolute file contains information about where the file is stored.  The memory
map specifies that the locations of the file are in user (target system) memory or
emulation memory.  This command also allows you to access and display
previously stored trace data, load a previously created configuration file, and load
absolute files with symbols.

Note that any file specified by <FILE> cannot be named "configuration",
"emul_mem", "user_mem", "symbols", "trace", or "trace_spec" because these are
reserved words, and are not recognized by the emulator/analyzer interface as
ordinary file names.

The absolute file is loaded into emulation memory by default.
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The parameters are as follows:

configuration This option specifies that a previously created emulation configuration file will be
loaded into the emulator.  You can follow this option with a file name.  Otherwise
the previously loaded configuration will be reloaded.

emul_mem Loads only those portions of the absolute file that reside in memory ranges mapped
as emulation memory.

<FILE> This represents the absolute file to be loaded into either target system memory,
emulation memory (.X files are assumed), or the trace memory (.TR files are
assumed).

noabort This option allows you to load a file even if part of the file is located at memory
mapped as "guarded" or "target ROM" (trom).

nosymbols This option causes the file specified to be loaded without symbols.

noupdate This option suppresses rebuilding of the symbol data base when you load an
absolute file.  If you load an absolute file, end emulation, then modify the file (and
relink it), the symbol database will not be updated upon reentering emulation and
reloading the file. The default is to rebuild the database.

symbols This option causes the file specified to be loaded with symbols.

trace This option allows you to load a previously generated trace file.

trace_spec This option allows you to load a previously generated trace specification.

Note that the current trace specification will be modified, but a new trace will not
be started.  To start a trace with the newly loaded trace specification, enter trace
again or specify trace again (not trace).  If you specify trace, a new trace will
begin with the default trace specification, not the one you loaded.

user_mem Loads only those portions of the absolute file that reside in memory ranges mapped
as target memory.

Examples
load  sort1 <RETURN>

load configuration  config3 <RETURN>

See Also The display trace command.
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log_commands

This command allows you to record commands that are executed during an
emulation session.

Commands executed during an emulation session are stored in a file until this
feature is turned off.  This is a handy method for creating command files.

To execute the saved commands after the file is closed, type the filename on the
command line.

The parameters are as follows:

<FILE> This represents the file where you want to store commands that are executed during
an emulation session.

noappend If the named file is an existing file, this option causes the new commands to
overwrite any information present in the file. If this option is not specified, new
commands are appended to the existing contents of the file.

off This option turns off the capability to log commands.

to This allows you to specify a file for the logging of commands.

Examples
log_commands  to  logfile <RETURN>

log_commands  off  <RETURN>

See Also The wait command.
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modify

This command allows you to observe or change information specific to the
emulator.

The modify command is used to:

• Modify contents of memory (as integers, strings, or real numbers).

• Modify the contents of the processor registers.

• View or edit the current emulation configuration.

• Modify the software breakpoints table.

The following pages contain detailed information about the various modify syntax
diagrams.
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modify configuration

This command allows you to view and edit the current emulation configuration
items.

The configuration questions are presented in sequence with either the default
response, or the previously entered response.  You can select the currently
displayed response by pressing <RETURN>. Otherwise, you can modify the
response as you desire, then press <RETURN>.

The default responses defined on powerup are displayed.

Examples
modify configuration  <RETURN>

See Also The load configuration command.
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modify keyboard_to_simio

This command allows the keyboard to interact with your program through the
simulated I/O software.

When the keyboard is activated for simulated I/O, its normal interaction with
emulation is disabled.  The emulation softkeys are blank and the softkey labeled
"suspend" is displayed on your screen.  Pressing suspend <RETURN> will
deactivate keyboard simulated I/O and return the keyboard to normal emulation
mode.  For details about setting up simulated I/O, refer to the Simulated I/O User’s
Guide.

See Also The display simulated_io command.
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modify memory

This command lets you modify the contents of selected memory locations.

You can modify the contents of individual memory locations to individual values.
Or, you can modify a range of memory to a single value or a sequence of values.

Modify a series of memory locations by specifying the address of the first location
in the series to be modified, and the values to which the contents of that location
and successive locations are to be changed. The first value listed will replace the
contents of the first memory location.  The second value replaces the contents of
the next memory location in the series, and so on, until the list is exhausted.  When
more than one value is listed, the value representations must be separated by
commas.  (See the examples for more information.)
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A range of memory can be modified such that the content of each location in the
range is changed to the single specified value, or to a single or repeated sequence.
This type of memory modification is done by entering the limits of the memory
range to be modified (--EXPR-- thru --EXPR--) and the value or list of values
(--EXPR--, ...  , --EXPR--) to which the contents of all locations in the range are to
be changed.

Note that if the specified address range is not large enough to contain the new data,
only the specified addresses are modified.

If the address range contains an odd number of bytes and a word operation is being
executed, the last word of the address range will be modified. Thus the memory
modification will stop one byte after the end of the specified address range.

If an error occurs in writing to memory (to guarded memory or target memory with
no monitor) the modification is aborted at the address where the error occurred.

For integer memory modifications, the default is to the current display memory
mode, if one is in effect.  Otherwise the default is to "byte."

For real memory modifications, the default is to the current display memory mode,
if one is in effect.  Otherwise the default is "word."

The parameters are as follows:

bytes Modify memory in byte values.

--EXPR-- An expression is a combination of numeric values, symbols, operators, and
parentheses, specifying a memory address.  See the EXPR syntax diagram.

FCODE The function code used to define the address space being referenced. See the syntax
diagram for FCODE to see a list of the function codes available and for an
explanation of those codes.

long Modify memory values as 32-bit long word values or 64-bit real values when
preceded by real.

real Modify memory as real number values.

<REAL#> This prompts you to enter a real number as the value.

short Modify memory values as 32-bit real numbers.

words Modify memory values as 16-bit values.

string Modify memory values to the ASCII character string given by <STRING>.
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<STRING> Quoted ASCII string including special characters as follows:

null \0

newline \n

horizontal tab \t

backspace \b

carriage return \r

form feed \f

backslash \\

single quote \’

bit pattern \ooo (where ooo is an octal number)

thru This option lets you specify a range of memory locations to be modified.

to This lets you specify values to which the selected memory locations will be
changed.

words Modify memory locations as 32-bit values.

, A comma is used as a delimiter between values when modifying multiple memory
addresses.

Examples
modify memory  data1 bytes to  0E3H , 01H , 08H <RETURN>

modify memory  data1 thru  DATA100 to  0FFFFH <RETURN>

modify memory  0675H real to  -1.303 <RETURN>

modify memory  temp real long to  0.5532E-8 <RETURN>

modify memory  buffer string  to  "Test \n\0" <RETURN>

See Also The copy memory, display memory, and store memory commands.
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modify register

This command allows you to modify the contents of the emulation processor
internal registers.

The entry you specify for <REGISTER> determines which register is modified.
Individual fields of control registers may be modified.

Register modification cannot be performed during real-time operation of the
emulation processor.  A break command or condition must occur before you can
modify the registers.

The parameters are as follows:

--EXPR-- An expression is a combination of numeric values, symbols, operators, and
parentheses, specifying a register value.  For the floating-point registers, the value
is interpreted as a decimal real number.  See the --EXPR-- description.

<REGISTER> This represents the name of a register.

to Allows you to specify the values to which the selected registers will be changed.

Examples
modify register  D2 to  41H <RETURN>

See Also The copy registers, display registers, and modify registers commands.
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modify software_breakpoints

This command changes the specification of software breakpoints.

Software breakpoints provide a way to accurately stop the execution of your
program at one or more instruction locations.  When a software breakpoint is set,
the instruction that is normally at that location is replaced with a TRAP instruction.
When the software breakpoint is executed, control is passed to the emulator’s
monitor program, and the original instruction is restored in the user program.  Thus,
execution is interrupted before the instruction at the specified address is executed.

Operation of the program can be resumed after the breakpoint is encountered, by
specifying either a run  or step command.

If you modify software breakpoints while the memory mnemonic display is active,
the new breakpoints are indicated by a "* " in the leftmost column of the instruction
containing the breakpoint.

The software breakpoint facility may be completely disabled or enabled via the
"modify software_breakpoints" command.  The default is "enabled".
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The parameters are as follows:

clear This option erases the specified breakpoint address. If no breakpoints are specified
in the command, all currently specified breakpoints are cleared.

disable This option turns off the software breakpoint capability.

enable This option allows you to modify the software breakpoint specification.

--EXPR-- An expression is a combination of numeric values, symbols, operators, and
parentheses, specifying a software breakpoint address. See the EXPR syntax
diagram.

permanent Sets a permanent breakpoint.  The software breakpoint instruction remains in the
program until the breakpoint is inactivated or removed.

set This option allows you to activate software breakpoints in your program.  If no
breakpoint addresses are specified in the command, all breakpoints that have been
inactivated (executed) are reactivated.

temporary Sets a temporary breakpoint.  When the break occurs, the original opcode is
replaced in the program.

, A comma is used as a delimiter between specified breakpoint values.

Examples
modify software_breakpoints enable  <RETURN>

modify software_breakpoints set  loop1 end , loop2 end ,
0E40H <RETURN>

modify software_breakpoints clear  <RETURN>

modify software_breakpoints set  <RETURN>

See Also The copy software_breakpoints, display memory mnemonic, and display
software_breakpoints commands.
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performance_measurement_end

This command stores data previously generated by the
performance_measurement_run command, in a file named "perf.out" in the
current working directory.

The file named "perf.out" is overwritten each time this command is executed.
Current measurement data existing in the emulation system is not altered by this
command.

Examples
performance_measurement_end  <RETURN>

See Also The performance_measurement_initialize and performance_measurement_run
commands.

Refer to the "Making Software Performance Measurements" chapter for examples
of performance measurement specification and use.
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performance_measurement_initialize

This command sets up performance measurements.

The emulation system will verify whether a symbolic database has been loaded.  If
a symbolic database has been loaded, the performance measurement is set up with
the addresses of all global procedures and static symbols. If a valid database has not
been loaded, the system will default to a predetermined set of addresses, which
covers the entire emulation processor address range.

The measurement will default to "activity" mode.

Default values will vary, depending on the type of operation selected, and whether
symbols have been loaded.

The parameters are as follows:

activity This option causes the performance measurement process to operate as though an
option is not specified.
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duration This option sets the measurement mode to "duration." Time ranges will default to a
predetermined set (unless a user-defined file of time ranges is specified).

<FILE> This represents a file you specify to supply user-defined address or time ranges to
the emulator.

global_symbols This option specifies that the performance measurement will be set up with the
addresses of all global symbols and procedures in the source program.

local_symbols_in This causes addresses of the local symbols to be used as the default ranges for the
measurement.

restore This option restores old measurement data so that a measurement can be continued
when using the same trace command as previously used.

--SYMB-- This represents the source file that contains the local symbols to be listed.  This also
can be a program symbol name, in which case all symbols that are local to a
function or procedure are used. See the SYMB syntax diagram.

Examples
performance_measurement_initialize  <RETURN>

performance_measurement_initialize  duration <RETURN>

performance_measurement_initialize local_symbols_in
mod_name <RETURN>

See Also The performance_measurement_run and performance_measurement_end
commands.

Refer to the "Making Software Performance Measurements" chapter for examples
of performance measurement specification and use.
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performance_measurement_run

This command begins a performance measurement.

This command causes the emulation system to reduce trace data contained in the
emulation analyzer, which will then be used for analysis by the performance
measurement software.

The default is to process data presently contained in the analyzer.

The parameters are as follows:

<COUNT> This represents the number of consecutive traces you specify. The emulation
system will execute the trace command, process the resulting data, and combine it
with existing data.  This sequence will be repeated the number of times specified by
the COUNT option.

Note that the trace command must be set up correctly for the requested
measurement.  For an activity measurement, you can use the default trace
command (trace <RETURN>).

For a duration measurement, you must set up the trace specification to store only
the points of interest.  To do this, for example, you could enter:

trace only  <symbol_entry> or  <symbol_exit>

Examples
performance_measurement_run  10 <RETURN>

performance_measurement_run  <RETURN>

See Also The performance_measurement_end and performance_measurement_initialize
commands.
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Refer to the "Making Software Performance Measurements" chapter for examples
of performance measurement specification and use.
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pod_command

Allows you to control the emulator through the direct HP 64700 Terminal Interface.

The HP 64700 Card Cage contains a low-level Terminal Interface, which allows
you to control the emulator’s functions directly.  You can access this interface
using pod_command.  The options to pod_command allow you to supply only
one command at a time. Or, you can select a keyboard mode which gives you
interactive access to the Terminal Interface.

There are certain commands that you should avoid while using the Terminal
Interface through pod_command.

stty, po, xp Do not use.  These commands will change the operation of the
communications channel, and are likely to hang the Softkey
Interface and the channel.

echo, mac Using these may confuse the communications protocols in use
on the channel.

wait Do not use.  The pod will enter a wait state, blocking access by
the emulator/analyzer interface.

init, pv These will reset the emulator pod and force an end
release_system command.

t Do not use.  The trace status polling and unload will become
confused.

To see the results of a particular pod_command (the information returned by the
emulator pod), you use display pod_command.

Refer to the 68000 Emulator User’s Guide for the Terminal Interface for
information on using the Terminal Interface to control the emulator.
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The parameters are as follows:

keyboard Enters an interactive mode where you can simply type Terminal Interface
commands (unquoted) on the command line.  Use display pod_command to see
the results returned from the emulator.

<POD_CMD> Prompts you for a Terminal Interface command as a quoted string.  Enter the
command in quotes and press <RETURN>.

suspend This command is displayed once you have entered keyboard mode.  Select it to stop
interactive access to the Terminal Interface and return to the Graphical User
Interface or Softkey Interface.

Examples This example shows a simple interactive session with the Terminal Interface.

display pod_command  <RETURN>

pod_command keyboard  <RETURN>

cf <RETURN>

tsq <RETURN>

tcq <RETURN>

Enter suspend to return to the Graphical User Interface or Softkey Interface.

See Also The display pod_command command.

Also see the 68000 Emulator User’s Guide for the Terminal Interface and the
Terminal Interface on-line help information.
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QUALIFIER

The QUALIFIER  parameter is used with trace only, trace prestore, and
TRIGGER  to specify states captured during the trace measurement.

You may specify a range of states (RANGE) or specific states (STATE) to be
captured.  You can continue to "or" states until the analyzer resources are depleted.
You can use only one RANGE statement in the entire trace command.

You can include "don’t care numbers." These contain an "x" preceded and/or
followed by a number.  Some examples include 1fxxh, 17x7o, and 011xxx10b.
"Don’t care numbers" may be entered in binary, octal, or hexadecimal base.

The default is to qualify on all states.

The parameters are as follows:

or This option allows you to specify multiple states (STATE) to be captured during a
trace measurement.  See the STATE syntax diagram.

RANGE This allows you to specify a range of states to be captured during a trace
measurement.  See the RANGE syntax diagram.

STATE This represents a unique state that can be a combination of address, data, status, and
executed address values.  See the STATE syntax diagram.

Examples
trace only address  mod_name:read_input <RETURN>

trace only address range  mod_name:read_input thru
output <RETURN>
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trace only address range  mod_name:clear thru  read_input
<RETURN>

See Also The trace command.
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RANGE

The RANGE parameter allows you to specify a condition for the trace
measurement, made up of one or more values.

The range option can be used for state qualifier labels. Range can only be used
once in a trace measurement.

Refer to the "Qualifying Trigger and Store Conditions" section in the "Using the
Emulation Analyzer" chapter for a list of the predefined values that can be assigned
to the status state qualifiers.

Expression types are "address" when none is chosen.

The parameters are as follows:

address The value following this softkey is searched for on the lines that monitor the
emulation processor’s address bus.

data The value following this softkey is searched for on the lines that monitor the
emulation processor’s data bus.

--EXPR-- An expression is a combination of numeric values, symbols, operators, and
parentheses, specifying an address, data, status, or executed address value.  See the
EXPR syntax diagram for details.

<external_label> This represents a defined external analyzer label.
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not This specifies that the analyzer search for the logical "not" of the specified range
(this includes any addresses not in the specified range).

range This indicates a range of addresses to be specified (--EXPR-- thru --EXPR--).

status The value following this softkey is searched for on the lines that monitor other
emulation processor signals.

thru This indicates that the following address expression is the upper address in a range.

Examples See the trace command examples.

See Also The trace command and the QUALIFIER syntax description.
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reset

This command suspends target system operation and reestablishes initial emulator
operating parameters, such as reloading control registers.

The reset signal is latched when the reset command is executed and released by
either the run  or break command.

See Also The break and run  commands.
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run

This command causes the emulator to execute a program.

If the processor is in a reset state, run  will cause the reset to be released.

If the emulator is configured to run directly into user code out of reset, the monitor
will not be entered and part of your debug environment may be temporarily
disabled.  A subsequent break into the monitor will restore it. See the "Enter
monitor from reset?" question in the configuration menu for more information.

If the from  parameter and an address is specified, the processor will start running
your program at that address. Otherwise, the run will occur from the address
currently stored in the processor’s program counter.

A run from reset command will reset the processor and then allow it to run.  It is
equivalent to entering a reset command followed by a run  command.

If the emulator is configured to participate in the READY signal on the CMB, then
this emulator will release the READY signal so that it will go TRUE if all other
HP 64700 emulators participating on that signal are also ready.  See the
cmb_execute command description.

Qualifying a run command with an until  parameter causes a software breakpoint to
be set before the program is run.

If you omit the address option (--EXPR--), the emulator begins program execution
at the current address specified by the emulation processor program counter.  If an
absolute file containing a transfer address has just been loaded, execution starts at
that address.

The parameters are as follows:
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address Specifies an address for a temporary register breakpoint that will be programmed
into one of the processor’s two breakpoint registers.  Up to two addresses may be
specified.

--EXPR-- An expression is a combination of numeric values, symbols, operators, and
parentheses, specifying a memory address.  See the EXPR syntax diagram.

FCODE The function code used to define the address space being referenced. See the syntax
diagram for FCODE to see a list of the function codes available and for an
explanation of those codes.

from This specifies the address from which program execution is to begin.

reset This option resets the processor prior to running.

transfer_address This represents the starting address of the program loaded into emulation or target
memory.  The transfer address is defined in the linker map and is part of the symbol
database associated with the absolute file.

until Causes a software breakpoint to be set at the specified address before the program
is run.

Examples
run  <RETURN>

run from  810H <RETURN>

run from  COLD_START <RETURN>

run from transfer_address until  910H <RETURN>

See Also The step command.
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SEQUENCING

Lets you specify complex branching activity that must be satisfied to trigger the
analyzer.

Sequencing provides you with parameters for the trace command that let you
define branching conditions for the analyzer trigger.

You are limited to a total of seven sequence terms, including the trigger, if no
windowing specification is given.  If windowing is selected, you are limited to a
total of four sequence terms.

The analyzer default is no sequencing terms.  If you select the sequencer using the
find_sequence parameter, you must specify at least one qualifying sequence term.

The parameters are as follows:

find_sequence Specifies that you want to use the analysis sequencer. You must enter at least one
qualifier.

QUALIFIER Specifies the address, data, status, or executed address value or value range that will
satisfy this sequence term if looking for a sequence (find_sequence), or will restart
at the beginning of the sequence (restart).  See the QUALIFIER syntax pages for
further information.
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occurs Selects the number of times a particular qualifier must be found before the analyzer
proceeds to the next sequence term or the trigger term.  This option is not available
when trace windowing is in use.  See the WINDOW  syntax pages.

<#TIMES> Prompts you for the number of times a qualifier must be found.

then Allows you to add multiple sequence terms, each with its own qualifier and
occurrence count.

restart Selects global restart.  If the analyzer finds the restart qualifier while searching for a
sequence term, the sequencer is reset and searching begins for the first sequence
term.

Examples
trace find_sequence  Caller_3 then  Write_Num restart
anly."anly.c": line 57 trigger after  Results+0c4h
<RETURN>

See Also The trace command and the QUALIFIER and WINDOW syntax descriptions.
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set

Chapter 11: Emulator/Analyzer Interface Commands
set

402



Controls the display format for the data, memory, register, software breakpoint, and
trace displays.With the set command, you can adjust the display format results for
various measurements, making them easier to read and interpret.  Formatting of
source lines, symbol display selection and width, and update after measurement can
be defined to your needs.

The display command uses the set command specifications to format measurement
results for the display window.  Another option to the set command, <ENV_VAR>
= <VALUE> , allows you to set and export system variables to the UNIX
environment.

The default display format parameters are the same as those set by the commands:

set update

set source off symbols off

You can return the display format to this state by entering:

set default

The parameters are as follows:

default This option restores all the set options to their default settings.

<ENV_VAR> Specifies the name of a UNIX environment variable to be set.

= The equals sign is used to equate the <ENV_VAR> parameter to a particular value
represented by <VALUE>.

inverse video

   off This displays source lines in normal video.

   on This highlights the source lines on the screen (dark characters on light background)
to differentiate the source lines from other data on the screen.
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langinfo In certain languages, you may have symbols with the same names but different
types.  For example, in IEEE695, you may have a file named main.c and a
procedure named main.  SRU would identify these as main(module) and
main(procedure).  The command display local_symbols_in main would cause an
error message to appear (Ambiguous symbol: main(procedure, module)).  Users of
C tend to think the procedure is important and users of ADA tend to think the
module is important.  By entering "langinfo" and "C", SRU will interpret the above
command to be main(procedure).  With langinfo ADA, SRU will interpret the
above command to be main(module).

   C Identifies ANSI C as the language so SRU can use the C hierarchy to disambiguate
symbols.

   ADA Identifies ADA as the language so SRU can use the ADA hierarchy to
disambiguate symbols.

   C_IEE695 Identifies C_IEEE-695 as the language so SRU can use the C_IEEE-695 hierarchy
to disambiguate symbols.

Note An alternate method for making the langinfo specification is to use the environment
variable, HP64SYMORDER.  By making the following entry in your .profile, the
langinfo setting will always be C, for example.

$ HP64SYMORDER=C   # I want to use the C disambiguating
                   # hierarchy
$ export HP64SYMORDER   # let children processes know
                        # about it

memory Sets update option for memory displays only.

noupdate When using multiple windows or terminals, and specifying this option, the display
buffer in that window or terminal will not update when a new measurement
completes.  Displays showing memory contents are not updated when a command
executes that could have caused the values in memory to change (modify memory,
load, etc.).

number_of_
source_lines

This allows you to specify the number of source lines displayed for the actual
processor instructions with which they correlate.  Only source lines up to the
previous actual source line will be displayed. Using this option, you can specify
how many comment lines are displayed preceding the actual source line.  The
default value is 5.
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   <NUMSRC> This prompts you for the number of source lines to be displayed. Values in the
range 1 through 50 may be entered.

source

   off This option prevents inclusion of source lines in the trace and memory mnemonic
display lists.

   on This option displays source program lines preceding actual processor instructions
with which they correlate.  This enables you to correlate processor instructions with
your source program code. The option works for both the trace list and memory
mnemonic displays.

   only This option displays only source lines.  Processor instructions are only displayed in
memory mnemonic if no source lines correspond to the instructions.  Processor
instructions are never displayed in the trace list.

symbols

   off This prevents symbol display.

   on This displays symbols.  This option works for the trace list, memory, software
breakpoints, and register step mnemonics.

   high Displays only high level symbols, such as those available from a compiler.  See the
Symbolic Retrieval Utilities User’s Guide for a detailed discussion of symbols.

   low Displays only low level symbols, such as those generated internally by a compiler,
or an assembly symbol.

   all Displays all symbols.

tabs_are This option allows you to define the number of spaces inserted for tab characters in
the source listing.

   <TABS> Prompts you for the number of spaces to use in replacing the tab character.  Values
in the range of 2 through 15 may be entered.

trace Sets update option for trace displays only.

update When using multiple windows or terminals, and specifying this option, the display
buffer in that window or terminal will be updated when a new measurement
completes.  This is the default.  Note that for displays that show memory contents,
the values will be updated when a command executes that changes memory
contents (such as modify memory, load, and so on).
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<VALUE> Specifies the logical value to which a particular UNIX environment variable is to
be set.

width

   source This allows you to specify the width (in columns) of the source lines in the memory
mnemonic display.  To adjust the width of the source lines in the trace display,
increase the widths of the label and/or mnemonic fields.

   label This lets you specify the address width (in columns) of the address field in the trace
list or label (symbols) field in any of the other displays.

   mnemonic This lets you specify the width (in columns) of the mnemonic field in memory
mnemonics, trace list and register step mnemonics displays.  It also changes the
width of the status field in the trace list.

   symbols This lets you specify the maximum width of symbols in the mnemonic field of the
trace list, memory mnemonic, and register step mnemonic displays.

   <WIDTH> This prompts you for the column width of the source, label, mnemonic, or symbols
field.

Note that <CTRL>f and <CTRL>g may be used to shift the display left or right to
display information which is off the screen.

Examples
set source on inverse_video on tabs_are  2 <RETURN>

set symbols on width label  30 mnemonic  20 <RETURN>

set  PRINTER = "lp -s" <RETURN>

set  HP64KSYMBPATH=".file1:proc1
.file2:proc2:code_block_1" <RETURN>

See Also The display data, display memory, display software_breakpoints, and display
trace commands.
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specify

This command prepares a run  or trace command for execution, and is used with
the cmb_execute command.

When you precede a run  or trace command with specify, the system does not
execute your command immediately.  Instead, it waits until until an EXECUTE
signal is received from the Coordinated Measurement Bus or until you enter a
cmb_execute command.

If the processor is reset and no address is specified, a cmb_execute command will
run the processor from the "reset" condition.

Note that the run  specification is active until you enter specify run disable.  The
trace specification is active until you enter another trace command without the
specify prefix.

The emulator will run from the current program counter address if no address is
specified in the command.
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The parameters are as follows:

disable This option turns off the specify condition of the run  process.

from

   --EXPR-- This is used with the specify run from command.  An expression is a combination
of numeric values, symbols, operators, and parentheses, specifying a memory
address.  See the EXPR syntax diagram.

   FCODE The function code used to define the address space being referenced. See the syntax
diagram for FCODE to see a list of the function codes available and for an
explanation of those codes.

  
transfer_address

This is used with the specify run from command, and represents the address from
which the program will begin running.

run This option specifies that the emulator will run from either an expression or from
the transfer address when a CMB EXECUTE signal is received.

TRACE This option specifies that a trace measurement will be taken when a CMB
EXECUTE signal is received.

until Specifies an address where program execution is to stop.  The emulator will set a
software breakpoint at this address and stop execution of your program when it
reaches this address and enter the monitor.

Examples
specify run from  START <RETURN>

specify trace after address  1234H <RETURN>

See Also The cmb_execute command.
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STATE

This parameter lets you specify a trigger condition as a unique combination of
address, data, status, and executed address values.

The STATE option is part of the QUALIFIER parameter to the trace command,
and allows you to specify a condition for the trace measurement.

Refer to the "Qualifying Trigger and Store Conditions" section in the "Using the
Emulation Analyzer" chapter for a list of the predefined values that can be assigned
to the status state qualifiers.
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The default STATE expression type is address.

The parameters are as follows:

address This specifies that the expression following is an address value.  This is the default,
and is therefore not required on the command line when specifying an address
expression.

and This lets you specify a combination of status and expression values when status is
specified in the state specification.

data The value following this softkey is searched for on the lines that monitor the
emulation processor’s data bus.

--EXPR-- An expression is a combination of numeric values, symbols, operators, and
parentheses, specifying an address, data, status, or executed address value.  See the
EXPR syntax diagram.

<external_label> This represents a defined external analyzer label.

not This specifies that the analyzer will search for the logical "not" of a specified state
(this includes any address that is not in the specified state).

status The value following this softkey is searched for on the lines that monitor other
emulation processor signals.

<STATUS> This prompts you to enter a status value in the command line.  Status values can be
entered from softkeys or typed into the keyboard.  Numeric values may be entered
using symbols, operators, and parentheses to specify a status value.  See the EXPR
syntax diagram.

Examples
trace before status write  <RETURN>

trace about address  1000H status write  <RETURN>

See the trace command examples.

See Also The trace command and the QUALIFIER syntax description.
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step

The step command allows sequential analysis of program instructions by causing
the emulation processor to execute a specified number of assembly instructions or
source lines.

You can display the contents of the processor registers, trace memory, and
emulation or target memory after each step command.

Source line stepping is implemented by single stepping assembly instructions until
the next PC is beyond the address range of the current source line.  When
attempting source line stepping on assembly code (with no associated source line),
stepping will complete when a source line is found.  Therefore, stepping only
assembly code may step forever. To abort stepping, press <CTRL>c.

When displaying memory mnemonic and stepping, the next instruction that will
step is highlighted.  The memory mnemonic display autopages to the new address if
the next PC goes outside of the currently displayed address range.  This feature
works even if stepping is performed in a different emulation window than one
displaying memory mnemonic.

If no value is entered for <NUMBER> times, only one step instruction is executed
each time you press <RETURN>.  Multiple instructions can be executed by holding
down the <RETURN> key.  Also, the default step is for assembly code lines, not
source code lines.
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If the from  address option (defined by --EXPR-- or transfer_address) is omitted,
stepping begins at the next program counter address.

The parameters are as follows:

--EXPR-- An expression is a combination of numeric values, symbols, operators, and
parentheses specifying a memory address.  See the EXPR syntax diagram.

FCODE The function code used to define the address space being referenced. See the syntax
diagram for FCODE to see a list of the function codes available and for an
explanation of those codes.

from Use this option to specify the address from which program stepping begins.

<NUMBER> This defines the number of instructions that will be executed by the step command.
The number of instructions to be executed can be entered in binary (B), octal (O or
Q), decimal (D), or hexadecimal (H) notation.

silently When you specify a number of steps, this option updates the register step
mnemonic only after stepping is complete.  This will speed up stepping of many
instructions.  The default is to update the register step mnemonic after each
assembly instruction (or source line) executes (if stepping is performed in the same
window as the register display).

transfer_address This represents the starting address of the program you loaded into emulation or
target memory.  The transfer_address is defined in the linker map.

source This option performs stepping on source lines.

Examples
step  <RETURN>

step from  810H <RETURN>

step  5 source  <RETURN>

step  20 silently  <RETURN>

step  4 from  main <RETURN>

See Also The display registers, display memory mnemonic, and set symbols commands.
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stop_trace

This command terminates the current trace and stops execution of the current
measurement.

The analyzer stops searching for trigger and trace states.  If trace memory is empty
(no states acquired), nothing will be displayed.

See Also The trace command.
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store

This command lets you save the contents of specific memory locations in an
absolute file.  You also can save trace memory contents in a trace file.

The store command creates a new file with the name you specify, if there is not
already an absolute file with the same name.  If a file represented by <FILE>
already exists, you must decide whether to keep or delete the old file.  If you
respond with yes to the prompt, the new file replaces the old one.  If you respond
with no, the store command is canceled and no data is stored.

The transfer address of the absolute file is set to zero.

The parameters are as follows:

--EXPR-- This is a combination of numeric values, symbols, operators, and parentheses,
specifying a memory address.  See the EXPR syntax diagram.

FCODE The function code used to define the address space being referenced. See the syntax
diagram for FCODE to see a list of the function codes available and for an
explanation of those codes.

<FILE> This represents a file name you specify for the absolute file identifier or trace file
where data is to be stored.  If you want to name a file beginning with a number, you

Chapter 11: Emulator/Analyzer Interface Commands
store

414



must precede the file name with a backslash (\) so the system will recognize it as a
file name.

memory This causes selected memory locations to be stored in the specified HP64000
format file with a .X extension.

thru This allows you to specify that ranges of memory be stored.

to Use this in the store memory command to separate memory locations from the file
identifier.

trace This option causes the current trace data to be stored in the specified file with a .TR
extension.

trace_spec This option stores the current trace specification in the specified file with a .TS
extension.

, A comma separates memory expressions in the command line.

Examples
store memory  800H thru  20FFH to  TEMP2 <RETURN>

store memory  EXEC thru  DONE to  \12.10 <RETURN>

store trace  TRACE <RETURN>

store trace_spec  TRACE <RETURN>

See Also The display memory, display trace, and load commands.
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--SYMB--
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This parameter is a symbolic reference to an address, address range, file, or other
value.

Note that if no default file was defined by executing the command display
local_symbols_in --SYMB--, or with the cws command, a source file name
(<FILE> ) must be specified with each local symbol in a command line.

Symbols may be:

• Combinations of paths, filenames, and identifiers defining a scope, or
referencing a particular identifier or location (including procedure entry and
exit points).

• Combinations of paths, filenames, and line numbers referencing a particular
source line.

• Combinations of paths, filenames, and segment identifiers identifying a
particular PROG, DATA or COMN segment or a user-defined segment.

The Symbolic Retrieval Utilities (SRU) handle symbol scoping and referencing.
These utilities build trees to identify unique symbol scopes.

If you use the SRU utilities to build a symbol database before entering the
emulation environment, the measurements involving a particular symbol request
will occur immediately.  If you then change a module and reenter the emulation
environment without rebuilding the symbol database, the emulation software
rebuilds the changed portions of the database in increments as necessary.

Further information regarding the SRU and symbol handling is available in the
Symbolic Retrieval Utilities User’s Guide.  Also refer to that manual for
information on the HP64KSYMBPATH  environment variable.

The last symbol specified in a display local_symbols_in --SYMB-- command, or
with the cws command, is the default symbol scope. The default is "none" if no
current working symbol was set in the current emulation session.

You also can specify the current working symbol by typing the cws command on
the command line and following it with a symbol name.  The pws command
displays the current working symbol on the status line.

Display memory mnemonic also can modify the current working symbol.
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The parameters are as follows:

<FILENAME> This is an UNIX path specifying a source file.  If no file is specified, and the
identifier referenced is not a global symbol in the executable file that was loaded,
then the default file is assumed (the last absolute file specified by a display
local_symbols_in command). A default file is only assumed when other parameters
(such as line) in the --SYMB-- specification expect a file.

line This specifies that the following numeric value references a line number in the
specified source file.

   <LINE#> Prompts you for the line number of the source file.

<IDENTIFIER> Identifier is the name of an identifier as declared in the source file.

SCOPE Scope is the name of the portion of the program where the specified identifier is
defined or active (such as a procedure block).

segment This indicates that the following string specifies a standard segment (such as
PROG, DATA, or COMN) or a user-defined segment in the source file.

<SEG_NAME> Prompts you for entry of the segment name.

(<TYPE>) When two identifier names are identical and have the same scope, you can
distinguish between them by entering the type (in parentheses). Do not type a space
between the identifier name and the type specification. The type will be one of the
following:

   filename Specifies that the identifier is a source file.

   module These refer to module symbols.  For Ada, they are packages. Other language
systems may allow user-defined module names.

   procedure Any procedure or function symbol.  For languages that allow a change of scope
without explicit naming, SRU assigns an identifier and tags it with type procedure.

   static Static symbols, which includes global variables.  The logical address of these
symbols will not change.

   task Task symbols, which are specifically defined by the processor and language system
in use.

: A colon is used to specify the UNIX file path from the line, segment, or symbol
specifier.  When following the file name with a line or segment selection, there
must be a space after the colon. For a symbol, there must not be a space after the
colon.
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Examples The following short C code example should help illustrate how symbols are
maintained by SRU and referenced in your emulation commands.

File /users/dave/control.c:
int *port_one;
main ()
{
int port_value;

  port_ptr = port_one;
  port_value = 10;

  process_port (port_ptr, port_value);
} /* end main */

File /system/project1/porthand.c:
#include "utils.c"

void process_port (int *port_num, int port_data)
{
static int i;
static int i2;

  for (i = 0; i <= 64; i++) {
    i2 = i * 2;
    *port_num = port_data + i2;
    delay();
      {
      static int i;
      i = 3;
      port_data = port_data + i;
      }
    }
} /* end of process_port */

File /system/project1/utils.c:
delay()
{
int i,j;
int waste_time;

  for (i = 0; i <= 256000; i++)
    for (j = 0; j <= 256000; j++)
      waste_time = 0;
} /* end delay */
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The symbol tree as built by SRU might appear as follows, depending on the object
module format and compiler used:

Note that SRU does not build tree nodes for variables that are dynamically
allocated on the stack at run-time, such as i and j within the delay () procedure.
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SRU has no way of knowing where these variables will be at run time and therefore
cannot build a corresponding symbol tree entry with run time address.

Here are some examples of referencing different symbols in the above programs:

control.c:main

control.c:port_one

porthand.c:utils.c:delay

The last example above only works with IEEE-695 object module format; the HP
object module format does not support referencing of include files that generate
program code.

porthand.c:process_port.i

porthand.c:process_port.BLOCK_1.i

Notice how you can reference different variables with matching identifiers by
specifying the complete scope. You also can save typing by specifying a scope with
cws. For example, if you are making many measurements involving symbols in the
file porthand.c, you could specify:

cws porthand.c:process_port

Then:

i

BLOCK_1.i

are prefixed with porthand.c: process_port before the database lookup.

If a symbol search with the current working symbol prefix is unsuccessful, the last
scope on the current working symbol is stripped. The symbol you specified is then
retested with the modified current working symbol. Note that this does not change
the actual current working symbol.

For example, if you set the current working symbol as

cws porthand.c:process_port.BLOCK_1
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and made a reference to symbol i2, the retrieval utilities attempt to find a symbol
called

porthand.c:process_port.BLOCK_1.i2

which would not be found. The symbol utilities would then strip BLOCK_1 from
the current working symbol, yielding

porthand.c:process_port.i2

which is a valid symbol.

You also can specify the symbol type if conflicts arise. Although not shown in the
tree, assume that a procedure called port_one is also defined in control.c. This
would conflict with the identifier port_one which declares an integer pointer. SRU
can resolve the difference. You must specify:

control.c:port_one(static)

to reference the variable, and

control.c:port_one(procedure)

to reference the procedure address.

See Also The copy local_symbols_in and display local_symbols_in commands.

Also refer to the Symbolic Retrieval Utilities User’s Guide for further information
on symbols.
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trace

This command allows you to trace program execution using the emulation analyzer.

Note that the options shown can be executed once for each trace command.  Refer
to the TRIGGER and QUALIFIER diagrams for details on setting up a trace.

You can perform analysis tasks either by starting a program run and then specifying
the trace parameters, or by specifying the trace parameters first and then initiating
the program run.  Once a trace begins, the analyzer monitors the system busses of
the emulation processor to detect the states specified in the trace command.

When the trace specification is satisfied and trace memory is filled, a message will
appear on the status line indicating the trace is complete. You can then use display
trace to display the contents of the trace memory.  If a previous trace list is on
screen, the current trace automatically updates the display.  If the trace memory
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contents exceed the page size of the display, the <NEXT>, <PREV>, <Up arrow>,
or <Down arrow> keys may be used to display all the trace memory contents.  You
also can press <CTRL>f and <CTRL>g to move the display left and right.

You can set up trigger and storage qualifications using the specify trace command.
The analyzers will begin tracing when a cmb_execute command executes, which
causes an EXECUTE signal on the Coordinated Measurement Bus.

The analyzer will trace any state by default.

The parameters are as follows:

again This option repeats the previous trace measurement.  It also begins a trace
measurement with a newly loaded trace specification. (Using trace without the
again parameter will start a trace with the default specification rather than the
loaded specification.)

anything This causes the analyzer to capture any type of information.

arm_trig2 This option allows you to specify the external trigger as a trace qualifier, for
coordinating measurements between multiple HP 64700s, or an HP 64700 and
another instrument.

Before arm_trig2 can appear as an option, you must modify the emulation
configuration interactive measurement specification. When doing this, you must
specify that either BNC or CMBT drive trig2, and that the analyzer receive trig2.
See the chapter on "Making Coordinated Measurements" for more information.

break_on_trigger This stops target system program execution when the trigger is found.  The
emulator begins execution in the emulation monitor. When using this option, the
on_halt option cannot be included in the command.

modify_command This recalls the last trace command that was executed.

on_halt When using this option, the analyzer will continue to capture states until the
emulation processor halts or until a stop_trace command is executed.  When this
option is used, the break_on_trigger, repetitively, and TRIGGER  options cannot
be included in the command.

only This option allows you to qualify the states that are stored, as defined by
QUALIFIER .

prestore This option instructs the analyzer to save specific states that occur prior to states
that are stored (as specified with the "only" option).
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QUALIFIER This determines which of the traced states will be stored or prestored in the trace
memory for display upon completion of the trace.  Events can be selectively saved
by using trace only to enter the specific events to be saved.  When this is used,
only the indicated states are stored in the trace memory.  See the QUALIFIER
syntax.

repetitively This initiates a new trace after the results of the previous trace are displayed.  The
trace will continue until a stop_trace or a new trace command is issued.  When
using this option, you cannot use the on_halt option.

SEQUENCING Allows you to specify up to seven sequence terms including the trigger.  The
analyzer must find each of these terms in the given order before searching for the
trigger.  You are limited to four sequence terms if windowing is enabled.  See the
SEQUENCING syntax pages for more details.

TRIGGER This represents the event on the emulation bus to be used as the starting, ending, or
centering event for the trace.  See the TRIGGER  syntax diagram.  When using this
option, you cannot include the on_halt option.

WINDOW Selectively enables and disables analyzer operation based upon independent enable
and disable terms.  This can be used as a simple storage qualifier.  Or, you may use
it to further qualify complex trigger specifications.  See the WINDOW  syntax
pages for details.

Examples
trace after  1000H <RETURN>

trace only address range  1000H thru  1004H <RETURN>

trace after address  1000H occurs  2 only address range
1000H thru  1004H break_on_trigger  <RETURN>

See Also The copy trace, display trace, load trace, load trace_spec, specify trace, store
trace, and store trace_spec commands.
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TRIGGER

This parameter lets you define where the analyzer will begin tracing program
information during a trace measurement.

A trigger is a QUALIFIER.  When you include the occurs option, you can specify
the trigger to be a specific number of occurrences of a QUALIFIER (see the
QUALIFIER syntax diagram).

The default is to trace after any state occurs once.

The parameters are as follows:

about This option captures trace data leading to and following the trigger qualifier.  The
trigger is centered in the trace listing.

after Trace data is acquired after the trigger qualifier is found.

before Trace data is acquired prior to the trigger qualifier.

occurs This specifies a number of qualifier occurrences of a range or state on which the
analyzer is to trigger.

QUALIFIER This determines which of the traced states will be stored in trace memory.

<#TIMES> This prompts you to enter a number of qualifier occurrences.

Chapter 11: Emulator/Analyzer Interface Commands
TRIGGER

426



Examples
trace after MAIN <RETURN>

trace after  1000H then data  5 <RETURN>

Also see the trace command examples.

See Also The trace command.

Also, refer to the "Making Coordinated Measurements" chapter.
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wait

This command allows you to present delays to the system.

The wait command can be an enhancement to a command file, or to normal
operation at the main emulation level.  Delays allow the emulation system and
target processor time to reach a certain condition or state before executing the next
emulation command.

The wait command does not appear on the softkey labels.  You must type the wait
command into the keyboard.  After you type wait, the command parameters will be
accessible through the softkeys.

The system will pause until it receives a <CTRL>c signal.

Note that if set intr <CTRL>c was not executed on your system, <CTRL>c
normally defaults to the backspace key.  See your UNIX system administrator for
more details regarding keyboard definitions.

The parameters are as follows:

measurement
_complete

This causes the system to pause until a pending measurement completes (a trace
data upload process completes), or until a <CTRL>c signal is received.  If a
measurement is not in progress, the wait command will complete immediately.

or This causes the system to wait for a <CTRL>c signal or for a pending measurement
to complete.  Whichever occurs first will satisfy the condition.
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seconds This causes the system to pause for a specific number of seconds.

<TIME> This prompts you for the number of seconds to insert for the delay.

Note that a wait command in a command file will cause execution of the command
file to pause until a <CTRL>c signal is received, if <CTRL>c is defined as the
interrupt signal.  Subsequent commands in the command file will not execute while
the command file is paused.  You can verify whether the interrupt signal is defined
as <CTRL>c by typing set at the system prompt.

Examples
wait  <RETURN>

wait  5; wait measurement_complete  <RETURN>
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WINDOW

Lets you select which states are stored by the analyzer.

WINDOW allows you to selectively toggle analyzer operation.  When enabled, the
analyzer will recognize sequence terms, trigger terms, and will store states.  When
disabled, the analyzer is effectively off, and only looks for a particular enable term.

You specify windowing by selecting an enable qualifier term; the analyzer will
trigger or store all states after this term is satisfied.  If the disable term occurs after
the analyzer is enabled, the analyzer will then stop storing states, and will not
recognize trigger or sequence terms.  You may specify only one enable term and
one disable term.

The analyzer defaults to recognizing all states.  If you specify enable, you must
supply a qualifier term.  If you then specify disable, you must specify a qualifier
term.

The parameters are as follows:

disable Allows you to specify the term which will stop the analyzer from recognizing states
once the enable term has been found.

enable Allows you to specify the term which will enable the analyzer to begin monitoring
states.

QUALIFIER Specifies the actual address, data, status value or range of values that cause the
analyzer to enable or disable recognition of states.  Note that the enable qualifier
can be different from the disable qualifier.  Refer to the QUALIFIER syntax pages
for further details on analyzer qualifier specification.

Examples
trace enable  _rand disable  0ecch <RETURN>
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See Also The trace command and the SEQUENCING and QUALIFIER syntax descriptions.
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Error Messages
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Error Messages

This chapter contains a list of error messages that may occur while operating the
emulator and analyzer.

The error log records error messages received during the emulation session. You
may want to display the error log to view the error messages. Sometimes several
messages will be displayed for a single error to help you locate a problem quickly.
To prevent overrun, the error log purges the oldest messages to make room for the
new ones.

To display the error log:

display error_log  <RETURN>

Error messages are grouped into the following categories:

• Graphical/Softkey Interface Messages - Unnumbered

• Graphical/Softkey Interface Messages - Numbered

• Terminal Interface Messages

Note that Terminal Interface messages are passed along to the Graphical User
Interface (or Softkey Interface) and appear, with numbers, in the error log display.
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Graphical/Softkey Interface Messages -
Unnumbered

Address range too small for request - request truncated

Cause: Too small of an address range is specified in a modify memory command.

Action: Specify a larger memory range.

Cannot create module file:

Cause: Insufficient disk space for the module file.

Action: Check disk space under /usr/hp64000.

Cannot start. Ending previous session, try again

Cause: The host system could not start a new emulation session, and is ending the
previous session.

Action: After the previous session has ended, try starting a new emulation session.
If that fails, try "emul700 -u <logical name>" to unlock the emulator and cycle
power, if needed.

Cannot start. Pod initialization failed

Cause: The host system could not start a new emulation session because it could
not initialize the emulator.

Action: Cycle power on the emulator; verify that there are no red lights on the front
of the emulator.  You may need to run the Terminal Interface "pv" command to
verify that the emulator is functioning properly before starting a new session.

Configuration not valid, restoring previous configuration
Configuration not valid, restoring default configuration

Cause: The modifications you tried to make to the emulator configuration are not
valid, so the host system restored the previous configuration.

Action: See the "Configuring the Emulator" chapter for more information about the
emulator configuration items and their settings.
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Configuration process QUIT

Cause: The configuration process ended because <CTRL> "\" (SIGQUIT signal)
was encountered. This is an easy way to exit configuration without saving any
changes.

Action: Try starting the emulation session again. If the problem persists, you may
need to cycle power on the emulator.

Connecting to <LOGICAL NAME>

Cause: This is a status message.  The host system is making a communication
connection to the emulator whose logical name is defined in
/usr/hp64000/etc/64700tab.net or /usr/hp64000/etc/64700tab.

Continue load failed

Cause: The host system could not continue the previous emulation session because
it could not load the continue file.

Action: Try again.  If the failure continues, call your HP Service Representative.

Continuing previous session, continue file loaded

Cause: This is a status message.  An emulation session which was ended earlier
with the end command has been restarted. The host system reported that the session
was continued (using settings from the previous session) and that the continue file
loaded properly.

Continuing previous session, user interface defaulted

Cause: The previous emulation session was continued and the Softkey Interface
was set to the default state.

Could not create default configuration

Cause: The host system could not create a default configuration for the emulation
session.

Action: Check disk space under /usr/hp64000 and verify proper software
installation.
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Could not create <CONFIGURATION BINARY FILENAME>

Cause: The system could not create a binary emulation configuration file (file.EB).

Action: Check the file.EB write permission and verify that the specified directory
exists and is writeable.

Could not exec configuration process

Cause: The host system could not fork the configuration process or could not
execute the configuration process.

Action: Make sure that the host system is operating properly, and that all Softkey
Interface files were loaded properly during the installation process. Try starting the
emulation session again.

Could not load default configuration

Cause: The host system could not load the default configuration into the emulator.

Action: Cycle power on the emulator and run the Terminal Interface "pv"
(performance verification) command on the emulator to verify that it is functioning
properly.  Also, verify proper software installation.  If loading default configuration
still fails, then call your HP 64000 representative.

<CONFIGURATION FILENAME> does not exist

Cause: The configuration file you are trying to load does not exist.

Action: Try the load configuration command again using a valid configuration file
name.

Don’t care number unexpected

Cause: While defining an expression in your command, you included a don’t care
number (a binary, octal, decimal, or hexadecimal number containing "x"), which
was not expected. Don’t care numbers are not valid for all commands. See the
EXPR command syntax for more information about expressions.

Emulation analyzer defaulted to delete label

Cause: Analyzer trace labels were changed or modified while labels were in use in
the trace specification.
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Action: Enter the previous trace specification and try again.

Emul700dmn continuation failed

Cause: Communication between the emulator and the host system to continue the
emulation session failed.

Action: Check the data communication switch settings on the rear panel of the HP
64700 series emulator. If necessary, refer to the HP 64700 Installation/Service
Guide.

Emul700dmn executable not found

Cause: The emulation session could not begin because the host system could not
locate the HP 64700 emulator daemon process executable.

Action: Make sure that software installation is correct. Then try starting the
emulator again.

Emul700dmn failed to start

Cause: The emulation session could not begin because the host system could not
start the HP 64700 emulator daemon process.

Action: Make sure there is sufficient disk space under /usr/hp64000.  Make sure the
host system is operating properly, that all Softkey Interface software has been
loaded correctly, and the data communication switch settings on the emulator rear
panel match the settings in the /usr/hp64000/etc/64700tab.net (or 64700tab) file.

Emul700dmn message too large
Emul700dmn message too small
Emul700dmn queue and/or semaphores missing
Emul700dmn queue failure
Emul700dmn error in file operation
Emul700dmn queue full

Cause: The HP 64700 emulator daemon process command was too large for the
host system to process.

Action: You must press end_release_system to exit this emulation session
completely; then start a new session. Make sure the host system is operating
properly, that all Softkey Interface software has been loaded correctly, and the data
communication switch settings on the emulator rear panel match the settings in the
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/usr/hp64000/etc/64700tab.net (or 64700tab) file.  You may have to cycle power
and use emul700 -u ,logical name> to unlock the system.

Emul700dmn sem op failed, perhaps kernel limits too low

Cause: The host system could not start the emulation session; there may be too
many processes running on the host system.

Action: Make sure the host system is operating properly, and is not overloaded with
currently executing processes. Stop or remove some processes on the system.  Also,
verify that the semaphore capabilities have been installed in the UNIX kernel. Then
try starting the emulation session again.

Emul700dmn version incompatible with this product

Cause: The emulation session could not begin because the version of the HP 64700
emulator daemon executable on host system is not compatible with the version of
the Softkey Interface you are using.

Action: Make sure the software has been properly installed. Then try starting the
emulator again.

<LOGICAL NAME>: End, continuing

Cause: This is a status message. The emulation session is being exited with the end
command. When you restart the emulation session later, it will continue using the
same settings as in the session you just ended. The emulator logical name is located
in the /usr/hp64000/etc/64700tab.net (or 64700tab) file.

<LOGICAL NAME>: End, released

Cause: This is a status message. The emulation session is being exited with the end
release_system command. When the session has ended, the emulator is released,
meaning that others can access and use it. When you restart the emulation session
later, the new session will use all default settings. The emulator logical name is
located in the /usr/hp64000/etc/64700tab.net (or 64700tab) file.

Ending released

Cause: This is a status message. The emulation session is being exited with the end
release_system. The emulator will be released for others to access and use it.
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Error: display size is <LINES> lines by <COLUMNS> columns. It must be at
least 24 by 80.

Cause: You tried to specify an incorrect window size.

Action: Set the window size accordingly, then start the emulation session.  The size
of the window must be a minimum of 24 lines (rows) by 80 columns to operate an
emulation session.

Error in configuration process
Error starting configuration process

Cause: Unexpected configuration error.

Action: Verify proper software installation and call your HP 64000 representative.

Fatal error from function <ADDRESS OF FUNCTION>

Cause: This is an unexpected fatal system error.

Action: Cycle power on the emulator and start again.  If this is a persistent problem,
call your HP 64000 representative.

File could not be opened

Cause: You tried to store or load trace data to a file with incorrect permission. Or
the analyzer could not find the file you specified, or else there were already too
many files open when you entered your command.

Action: Check the directory and file for correct read and write permission.  Specify
a file that is accessible to the analyzer. Close the other files that are presently open.

File perf.out does not exist

Cause: You tried to execute the "restore" command to continue a previous software
performance measurement, and the SPMT software found that no
"performance_measurement_end" command was previously executed to create a
file from which "restore" could be performed.

Action: Execute a new SPMT measurement.
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File perf.out not generated by measurement software

Cause: The faile named perf.out exists in the current directory, but it was not
created by the "performance_measurement_end" command.

Action: Rename the old "perf.out" file, or move it to another directory.

HP64700 I/O channel semaphore failure: <string>

Cause: Semaphore (ipc) facility not installed.

Action: Reconfigure the kernel to add ipc facility.

HP 64700 I/O error; communications timeout

Cause: This is a communication failure.

Action: Check power to the emulator and check that all cables are connected
properly.  If you are using LAN and heavy LAN traffic is present, try setting the
environment variable to HP64700TIMEOUT="30" (or larger if needed).  The value
is the number of seconds before timeout occurs.  Then try running again.

HP64700 I/O error; connection timed out

Cause: A user abort occurred while attempting to connect via LAN.

Action: Possibly connecting to an emulator many miles away, be patient.

HP 64700 I/O error; power down detected

Cause: The emulator power was cycled.

Action: Do not do this during a user interface session; this may force the user
interface to end immediately.

HP64700 I/O channel busy; communications timed out

Cause: The communications channel is in use for an unusually long period of time
by another command.

Action: try again later.
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Illegal status combination

Cause: You tried to specify combinations of status qualifiers in expressions
incorrectly when entering commands.

Action: Refer to the "Emulator/Analyzer Interface Commands" chapter for
information about syntax of commands.

Illegal symbol name

Cause: You tried to specify incorrect symbol names when entering commands.

Action: Specify correct symbol names.  To see global symbol names, use the
display global_symbols command. To see local symbol names, use the
display local_symbols_in <SYMB> command.

Initialization failed

Cause: The emulator could not be initialized.

Action: Make sure your data communication switch settings are correct, and that all
Softkey Interface software has been loaded properly. Cycle power on the emulator,
then try starting up the emulation session again.

Initialization load failed

Cause: The emulator could not be initialized.

Action: Make sure your data communication switch settings are correct, and that all
Softkey Interface software has been loaded properly. Cycle power on the emulator,
then try starting up the emulation session again.

Initializing emulator with default configuration

Cause: This is a status message.  The host system started the emulation session and
initialized the emulator using the default configuration. The emulator is probably
operating correctly.

Initializing user interface with default config file

Cause: This is a status message. The host system started the emulation session and
Softkey Interface using the default configuration file. The emulator is probably
operating correctly.
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Insufficient emulation memory, memory map may be incomplete

Cause: You can map only the amount of emulation memory available in your
emulator. Trying to map additional unavailable memory may cause information to
be missing from your memory map.

Action: Modify your configuration and update the memory map to correctly reflect
the amount of emulation memory available.

Invalid answer in <CONFIGURATION FILENAME> ignored

Cause: You must provide acceptable responses to questions in the configuration file
(file.EA). The emulator ignored the incorrect response. Incorrect responses may
appear in configuration files when you have saved the configuration to a file, edited
it later, and tried reloading it into the emulator. This may also occur if you have
loaded a configuration file that you created while using another emulator, and the
response differs from the response required for this emulator.

Action: Examine your configuration file to check for inappropriate responses to
configuration file questions.

Inverse assembly file <INVERSE ASSEMBLER FILENAME> could not be
loaded
Inverse assembly file <INVERSE ASSEMBLER FILENAME> not found,
<filename>
Inverse assembly not available

Cause: The file does not exist.

Action: Reload your interface and/or real-time operating system software.

Inverse assembly not available

Cause: The inverse assembler for your emulator is missing.

Action: Verify proper software installation.

Joining session already in progress, continue file loaded

Cause: This is a status message.  When operating the emulator in multiple
windows, a new emulation session is "joined" to a current session. In this case, the
new session was able to continue because the continue file loaded properly.

Chapter 12: Error Messages
Graphical/Softkey Interface Messages - Unnumbered

443



Joining session already in progress, user interface defaulted

Cause: When operating the emulator in multiple windows, a new emulation session
is "joined" to a current session. In this case, the new session used the user interface
default selections.

Load aborted

Cause: While loading a file into the emulator, an event occurred that caused the
host system to stop the load process.

Action: Use the display error_log command to view any errors. If the problem
persists, make sure the host system and emulator are operating properly, and that
you are trying to load an acceptable file. See the "Emulator/Analyzer Interface
Commands" chapter for information about the load command.

Load completed with errors

Cause: While loading a file into the emulator, one or more events occurred that
caused errors during the load process.

Action: Use the display error_log command to view any errors. You may need to
modify the configuration and map memory before you load the file again. If the
problem persists, make sure the host system and emulator are operating properly,
and that you are trying to load an acceptable file.

Measurement system not found

Cause: You tried to end the current emulation session and select another
measurement system module which could not be located by the host system.

Action: Either try the end select measurement_system command again or end and
release the emulation session.

Memory allocation failed, ending released

Cause: This is a fatal system error because the emulation session was unable to
allocate memory.

Action: You may need to reconfigure your UNIX kernel to increase the per process
maximum memory limit and available swap space.  Reboot your UNIX system and
try starting a new session again.
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Memory block list unreadable

Memory range overflow

Cause: A modify memory command is attempted that would cross physical 0.

Action: Limit the modify memory command to not overflow physical 0 or break
the command into two separate modify commands.

No address label defined

Cause: The address trace label was somehow removed in the terminal interface
using the tlb  command.

Action: End session and start again.

No more processes may be attached to this session

Cause: You can operate an emulator in four windows. Each time you start the
emulator in another window, a new process is attached to the current session.

Action: Do not try to use more than four windows.  Once you have started the
emulator in four windows, you have reached the maximum number of processes
allowed for that emulator.

Not an absolute file
No absolute file: <file>
No absolute file, No database: <file>

Cause: You tried to load a file into the emulator that is not an executable or
absolute file, so the host system stopped the load process.

Action: Try your command again, and make sure you specify a valid absolute file
name to be loaded.

No symbols loaded

Cause: You tried to step through lines in the source file before symbols are loaded.

Action: Load symbols and try again, or use step with the "source" option (i.e. step
assembly language program).
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No valid trace data

Cause: You tried to store trace data before a trace was completed.

Action: Wait until valid trace data is available before attempting to store a trace.

Not a valid trace file - load aborted

Cause: You tried to load a file.TR that was not created by the emulation session.

Action: Only load trace data files that were created by the emulator.

Not compatible trace file - load aborted

Cause: You tried to load a file.TR that was created by another type of emulator.

Action: Only load trace data files that were created by the same type of emulator.

Number of lines not in range: 1 <= valid lines <= 50

Cause: You tried to enter a number of lines that was outside the range from 1 to 50.

Action: Try entering the command again using a valid number of lines.

Number of spaces not in range: 2 <= valid spaces <= 15

Cause: You tried to enter a number of spaces outside the range from 2 to 15.

Action: Try entering the command again using a valid number of spaces.

opcode extends beyond specified address range

Cause: Memory disassembly is attempted on an address range that is too small.

Action: Display memory mnemonic using a large address range, or no address
range at all.

Perfinit - Absolute file (database) must be loaded line <LINE NUMBER>

Cause: No symbolic data base has been opened (or exists) for the target file when
you executed the "performance_measurement_initialize" command.

Action: Make sure a data base has been loaded for the target file.
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Perfinit - error in input file line <LINE NUMBER> invalid symbol

You included a "label" file name with your "performance_measurement_initialize"
command, and that file contains an invalid symbol.

Action: Edit the file and correct the invalid symbol.

Perfinit - error in input file line <NUMBER>

Cause: You included an input file name with your
"performance_measurement_initialize" command, and that file contains a syntax
error.

Action: Edit the file and correct the syntax error.

Perfinit <—-EXPR—- ERROR> line <LINE NUMBER>

Perfinit - File could not be opened

Cause: You specified a file as an option to "performance_measurement_initialize",
and the file you specified could not be found or opened by SPMT software.

Action: Make sure you entered the correct file name.

Perfinit - No events in file

Cause: You specified a file along with your "performance_measurement"initialize"
command that contained no events.  Any measurement displayed from this file will
have NULL results.

Action: Either edit the file to add events, or use the default setup to start a new
measurement.

perf.out file could not be opened - created

Cause: The performance analyzer failed to open or create a file named "perf.out" in
response to your "performance_measurement_end" command.

Action: Free up some file space or correct the write permissions in your current
working directory.
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Performance tool must be initialized

Cause: You tried to make a performance measurement when the Software
Performance Measurement Tool (SPMT) was not initialized.

Action: The Software Performance Measurement Tool (SPMT) must be initialized
before making performance measurements on your software. Use the
performance_measurement_initialize command to initialize the SPMT.

Performance tool not initialized

Cause: The Software Performance Measurement Tool (SPMT) has not been
initialized.

Action: To make accurate activity or duration measurements on current data, use
the performance_measurement_initialize command to initialize the SPMT before
running a performance measurement.

Question file missing or invalid

Cause: Some of the Softkey User Interface files are missing or are corrupted.

Action: Reinstall the host software and try starting the emulation session again.

Range crosses segment boundary

Cause: On a segment offset processor, an address range is specified that would
cross different segments.

Action: Break the memory command into multiple commands so that the address
ranges start and end in the same segment.

Read memory failed at <PHYSICAL ADDRESS> - store aborted

Cause: While storing memory from the emulator to a file, a read memory error
occurred. 

Action: Use the display error_log command to view any errors.  You may need to
modify the configuration and map memory before storing the file again.

Session aborted

Cause: This will only happen when running multiple emulation windows and a
fatal system error occurs.
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Action: Find the window that caused the error and see the error message that it
displayed.  All the additional windows will simply state "session aborted".  Cycle
power on the emulator and enter emul700 -u <logical name> to make sure the
emulator is unlocked.

Session cannot be continued, ending released

Cause: The emulation session is ending automatically because it could not be
continued from the previous session. When the session has ended the emulator will
be released, meaning that others can access and use it.

Action: When you restart the emulation session later, the new session will use all
default settings.

Slave clock requires at least one edge

Cause: The analyzer has an invalid clock specification.

Action: Modify your configuration and try your command again.

Starting address greater than ending address

Cause: You specified a starting address that is greater than the ending address.

Action: Specify a starting address that is less than or equal to the ending address.

Starting new session, continue file loaded

Cause: This is a status message.  The emulator was started using a new emulation
session, and the continue file loaded properly.

Starting new session, user interface defaulted

Cause: The emulator was started using a new emulation session, and the user
interface was set to default selections.

Action: Call your HP Service Representative.

Status unknown, run "emul700 -l <LOGICAL NAME>"

Cause: The host system cannot determine the status of the emulator.

Action: To verify communication between the emulator and the host system, and
display the emulator status, enter the emul700 -l <logical name> command. The
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emulator logical name is located in the /usr/hp64000/etc/64700tab.net (or
64700tab) file.

Stepping aborted; number steps completed: <STEPS TAKEN>

Cause: Stepping aborted because <CTRL>c or software breakpoint was hit,
guarded memory was accessed, or some other kind of error occurred.

Action: See the error log display for any abnormal errors.  Correct those errors and
then step again.

Stepping complete

Cause: Stepping was completed successfully.

Step count must be 1 through 999

Cause: You tried to use a step count greater than 999.

Action: Use a step count less than 1000.

Symbols not accessible, symbol database not loaded

Cause: You specified a trace list with values expressed using symbols defined in
the source code modules, such as source on, and the database file has not been
loaded into emulation.  Example: display trace symbols on.

Timeout in emul700dmn communication

Cause: The host system could not start the emulation session because the HP 64700
emulator process ran out of time before the emulator could start.

Action: You must press end_release_system to exit this emulation session
completely; then start a new session. Make sure the host system is operating
properly, that all Softkey Interface software has been loaded correctly, and the data
communication switch settings on the emulator rear panel match the settings in the
/usr/hp64000/etc/64700tab.net (or 64700tab) file.

Trace file not found

Cause: You tried to load trace data file that does not exist.

Action: Find the correct name and path of the trace data file and try again.
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Unexpected message from emul700dmn

Cause: The host system could not start the emulation session because of an
unexpected message from the HP 64700 emulator process command.

Action: You must press end_release_system to exit this emulation session
completely; then start a new session. Make sure the host system is operating
properly, that all Softkey Interface software has been loaded correctly, and the data
communication switch settings on the emulator rear panel match the settings in the
/usr/hp64000/etc/64700tab.net (or 64700tab) file.

Unknown expression type

Cause: While entering your command, you included an unknown expression type.

Action: See the EXPR command syntax for more information about expressions.
Then try entering your command again with a known expression type.

Unload trace data failed

Cause: An unexpected error occurred while waiting for a trace to be completed.

Action: End and release the session, and then try again.

Wait time failure, could not determine system time

Cause: The system call failed.

Action: Verify that ’date’ executes correctly from the UNIX prompt.

Warning: at least one integer truncated to 32 bits
Warning: at least one integer truncated to 16 bits
Warning: at least one integer truncated to 8 bits

Cause: The number entered was too large for the currently specified display or
access size.

Action: Try entering the command again using the correct size of number.

Width not in range: 1 <= valid width <= 80

Cause: You tried to specify the width of the field outside the range from 1 to 80.

Action: Try entering the command again using a valid number for the width.
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Graphical/Softkey Interface Messages - Numbered

These numbered messages can occur because of various problems with the
emulator/analyzer.

10315 Logical emulator name unknown; not found in 64700tab file

Cause: This message may occur while trying to start up the emulator.  It indicates
that the emulator name specified could not be found in the 64700tab.net or
/etc/hosts files.

Action: Specify the name in one of these files.

10326 Emulator locked by another user

Cause: This message occurs when you try to start an emulation interface, but your
attempt failed because the emulator is being used by someone else.

Action: The current user must release the emulator.

10327 Cannot lock emulator; failure in obtaining the accessid
Cannot lock emulator; failure in <ERRNO MSG>

10328 Cannot unlock emulator; emulator not locked

Cause: You have issued a command to unlock an emulator that is not locked.

Action: The emulator is available now.  You can start the interface.

10328
10328

Cannot unlock emulator; lock file missing
Cannot unlock emulator; semaphore missing

Cause: Lock semaphore missing.

Action: Verify existence and permissions of /usr/hp64000 directory.  Cycle
emulator power and use emul700 -u <logical name>.

10328 Cannot unlock emulator; emulator in use by user: <USER NAME>

Cause: The emulator is already in use by the named user.

Action: Current user must release the emulator.
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10329 Emulator locked by user: <USER NAME>

Cause: You tried to start an emulator interface, but your attempt failed because the
emulator is already in use by someone else.

Action: Current user must release the emulator.

10330 Emulator locked by another user interface

Cause: You tried to start an emulator interface, but your attempt failed because the
emulator is already in use by someone else.

Action: Current user must release the emulator.

10331 HP64700 I/O channel in use by emulator: <LOGICAL NAME>

Cause: You tried to start an emulator interface, but your attempt failed because the
emulator is already in use by someone else.

Action: Current user must release the emulator.

10332 Cannot default emulator; already in use

Cause: You tried to start an emulator interface, but your attempt failed because the
emulator is already in use by someone else.

Action: Current user must release the emulator.

10350 Cannot interpret emulator output

Cause: There may be characters dropped in the information returned from the
emulator.

Action: Ignore this message unless it becomes frequent.  If it becomes frequent, you
may have a fatal error; call your HP 64700 representative.

10351 Exceeded maximum 64700 command line length

Cause: Your command is longer than 240 characters.

Action: Shorten the command.

10352 Incompatible with 64700 firmware version

Cause: The installed interface firmware combination is incorrect or incompatible.
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Action: Upgrade the interface software of product firmware.

10360 Analyzer limitation; all range resources in use
Analyzer limitation; all pattern resources in use
Analyzer limitation; all expression resources in use

Cause: Your trace specification would use more than the maximum number of
resources available to the analyzer.

Action: Simplify the trace specification.

10371 64700 command aborted

Cause: User abort occurred due to emulator being monopolized by another
command.

Action Don’t issue an abort.
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Terminal Interface Messages

This section contains descriptions of error messages that can occur while using the
Terminal Interface.  The error messages are listed in numerical order, and each
description includes the cause of the error and the action you should take to remedy
the situation.

The emulator can return messages to the display only when it is prompted to do so.
Situations may occur where an error is generated as the result of some command,
but the error message is not displayed until the next command (or a carriage return)
is entered.

A maximum number of 8 error messages can be displayed at one time.  If more
than 8 errors are generated, only the last 8 are displayed.

Emulator Messages

20 Attempt to change foreground monitor map term

Cause:  When configuring the emulator to use a foreground monitor, a memory
range is automatically mapped for the monitor’s use.  You attempted to alter that
term when mapping memory.

Action:  Try using another memory range for the new map term.  If you need to
have the range used by the foreground monitor, then switch to a background
monitor, delete the old foreground monitor map term, and add the new term.  Now
you can return to using a foreground monitor; remember you will need to reload the
monitor code.

21 Insufficient emulation memory

Cause:  You have attempted to map more emulation memory than is available.

Action:  Reduce the amount of emulation memory that you are trying to map.

40 Restricted to real time runs

Cause:  While the emulator is restricted to real-time execution, you have attempted
to use a command that requires a temporary break in execution to the monitor.  The
emulator does not permit the command and issues this error message.

Chapter 12: Error Messages
Terminal Interface Messages

455



Action:  You must break the emulator’s execution into the monitor before you can
enter the command.

61 Emulator is in the reset state

Cause:  You have entered a command that requires the emulator to be running in
the monitor (for example, displaying registers).

Action:  Enter the break command to cause the emulator to run in the monitor, and
enter the command that caused the error again.

80 Stack pointer is odd

Cause:  You have attempted to modify the stack pointer to an odd value for a
processor that expects the stack to be aligned on a word boundary (such as the
68000).

Action:  Modify the stack pointer to an even value.

81 Stack is in guarded memory

Cause:  Your stack pointer pointed to a location in memory mapped as guarded;
you then attempted to run or step the emulation processor.  The emulator was
unable to access the stack to complete the transition from the monitor to the user
program or vice versa.

Action:  Either remap memory so the stack pointer points to a location in RAM, or
change the stack pointer value (either with your program or by configuring the
emulator’s stack pointer value on reset) to point to a location in RAM.

82 Stack is in target ROM

Cause:  Your stack pointer pointed to a location in memory mapped as target ROM;
you then attempted to run or step the emulation processor.  The emulator was
unable to access the stack to complete the transition from the monitor to the user
program or vice versa.

Action:  Either remap memory so the stack pointer points to a location in RAM, or
change the stack pointer value (either with your program or by configuring the
emulator’s stack pointer value on reset) to point to a location in RAM.
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83 Stack is in emulation ROM

Cause:  Your stack pointer pointed to a location in memory mapped as emulation
ROM; you then attempted to run or step the emulation processor.  The emulator
was unable to access the stack to complete the transition from the monitor to the
user program or vice versa.

Action:  Either remap memory so the stack pointer points to a location in RAM, or
change the stack pointer value (either with your program or by configuring the
emulator’s stack pointer value on reset) to point to a location in RAM.

84 Program counter is odd

Cause:  You attempted to modify the program counter to an odd value using the
modify registers command on a processor which expects even alignment of
opcodes.

Action:  Modify the program counter only to even numbered values.

102 Monitor failure; no clock input

Cause:  The monitor is unable to run because no emulation processor clock is
available.

Action:  Make sure a clock meeting the microprocessor’s specifications is input to
the clock pin of the target system probe.

103 Monitor failure; no processor cycles

Cause:  The monitor is unable to run since the processor is not running.  The
monitor is unable to determine the cause of the failure.

Action:  If running in-circuit, troubleshoot the target system.  If running out of
circuit, reinitialize the emulator and try the procedure again.

104 Monitor failure; bus grant

Cause:  The monitor is unable to run.  The emulation processor is not running
because it has granted the bus to another device.

Action:  Wait until the processor has regained bus control, then retry the operation.
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105 Monitor failure; halted

Cause:  The monitor is unable to run because the processor is halted (due to an
external halt line or a halt instruction).

Action:  Release the external halt and retry the operation.  If the processor halted
due to a halt instruction, try the reset command, then retry the operation.

106 Monitor failure; wait state

Cause:  The monitor is unable to run because the processor is in a continuous wait
state.

Action:  A continuous wait state may indicate target system problems.
Troubleshoot the wait line.  If you were running out of circuit, try initializing the
emulator, then retry the procedure.

107 Monitor failure; bus error

Cause:  The monitor is unable to run because the processor has encountered a bus
fault (such as the 68000 /BERR line).

Action:  Release the /BERR line and determine why it was activated.

68000 Emulator Messages

The following error messages are unique to the 68000 emulator.

140 Supervisor stack pointer not initialized

Cause:  The supervisor stack pointer was not initialized to a value on the transition
from emulation reset to the monitor.

Action:  Modify the emulator configuration to define a supervisor stack pointer
lying within an area mapped as RAM and reserved for stack space, and make the
transition from emulator reset to the monitor.  Or, you can modify the supervisor
stack pointer directly by modifying the SSP register.

141 Foreground monitor operating in USER mode

Cause:  The foreground monitor was found operating in the 68000 user program
state.
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Action:  Reset the emulator.  Check your foreground monitor source code to verify
that it keeps the processor in the supervisor state and does not make transitions into
the user program state.

142 Supervisor stack in guarded memory at <address>

Cause:  The supervisor stack either was defined in or grew into a memory range
mapped as guarded.

Action:  Reset the emulator.  Then, define the supervisor stack pointer within a
memory range mapped as emulation or target RAM and allow sufficient room for
the stack to grow as procedures are activated and deactivated.

143 Supervisor stack is in ROM at <address>

Cause:  The supervisor stack either was defined in or grew into a memory range
mapped as ROM.

Action:  Reset the emulator.  Then, define the supervisor stack pointer within a
memory range mapped as emulation or target RAM and allow sufficient room for
the stack to grow as procedures are activated and deactivated.

145 BERR occurred during background operation

Cause:  A bus error was encountered while the emulator was executing the
background monitor.

Action:  Reset the emulator.

146 BERR during background access to supervisor stack

Cause:  A bus error occurred while the emulation monitor was attempting to push
or pop data on the supervisor stack.

Action:  Define the supervisor stack pointer within a memory range mapped as
emulation or target RAM and allow sufficient room for the stack to grow as
procedures are activated and deactivated.

147 RESET during background operation

Cause:  A target system RESET occurred while the emulator was executing in the
background monitor.
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Action:  Verify the register state is as expected, if so, you may continue with no
further action. If not, reset the emulator from the emulation system.

149 Unexpected stack format on background entry

Cause:  The stack format word was different from that expected upon normal
background entry.

Action:  Set up the desired register states; or, reset the emulator.

General Emulator and System Messages

204 FATAL SYSTEM SOFTWARE ERROR

205 FATAL SYSTEM SOFTWARE ERROR

208 FATAL SYSTEM SOFTWARE ERROR

Cause:  The system has encountered an error from which it cannot recover.

Action:  Write down the sequence of commands which caused the error.  Cycle
power on the emulator and reenter the commands.  If the error repeats, call your
local HP Sales and Service office for assistance.

206 Incompatible compatibility table entry

Cause:  The emulation firmware (ROM) is not compatible with the analysis or
system firmware in your HP 64700 system.

Action:  The ROMs in your emulator must be compatible with each other for your
emulation system to work correctly.  Contact your Hewlett-Packard Representative.

312 Ambiguous address: %s

Cause:  Certain emulators support segmentation or function code information in
addressing.  The emulator is unable to determine which of two or more address
ranges you are referring to, based upon the information you entered.

Action:  Re-enter the command and fully specify the address, including
segmentation or function code information.
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318 Count out of bounds: %s

Cause:  You specified an occurrence count less than 1 or greater than 65535.

Action:  Re-enter the command, specifying a count value from 1 to 65535.

400 Record checksum failure

Cause:  During a transfer operation, the checksum specified in a file did not agree
with that calculated by the HP 64700.

Action:  Retry the transfer operation.  If the failure is repeated, make sure that both
your host and the HP 64700 data communications parameters are configured
correctly.

401 Records expected: %s; records received: %s

Cause:  The HP 64700 received a different number of records than it expected to
receive during a transfer operation.

Action:  Retry the transfer.  If the failure is repeated, make sure that the data
communications parameters are set correctly on the host and on the HP 64700.

410 File transfer aborted

Cause:  A transfer operation was aborted due to a break received, most likely a
<CTRL>c from the keyboard.

Action:  If you typed <CTRL>c, you probably did so because you thought the
transfer was about to fail.  Retry the transfer, making sure to use the correct
command options.  If you are unsuccessful, make sure that the data
communications parameters are set correctly on the host and on the HP 64700, then
retry the operation.

411 Severe error detected, file transfer failed

Cause:  An unrecoverable error occurred during a transfer operation.

Action:  Retry the transfer.  If it fails again, make sure that the data
communications parameters are set correctly on the host and on the HP 64700.
Also make sure that you are using the correct command options, both on the
HP 64700 and on the host.
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412 Retry limit exceeded, transfer failed

Cause:  The limit for repeated attempts to send a record during a transfer operation
was exceeded, therefore the transfer was aborted.

Action:  Retry the transfer.  Make sure you are using the correct command options
for both the host and the HP 64700.  The data communications parameters need to
be set correctly for both devices.  Also, if you are in a remote location from the
host, it is possible that line noise may cause the failure.

413 Transfer failed to start

Cause:  Communication link or transfer protocol incorrect.

Action:  Check link and transfer options.

415 Timeout, receiver failed to respond

Cause:  Communication link or transfer protocol incorrect.

Action:  Check link and transfer options.

600 Adjust PC failed during break

Cause:  System failure or target condition.

Action:  Run performance verification (Terminal Interface pv command), and
check target system.

602 Break failed

Cause:  The break command was unable to break the emulator to the monitor.

Action:  Determine why the break failed, then correct the condition and retry the
command.  See message 608.

603 Read PC failed during break

Cause:  System failure or target condition.

Action:  Try again.

604 Disable breakpoint failed: %s

Cause:  System failure or target condition.

Chapter 12: Error Messages
Terminal Interface Messages

462



Action:  Run performance verification (Terminal Interface pv command), and
check target system.

605 Undefined software breakpoint: %s

Cause:  The emulator has encountered a software breakpoint in your program that
was not inserted with the modify software_breakpoints set command.

Action:  Remove the breakpoint instructions in your code before assembly and link.

606 Unable to run after CMB break

Cause:  System failure or target condition.

Action:  Run performance verification (Terminal Interface pv command), and
check target system.

608 Unable to break

Cause:  This message is displayed if the emulator is unable to break to the monitor
because the emulation processor is reset, halted, or is otherwise disabled.

Action:  First, look at the emulation prompt and other status messages displayed to
determine why the processor is stopped.  If reset by the emulation controller, use
the break command to break to the monitor.  If reset by the emulation system,
release that reset.  If halted, try reset and break to get to the monitor.  If there is a
bus grant, wait for the requesting device to release the bus before retrying the
command.  If there is no clock input, perhaps your target system is faulty.  It’s also
possible that you have configured the emulator to restrict to real time runs, which
will prohibit temporary breaks to the monitor.

610 Unable to run

Cause:  System failure or target condition.

Action:  Run performance verification (Terminal Interface pv command), and
check target system.

611 Break caused by CMB not ready

Cause:  This status message is printed during coordinated measurements if the
CMB READY line goes false.  The emulator breaks to the monitor.  When CMB
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READY is false, it indicates that one or more of the instruments participating in the
measurement is running in the monitor.

Action:  None, information only.

612 Write to ROM break

Cause:  This status message will be printed if you have enabled breaks on writes to
ROM and the emulation processor attempted a write to a memory location mapped
as ROM.

Action:  None (except troubleshooting your program).

613 Analyzer Break

Cause:  Status message.

614 Guarded memory access break

Cause:  This message is displayed if the emulation processor attempts to read or
write memory mapped as guarded.

Action:  Troubleshoot your program; or, you may have mapped memory incorrectly.

615 Software breakpoint: %s

Cause:  This status message will be displayed if a software breakpoint is
encountered during a program run.  The emulator is broken to the monitor.  The
string %s indicates the address where the breakpoint was encountered.

616 BNC trigger break

Cause:  This status message will be displayed if you have configured the emulator
to break on a BNC trigger signal and the BNC trigger line is activated during a
program run.  The emulator is broken to the monitor.

617 CMB trigger break

Cause:  This status message will be displayed if you have configured the emulator
to break on a CMB trigger signal and the CMB trigger line is activated during a
program run.  The emulator is broken to the monitor.
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618 trig1 break

Cause:  This status message will be displayed if you use the break_on_trigger
syntax of the trace command and the analyzer has found the trigger condition while
tracing a program run.  The emulator is broken to the monitor.

619 trig2 break

Cause:  This status message will be displayed if you have used the internal trig2
line to connect the analyzer or external analyzer trigger output to the emulator
break input and the analyzer has found the trigger condition.  The emulator is
broken to the monitor.

620 Unexpected software breakpoint

Cause:  If you have enabled software breakpoints, this message is displayed if a
software breakpoint instruction is encountered in your program that was not
inserted by a modify software_breakpoints set command and is therefore not in
the breakpoint table.

Action:  Remove the breakpoint instructions in your code before assembly and link,
and use the modify software_breakpoints set command to reinsert them after the
program is loaded into memory.

621 Unexpected step break

Cause:  System failure.

Action:  Run performance verification (Terminal Interface pv command).

622 %s

Cause:  Monitor specific message.

623 CMB execute break

Cause:  This message occurs when coordinated measurements are enabled and an
EXECUTE pulse causes the emulator to run; the emulator must break before
running.

Action:  This is a status message; no action is required.
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624 Configuration aborted

Cause:  Occurs when a <CTRL>c is entered while emulator configuration items are
being set.

626 Configuration failed; setting unknown: %s=%s

Cause:  Target condition or system failure.

Action:  Check target system, and run performance verification (Terminal Interface
pv command).

628 Guarded memory break: %s"

Cause:  A memory access to a location mapped as guarded memory has occurred
during execution of the user program.

Action:  Investigate the cause of the guarded memory access by the user program.

628 Write to ROM break: %s"

Cause:  When the emulator is configured to break on writes to ROM, a memory
write access to a location mapped as ROM has occurred during execution of the
user program.

Action:  Investigate the cause of the write to ROM by the user program.  You can
configure the emulator so that it does not break on writes to ROM.

630 Register access aborted

Cause:  Occurs when a <CTRL>c is entered during register display.

631 Unable to read registers in class: %s

Cause:  The emulator was unable to read the registers you requested.

Action:  To resolve this, you must look at the other status messages displayed.
Most likely, the emulator was unable to break to the monitor to perform the register
read.  See message 608.

632 Unable to modify register: %s=%s

Cause:  The emulator was unable to modify the register you requested.
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Action:  To resolve this, you must look at the other status messages displayed.  It’s
likely that emulator was unable to break to the monitor to perform the register
modification.  See message 608.

634 Display register failed: %s

Cause:  The emulator was unable to display the register you requested.

Action:  To resolve this, you must look at the other status messages displayed.  It’s
likely that emulator was unable to break to the monitor to perform the register
display.  See message 608.

636 Register not writable: %s

Cause:  This error occurs when you attempt to modify a read only register.

Action:  If this error occurs, you cannot modify the contents of the register with the
modify register command.

637 Register class cannot be modified: %s

Cause:  You tried to modify a register class instead of an individual register.

Action:  You can only modify individual registers.  Refer to the display registers
command description for a list of register names.

640 Unable to reset

Cause:  Target condition or system failure.

Action:  Check target system, and run performance verification (Terminal Interface
pv command).

650 Unable to configure break on write to ROM

Cause:  The emulator controller is unable to configure for breaks on writes to
ROM, possibly because the emulator was left in an unknown state or because of a
hardware failure.

Action:  Initialize the emulator or cycle power.  Then reenter the command.  If the
same failure occurs, call your HP sales and service office.
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651 Unable to configure break on software breakpoints

Cause:  The emulator controller cannot enable breakpoints, possibly because the
emulator is in an unknown state or because of a hardware failure.

Action:  Initialize the emulator or cycle power, then re-enter the command.  If the
same failure occurs, call your HP sales and service office.

653 Break condition configuration aborted

Cause:  Occurs when <CTRL>c is entered during the configuration of break
conditions.

661 Software breakpoint break condition is disabled

Cause:  You have attempted to set or clear a software breakpoint when software
breakpoints are disabled.

Action:  You must enable software breakpoints before you can set them.

663 Specified breakpoint not in list: %s

Cause:  You tried to clear a software breakpoint that was not previously set.  The
string %s prints the address of the breakpoint you attempted to clear.

Action:  You must first set a software breakpoint before it can be cleared.

664 Breakpoint list full; not added: %s

Cause:  The software breakpoint table is already reached the maximum of 32
breakpoints.  The breakpoint you just requested, with address %s, was not inserted.

Action:  Clear breakpoints that are no longer in use.  Then, set the new breakpoint.

665 Enable breakpoint failed: %s

Cause:  System failure or target condition.

Action:  Check memory mapping and configuration questions.

666 Disable breakpoint failed: %s

Cause:  System failure or target condition.

Action:  Check memory mapping and configuration questions.
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667 Breakpoint code already exists: %s

Cause:  You attempted to insert a breakpoint; however, there was already a
software breakpoint instruction at that location which was not already in the
breakpoint table.

Action:  Your program code is apparently using the same instructions as used by
the software breakpoints feature.  Remove the breakpoint instructions from your
program code and use the modify software_breakpoints set command to insert
them.

668 Breakpoint not added: %s

Cause:  You tried to insert a breakpoint in a memory location which was not
mapped or was mapped as guarded memory.

Action:  Insert breakpoints only within memory ranges mapped to emulation or
target RAM or ROM.

669 Breakpoint remove aborted

Cause:  Occurs when <CTRL>c is entered when clearing a software breakpoint.

670 Breakpoint enable aborted

Cause:  Occurs when <CTRL>c is entered when setting software breakpoints.

671 Breakpoint disable aborted

Cause:  Occurs when <CTRL>c is entered when disabling software breakpoints.

680 Stepping failed

Cause:  Stepping has failed for some reason.

Action:  Usually, this error message will occur with other error messages.  Refer to
the descriptions of the accompanying error messages to find out more about why
stepping failed.

684 Failed to disable step mode

Cause:  System failure.

Action:  Run performance verification (Terminal Interface pv command).
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686 Stepping aborted; number steps completed: %d

Cause:  This message is displayed if a break was received during a step command
with a step count greater than zero.  The break could have been due to any of the
break conditions or a <CTRL>c break.  The number of steps completed is displayed.

688 Step display failed

Cause:  System failure or target condition.

Action:  Check memory mapping and configuration questions.

689 Break due to cause other than step

Cause:  An activity other than a step command caused the emulator to break.  This
could include any of the break conditions or a <CTRL>c break.

692 Trace error during CMB execute

Cause:  System failure.

Action:  Run performance verification (Terminal Interface pv command).

693 CMB execute; run started

Cause:  This status message is displayed when you are making coordinated
measurements.  The CMB /EXECUTE pulse has been received; the emulation
processor started running at the address specified by the specify run command.

Action:  None; information only.

694 Run failed during CMB execute

Cause:  System failure or target condition.

Action:  Run performance verification (Terminal Interface pv command), and
check target system.

700 Target memory access failed

Cause:  This message is displayed if the emulator was unable to perform the
requested operation on memory mapped to the target system.
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Action:  In most cases, the problem results from the emulator’s inability to break to
the monitor to perform the operation.  See message 608.

702 Emulation memory access failed

Cause:  System failure.

Action:  Run performance verification (Terminal Interface pv command).

707 Request access to guarded memory: %s

Cause:  The address or address range specified in the command included addresses
within a range mapped as guarded memory.  When the emulator attempts to access
these during command processing, the above message is printed, along with the
specific address or addresses accessed.

Action:  Re-enter the command and specify only addresses or address ranges within
emulation or target RAM or ROM.  Or, you can remap memory so that the desired
addresses are no longer mapped as guarded.

710 Memory range overflow

Cause:  Accessing a word or short word, for example display memory 0ffffffff
blocked word will cause a rounding error that overflows physical memory.

Action:  Reduce memory display request.

725 Unable to load new memory map; old map reloaded

Cause:  There is not enough emulation memory left for this request.

Action:  Reduce the amount of emulation memory requested.

726 Unable to reload old memory map; hardware state unknown

Cause:  System failure.

Action:  Run performance verification (Terminal Interface pv command).

754 Memory modify aborted; next address: %s

Cause:  This message is displayed if a break occurs during processing of a modify
memory command.  The break could result from any of the break conditions
(except a software breakpoint) or could have resulted from a <CTRL>c break.
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Action:  Retry the operation.  If breaks are occurring continuously, you may wish to
disable some of the break conditions.

901 Invalid firmware for emulation subsystem

Cause:  This error occurs when the HP 64700 system controller determines that the
emulation firmware (ROM) is invalid.

Action:  This message is not likely to occur unless you have upgraded the ROMs in
your emulator.  Be sure that the correct ROM is installed in the emulation controller.

902 Invalid analysis subsystem; product address: %s

Cause:  This error occurs when the HP 64700 system controller determines that the
analysis firmware (ROM) is invalid.

Action:  This message is not likely to occur unless you have upgraded the ROMs in
your emulator.  Be sure that the correct ROMs are installed in the analyzer board.

903 Invalid ET subsystem; product address: %s

Cause:  Detects an invalid ET.  Used only internally.

904 Invalid auxiliary subsystem; product address: %s

Cause:  For future products.

911 Lab firmware for emulation subsystem

Cause:  This message should never occur.  It shows that you have an unreleased
version of emulation firmware.

912 Lab firmware analysis subsystem; product address: %s

Cause:  This message should never occur.  It shows that you have an unreleased
version of analysis firmware.

913 Lab firmware subsystem; product address: %s

Cause:  This message should never occur.  It shows that you have an unreleased
version of system controller firmware.
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914 Lab firmware auxiliary subsystem; product address: %s

Cause:  This message should never occur.  It shows that you have an unreleased
firmware version of the auxiliary subsystem.

Analyzer Messages

1105 Unable to delete label; used by emulation analyzer: <label>

Cause:  This error occurs when you attempt to delete an emulation trace label
which is currently being used as a qualifier in the emulation trace specification or is
currently specified in the emulation trace format.

Action:  You stop the trace or must change the trace command before you can
delete the label.

1106 Unable to delete label; used by external state analyzer: <label>

Cause:  This error occurs when you attempt to delete an external trace label which
is currently being used as a qualifier in the external state trace specification or is
currently specified in the external trace format.

Action:  You stop the trace or must change the trace command before you can
delete the label.

1107 Unable to delete label; used by external timing analyzer: <label>

Cause:  This error occurs when you attempt to delete an external trace label which
is currently being used as a qualifier in the external timing trace specification.

Action:  Remove the label from the external timing analyzer specifications, and
then delete the label.

1108 Unable to redefine label; used by emulation analyzer: <label>

Cause:  This error occurs when you attempt to redefine an emulation trace label
which is currently used as a qualifier in the emulation trace specification.

Action:  You stop the trace or must change the trace command before you can
redefine the label.
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1109 Unable to redefine label; used by external state analyzer: <label>

Cause:  This error occurs when you attempt to redefine an external trace label
which is currently used as a qualifier in the external state trace specification.

Action:  You stop the trace or must change the trace command before you can
redefine the label.

1110 Unable to redefine label; used by external timing analyzer: <label>

Cause:  This error occurs when you attempt to redefine an emulation or external
trace label which is currently being used as a qualifier in the external timing trace
specification.

Action:  Remove the label from the external timing analyzer specifications, and
then redefine the label.

1301 External label in use: <label>

Cause:  This error occurs when you attempt to select the external analyzer’s
independent state mode while an external trace label is currently used as a qualifier
in the emulation analyzer trace specification.

Action:  Remove any external trace label qualifiers from emulation trace
specifications before selecting the external analyzer’s independent state mode.

1304 Analyzer trace running

Cause:  This error occurs when you attempt to change the external analyzer mode
while a trace is in progress.

Action:  Halt the trace before changing the external analyzer mode.

1305 CMB execute; emulation trace started

Cause:  This status message informs you that an emulation trace measurement has
started as a result of a CMB execute signal (as specified by the specify trace
command).

2021 Period not in 1/2/5 sequence: <period>

Cause:  This error message occurs when the external timing sample period is not in
a 1/2/5 sequence; for example, 10ns, 20ns, 50ns, 100ns, 200ns, 500ns, 1us, 2us,
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5us, etc.  Some examples of invalid sample period specifications are: 12ns, 18ns,
25ns, 60ns, 80ns, etc.

Action:  Use a number in the 1/2/5 sequence when specifying the external timing
sample period.

2022 Sample period out of bounds: <bounds>

Cause:  The external timing sample period must be between 10 ns and 50 ms (in a
1/2/5 sequence).

Action:  Re-enter the command with the sample period between the bounds shown.

2030 Negated patterns not allowed in timing

Cause:  This error occurs when you attempt to specify a "not equals" expression
when defining the external timing trigger.  You can only specify labels which equal
patterns (of 1’s, 0’s, or X’s).

Action:  Do not attempt to specify negated timing patterns.

2031 Invalid trigger duration: <duration>

Cause:  This error occurs when you attempt to specify an external timing trigger
duration which is in the valid range but is not a multiple of 10 ns.

Action:  Re-enter the command with the trigger duration as a multiple of 10 ns.

2032 Trigger duration out of bounds: <bounds>

Cause:  This error occurs when you attempt to specify an external timing trigger
duration outside the valid range.  A "greater than" duration must fall within the
range of 30 ns to 10 ms (and must be a multiple of 10 ns).  A "less than" duration
must fall within the range 40 ns to 10ms (and must be a multiple of 10 ns).

Action:  Re-enter the command with the trigger duration within the bounds shown.

2042 Trigger delay out of bounds: <bounds>

Cause:  This error occurs when you attempt to specify an external timing trigger
delay outside the valid range.  The external timing trigger delay must be between 0
and 10 ms (in 10 ns increments).

Action:  Re-enter the command with the trigger delay within the bounds shown.
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Concepts

This chapter provides conceptual information on the following topics:

• X resources and the Graphical User Interface.
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X Resources and the Graphical User Interface

This section contains more detailed information about X resources and scheme files
that control the appearance and operation of the Graphical User Interface.  This
section:

• Describes the X Window concepts surrounding resource specification.

• Describes the Graphical User Interface’s implementation of scheme files.

X Resource Specifications

An X resource specification is a resource name and a value.  The resource name
identifies the element whose appearance or behavior is to be defined, and the value
specifies how the element should look or behave.  For example, consider the
following resource specification:

Application.form.row.done.background: red

The resource name is "Application.form.row.done.background:" and the value is
"red".

Resource Names Follow Widget Hierarchy

A widget is an OSF/Motif graphic device from which X applications are built. For
example, pushbuttons and menu bars are Motif widgets.  Applications are built
using a hierarchy of widgets, and the application’s X resource names follow this
hierarchy.  For example:

Application.form.row.done.background: red

In the resource name above, the top-level widget is named after the application.
One of the top-level widget’s children is a form widget, one of the form widget’s
children is a row-column manager widget, and one of the row-column manager
widget’s children is a pushbutton widget.  Resource names show a path in the
widget hierarchy.

Each widget in the hierarchy is a member of a widget class, and the particular
instance of the widget is named by the application programmer.
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Class Names or Instance Names Can Be Used

When specifying resource names, you can use either instance names or class names.
For example, a "Done" pushbutton may have an instance name of "done" and a
class name of "XmPushButton".  To set the background color for a hypothetical
"Done" pushbutton, you can use:

Application.form.row.done.background: red

Or, you can use:

Application.form.row.XmPushButton.background: red

Applications also have class and instance names.  For example, an application may
have an instance name of "applic1" and a class name of "Application".  To set the
background color for a hypothetical "Done" pushbutton only in the "applic1"
application, you can use:

applic1.form.row.done.background: red

Note that instance names are more specific than class names.  That is, class names
may apply to many instances of the widget.

The class and instance names for the widgets in the Graphical User Interface can be
displayed by choosing Help→X Resource Names and clicking on the "All names"
button.

Wildcards Can Be Used

A wildcard may be used to match a resource specification to many different
widgets at once.  For example, to set the background color of all pushbuttons, you
can use:

Application*XmPushButton.background: red

Note that resource names with wildcards are more general than those without
wildcards.
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Specific Names Override General Names

A more specific resource specification will override a more general one when both
apply to a particular widget or application.

The names for the application and the main window widget in HP64_Softkey
applications have been chosen so that you may specify custom resource values that
apply in particular situations:

1 Apply to ALL HP64_Softkey applications:

HP64_Softkey*<resource>: <value>

2 Apply to specific types of HP64_Softkey applications:

emul*<resource>: <value> (for the emulator)
perf*<resource>: <value> (for the performance analyzer)

3 Apply to all HP64_Softkey applications, but only when they are connected to a
particular type of microprocessor:

*m68000*<resource>: <value> (for the 68000)
*m68020*<resource>: <value> (for the 68020)

4 Apply to a specific HP64_Softkey application connected to a specific
processor:

perf.m68000*<resource>: <value> (for the 68000 perf. analyzer)
emul.m68020*<resource>: <value> (for the 68020 emulator)

If all four examples above are used for a particular resource, #3 will override #2 for
all applications connected to a 68000 emulator, and #4 will override #2, but only
for the specifically mentioned type of microprocessor.

When modifying resources, your resource paths must either match, or be more
specific than, those found in the application defaults file.

How X Resource Specifications are Loaded

When the Graphical User Interface starts up, it loads resource specifications from a
set of configuration files located in system directories as well as user-specific
locations.
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Application Default Resource Specifications

Default resource specifications for an application are placed in a system directory:

HP-UX /usr/lib/X11/app-defaults

SunOS /usr/openwin/lib/X11/app-defaults

The name of the Graphical User Interface application defaults file is HP64_Softkey
(same as the application class name).  This file is well-commented and contains
information about each of the X resources you can modify.  You can easily view
this file by choosing Help→Topic and selecting the "X Resources: App Default
File" topic.  Do not modify the application defaults file; any changes to this file will
affect the appearance and behavior of the application for all users.

User-Defined Resource Specifications

User-defined resources (for any X application) are located in the X server’s
RESOURCE_MANAGER property or in the user’s $HOME/.Xdefaults file.

Load Order

Resource specifications are loaded from the following places in the following order:

5 The application defaults file.  For example,
/usr/lib/X11/app-defaults/HP64_Softkey when the operating system is HP-UX
or /usr/openwin/lib/X11/app-defaults/HP64_Softkey when the operating
system is SunOS.

6 The $XAPPLRESDIR/HP64_Softkey file.  (The XAPPLRESDIR environment
variable defines a directory containing system-wide custom application
defaults.)

7 The server’s RESOURCE_MANAGER property.  (The xrdb  command loads
user-defined resource specifications into the RESOURCE_MANAGER
property.)

If no RESOURCE_MANAGER property exists, user defined resource settings
are read from the $HOME/.Xdefaults file.
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8 The file named by the XENVIRONMENT environment variable.

If the XENVIRONMENT variable is not set, the $HOME/.Xdefaults-host file
is read (typically contains resource specifications for a specific remote host).

9 Resource specifications included in the command line with the -xrm  option.

When specifications with identical resource names appear in different places, the
latter specification overrides the former.

Scheme Files

Several of the Graphical User Interface’s X resources identify scheme files that
contain additional X resource specifications.  Scheme files group resource
specifications for different displays, computing environments, and languages.

Resources for Graphical User Interface Schemes

There are five X resources that identify scheme files:

HP64_Softkey.labelScheme:

Names the scheme file to use for labels and button text.  Values can be: Label,
$LANG, or a custom scheme file name.  The default uses the $LANG
environment variable if it is set and if a scheme file named Softkey.$LANG
exists in one of the directories searched for scheme files; otherwise, the default
is Label.

HP64_Softkey.platformScheme:

Names the subdirectory for the platform specific color, size, and input scheme
files.  This resource should be set to the platform on which the X server is
running (and displaying the Graphical User Interface) if it is different than the
platform where the application is running.  Values can be: HP-UX, SunOS,
pc-xview, or a custom platform scheme directory name.

HP64_Softkey.colorScheme:

Names the color scheme file.  Values can be: Color, BW, or a custom scheme
file name.
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HP64_Softkey.sizeScheme:

Names the size scheme file which defines the fonts and the spacing used.
Values can be: Large, Small, or a custom scheme file name.

HP64_Softkey.inputScheme:

Names the input scheme file which specifies mouse and keyboard operation.
Values can be: Input, or a custom scheme file name.

The actual scheme file names take the form: "Softkey.<value>".

Scheme File Names

There are six scheme files provided with the Graphical User Interface.  Their names
and brief descriptions of the resources they contain follow.

Softkey.Label Defines the labels for the fixed text in the interface. Such
things as menu item labels and similar text are in this file.
If the $LANG environment variable is set, the scheme file
"Softkey.$LANG" is loaded if it exists; otherwise, the file
"Softkey.Label" is loaded.

Softkey.BW Defines the color scheme for black and white displays. This
file is chosen if the display cannot produce at least 16
colors.

Softkey.Color Defines the color scheme for color displays.  This file is
chosen if the display can produce 16 or more colors.

Softkey.Large Defines the size scheme (that is, the window dimensions
and fonts) for high resolution displays (1000 pixels or more
vertically).

Softkey.Small Defines the size scheme (that is, the window dimensions
and fonts) for low resolution displays (less than 1000 pixels
vertically).

Softkey.Input Defines the input scheme (that is, the button and key
bindings for the mouse and keyboard).
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Load Order for Scheme Files

Scheme files are searched for in the following directories and in the following order:

10 System scheme files in directory /usr/hp64000/lib/X11/HP64_schemes.

11 System-wide custom scheme files located in directory
$XAPPLRESDIR/HP64_schemes.

12 User-defined scheme files located in directory $HOME/.HP64_schemes (note
the dot in the directory name).

Custom Scheme Files

You can modify scheme files by copying them to the directory for user-defined
schemes and changing the resource specifications in the file.  For example, if you
wish to modify the color scheme, and your platform is HP-UX, you can copy the
/usr/hp64000/lib/X11/HP64_schemes/HP-UX/Softkey.Color file to
$HOME/.HP64_schemes/HP-UX/Softkey.Color and modify its resource
specifications.

You can create custom scheme files by modifying the X resource for the particular
scheme and by placing the custom scheme file in the directory for user-defined
schemes.  For example, if the following resource specifications are made:

HP64_Softkey.platformScheme:  HP-UX
HP64_Softkey.colorScheme:     MyColor

The custom scheme file would be:

$HOME/.HP64_schemes/HP-UX/Softkey.MyColor
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Installation at a Glance

Before you can use the Graphical User Interface, you may need to install emulator
hardware, and you have to install the interface software.  You also need to verify
the installation of the interface software and understand how to start the Graphical
User Interface for the first time.

This chapter is not intended to be a complete installation guide for all of the
just-mentioned tasks.  This chapter concentrates on information, not found in other
places, that is necessary for the installation or operation of the interface.

Installation Overview for HP 9000 Hosted Systems

Users of HP 9000 hosted systems should follow the instructions in the section titled
"Installation for HP 9000 Hosted Systems". Briefly, those instructions tell you to do
the following:

1 If necessary, install emulator, analyzer, or memory cards in the HP 64700
Series Cardcage according to the instructions found in the HP 64700 Series
Installation/Service Guide.

2 Connect the emulator to your system and configure the emulator to
communicate via the LAN (or RS-422 or RS-232) with the HP 9000 according
to instructions also found in the HP 64700 Series Installation/Service Guide.

3 Install the Graphical User Interface and supporting HP 64700 Series software
according to instructions found in this chapter.  Alternatively, you may install
the Softkey Interface and choose not to install the Graphical User Interface.

4 Verify the software installation according to instructions given in the
"Installation for HP 9000 Hosted Systems" section of this chapter.

5 Start the interface according to instructions given in the "Installation for
HP 9000 Hosted Systems" section of this chapter.

6 Exit the interface and go on to other chapters in this book.

Minimum HP 9000 Hardware and System Requirements

The following is a set of minimum hardware and system recommendations for
operation of the Graphical User Interface on HP 9000 Series 300/400 and Series
700 workstations.
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HP-UX For Series 9000/300 and Series 9000/400 workstations, the minimum
supported version of the operating system is 7.03 or later. For Series 9000/700
workstations, the minimum supported version of the operating system is version
8.01.

Motif/OSF For Series 9000/700 workstations, you must also have the Motif 1.1
dynamic link libraries installed.  They are installed by default, so you do not have
to install them specifically for this product, but you should consult your HP-UX
documentation for confirmation and more information.

Hardware and Memory Any workstation used with the Graphical User
Interface should have a minimum of 16 megabytes of memory. Series 300
workstations should have a minimum performance equivalent to that of a
HP 9000/350. A color display is also highly recommended.

From here, you should proceed to the section titled "Installation for HP 9000
Hosted Systems" for instructions on how to install, verify, and start the Graphical
User Interface on HP 9000 systems.
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Installation Overview for Sun SPARCsystems

Users of Sun SPARCsystems should follow the instructions in the section titled
"Installation for Sun SPARCsystems".  Briefly, those instructions tell you to do the
following:

7 If necessary, install emulator, analyzer, or memory cards in the HP 64700
Series Cardcage according to the instructions found in the HP 64700 Series
Installation/Service Guide.

8 Connect the emulator to your system and configure the emulator to
communicate via the LAN with the hosted workstation according to
instructions also found in the HP 64700 Series Installation/Service Guide.

9 Install the Graphical User Interface and supporting HP 64700 Series software
according to instructions found in this chapter.  Alternatively, you may install
the Softkey Interface and choose not to install the Graphical User Interface.

10 Verify the software installation according to instructions given in the
"Installation for Sun SPARCsystems" section of this chapter.

11 Start the interface according to instructions given in the "Installation for Sun
SPARCsystems" section of this chapter.

12 Exit the interface and go on to other chapters in this book.

Minimum Sun SPARCsystem Hardware and System Requirements

The following is a set of minimum hardware and system recommendations for
operation of the Graphical User Interface on Sun SPARCsystem workstations.

SunOS The Graphical User Interface software is designed to run on a Sun
SPARCsystem with SunOS version 4.1 or 4.1.1 or greater.  The tape uses the
QIC-24 data format.

Hardware and Memory Any workstation used with the Graphical User
Interface should have a minimum of 16 megabytes of memory.  A color display is
also highly recommended.

From here, you should proceed to the section titled "Installation for Sun
SPARCsystems" for instructions on how to install, verify, and start the Graphical
User Interface on SPARCsystem workstations.
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Installation for HP 9000 Hosted Systems 

Follow these instructions to install the Graphical User Interface on HP 9000
workstations.  You can also follow these instructions through Step 4 to find out
how not to install the Graphical User Interface if you want to use just the Softkey
Interface.

Step 1. Install the hardware in the HP 64700
Series Cardcage

Turn to the HP 64700 Series Installation/Service Guide and follow the instructions
for installing emulator, memory, or analyzer cards in the HP 64700 Series
Cardcage. It may be that you already have installed the cards in the cardcage or
your cardcage came with cards already installed.

If you have already installed the hardware and software and connected the emulator
to your host system, skip to Step 5 to verify the software installation. Otherwise,
continue with Step 2 of these instructions.

Step 2. Configure the emulator for the
communication channel

Turn to the HP 64700 Series Installation/Service Guide and follow the instructions
for configuring the emulator to communicate via LAN, RS-422, or RS-232.
(RS-422 and RS-232 are only supported on HP 9000 Series 300/400 machines.)

When you have configured the emulator to communicate via the channel you have
chosen, continue with Step 3 of these instructions.
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Step 3. Connect the emulator to your system

Turn to the HP 64700 Series Installation/Service Guide and follow the instructions
for connecting the emulator to your system. You can connect the emulator via
LAN, RS-422, or RS-232.

When you have connected the emulator to your host system, continue with Step 4
of these instructions.

Step 4. Install the software

The tape that contains the Graphical User Interface software may contain several
products.  Usually, you will want to install all of the products on the tape.
However, to save disk space, or for other reasons, you can choose to install selected
filesets.

If you plan on using the Softkey Interface instead of the Graphical User Interface,
you can save about 3.5 megabytes of disk space by not installing the XUI suffixed
filesets in the "64700 Operating Environment" and "<processor-type> Emulation
Tools" partitions.  (Also, if you choose not to install the Graphical User Interface,
you will not have to use a special command line option to start the Softkey
Interface.)

Refer to the information on updating HP-UX in your HP-UX documentation for
instructions on viewing partitions and filesets and marking filesets that should not
be loaded.

The following sub-steps assume that you want to install all products on the tape.

1 Become the root user on the system you want to update.

2 Make sure the tape’s write-protect screw points to SAFE.
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3 Put the product media into the tape drive that will be the source device for the
update process.

4 Confirm that the tape drive BUSY and PROTECT lights are on.  If the PROTECT
light is not on, remove the tape and confirm the position of the write-protect screw.
If the BUSY light is not on, check that the tape is installed correctly in the drive
and that the drive is operating correctly.

5 When the BUSY light goes off and stays off, start the update program by entering

/etc/update 

at the HP-UX prompt.

6 When the HP-UX update utility main screen appears, confirm that the source and
destination devices are correct for your system.  Refer to the information on
updating HP-UX in your HP-UX documentation if you need to modify these values.

7 Select "Load Everything from Source Media" when your source and destination
directories are correct.

8 To begin the update, press the softkey <Select Item>.  At the next menu, press the
softkey <Select Item> again.  Answer the last prompt with

y

It takes about 20 minutes to read the tape.

9 When the installation is complete, read /tmp/update.log to see the results of the
update.
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Step 5. Verify the software installation

A number of new filesets were installed on your system during the software
installation process.  This and following steps assume that you chose to load the
Graphical User Interface filesets.

You can use this step to further verify that the filesets necessary to successfully
start the Graphical User Interface have been loaded and that customize scripts have
run correctly. Of course, the update process gives you mechanisms for verifying
installation, but these checks can help to double-check the installation process.

1 Verify the existence of the HP64_Softkey file in the /usr/lib/X11/app-defaults
subdirectory by entering 
ls /usr/lib/X11/app-defaults/HP64_Softkey at the HP-UX prompt.

Finding this file verifies that you loaded the correct fileset and also verifies that the
customize scripts executed because this file is created from other files during the
customize process.

2 Examine /usr/lib/X11/app-defaults/HP64_Softkey near the end of the file to
confirm that there are resources specific to your emulator.

Near the end of the file, there will be resource strings that contain references to
specific emulators. For example, if you installed the Graphical User Interface for
the 68000 emulator, resource name strings will have m68000 embedded in them.

After you have verified the software installation, you must start the X server and an
X window manager (if you are not currently running an X server). If you plan to
run the Motif Window Manager (mwm), or similar window manager, continue with
Step 6a of these instructions. If you plan to run HP VUE, skip to Step 6b of these
instructions.
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Step 6a. Start the X server and the Motif Window
Manager (mwm)

If you are not already running the X server and a window manager, do so now. The
X server is required to use the Graphical User Interface because it is an X Windows
application. A window manager is not required to execute the interface, but, as a
practical matter, you must use some sort of window manager with the X server.

• Start the X server by entering x11start at the HP-UX prompt.

Consult the X Window documentation supplied with the HP-UX operating system
documentation if you do not know about using X Windows and the X server.

After starting the X server and Motif Window Manager, continue with step 7 of
these instructions.

Step 6b. Start HP VUE

If you are running the X server under HP VUE and have not started HP VUE, do so
now.

HP VUE is a window manager for the X Window system. The X server is
executing underneath HP VUE. Unlike the Motif Window Manager, HP VUE
provides a login shell and is your default interface to the HP 9000 workstation.
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Step 7. Set the necessary environment variables

The DISPLAY environment variable must be set before the Graphical User
Interface will start.  Also, you should modify the PATH environment variable to
include the "/usr/hp64000/bin" directory, and, if you have installed software in a
directory other than "/", you need to set the HP64000 environment variable.

The following instructions show you how to set these variables at the UNIX
prompt.  Modify your ".profile" or ".login" file if you wish these environment
variables to be set when you log in.  The following instructions also assume that
you’re using "sh" or "ksh"; if you’re using "csh", environment variables are set
using the "setenv <VARIABLE> <value>" command.

1 Set the DISPLAY environment variable by entering

DISPLAY=<hostname>:<server_number>.<screen_number>
export DISPLAY

For example:

DISPLAY=myhost:0.0; export DISPLAY

Consult the X Window documentation supplied with the UNIX system
documentation for an explanation of the DISPLAY environment variable.

2 Set the HP64000 environment variable.

For example, if you installed the HP 64000 software relative to the root directory,
"/", you would enter

HP64000=/usr/hp64000; export HP64000

If you installed the software relative to a directory other than the root directory, it is
strongly recommended that you use a symbolic link to make the software appear to
be under /usr/hp64000.  For example, if you installed the software relative to
directory /users/team, you would enter

ln -s /users/team/usr/hp64000 /usr/hp64000

If you do not wish to establish a symbolic link, you can set the HP64000 variable to
the full path that contains the HP 64000 software. Again, if you installed relative to
/users/team, you would enter
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HP64000=/users/team/usr/hp64000; export HP64000

3 Set the PATH environment variable to include the usr/hp64000/bin directory by
entering

PATH=$PATH:$HP64000/bin; export PATH

Including usr/hp64000/bin in your PATH relieves you from prefixing HP 64700
executables with the directory path.

4 Set the MANPATH environment variable to include the usr/hp64000/man and
usr/hp64000/contrib/man directories by entering

MANPATH=$MANPATH:$HP64000/man:$HP64000/contrib/man
export MANPATH

Including these directories in your MANPATH variable lets you access the on-line
"man" page information included with the software.
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Step 8. Determine the logical name of your
emulator

The logical name of an emulator is a label associated with a set of communications
parameters in the $HP64000/etc/64700tab.net file. The 64700tab.net file is placed
in the directory as part of the installation process.

1 Display the 64700tab.net file by entering 
more /usr/hp64700/etc/64700tab.net at the HP-UX prompt.

2 Page through the file until you find the emulator you are going to use.

This step will require some matching of information to an emulator, but it should
not be difficult to determine which emulator you want to address.

Examples A typical entry for an 68000 emulator connected to the LAN would appear as
follows:

#---------------------------------------------------------------------------
# Channel| Logical   | Processor | Remainder of Information for the Channel
#  Type  |  Name     |   Type    | (IP address for LAN connections)
#---------------------------------------------------------------------------
   lan:     em68000     m68000      21.17.9.143

A typical entry for an 68000 emulator connected to an RS-422 port would appear as
follows:

#-------------------------------------------------------------------------------
#        |           |           |      |            |Xpar|Parity|Flow|Stop|Char
# Channel| Logical   | Processor | Host |  Physical  |Mode|      |    |Bits|Size
#  Type  |  Name     |   Type    | Name |   Device   |    |      |XON |    |
#        |           |           |      |            |OFF | NONE |RTS | 2  | 8
#-------------------------------------------------------------------------------
  serial:   em68000     m68000    myhost /dev/emcom23 OFF   NONE  RTS   2    8
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Step 9. Start the interface with the emul700
command

1 Apply power to the emulator you wish to access after making sure the emulator is
connected to the LAN or to your host system.

On the HP 64700 Series Emulator, the power switch is located on the front panel
near the bottom edge. Push the switch in to turn power on to the emulator.

2 Wait a few seconds to allow the emulator to complete its startup initialization.

3 Choose a terminal window from which to start the Graphical User Interface.

4 Start the Graphical User Interface by entering the emul700 command and giving
the logical name of the emulator as an argument to the command, as in

$HP64000/bin/emul700 <logical_name> &

or
emul700 <logical name> & 

if $HP64000/bin is in you path.

If you are running the X server, if the Graphical User Interface is installed, and if
your DISPLAY environment variable is set, the emul700 command will start the
Graphical User Interface. Otherwise, emul700 starts the Softkey Interface.

You should include an ampersand ("&") with the command to start the Graphical
User Interface as a background process. Doing so frees the terminal window where
you started the interface so that the window may still be used.

5 Optionally start additional Graphical User Interface windows into the same
emulation session by repeating the previous step.

You can also choose to use the Softkey Interface under X Windows, but you must
include a command line argument to emul700 to override the default Graphical
User Interface. Start the Softkey Interface by entering 
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emul700 -u skemul <logical name>

Example Suppose you have discovered that the logical name for a 68000 emulator connected
to the LAN is "em68000". To start the Graphical User Interface and begin
communicating with that emulator, enter (assuming your $PATH includes
$HP64000/bin)

emul700 em68000

After a few seconds, the Graphical User Interface Emulator/Analyzer window
should appear on your screen. The window will be similar to the following:
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Step 10. Exit the Graphical User Interface

1 Position the mouse pointer over the pulldown menu named "File" on the menu bar
at the top of the interface screen.

2 Press and hold the command select mouse button until the File menu appears.

3 While continuing to hold the mouse button down, move the mouse pointer down
the menu to the "Exit" menu item.

4 Display the Exit cascade menu by moving the mouse pointer to the right edge of
the Exit menu choice. There is an arrow on the right edge of the menu item.

5 Choose "Released" from the cascade menu.

The interface will terminate and release the emulator for use by others.
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Installation for Sun SPARCsystems

Follow these instructions to install the Graphical User Interface on Sun
SPARCsystem workstations.  You can also follow these instructions through Step 4
to find out how to prevent installation of the Graphical User Interface if you only
plan to use the Softkey Interface.

Step 1. Install the hardware in the HP 64700
Series Cardcage

Turn to the HP 64700 Series Installation/Service Guide and follow the instructions
for installing emulator, memory, or analyzer cards in the HP 64700 Series
Cardcage. It may be that you already have installed the cards in the cardcage or
your cardcage came with cards already installed.

If you have already installed the hardware and software and connected the emulator
to your host system, skip to Step 5 to verify the software installation. Otherwise,
continue with Step 2 of these instructions.

Step 2. Configure the emulator for the
communication channel

Turn to the HP 64700 Series Installation/Service Guide and follow the instructions
for configuring the emulator to communicate via LAN. (RS-422 and RS-232 are
only supported on HP 9000 Series 300/400 machines.)

When you have configured the emulator to communicate via LAN, continue with
Step 3 of these instructions.
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Step 3. Connect the emulator to your system

Turn to the HP 64700 Series Installation/Service Guide and follow the instructions
for connecting the emulator to your system. You can connect the emulator via LAN.

When you have connected the emulator to your host system, continue with Step 4
of these instructions.

Step 4. Install the software

The tape that contains the Graphical User Interface software may contain several
products.  Usually, you will want to install all of the products on the tape.
However, to save disk space, or for other reasons, you can choose to install selected
filesets.

If you plan on using the Softkey Interface instead of the Graphical User Interface,
you can save about 3.5 megabytes of disk space by not installing the XUI suffixed
filesets.  (Also, if you choose not to install the Graphical User Interface, you will
not have to use a special command line option to start the Softkey Interface.)

Refer to the Software Installation Notice for software installation instructions.
After you are done installing the software, return here.
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Step 5. Start the X server and OpenWindows

If you are not already running the X server, do so now. The X server is required to
run the Graphical User Interface because it is an X application.

• Start the X server by entering /usr/openwin/bin/openwin at the UNIX prompt.

Consult the OpenWindows documentation if you do not know about using
OpenWindows and the X server.

Step 6. Set the necessary environment variables

The DISPLAY environment variable must be set before the Graphical User
Interface will start.  Also, you should modify the PATH environment variable to
include the "usr/hp64000/bin" directory, and, if you have installed software in a
directory other than "/", you need to set the HP64000 environment variable.

The following instructions show you how to set these variables at the UNIX
prompt.  Modify your ".profile" or ".login" file if you wish these environment
variables to be set when you log in.  The following instructions also assume that
you’re using "csh"; if you’re using "sh", environment variables are set in the
"<VARIABLE>=<value>; export <VARIABLE>" form.

1 The DISPLAY environment variable is usually set by the openwin startup script.
Check to see that DISPLAY is set by entering

echo $DISPLAY

If DISPLAY is not set, you can set it by entering

setenv DISPLAY=<hostname>:<server_number>.<screen_number>
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For example:

setenv DISPLAY=myhost:0.0

Consult the OpenWindows documentation for an explanation of the DISPLAY
environment variable.

2 Set the HP64000 environment variable.

For example, if you installed the HP 64000 software relative to the root directory,
"/", you would enter

setenv HP64000 /usr/hp64000

If you installed the software relative to a directory other than the root directory, it is
strongly recommended that you use a symbolic link to make the software appear to
be under /usr/hp64000.  For example, if you installed the software relative to
directory /users/team, you would enter

ln -s /users/team/usr/hp64000 /usr/hp64000

If you do not wish to establish a symbolic link, you can set the HP64000 variable to
the full path that contains the HP 64000 software; also set the
LD_LIBRARY_PATH variable to the directory containing run-time libraries used
by the HP 64000 products.  Again, if you installed relative to /users/team, you
would enter

setenv HP64000 /users/team/usr/hp64000
setenv LD_LIBRARY_PATH ${LD_LIBRARY_PATH}:${HP64000}/lib

3 Set the PATH environment variable to include the usr/hp64000/bin directory by
entering

setenv PATH ${PATH}:${HP64000}/bin

Including usr/hp64000/bin in your PATH relieves you from prefixing HP 64700
executables with the directory path.
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4 Set the MANPATH environment variable to include the usr/hp64000/man and
usr/hp64000/contrib/man directories by entering

setenv MANPATH ${MANPATH}:${HP64000}/man
setenv MANPATH ${MANPATH}:${HP64000}/contrib/man

Including these directories in your MANPATH variable lets you access the on-line
"man" page information included with the software.

5 If the Graphical User Interface is to run on a SPARCsystem computer that is not
running OpenWindows, include the /usr/openwin/lib directory in
LD_LIBRARY_PATH.

setenv LD_LIBRARY_PATH ${LD_LIBRARY_PATH}:/usr/openwin/lib

Step 7. Verify the software installation

A number of product filesets were installed on your system during the software
installation process.  Due to the complexity of installing on NFS mounted file
systems, a script that verifies and customizes these products was also installed.
This stand alone script may be run at any time to verify that all files required by the
products are in place in the file system.  If required files are not found, this script
will attempt to symbolically link them from the $HP64000 install directory to their
proper locations.

• Run the script $HP64000/bin/envinstall.
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Step 8. Map your function keys

If you are using the Softkey Interface, map your function keys by following the
steps below.

1 Copy the function key definitions by typing:

cp $HP64000/etc/ttyswrc ~/.ttyswrc

This creates key mappings in the .ttyswrc file in your $HOME directory.

2 Remove or comment out the following line from your .xinitrc file:

xmodmap -e ’keysym F1 = Help’

If any of the other keys F1-F8 are remapped using xmodmap, comment out those
lines also.

3 Add the following to your .profile or .login file:

stty erase ^H
setenv KEYMAP sun

The erase character needs to be set to backspace so that the Delete key can be used
for "delete character."

If you want to continue using the F1 key for HELP, you can use use F2-F9 for the
Softkey Interface.  All you have to do is set the KEYMAP variable.  If you use
OpenWindows, type:

setenv KEYMAP sun.2-9

If you use xterm windows (the xterm window program is located in the directory
/usr/openwin/demo), type:

setenv KEYMAP xterm.2-9

Reminder: If you are using OpenWindows, add /usr/openwin/bin to the end of the
$PATH definition, and add the following line to your .profile:
setenv OPENWINHOME /usr/openwin

After you have mapped your function keys, you must start the X server and an X
window manager (if you are not currently running an X server).
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Step 9. Determine the logical name of your
emulator

The logical name of an emulator is a label associated with a set of communications
parameters in the $HP64000/etc/64700tab.net file. The 64700tab.net file is placed
in the directory as part of the installation process.

1 Display the 64700tab.net file by entering 
more $HP64000/etc/64700tab.net at the UNIX prompt.

2 Page through the file until you find the emulator you are going to use.

This step will require some matching of information to an emulator, but it should
not be difficult to determine which emulator you want to address.

Examples A typical entry for an 68000 emulator connected to the LAN would appear as
follows:

#---------------------------------------------------------------------------
# Channel| Logical   | Processor | Remainder of Information for the Channel
#  Type  |  Name     |   Type    | (IP address for LAN connections)
#---------------------------------------------------------------------------
   lan:     em68000     m68000      21.17.9.143
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Step 10. Start the interface with the emul700
command

1 Apply power to the emulator you wish to access after making sure the emulator is
connected to the LAN.

On the HP 64700 Series Emulator, the power switch is located on the front panel
near the bottom edge. Push the switch in to turn power on to the emulator.

2 Wait a few seconds to allow the emulator to complete its startup initialization.

3 Choose a terminal window from which to start the Graphical User Interface.

4 Start the Graphical User Interface by entering the emul700 command and giving
the logical name of the emulator as an argument to the command, as in

$HP64000/bin/emul700 <logical_name> &

or
emul700 <logical name> & 

if $HP64000/bin is in your path.

If you are running the X server, if the Graphical User Interface is installed, and if
your DISPLAY environment variable is set, the emul700 command will start the
Graphical User Interface. Otherwise, emul700 starts the Softkey Interface.

You should include an ampersand ("&") with the command to start the Graphical
User Interface as a background process. Doing so frees the terminal window where
you started the interface so that the window may still be used.

5 Optionally start additional Graphical User Interface windows into the same
emulation session by repeating the previous step.

You can also choose to use the Softkey Interface in a terminal emulation window,
but you must include a command line argument to emul700 to override the default
Graphical User Interface. Start the Softkey Interface by entering 
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emul700 -u skemul <logical name>

Example Suppose you have discovered that the logical name for a 68000 emulator connected
to the LAN is "em68000". To start the Graphical User Interface and begin
communicating with that emulator, enter (assuming your $PATH includes
$HP64000/bin)

emul700 em68000

After a few seconds, the Graphical User Interface Emulator/Analyzer window
should appear on your screen. The window will be similar to the following:
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Step 11. Exit the Graphical User Interface

1 Position the mouse pointer over the pulldown menu named "File" on the menu bar
at the top of the interface screen.

2 Press and hold the command select mouse button until the File menu appears.

3 While continuing to hold the mouse button down, move the mouse pointer down
the menu to the "Exit" menu item.

4 Display the Exit cascade menu by moving the mouse pointer to the right edge of
the Exit menu choice. There is an arrow on the right edge of the menu item.

5 Choose "Released" from the cascade menu.

The interface will terminate and release the emulator for use by others.
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Glossary

access mode Specifies the types of cycles used to access target system memory
locations.  For example a "byte" access mode tells the monitor program to use
load/store byte instructions to access target memory.

analyzer An instrument that captures data on signals of interest at discreet
periods.

background The emulator mode in which foreground operation is suspended so
the emulation processor can be used for communication with the emulation
controller.  The background monitor does not occupy any processor address space.

background emulation monitor An emulation monitor program that does not
execute as part of the user program, and therefore, operates in the emulator’s
background mode.

background memory Memory space reserved for the emulation processor
when it is operating in the background mode.  Background memory does not take
up any of the microprocessor’s address space.

display mode When displaying memory, this mode tells the emulator the size of
the memory locations to display.  When modifying memory, the display mode tells
the emulator the size of the values to be written to memory.

embedded microprocessor system The microprocessor system which the
emulator plugs into. 

emulation bus analyzer The internal analyzer that captures emulator bus cycle
information synchronously with the processor’s clock signal.

emulation monitor program A program that is executed by the emulation
processor which allows the emulation controller to access target system resources.
For example, when you display target system memory locations, the monitor
program executes microprocessor instructions that read the target memory locations
and send their contents to the emulation controller.
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emulator An instrument that performs just like the microprocessor it replaces, but
at the same time, it gives you information about the operation of the processor.  An
emulator gives you control over target system execution and allows you to view or
modify the contents of processor registers, target system memory, and I/O
resources.

foreground The mode in which the emulator is executing the user program.  In
other words, the mode in which the emulator operates as the target microprocessor
would.

global restart When the same secondary branch condition is used for all terms in
the analyzer’s sequencer, and secondary branches are always back to the first term.

prestore The analyzer feature that allows up to two states to be stored before
normally stored states.  This feature is useful when you want to find the cause of a
particular state. For example, if a variable is accessed from many different places in
the program, you can qualify the trace so that only accesses of that variable are
stored and turn on prestore to find out where accesses of that variable originate
from.

primary sequencer branch Occurs when the analyzer finds the primary branch
state specified at a certain level and begins searching for the states specified at the
primary branch’s destination level.

real-time Refers to continuous execution of the user program without
interference from the emulator.  (Such interference occurs when the emulator
temporarily breaks into the monitor so that it can access register contents or target
system memory or I/O.)

secondary sequencer branch Occurs when the analyzer finds the secondary
branch state specified at a certain level before it found the primary branch state and
begins searching for the states specified at the secondary branch’s destination level.

sequence terms Individual levels of the sequencer.  The HP 64705A analyzer
provides 8 sequence terms.

sequencer The part of the analyzer that allows it to search for a certain sequence
of states before triggering.

Glossary
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sequencer branch Occurs when the analyzer finds the primary or secondary
branch state specified at a certain level and begins searching for the states specified
at another level.

target system The microprocessor system which the emulator plugs into. 

trace A collection of states captured on the emulation bus (in terms of the
emulation bus analyzer) or on the analyzer trace signals (in terms of the external
analyzer) and stored in trace memory.

trigger The captured analyzer state about which other captured states are stored.
The trigger state specifies when the trace measurement is taken.

Glossary
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Index

A about, trigger position specification, 212
absolute count, in the trace display, 235
absolute files, 374

loading, 141
loading without symbols, 142
storing memory contents into, 142

absolute status, in the trace display, 229
access mode, 517
access size (target memory), 133
action keys, 26

custom, 318
operation, 73
with command files, 318
with entry buffer, 71, 73

activity measurements (SPMT), 245-259
additional symbols for address, 253
confidence level, 254
error tolerance, 254
interpreting reports, 252
mean, 252
relative and absolute counts, 253
standard deviation, 253
symbols within range, 253
trace command setup, 247

address (analyzer state qualifier softkey), 211, 395, 410
address lines driven during background, 134
address overlays, memory mapping, 126
address qualifiers, 211
address range file format (SPMT measurements), 249
after, trigger position specification, 212
ambiguous address error message, 126
analyzer, 517

arming other HP 64700 Series analyzers, 5
breaking emulator execution into the monitor, 4
breaking execution of other HP 64700 Series emulators, 5
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count qualifiers, 217
definition, 4
dma status qualifier, 130
general description, 4
occurrence count, 214
prestore qualifiers, 216
state qualifiers, 211
storage  qualifiers, 215
tagging bus arbitration, 130
trace at EXECUTE, 297
trigger condition, 212
using the, 198

analyzer probe
assembling, 276
connecting to the target system, 278

analyzer status
occurrence left information, 202
sequence term information, 202

app-defaults directory
HP 9000 computers, 484
Sun SPARCsystem computers, 484

application resource
See X resource

arm information, 201
arm_trig2, in trace command, 424

B background, 112-113, 517
address driven, 134
driving target system during, 134
emulation monitor, 517
memory, 517
tracing, 137

background execution, tracing, 137
background function codes driven, 134
background monitor, 113

selecting, 112-119
bases (number), 207
bbaunload command, syntax, 337
before, trigger position specification, 212
BERR, response to during target memory cycles, 131
binary numbers, 207
BKPT, software breakpoint instruction (68010), 160
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BNC
connector, 5, 290
trigger signal, 292

break command, 157
syntax, 336

break on guarded memory access, 219
breakpoint illegal instruction, 160
breakpoints, 34

screen to file, 192
TRAP instruction, 137

breaks on write to ROM, 136
bus arbitration

configure emulator’s response, 129
status qualifier, 130
tagging, 130
tagging and the dma analyzer status qualifier, 130
using configuration to isolate target problem, 98

bus error response by emulator, 122, 131
bus width (data), setting, 133

C cascade menu, 64
cautions

BNC accepts only TTL voltage levels, 295
CMB 9-pin port is NOT for RS-232C, 293
real-time dependent target system circuitry, 109

changing
directory context in configuration window, 105
directory context in emulator/analyzer window, 152
symbol context, 153

characterization of memory, 122
class name, X applications, 482
client, X, 310
clock source selection, emulator configuration, 108
clocks

See also slave clocks
closing

emulator/analyzer windows, 59
CMB (coordinated measurement bus), 290

EXECUTE line, 292, 338
HP 64700 connection, 293
READY line, 291
signals, 291
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TRIGGER line, 291
cmb_execute command, 298, 338
color scheme, 312, 316, 486
column width, trace display option, 234
columns in main display area, 313
command buttons, 27
command files, 376

other things to know about, 88
passing parameters, 87

command line, 27
Command Recall dialog box, 28
Command Recall dialog box, operation, 82
copy-and-paste to from entry buffer, 72
editing entry area with popup menu, 81
editing entry area with pushbuttons, 80
entering commands, 79
entry area, 27
executing commands, 79
help, 82
keyboard use of, 83-85
on-line help, 85
recalling commands with dialog box, 82
turning on or off, 78, 313

command paste mouse button, 29
Command Recall dialog box operation, 74
command select mouse button, 29
commands, 83

combining on a single command line, 83
completion, 83
editing in command line entry area, 80-81
entering in command line, 79
executing in command line, 79
keyboard entry, 83
line erase, 84
map, 127
recall, 84
recalling with dialog box, 82
summary, 335
word selection, 84

comparison of foreground/background monitors, 114
configuration (emulator)
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A23-A8 values for driven background cycles, 134
background states, tracing, 137
breaks on writes to ROM, 136
bus arbitration enable/disable, 129
bus arbitration tagging, 130
bus error response, 131
bus error response by emulator, 122
data bus width, 133
drive background cycles to target, 134
DTACK interlock, 128
DTACK interlock for monitor, 119
function codes for driven background cycles, 134
inverse assembly syntax, 110
monitor entry after, 109
monitor selection, 112-119
supervisor stack pointer reset value, 132
target system interrupts enable/disable, 132
TRAP instruction for breakpoint, 137

configuration context
displaying from configuration window, 106

configuration, emulator
exiting the interface, 107
loading from file, 107
modifying a section, 102
starting the interface, 100
storing, 104

context
changing directory in configuration window, 105
changing directory in emulator/analyzer window, 152
changing symbol, 153
displaying directory from configuration window, 106
displaying directory from emulator/analyzer window, 152
displaying symbol, 152

coordinated measurements, 299
break_on_trigger syntax of the trace command, 299
definition, 290

copy command, 339-341
data, 340
display, 340
error_log, 340
event_log, 340
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global symbols, 340
help, 340
local_symbols_in, 342
memory, 343-344
pod_command, 341
registers, 345

software breakpoints, 341
status, 341
trace, 346

copy-and-paste
addresses, 69
from entry buffer, 72
multi-window, 69, 72
symbol width, 69
to entry buffer, 68

copying
breakpoints screen to file, 192
data values screen to file, 192
display area to file, 192
emulator status screen to file, 193
error log to file, 193
event log to file, 193
global symbols to file, 193
local symbols to file, 193
memory to file, 192
pod commands screen to file, 193
registers to file, 192
trace listing to file, 192

count absolute/relative, trace display option, 235
count qualifiers, 217
count, occurrence, 214
cursor buttons, 28

D data
copy command, 340
display command, 349-351

data (analyzer state qualifier softkey), 211, 395, 410
data (external), trace display option, 238
data bus width, 133
data value

screen to file, 192

Index

526



data values, 181-182
adding items to the existing display, 182
clearing the display and adding a new item, 182
displaying, 181

data values, displaying, 38
decimal numbers, 207
default trace command, 200
default trace display

returning to, 237
demos, setting up, 321-323
demultiplexing, using slave clocks for, 283
demux, slave clock mode, 285
depth of the trace, 206
device table file, 32, 53-54
dialog box, 73

Command Recall, operation, 74, 82
Directory Selection, 152
Directory Selection, operation, 73, 76
Entry Buffer Recall, operation, 71, 74
File Selection, operation, 74-75
Trace Specification Selection, operation, 206

directory context
changing in configuration window, 105
changing in emulator/analyzer window, 152
displaying from configuration window, 106
displaying from emulator/analyzer window, 152

Directory Selection dialog box operation, 73, 76
display area, 27

columns, 313
lines, 313-314
screen to file, 192

display command, 347-348
data, 349-351
error_log, 347
event_log, 348
global_symbols, 352
local_symbols_in, 353
memory, 354-357
memory mnemonic, 33, 176
pod_command, 348
registers, 173-174, 358
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simulated_io, 359
software_breakpoints, 360
status, 200, 348
symbols, 143
trace, 204, 361-364

display mode, 517
display trace, 226-238

about line number, 227-228
absolute format, 229
count absolute/relative, 235
default, 237
external data, 238
mnemonic format, 230
offset by, 236
positioning, left/right, 205
positioning, up/down, 205
source line inclusion, 231
symbol information inclusion, 233
width of columns, 234

displaying
registers, 173
simulated io screen, 194, 196

displays, copying, 340
DMA limitations, 129
don’t care digits, 208
downloading absolute files, 5, 141
driving background cycles to target system, 134
DTACK interlock, 122, 128, 131

for monitor, 119
DTACK when out-of-circuit, 129
dual-port emulation memory, 110
duration measurements (SPMT), 260-268

average time, 265
confidence level, 266
error tolerance, 266
interpreting reports, 265
maximum time, 265
minimum time, 265
number of intervals, 265
recursion considerations, 260
selecting, 263
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standard deviation, 266
trace command setup, 261

E editing
command line entry area with popup menu, 81
command line entry area with pushbuttons, 80
file, 189, 313
file at address, 189, 313
file at program counter, 189
file at symbol from symbols screen, 189
file from memory display screen, 189

embedded microprocessor system, 517
emul700, command to start the emulator/analyzer interface, 53
emulation bus analyzer, 517
emulation memory, 121

dual-port, 110
loading absolute files, 141
size of, 121
synchronizing to target system, 122

emulation monitor, 517
foreground or background, 112-119
function of, 113

emulation session
exiting, 60

emulation, external analyzer mode, 282
emulator, 518

bus error response, 131
configuring the, 96
data bus width, 133
device table file, 32, 53-54
error messages, 455
general description, 4
multiple start/stop, 5, 297-298
running from target reset, 155
status lines, predefined values for, 211
using the, 140

emulator configuration
address driven during background, 134
background cycles driven to target, 134
break processor on write to ROM, 136
bus arbitration, 129
bus arbitration tagging, 130
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bus error response, 122
bus error response by emulator, 131
clock selection, 108
data bus width, 133
DTACK interlock, 128
DTACK interlock for monitor, 119
exiting the configuration interface, 107
function codes driven during background, 134
inverse assembly syntax, 110
load command, 375
loading from file, 107
modify command, 378
modifying a configuration section, 102
monitor entry after, 109
restrict to real-time runs, 109
starting the configuration interface, 100
storing, 104
supervisor stack pointer reset value, 132
target memory access size, 133
target system interrupts enable/disable, 132
trace background/foreground operation, 137
TRAP instruction for breakpoint, 137

emulator limitations, 129
DMA support, 121

emulator status
displaying, 193

emulator/analyzer interface
exiting, 47, 59-60
running in multiple windows, 53
starting, 53-56

enable/disable target system interrupts, 132
end command, 47, 60, 365
entry

pod commands, 92
simulated io, 195

entry buffer, 27
address copy-and-paste to, 69
clearing, 68
copy-and-paste from, 72
copy-and-paste to, 68
Entry Buffer Recall dialog box, 27
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Entry Buffer Recall dialog box, operation, 71
multi-window copy-and-paste from, 72
multi-window copy-and-paste to, 69
operation, 71
recall button, 27
recalling entries, 71
symbol width and copy-and-paste to, 69
text entry, 68
with action keys, 71, 73
with pulldown menus, 71

Entry Buffer Recall dialog box operation, 74
environment variables (UNIX)

HP64KPATH, 90
HP64KSYMBPATH, 417
PATH, 53
Softkey Interface, setting while in, 186

eram, memory characterization, 122
erom, memory characterization, 122
error log

to file, 193
error messages, 434

analyzer, 473
emulator, 455
general and system error/status, 460
Terminal Interface, 455

error_log
copy command, 340
display command, 347

event log
to file, 193

event_log, 57
copy command, 340
display command, 348

EXECUTE
CMB signal, 292
tracing at, 297

exit, emulator/analyzer interface, 47, 59-60
exiting

emulation session, 60
emulator/analyzer windows, 59

expressions, 207
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--EXPR-- syntax, 366-368
external analyzer

configuration, 279-287
general description, 4
labels, 280, 286
mode, 282
should emulation control?, 280
using, 274

external data, trace display option, 238

F file
breakpoints screen to, 192
data values screen to, 192
display area to, 192
editing, 189
editing at address, 189
editing at program counter, 189
editing at symbol from symbols screen, 189
editing from memory display screen, 189
emulator configuration, 104
emulator configuration load, 107
emulator status screen to, 193
error log to, 193
event log to, 193
global symbols to, 193
local symbols to, 193
memory to, 192
pod commands screen to, 193
registers to, 192
trace listing to, 192

file extensions
.EA and .EB, configuration files, 104

file formats
address ranges for SPMT measurements, 249
time ranges for SPMT measurements, 263

File Selection dialog box operation, 74-75
firmware updates, 5
foreground, 112-113, 518
foreground monitor, 113

advantages/disadvantages, 114
customizing, 114
emulator modes when using, 113
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example of using, 117
location of shipped files, 114
memory space required, 114
selecting, 112-119
single-step processor, 116-117

foreground operation, tracing, 137
formal parameters (command files), 87
forward command, syntax, 371
function code lines to analyzer, 210
function codes

driven during background, 134
mapping memory, 126
memory mapping, 126
monitor, 116
need for separately linked modules, 126

functions, step over, 176

G global restart qualifier, 223, 518
global symbols, 33, 208, 352

copy command, 340
display command, 144, 352
initializing the SPMT measurement with, 249
to file, 193

grabbers
connecting to analyzer probe, 277

guarded memory accesses, 122, 126, 219

H halfbright, 79-80
halt, trace, 203
hand pointer, 27, 67
hardware

HP 9000 memory needs, 493
HP 9000 minimum performance, 493
HP 9000 minimums overview, 492
SPARCsystem memory needs, 494
SPARCsystem minimum performance, 494
SPARCsystem minimums overview, 494

help
command line, 82
copy command, 340
help index, 77
on-line, 85
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softkey driven information, 85
help command, 372-373
help index, displaying, 77
hexadecimal numbers, 208
HP 9000

700 series Motif libraries, 493
HP-UX minimum version, 493
installing software, 495-505
minimum system requirements overview, 492

HP 98659 RS-422 Interface Card, 5
HP-UX

minimum version, 493
HP64KPATH, UNIX environment variable, 90
HP64KSYMBPATH environment variable, 417

I IEEE-695 absolute file format, 141
input

pod commands, 92
simulated io, 195

input scheme, 312, 486
installation

at a glance, 492-494
HP 9000 overview, 492
HP 9000 specific instructions, 495-505
SPARCsystem specific instructions, 506-515
SPARCsystems overview, 494

instance name, X applications, 481-482
interactive measurements, 299
interface

exiting, 60
interface, emulator configuration

exiting, 107
modifying a section, 102
starting, 100

interlock DTACK, 122, 128
for monitor, 119

interrupts, 114
enable/disable from target system, 132

inverse assembly syntax, emulator configuration, 110
inverse video

graphical interface demo/tutorial files, 322
inverse video, source line display option, 231
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K keyboard
choosing menu items, 65
pod commands, 92
simulated io, 195

keyboard accelerators, 66
keyboard focus policy, 66
keyboard_to_simio, modify command, 379

L label scheme, 312, 316, 486
labels

configuration file, 287
LANG environment variable, 486
LD_LIBRARY_PATH environment variable, 510
libraries

Motif for HP 9000/700, 493
limitations, DMA, 129
line numbers (source file), symbol display, 145
line numbers (trace)

displaying about, 228
line numbers (trace), displaying about, 227
lines in main display area, 313-314
list, trace, 204
load command, 374-375

absolute files, 141
configuration, 375
trace, 241-242, 375
trace_spec, 240, 375

local symbols, 208, 353
copy command, 342
display command, 145, 353
initializing the performance measurement with, 249
to file, 193

locked, end command option, 60
log_commands command, 376

M map command, 127
mapper ranges, 120
mapping memory, 120-127
memory, 343-344

activity measurements (SPMT), 245, 252
characterization of, 122
contents listed as asterisk (*), 343
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copy command, 343-344
display command, 354-357
displaying, 175
displaying at an address, 179
displaying repetitively, 180
dual-port emulation, 110
loading programs into, 141
mapping, 120-127
mnemonic format display, 176
modify command, 380-382
modifying, 180
re-assignment of emulation memory blocks in mapper, 125
store command, 415
to file, 192

memory mapping
block size, 120
function code specification, 126
overlaid addresses, 126
resolution, 120
using emulation memory in place of target, 127

memory recommendations
HP 9000, 493
SPARCsystem, 494

memory refresh, 98
menus

editing command line with popup, 81
hand pointer means popup, 27, 67
pulldown operation with keyboard, 65
pulldown operation with mouse, 64-65

messages
status, 460
Terminal Interface error, 455

mixed, slave clock mode, 283
mnemonic information in trace listing, 230
mnemonic memory display, 33, 176
mnemonic memory display, setting the source/symbol modes, 183
modes, source/symbol, 183
modify

registers, 174
modify command, 377

configuration, 378
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keyboard_to_simio, 379
memory, 380-382
register, 383
software_breakpoints, 384-385

modify_command, trace command option, 206
module duration measurements (SPMT), 260
module usage measurements (SPMT), 260
monitor (emulation)

address of, 116
foreground monitor filename, 116
foreground or background, 112-119
foreground/background comparison, 114
function code selection, 116
function of, 113
selecting, 112-119
selecting entry after configuration, 109

Motif
HP 9000/700 requirements, 493

mouse
choosing menu items, 65

mouse buttons, 29
mouse, choosing menu items, 64
multi-window

copy-and-paste from entry buffer, 72
copy-and-paste to entry buffer, 69

multiple commands, 83
multiple emulator start/stop, 5

N name_of_module command, 187
nesting command files, 86
NORMAL key, 334, 366
nosymbols, 143
notes

"perf.out" file is in binary format, 270
breakpoint locations must contain opcodes, 165, 167
CMB EXECUTE and TRIGGER signals, 292
external timing analyzer does not use configuration labels, 287
measurement errors on recursive/multiple entry routines, 261
only one range resource available, 395
re-assignment of emulation memory blocks by mapper, 125
selecting internal clock forces reset, 108
some compilers emit more than one symbol for an address, 253
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step command doesn’t work when CMB enabled, 297
trigger found but trace memory not filled, 205

number bases, 207
number of source lines, trace display option, 231
numerical values, 207

O occurrence counts, 214, 221
octal numbers, 207
offset by, trace display option, 236
on-line help, 85
on_halt, trace command option, 219
only, trace command storage qualifier, 215
operating system

HP-UX minimum version, 493
SunOS minimum version, 494

operators, 208
overlaid addresses

memory mapping, 126
overview

HP 9000 installation, 492
installation, 492-494
SPARCsystems installation, 494

P parameter passing in command files, 87
parent symbol

displaying from symbols screen, 149
paste mouse button, 29
PATH, UNIX environment variable, 53
perf.out, SPMT output file, 250, 264, 269-271, 386
perf32, SPMT report generator utility, 244, 269-270

interpreting reports, 252, 265
options, 271
using the, 271

performance measurements
See software performance measurements

performance_measurement_end command, 386
performance_measurement_initialize command, 387-388
performance_measurement_run command, 389-390
platform

HP 9000 memory needs, 493
HP 9000 minimum performance, 493
SPARCsystem memory needs, 494
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SPARCsystem minimum performance, 494
platform scheme, 312, 485
pod commands, 391-392

copy command, 341
display command, 348
display screen, 92
keyboard input, 92
screen to file, 193

popup menus
command line editing with, 81
hand pointer indicates presence, 27, 67

positioning the trace display left/right, 205
positioning the trace display up/down, 205
prestore, 216
prestore qualifier, 216
prestore qualifiers, 216, 518
primary branches (analyzer sequencer), 518
processor data bus width, 133
processor type, 54
program activity measurements (SPMT), 245, 252
program counter

mnemonic memory display, 34
running from, 154

pulldown menus
choosing with keyboard, 65
choosing with mouse, 64-65

pushbutton select mouse button, 29

Q QUALIFIER, in trace command, 393-394
qualifiers, 211

count, 217
prestore, 216
simple trigger, 212
slave clock, 283
storage, 215

R RAM, mapping emulation or target, 122
range resource, note on, 395
RANGE, in trace command, 395-396
ranges, memory mapper, 120
READY, CMB signal, 291
real-time execution, 518
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real-time runs
commands not allowed during, 110
restricting the emulator to, 109

recall buffer, 27
columns, 319
initial content, 319-320
lines, 319
recalling entries, 71

recall, command, 84
dialog box, 82

recall, trace specifications dialog box, 206
recursion in SPMT measurements, 260
registers

copy command, 345
display command, 358
display/modify, 173-174
displaying, 173
modify, 174
modify command, 383
to file, 192

registers, displaying, 39
relative count, in the trace display, 235
release_system, end command option, 47, 60, 104
repetitive display of memory, 180
reset (emulator), commands which cause exit from, 159
reset command, 397
reset SSP and foreground monitor, 132
reset value for supervisor stack pointer, 132
reset, run from target, 155
resolution, memory mapper, 120
resource

See X resource
RESOURCE_MANAGER property, 484
restart term, 221, 223
restrict to real-time runs

emulator configuration, 109
permissible commands, 109
target system dependency, 109

ROM
mapping emulation or target, 122
writes to, 122
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RS-422, host computer interface card, 5
run command, 154, 398-399
run from reset, 155

S scheme files (for X resources), 311, 485
color scheme, 312, 316, 486
custom, 316-317, 487
input scheme, 312, 486
label scheme, 312, 316, 486
platform scheme, 312, 485
size scheme, 312, 486

scroll bar, 27
secondary branch expression, 518
select mouse button, 29
selecting emulation monitor, 112-119
sequencer (analyzer), 518

branch, 519
terms, 221, 518
using the, 221-225

SEQUENCING, in trace command, 400-401
server, X, 310, 484
set command, 402-406
shell variables, 88
sig INT, 269
signals, CMB, 291
simulated I/O, 96, 379

display command, 359
simulated io

displaying screen, 194, 196
keyboard input, 195

size scheme, 312, 486
slave clocks, 283
softkey driven help information, 85
softkey pushbuttons, 27
softkeys, 83
software

installation for HP 9000, 495-505
installation for SPARCsystems, 506-515

software breakpoints, 160-172
clearing, 170
clearing all, 172
copy command, 341
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deactivating, 167
display command, 360
enable/disable, 163
modify command, 384-385
opcode locations, 165, 167
permanent, setting, 165
re-activating, 168
ROM code, 160
selection of TRAP instruction, 137
setting, 166
setting all, 167
setting while running user code, 161

software breakpoints list, displaying, 162
software performance measurements, 243, 245-272

absolute information, 252
activity measurements, 245-259
adding traces, 250, 264
duration, 260-268
end, 386
ending, 270
how they are made, 244
initialize, 387-388
initializing, 248, 263
initializing, default, 248
initializing, duration measurements, 263
initializing, user defined ranges, 249, 263
initializing, with global symbols, 249
initializing, with local symbols, 249
memory activity, 245, 252
module duration, 260
module usage, 260
program activity, 245, 252
recursion, 260
relative information, 252
restoring the current measurement, 250, 264
run, 389-390
running, 269
trace command setup, 247
trace display depth, 247

source lines
set command, 405
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symbol display, 145
trace display, 231
trace display, number of, 231

source/symbol modes, setting, 183
SPARCsystems

installing software, 506-515
minimum system requirements overview, 494
SunOS minimum version, 494

specify command, 407-408
SPMT (Software Performance Measurement Tool)

See software performance measurements
sq adv, captured sequence state, 222
SRU (Symbolic Retrieval Utilities), 417-418
SSP unaffected by target resets during background, 132
Stack is in guarded memory, error message, 133
stack pointer (supervisor), reset value, 132
state, external analyzer mode, 282
STATE, in trace command, 409-410
status

copy command, 341
display command, 200, 348

status (analyzer state qualifier softkey), 211, 396, 410
predefined values for, 211

status line, 27
status line (display), 57
status, emulator

screen to file, 193
step command, 35, 157-158, 411-412
step over, 176
stop_trace command, 203, 413
storage qualifiers, 215
store command, 414-415

absolute files, 141-142
store trace command, 241-242
store trace_spec command, 239
summary of commands, 335
SunOS

minimum version, 494
supervisor stack pointer, reset value, 132
switching

directory context in configuration window, 105
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directory context in emulator/analyzer window, 152
symbol context, 153

--SYMB-- syntax, 416-422
symbol context

changing, 153
displaying, 152

symbol file, loading, 143
symbols, 143, 208

displaying, 143
displaying parent from symbols screen, 149
global to file, 193
local to file, 193
set command, 405
--SYMB-- syntax, 416-422
trace display, 233

synchronous measurements, 297
syntax conventions, 334
system requirements

HP 9000 overview, 492
HP-UX minimum version, 493
OSF/Motif HP 9000/700 requirements, 493
SPARCsystem overview, 494
SunOS minimum version, 494

T t (start trace) command, 200
tabs are, source line display option, 231
tagging bus arbitration, 130
target memory

access size, 133
loading absolute files, 141
ROM, symbols for, 143

target reset, running from, 155
target system, 519

dependency on executing code, 109
interrupts, enable/disable, 132
RAM and ROM, 122

terminal emulation window, opening, 193
threshold voltages, 280-281
time range file format (SPMT measurements), 263
timing

external analyzer mode, 282
trace, 519
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at EXECUTE, 297
copy command, 346
depth of, 206
display command, 361-364
displaying the, 204
halting the, 203
listing the, 204
listing to file, 192
load command, 375
loading, 241-242
on_halt, 219
prestore qualifier, 216
recalling trace specifications, 206
starting the, 200
stopping the, 203
storage qualifier, 215
storage qualifier with prestore, 216
store command, 415
storing, 241-242
Trace Specification Selection dialog box, 206
trigger position, 212

trace command, 423-425
default, 200
loading and storing, 239-240
setting up for SPMT measurements, 247

trace display, 226-238
about line numbers, 227-228
absolute format, 229
count absolute/relative, 235
default, 237
depth, SPMT measurements, 247
external data, 238
mnemonic format, 230
offset by, 236
positioning, left/right, 205
positioning, up/down, 205
source line inclusion, 231
symbol information inclusion, 233
width of columns, 234

trace display, setting the source/symbol modes, 183
trace signals (emulation analyzer), 209
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trace status display, 200
trace_spec

load command, 375
store command, 415

tracing background operation, 137
tram, memory characterization, 122
transfer address, 155
TRAP instruction

selecting for software breakpoints, 137
software breakpoints (68000), 160

trigger, 519
condition, 212
position, 212
position, accuracy of, 212
specifying a simple, 212
stop driving on break, 304

TRIGGER, CMB signal, 291
TRIGGER, in trace command, 426-427
trom, memory characterization, 122
TTL (softkey for specifying threshold voltages), 281
tutorials

setting up, 321-323

U undefined software breakpoint, 160
uploading memory, 5
user (target) memory, loading absolute files, 141
user program, 518

V values, 207
predefined for analyzer state qualifiers, 211

vector table, 132
voltages, threshold, 281

W wait command, 428-429
command files, using in, 86

watchdog timer, 98
widget resource

See X resource
width of columns, trace display option, 234
window

exiting emulator/analyzer, 59
WINDOW, in trace command, 430-431
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window, terminal emulation, opening, 193
windows

opening additional emulator/analyzer, 57
running the emulator/analyzer interface in multiple, 53

workstation
HP 9000 memory needs, 493
HP 9000 minimum performance, 493
SPARCsystem memory needs, 494
SPARCsystem minimum performance, 494

write to ROM break, 136

X X client, 310
X resource, 310

$XAPPLRESDIR directory, 484
$XENVIRONMENT variable, 485
.Xdefaults file, 484
/usr/hp64000/lib/X11/HP64_schemes, 487
app-defaults file, 484
class name for applications, 482
class name for widgets, 482
command line options, 485
commonly modified graphical interface resources, 312
defined, 481
general form, 481
instance name for applications, 482
instance name for widgets, 481
loading order, 484
modifying resources, generally, 312-315
RESOURCE_MANAGER  property, 484
scheme file system directory, 487
scheme files, Graphical User Interface, 485
scheme files, named, 486
schemes, forcing interface to use certain, 485
Softkey.BW, 486
Softkey.Color, 486
Softkey.Input, 486
Softkey.Label, 486
Softkey.Large, 486
Softkey.Small, 486
wildcard character, 482
xrdb, 484
xrm command line option, 485

Index

547



X server, 310, 484
X Window System, 53
xbits, external analyzer label, 286
XEnv_68k_except symbol and effect on breakpoionts, 163
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Certification and Warranty

Certification 

Hewlett-Packard Company certifies that this product met its published
specifications at the time of shipment from the factory.  Hewlett-Packard further
certifies that its calibration measurements are traceable to the United States
National Bureau of Standards, to the extent allowed by the Bureau’s calibration
facility, and to the calibration facilities of other International Standards
Organization members. 

Warranty 

This Hewlett-Packard system product is warranted against defects in materials and
workmanship for a period of 90 days from date of installation.  During the warranty
period, HP will, at its option, either repair or replace products which prove to be
defective. 

Warranty service of this product will be performed at Buyer’s facility at no charge
within HP service travel areas.  Outside HP service travel areas, warranty service
will be performed at Buyer’s facility only upon HP’s prior agreement and Buyer
shall pay HP’s round trip travel expenses.  In all other cases, products must be
returned to a service facility designated by HP. 



For products returned to HP for warranty service, Buyer shall prepay shipping
charges to HP and HP shall pay shipping charges to return the product to Buyer.
However, Buyer shall pay all shipping charges, duties, and taxes for products
returned to HP from another country. HP warrants that its software and firmware
designated by HP for use with an instrument will execute its programming
instructions when properly installed on that instrument.  HP does not warrant that
the operation of the instrument, or software, or firmware will be uninterrupted or
error free. 

Limitation of Warranty 

The foregoing warranty shall not apply to defects resulting from improper or
inadequate maintenance by Buyer, Buyer-supplied software or interfacing,
unauthorized modification or misuse, operation outside of the environment
specifications for the product, or improper site preparation or maintenance. 

No other warranty is expressed or implied. HP specifically disclaims the
implied warranties of merchantability and fitness for a particular purpose.

Exclusive Remedies

The remedies provided herein are buyer’s sole and exclusive remedies. HP
shall not be liable for any direct, indirect, special, incidental, or consequential
damages, whether based on contract, tort, or any other legal theory.

Product maintenance agreements and other customer assistance agreements are
available for Hewlett-Packard products. 

For any assistance, contact your nearest Hewlett-Packard Sales and Service Office.



Safety

Summary of Safe Procedures

The following general safety precautions must be observed during all phases of
operation, service, and repair of this instrument. Failure to comply with these
precautions or with specific warnings elsewhere in this manual violates safety
standards of design, manufacture, and intended use of the instrument.
Hewlett-Packard Company assumes no liability for the customer’s failure to
comply with these requirements.

Ground The Instrument

To minimize shock hazard, the instrument chassis and cabinet must be connected to
an electrical ground. The instrument is equipped with a three-conductor ac power
cable. The power cable must either be plugged into an approved three-contact
electrical outlet or used with a three-contact to two-contact adapter with the
grounding wire (green) firmly connected to an electrical ground (safety ground) at
the power outlet. The power jack and mating plug of the power cable meet
International Electrotechnical Commission (IEC) safety standards.

Do Not Operate In An Explosive Atmosphere

Do not operate the instrument in the presence of flammable gases or fumes.
Operation of any electrical instrument in such an environment constitutes a definite
safety hazard.

Keep Away From Live Circuits

Operating personnel must not remove instrument covers. Component replacement
and internal adjustments must be made by qualified maintenance personnel. Do not



replace components with the power cable connected. Under certain conditions,
dangerous voltages may exist even with the power cable removed. To avoid
injuries, always disconnect power and discharge circuits before touching them.

Do Not Service Or Adjust Alone

Do not attempt internal service or adjustment unless another person, capable of
rendering first aid and resuscitation, is present.

Do Not Substitute Parts Or Modify Instrument

Because of the danger of introducing additional hazards, do not install substitute
parts or perform any unauthorized modification of the instrument. Return the
instrument to a Hewlett-Packard Sales and Service Office for service and repair to
ensure that safety features are maintained.

Dangerous Procedure Warnings

Warnings, such as the example below, precede potentially dangerous procedures
throughout this manual. Instructions contained in the warnings must be followed.

WARNING Dangerous voltages, capable of causing death, are present in this instrument. Use
extreme caution when handling, testing, and adjusting.



Safety Symbols Used In Manuals

The following is a list of general definitions of safety symbols used on equipment
or in manuals:

Instruction manual symbol: the product is marked with this symbol when it is
necessary for the user to refer to the instruction manual in order to protect against
damage to the instrument.

Indicates dangerous voltage (terminals fed from the interior by voltage exceeding
1000 volts must be marked with this symbol).

Protective conductor terminal. For protection against electrical shock in case of a
fault. Used with field wiring terminals to indicate the terminal which must be
connected to ground before operating the equipment.

Low-noise or noiseless, clean ground (earth) terminal. Used for a signal common,
as well as providing protection against electrical shock in case of a fault. A terminal
marked with this symbol must be connected to ground in the manner described in
the installation (operating) manual before operating the equipment.

Frame or chassis terminal. A connection to the frame (chassis) of the equipment
which normally includes all exposed metal structures.

Alternating current (power line).

Direct current (power line).

Alternating or direct current (power line).



Caution The Caution sign denotes a hazard. It calls your attention to an operating procedure,
practice, condition, or similar situation, which, if not correctly performed or
adhered to, could result in damage to or destruction of part or all of the product.

Warning The Warning sign denotes a hazard. It calls your attention to a procedure, practice,
condition or the like, which, if not correctly performed, could result in injury or
death to personnel.
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